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Introduction

Thank you for purchasing the Model 22X PCB Automatic Optical Inspection (AQI) system. To ensure
proper use, please read this User's Manual carefully.

- It is forbidden to reprint or copy the part or all of contents of this manual without permission.
- Contents of this manual may change without notice for improvement.

Please be advised of the following:

1. Users should have basic computer skills. Personal computers and peripherals have been purchased
by proxy, and our responsibility, when failures or problems occur, shall be limited to making repair
and replacement requests to the computer manufacturer

2. Regarding all defects and bugs in the software, update notices will be sent to you for 1 year after
shipment. The latest software is available for free download at http://www.model22x.com/.

3.Please dedicate a personal computer for use only with this device. Changes in the operating environ-
ment may lead to decreased performance or result in defective operation.

4. Failures and problems that occur within 1 year after purchase, and for which we are responsible, will
be repaired and improved at no additional charge. However, please understand that we will not be
responsible for any data loss that occurs during the repair process. Data restoration shall be the cus-
tomer’s responsibility.

5.The principle of pattern matching is based on measuring the level of similarity between two images.
The tolerances for determining similarity can be set higher or lower. However, the inspection result
may incline toward either OK or NG.

6. We will not be liable for any damage to the inspected PCB by our AOI or for missing or False NGs.

7. The brightness of lighting may change depend on environment, please calibrate the lighting regularly
using the 22X software.
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1. Model 22X

Model 22X is a PCB Automatic Optical Inspection (AQI) system that inspects PCBs (Printed Circuit
Boards) for the presence of parts, misalignments, incorrect parts and letters, extra parts (such as solder
balls and scratches), as well as detecting solder printing, solder shorts and solder fillets.

H Model 22X Features

*The inspection process is very simple; using the mouse, just make a frame over the component/part to
be inspected or drag & drop the inspection frame from library on component.

*The Model 22X can inspect PCBs after many processes; after solder printing, after chip placer, after
mounter, and after re-flow.

*The Model 22X displays the inspection results in 3 view modes;
Map View, NG List View, NG Cell View.

H Inspection Procedure Overview
The Inspection procedure of Pattern Matching algorithm is as follows:

Place the Inspection Frame onto the part of the PCB that you want to inspect.

Store the Master Picture for each Inspection Frame. The Master Picture is an OK sample picture.
Compare the Inspection Frames to the Master Picture.

The Inspection Frame is divided into small grids and within each grid, if the difference rate caused
by the subtraction (displayed as light leakage) is within acceptable tolerances, it will be judged
OK. If the rate is out of acceptable tolerances, it will be judged NG. Color in each grid is also
checked, which means that even if the brightness and geometry are the same, the Inspection
Frame will be judged NG if the color is different.

As described above, the inspection method is quite simple, but OK/NG criteria can be customized in vari-
ous ways. Moreover, screen displays can be customized for ease of use. Various Inspection settings are
possible depending on the PCBs manufacturing process. Using this manual as a reference, please find
the method that best meets your needs.
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2. 22X Interface

The Model 22X software is designed for easy operation using a mouse. First, you need to understand
the configuration of the main window, which is the main workspace.

Other windows are described in their corresponding chapters. For your reference, all of the menu items
are explained in the following Chapters.

2-1 Main Window

The display resolution differs by model. Older models use the standard Normal Pixel Display while new-
er models use the high resolution Mega pixel Display.

1. Work area
This is an area used in many tasks such as changing the displayed area or placing Inspection Frames.
The behavior changes depending on the tool that is selected.

2. Pointer Tool
This tool is used to create stamp from automatic stamp creation wizard, or select Inspection Frames.
Frames can be moved by dragging and dropping.

Main Window (Normal Display)

o- dddd
b

18/ o L(LLLL DIPAD
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3. Inspection Frame Tool
This tool is used to create Inspection Frames. The default is the Rectangle tool, but by clicking and
holding down the mouse, you can select the Rectangle, Oval or Polygon tools.
This tool can also be changed to the Stamp tool. The stamp tool is used to paste stamps.

4. Move Tool
This tool moves the PCB and changes the display area.

5. Eject Button
This button moves the PCB to the front in order to gject it. By holding mouse down, sub menu appears.
You can select menu from “Eject”, “Home”, and “Origin”.

6. Swap A/B Button
When inspecting both sides of the PCB, this button allows you to select either the A or B-side.

7. Eyeglass Button
This button is used to create or display the Map View, or to display NG Symbols.

8. Pitch Button
The frame around the work area is actually a button that is used to move the PCB. When you move the
mouse pointer over the frame, the pointer changes to a triangle. Then, when you click on the frame, the
PCB moves by the Pitch value. The Pitch value can be customized from the Settings Menu > Con-
figuration > General and changing the Pitch X% and Pitch Y% values.

9. Message Bar
Warnings will be displayed in this area. Information and coordinates about the selected inspection frame
will also be displayed here.

Main Window (VGA size Display)

6 0

:
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10. Master Picture Area
When you select the inspection frame in the Work Area, the Master Picture of the selected frame will be
displayed here. The ¥ button displayed on the upper left is the Master Picture Pull-Down Menu that in-
cludes menu items to edit the Master Picture.

11. Cell Map Area
This area displays the position of each cell on the PCB. When a cell is selected, details of the selected
cell are displayed in the work area.
When a cell is selected in the Cell Map Area, Inspection Frames will not be displayed in the cell.
A cell is a shot by the 22X's camera.

[ Cell Operation Tools ]
These are tools used for operations within the Cell Map.

12. Cell Menu Button
Pull-Down menu for cell operations.

13. Cell Selection Tool
The Cell Menu Button becomes active only after selecting this tool and dragging over cells.

14. Cell Expansion Tool
By selecting this tool and dragging over a cell(s), the selected cell(s) within the Cell Map Area will be en-
larged.

15. Blend Tool
This tool allows you to set the blend rate when displaying the PCB image as the cell map background.
The PCB image will not be displayed when no cell is selected. The PCB image is displayed clearly at
FULL, but the cells will become somewhat blurry.

[ Inspection Frame Tools ]
These tools are used for the selected Inspection Frame.

16. Re-inspection Button
This button is for inspecting the selected Inspection Frame again.

17. Analyze Button
This button is for analyzing the selected Inspection Frame.

18. Add Master Picture Button
This button is for adding the selected Inspection Frame image as a Master Picture.

19. Delete Button
This button is for deleting the selected Inspection Frame.

[ Control Buttons ]

20. NG Pause Button
This button sets the system to pause when an NG point is found during inspection. To use this setting,
click to highlight this button before inspection.

21. Start Button
This button starts inspection.

22. Stop Button
This button stops inspection. When this button is pressed, the next inspection will start from the begin-
ning of the inspection process.

23. Pause Button
This button pauses inspection. When pressing the Start Button, the inspection is re-started from the
paused position.

6
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3. Startup, Shut Down and
Authorisation

Operations for Startup and Shut Down as well as Authorisation are explained in this chapter. (Software
Installation and all initial settings have been completed before you receive the product. If these operations
are required, please refer to chapters 25 and 26).

3-1 Startup

M The Startup procedure is as follows:

1. Turn on the power on the 22X machine.

2. Press the power key of the Macintosh to start up the computer.

3. If the 22X software is included as a startup item, the program will launch automatically. If not,
double click the 22X icon to launch the software.

4. After starting up, message for machine warm-up will be displayed. This message will be dis-
played whenever you reboot the computer.

5. When the “Warm-Up” button is clicked, the 22X machine confirms the Origin positions and
begins the warm-up procedure until lighting stabilization is done. Press “Cancel” button, and
message will disappear when warm-up procedure is not necessary.

6. If warm-up procedure is not done, press “Origin” button to confirm the Origin positions.

* The user can set the warm-up time. Click on the clock icon in the warm-up dialog to enter the
desired warm-up time.

The warm-up time can be set in minute increments ranging from 5 to 60 minutes.

3-2 Shut Down

B The Shut Down procedure is as follows:

1. Select Shut Down from the File menu to shut down the 22X software.

2. Select Shut Down... from the Apple Menu on the left top corner of the Macintosh screen to
shut down the system.

3. Turn off the power on the 22X machine.
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3-3 Authorisation

Authorisation sets the user level.

B Operator Mode ...... Allows operations for inspection.
B Programmer Mode ...... Allows editing of inspection programs.
W Supervisor Mode ...... No limits.

The mode can be changed by selecting File menu > Authorisation (Screen 1). Supervisor Mode is re-
quired to make 22X system settings. In that case, please follow these steps:

1.When you enter Operator Mode for the first time, or when you change from Programmer Mode
to Supervisor Mode for the first time, you are required to setup a password. When the entry
dialog is displayed, enter a case sensitive password (up to 16 characters).

2. For verification, Re-entry of the password will be requested. The mode will change after you
correctly re-enter the password.

3. The software will launch in the selected mode the next time you run the software.

* The password is required when changing from Operator Mode to Programmer Mode, or from Pro-
grammer Mode to Supervisor Mode. We recommend keeping a record of the password and keeping it
in a safe place.

* In Operator Mode, the menu bar is hidden, and operations are possible only from the operation but-

tons on the 22X machine. However, by clicking on the menu bar, you can select Open, Open Recent
File, Edit Mode, Operator Login, Print, Lot Number and Shut Down. By selecting Edit, you can
switch to the Programmer Mode (Screen 2).

* In Programmer Mode, the following items in the Settings menu cannot be changed; Calibrate Pixel/
cm, For Supervisor, Mechanical Calibration (except Check) and Reset Camera.

3-3

(Screen 1) (Screen 2)
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3-4 Operator Login

Who was operating AOI? By using Operator Login function, it will be obvious. Operator Login should not
be set if AQI is run by one person. But in the factory, many operators may work in different time schedule.
The AQI operator name can print on roll-paper or send to data server software Rc22X / CS-Center
together with the inspection result.

Please create and activate account as following;

1. Start 22X in Supervisor mode or Programmer mode.

2. Select Operator Account in Settings menu's Configuration (Screen 1).

3. Operator Account window opens (Screen 2). Press "+" button to add new operator, and press
"-" button to delete operator.

4. Set Log-in ID, Password, and Protect mode (optional). Protect mode can be selected from
"Unset", "Operator Mode", "Programmer Mode", and "Supervisor Mode". Initial setting is "---"
(No setting). Setting of Protect mode stays as same as setting which had been set at last time
you close 22X.

5. If the checkbox "Show Login window at software startup" is checked, log-in window is
displayed at startup from next time, and software can't be started without log-in (Screen 3).

6. After log-in, 22X starts by Protect mode which had been set at procedure 4. Operator name
is displayed after log-in at the bottom left of Work Area (Screen 4). In version 4.9.9 or later,
Operator Login menu is selectable also from Window menu.

7. If you start software in Operator mode, Operator Login menu is selectable and operator can
login also from this menu. This menu is useful at factory, in case the line keeps working and
can't stop AQI, from this menu, new operator can login without stopping AOI.

* In order to save AOI Operator name, "Show Login window at software startup" must be checked and
all staff has to login always.

3-4

(Screen 1)

(Screen 3)

(Screen 4)

(Screen 2)
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AQI operator name can be confirmed on repairing software Rep22X / CS-Repair greater version than
below.

Rc22X: Version 1.4.4.3 CS-Center: Version 1.1.3.1
Rep22X: Version 1.5.1.4 CS-Repair: Version 1.1.3.2
10
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4. Quickstart Guide

In order to use this software effectively, it is important to create an accurate Inspection program.. Creating
a good Inspection Program is the key to enabling a smooth inspection process. This chapter outlines the
operation for creating and verifying an Inspection Program (please refer to related chapters for details of
settings and other items).

Work Flow

Here is the basic inspection work flow:

V¥ [Creating Inspection Program ]
1. Preparation
Execute Automatic calibration.
2. Setting the PCB (Described in Chapter 6)
Correctly set the PCB and place Fiducial Mark(s).
3. Creating Stamp Library (Described in Chapter 7, 8 and 9)
Create Inspection Frames on the components you want to inspect. Only area where these
Inspection Frames are placed will be inspected.
4. Pasting Stamps
Paste stamps on the same components on PCB
5. Cell Optimization (Described in Chapter 11)
Merge neighboring cells to reduce the inspection time.
6. Test Run / Improvement
Test run the Inspection Program with the PCB used to create the program. If there are any
problems, review the program..
7. Creating Map View (Described in Chapter 12)
Create Map View for verification/classification.

V[ Tune-Up ]
8. Inspect another PCB

Run the Inspection Program with different PCBs.

WV [ Starting Inspection ]

9. Let's start inspection

11
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The above is just one example of an inspection workflow. The optimal method will vary depending on your
environment. Once you are familiar with the application, please identify the optimal method for effective
inspection.

* This software can handle CAD data when creating an Inspection Program (comma or tab delimiter
data in the CSV/Text format). By loading CAD Data, you can set Inspection Frames based on location
data contained in the CAD Data. Since part numbers are included in the data, it is much easier to find
the corresponding parts, and much faster to make the Inspection Program. Details for this process
are described in the following chapter.

4-1 Preparation

V¥ 4-1-1 Selecting the PCB

For accurate inspection, you need to select a reliable PCB to create the Master Pictures. Due to varia-
tions in the color of PCBs and components, and the glare of the solder, trial PCBs and old PCBs are not
suitable for creating the Master Picture.

V¥ 4-1-2 Calibration Settings
Confirm whether brightness and color are set up correctly (if Calibration is already done, skip this section).

. Select Calibrate from the Setting menu.

. When the dialog “Move to calibration position?” appears, click OK.

. The Work Area is colored in grey and the color meter will be displayed.

. Click on the Auto Cal. button.

. Make sure that all the color meter indicators except for saturation and hue are pointing close to

a A~ W N =

the center (Screen 1).
6. If your AOI has Diffuse-On Axis LED, press “renew DOAL’ to adjust the lighting timings.
7. Press Finish to exit calibration.

oo

. Press the Eject button to move the carrier to the front.

(Screen 1)
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V¥ 4-1-3 Environment Settings Confirmation

Select General from the Setting > Configuration menu. Normally, this can be left at the default set-
tings, but the settings may need to be changed depending on the PCB. Please refer to Chapter "Settings"
for details.

4-2 Setting the PCB

V¥ 4-2-1 PCB Carrier Adjustment (benchtop type only)

The carrier width should be adjusted to match the width of the PCB. Loosen the knobs on the carrier rall,
adjust the width to match the PCB, and tighten them well. If the PCB is even slightly loose, the results will
not be accurate, so please make sure that the PCB is completely fixed (Screen 1).

In F series and S (GTAZ) series with top clamping, PCB will move to the position of clamping when clicking
“PCB Width Setting” in sub menu when PCB is in gject position (Screen 2). You can adjust the width to
prevent PCB shifting after moved position. Also the model with the area sensor can perform adjustment
without detecting a sensor.

V¥ 4-2-2 Fiducial Mark(s) Setting
When PCB has fiducial marker(s), the marker position should be defined first. In order to facilitate camera
movement between each cell, it is recommended to set these in the beginning.

1. Display a marker in the center of the screen by using the Move Tool and Pitch Button.
2. Select Inspection Frame Tool, and create a frame larger than the marker (about twice the size
of the marker) (Screen 1).

4-2-1
(Screen 1) (Screen 2)
4-2-2
) Marker setting
u [l =[=]=] € ok )
— ]
I Ilvl I"I__I_ _I_I_ _I_ I
p Details ( Filter )
(Screen 1) (Screen 2) (Screen 3)
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4-2-2

&) Marker setting
o [CESlLEEE] - ONGETSD)
e
1 ] 1 ] I..-ﬂ:I- -I- I- -I- ] I—I-Eb-
b Details X0 YO (" Filter )
(Screen 5)

(Screen 4)

(Screen 6)

3. Select Assign Fiducial Mark from the Edit menu. A square icon appears within the frame, and
this frame will be recognized as the Fiducial Mark (Screen 2).

4. Click on the frame to display the Marker Setting Window (Screen 3).

5. Clearly delineate the Marker by converting the area surrounding the Marker to 2 bit (black and
white) data. In most cases, the slide bar can be moved while in the default "AT" mode, adjusting
it until the shape of the marker becomes transparent (Screen 4). When the AT mode does not
work well, use the color settings, and, if contrast is insufficient, click on Filter for more detailed
settings (Refer to 6 "Fiducial Marker Settings" for more details).

6. Select round, square or cross buttons depending on the shape of the marker.

7. Click on the Automatic Centering Button to set the center of the marker.

8. Press on the slide bar tab to confirm that the display shows "X0.0 Y0.0". A 1 to -1 error toler-
ance is acceptable (Screen 5).

9. Following the same procedure, set a second Fiducial Marker (Sub-Marker) on the diagonally op-
posite side. Then, confirm that two cells have been created, one that includes the Main Marker
and another that includes the Sub-Marker, in the Cell Map Area on the right. You can display
the marker positions by clicking on the Cell (Screen 6).

* Solder plated markers or non-uniform, thin copper foil PCBs tend to show more errors. In this case,

you may need to set it more precisely. Refer to Chapter 7, "Fiducial Marker" for more details.

4-3 Creating Stamp (Library)

This software inspects only the areas designated as Stamp Frames. It first checks the Inspection Frame
displayed on-screen, then the nearest Inspection Frame and so on. Creating Inspection Frame is a
very important process that defines the areas to be inspected while also creating an Good sample for
comparison. The recommended procedure here is to create Stamps starting from the top left and then
move right or down by Pitch Button.
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You can create stamp by drawing frame with mouse. Please refer to Chapter 7 for creating stamps.

4-4 Pasting Stamps

Library for many components may be created in the previous step. Next step is placing stamps on all
components on PCB. When you have CAD data, move to the next chapter. When you place stamps
manually, there is two ways to place stamps; “one by one” or “multiple and automatic”

The operation to place “one by ong”.
Select “Stamp Palette” from Stamp menu. Stamp list will be shown. Select a (pack) stamp. After
selecting a stamp, mouse cursor holds transparent stamp picture (Screen 1).
Move mouse cursor onto the component, and click the mouse. Stamp will be pasted.
There are two methods for "multiple and automatic" paste. One is to paste stamps on the similar images
of the current view in Work Area and the other is to paste stamps on Map View, that is, on the whole PCB
at once automatically.

The method to paste stamp automatically in the current view:

1. Select “Stamp Palette” from Stamp menu. Stamp list will be shown. Select a (pack) stamp, the
mouse cursor holds transparent stamp picture (Screen 1).

2. Select "Automatic Paste (Current View)" from Stamp menu. Stamp will automatically be
pasted on similar components in Work Area (Screen 2).

*The number of stamp pasted is shown in the message bar at the bottom left.
3. There is short cut for "Automatic Paste", press "command + g" on keyboard. After executing

Automatic Paste, if there is still a few components on where no stamp is pasted, press
"command + g" quickly twice or three times. The threshold of matching is more tolerant on

4-4

(Screen 1)
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4-4

-

(Screen 2)

>

(Screen 3)

second and third "command + g". As a result the components on where no stamp is pasted will
now have stamps (Screen 3).

The method to paste on the whole Map View:

1. Select “Stamp Palette” from Stamp menu and show Stamp list on the screen.
2. Create a Map View by clicking the glasses icon of the bottom menu bar. Be sure to create a
"high density" Map View.
* To use this function, the Map View has to be of high density.

3. Select "Automatic Paste (Map View)" from Stamp menu. [Automatic Paste List]
window appears. Add here the stamps you want to paste from the stamp list .
First, click a stamp from the Stamp list and move the mouse cursor to [Automatic Paste
List] window. When the mouse cursor shape changes into "+", click the mouse there.
The stamp is added in [Automatic Paste List]. (Screen 4)
If you want to paste multiple stamps, repeat the same steps. If you want to delete a stamp from
the list, click on the stamp and press [delete] key from the keyboard.
*Stamp without Master Picture cannot be added in the Automatic Paste List.

4. When completed the [Automatic Paste List], click [Start] button and 22X software starts pasting
the stamps in Map View.

* Stamp is not pasted at the edge of frame.

* Stamp is not pasted on angled component (such as 30 degrees, not 0/90/180/270 degrees).

* Stamp is pasted by referring master picture, therefore not all stamps are pasted.
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4-4

(Screen 4)

(Screen 5)

There stamps won't be pasted automatically: color too simple (one or two colors only), not
characteristic, including solder which shape and reflection differs. (Screen 5)

*The automatically pasted stamps have frames colored in red. By pressing [Stop] button, the
frame color turns back to normal.

*Automatic pasting on Map View takes time. (It takes about 20 minutes to paste 10 different
stamps on M sized PCB.) Recommended to use this function when you have enough time.

4-5 Cell Optimization

By optimizing cells, neighboring cells will be merged, thus reducing the total number cells and improving
inspection speed. After placing inspection frames, select all cells in the Cell Map, click on the Pull-Down
menu and select Cell Optimization (Screen 1).

* This is not necessarily the best way for optimization. There are other methods for optimization. Refer
to Chapter 11, "Cell Operation" for more details.

4-6 Tune-Up/Improvement

Now, click the Start Button

If the procedure has been followed correctly, the inspection will be executed starting with the Main Mark-
er > Sub-Marker > Inspection Frames, then move to the Eject position and OK/NG will be displayed in
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4-5

(Screen 1)

4-6

(Image 1)

the Work Area.(Image 1).

If NG is displayed, the filter setting may be too sensitive, reacting to camera noise or even to slight board
misalignments. Please check the NG Inspection Frame and adjust filter settings. For adjusting, please read
Chapter 8 for pattern matching frames, and Chapter 9 for histogram frames. Adjust untill all inspection
frames to be OK.

* In this procedure, the exact same PCB is being inspected, but it will not always return a 100%
match. The discrepancies are due to slight differences between the picture from the Master Picture
setup and the picture at the time of inspection. To avoid unnecessary re-inspections, this program is

designed to judge OK within a user-set range of acceptable tolerances.

4-7 Creating Map View

Click on the Eyeglass Button to create a PCB Map. NG points are displayed in red. Now, the work for
creating the Inspection Program is complete.

4-8 Inspect other PCBs

For the next step, the Inspection Program should be tested using a different PCB. Since the condition of
components/parts varies from PCB to PCB, it is important to test the inspection program using a second
PCB to adjust the tolerance of the Inspection Program in order to avoid False NGs and missing NGs.

1. Remove the PCB used for creating Inspection Program and set a different PCB.

2. Press the Start button on the machine to start inspection.

Even though there may be no actual NGs, slight differences will be detected NG. These will be displayed
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4-8

(Screen 1) (Screen 2)

on the screen as red frames or red cells (Screen 1).

3. If there are any NG points, the Map View with red marked NG points will be displayed after the
inspection. (when Display NG on Map is checked in Setting > General Setting (Screen 2)),
otherwise an NG message is displayed in the Work Area.

If NG is displayed, the filter setting may be too sensitive, Please check the NG Inspection Frame and
adjust filter settings. For adjusting, please read Chapter 9 for pattern matching frames, and Chapter 10 for
histogram frames. Adjust untill all inspection frames to be OK.

4-9 Actual Inspection

Inspection preparation is now complete. Let’s start inspection. While inspecting, if there are too many false
NG or a missing NG, please read next “Handling of missing NGs” and “Handling of false NGs”.

* Please carefully check if there are any NG points that have been missed or if there are any OK points

that have been flagged as NG (False NG). The following explains how to handle these cases.

4-10 Handling of missing NGs and false NGs

If an obvious defect has been missed or good components are detected NG, please try the following. In
order to reduce False NGs, the filter setting should be kept at high accuracy while slackening the tolerance

- Tune-up parameters of Pattern Matching and Histogram stamps.
- Change inspection algorithm (Pattern Matching <-> Histogram <-> Others).
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First, you need to analyze the cause of the missing/False NG and find the problems.
Following is the methods to measure false NG of pattern matching frames.

V¥V 4-10-1 Analysis
Following is the procedure to analyze False NGs.

1. Select the frame which was judged as NG. If you have moved from the Map View or the NG List
View, it is already selected.

2. Click on the Analyze button on the right. (Analysis can be suspended by clicking on the Stop
or Pause button.)

3. The interior of the frame is separated by grids. The sections divided by grids are colored in blue
or red. The blue frame is the matching area and the red frame shows the area that does not
match. In order to be judged as OK, all grids must be in Solid lined blue. The definition of the
grid colors is as follows (Screen 1).

Blue frame (Solid line) ... Within acceptable tolerances (OK)

Blue frame Dotted line ... Slightly out of acceptable tolerances NG
Red frame Solid line ... Matching NG

Red frame Bold line ... Saturation or hue NG

First, you need to closely study the color of the frames.

4. During the analysis, the cursor changes to a triangle, designating the direction being searched
for a matching pattern. The frame moves slightly to find the matching pattern.

5. In the end, the search for a matching pattern will terminate, marking the area as an NG. In this
case, the message bar will show the major causes of the failure. The failure definitions are as
follows:

B Mismatch - A pattern matching method is evaluated on each element of RGB. Pattern matching is
evaluated at each required resolution, and if acceptable tolerances are not met, it will be evaluated as a
Mismatch.

B Mismatch by Hue - After pattern matching is OK, hue differences are evaluated. Hue differences must
also fall within defined tolerances.

W Mismatch by Saturation (too low/too high) - After matching by hue, saturation differences are evaluated.
Saturation differences must also fall within defined tolerances.

After finding the problems, read Chapter 9 and change filter settings, add more master pictures or use
lighting selection to reduce missing/false NGs.

6. With Histogram stamps, open the setting window after analysis. You can confirm the % and
thresholds, read Chapter 10 and take measurements.

If the frame has multiple Master Pictures, switch the Master Pictures and press the Analyze button again.
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4-10-1 4-11

(Screen 1)

The analysis is executed only on the activated Master Picture.

4-11 Updating Stamps

When adjusting various Inspection Frames, you may need to change the frame size or the filter settings of
the same Stamp that is used in more than one place. If you change settings on Stamps one by one, you
are not taking full advantage of "common stamps".

Therefore, we recommend that you find optimum filter settings that can be used under as many conditions
as possible, and apply these changes to the Stamp itself. By using this method, you will no longer need to
edit the filter for each Inspection Frame. Just click on the Revising Stamps button (Screen 1) and select
Update all.

4-12 Save

Save the Inspection Program. For new Inspection Programs, the command will always be "Save As".
Changes to the software environment are also saved.

1. Enter the file name.
2. Click on "Save".
3. The window title will change to the saved name.
4. All the information that you have created will be saved.
* File name should be within 31 bytes. If exceeds, file name may not be shown/saved correctly.
* Save the programs in disks in Mac formatted. If you save them in Windows PC or Unix system

including NAS server, the program files are destroyed and you can't open them.

It is also possible to save data for both the surface and the back of the PCB as SIDE A and SIDE B. Refer
to 6-5, "Fiducial Mark and PCB side" for details.
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5. GAD Data Application Guide

This software can import CAD Data and NC data (Numerical Control Data) created by the P&P machine.
In this manual, such Data is called NC data. NC Data is a data file which indicates the coordinates of
components. The coordinates can be used to place each Inspection Frame into the Inspection Program.
This chapter explains how to apply NC Data.

This is a very useful method for positioning Inspection Frames, but since the size of the frame is not

included in the data, some additional works are required.

5-1 File Format to Import

The file formats that can be imported are one of the following. Rotation direction is counter clockwize.

1. CSV/TEXT Format (Comma, Tab separator)

This software also supports tab-delimited and comma delimited data. One component information must
be written in one line.
(Example)
1215,00795,000,1,R123, Partsname 1
1210,04455,090,2,C123, Partsname 2
3605,04430,000,3,D123, Partsname 3
3580,02665,000,4,E567, Partsname 4

This format follows the order “X, Y, W, Z, Ref.Des, Part Name”.
) ST Absolute location in direction X in 1/100mm units (Example: 123.56 X12356)
Y...... Absolute location in direction Y in 1/100mm units (Example: 345.67 Y34567)
W...... rotation in 90 degree increments (Example: W00180)
Z...... Part cassette number
The absolute position in the . XY direction is in 1/100mm units, but when decimal points are included, the

data will be interpreted in mm units.

2. Panaformat Type 1

Text format, file starts with a “$” and ends with an “*”.
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(Example)
$
N001/0G1M0T004X+00000Y+00000Z-00V+W+
N002/0M004T000X-14760Y-18930Z001V3W7

N051/0M004T000X-14990Y-189852025V1W1
N052/0M000T000X000000Y000000Z025V1W1
N053/0*
In the example above, the software imports only X, Y, Z and W data (other data will be ignored).
* Numbers for W can be 1 = 45 degrees, 2 = 90 degrees, 3 = 135 degrees in Pana format. Do not

forget to press Step 90’ in following procedure to avoid to treat W=1 as 1 degree.

3. Panaformat Type 2

Type 2 includes Ref.Des and Part Names in addition to X, Y, Z and W values.
(Example)
% HEADER
% NCDATA
NO001X0YOWO0Z1PN ()C ()M000100T/0;MARU1515
N0002X-08340Y+1666°0W000Z001PN (R1234)C (R 01)M000002T0/0;

4. 22X Data Format

Format that is output by 22X, which can be imported to 22X.
(Example)
$
X20300Y04500W00180200062;R121 \RA05010205
X21100Y11500W00180200062;R77 \RA05012005
X20300Y11500W00180Z00062;R10 \RA05047205
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The format follows these rules:
$...... Data start
eeenn Ref.Des, 15 characters or less (Example: ;ABC)
\...... Part Name, 31 characters or less ( Example: \RA345)
data is delimited with line breaks

R Data end

Ref.Des and Part Name must be placed after the separators (X, Y, Z, W) and Ref.Des always precede Part
Name. Ref.Des and Part Name must not include " or V.

Ref.Des and Part Name are not a requirement for NC Data. However, Ref.Des make the program much
easier to understand since Ref.Des will be included in the Stamp’s information and when showing the
inspection result in the Map View, 22X will display the Ref.Des next to the red circle pointing NG. When
applying Stamps to the corresponding components, the inclusion of Part Names will allow for a more in-

tuitive matching process. If NC Data contains the Part Name, the Stamp Name will be automatically gen-

erated from the Part Name while in Teach Mode.

5-2 Creating Stamps from CAD Data

V¥ 5-2-1 Setting the PCB

Set the PCB. The PCB must be completely non-defective.

V¥ 5-2-2 Importing Stamps
When using NC Data, a common technique is to create a Stamp beforehand, and apply the Stamp to the
components after importing NC Data. Before Importing NC Data, you should Import the Stamps that cor-

respond to the Part Names.

V¥ 5-2-3 Importing NC Data

Select Import Data File from the File menu, and choose the NC Data file. NC Data can be imported for
either side A or side B, but the Inspection Frames for the first side must be set and Combine Cells After

Import must be completed before importing the other side.

V¥ 5-2-4 Adjust PCB rotation

When NC Data is imported, the CAD coordinates arrangement window showing the coordinates of the NC
data will appear. Align it until it comes at the same position as the PCB by 3 buttons in orientation menu.
PCB size is shown at the bottom of the window.

* If the angle direction of your CAD data is clock wise, press flip to cw button.
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5-2-5

(Position adjustment Window (Screen 1) (Screen 2)

H Horizontally

When the lateral position of the layout and the actual PCB is inverse, click on Horizontally.

H Vertically

When the longitudinal position of the layout and the actual PCB is inverse, click on Vertically.

W 90 Degrees

When the layout and the actual PCB is misaligned by 90 degrees, click on 90 Degrees will rotate in ccw.

H flip to cw

Switch the direction of rotation. Default rotation directory of this machine is counter-clockwise, but some

Mounters rotation is clockwise. By pressing this button, the rotate direction will be clockwise.

M Flip marks

The coordinates X and Y are represented by the symbol mark of long square in the Position adjustment
window. By pressing this button, the marks rotate +90 degrees. This button only changes the view.

* When rotating Horizontally/Vertically, component angle may not match to stamp angle.

l Step 90’

If you want 22X to interpret 89 degrees to 90 degrees because of inaccurate P&P machine, or data is in

Panaformat, press this button to convert odd angles to 0/90/180/270.

V¥ 5-2-5 Positioning

Align the actual components shown in the Work Area and the NC Data coordinates shown in the Position

Adjustment Window by taking 1 fiducial point and 1 reference point (maximum 4 reference points).
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5-2-5

(Screen 3) (Screen 4)

(Screen 5) (Screen 6)

1.

If the data contains Part Name and Ref.Des, the CAD coordinates arrangement window will dis-
play the Ref.Des and Part Name when you move the cursor over the marks of coordinates. First,
select a point to be a fiducial and double click on it. The point should be nearest point from the

corner. The clicked point will be colored in red (Screen 2).

. In the Work Area, move to the component which corresponds to the coordinate chosen in

step.1, and set the component in the center of Work Area. Moving is possible by 4 arrow keys.
You can move 1 pixel by clicking arrow key. You can move 8 pixel by clicking arrow key with
pressing option or control key. You can move 64 pixel by clicking arrow key with pressing op-
tion + control keys. You can move a Cell by clicking arrow key with pressing shift key.

Click "Set fiducial" (Screen 3). The red color will turn blue, green grid is displayed and the win-

dow in separated into 4 blocks.

. Next, select a point in the CAD coordinates arrangement window that is diagonally opposite to

the fiducial point. This will be a reference point. Click on the mark, and it will be colored red,

and the camera will automatically move to that point in the Work Area.

4. The component selected as a reference point will be displayed in the center of the Work Area.
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If it is accurately aligned in the center, click OK and skip step 5. If it is misaligned, Move the
actual component to the center of the Work Area as well as step 2. After adjustment, the blue

point will be appeared at the corner of that block. (Screen 4)

. Confirm if the coordinates are in the center of the Work Area by clicking some marks. If they are
not aligned in center, take 2nd reference point. The 2nd reference point should be set in the
block where no fiducial or 1st reference point is set. After setting 2nd reference point and con-
firmation, if there is still misalignment, you can set 3rd reference point. (Screen 5) If your PCB is
very large and the center of PCB is warping, you can set 4th reference point in the yellow center

area.

Note: Hints for selecting a fiducial and reference points

There are not many PCBs on which CAD coordinates match perfectly. Especially PCBs after reflow

oven are expanded, and after cooling down, they are shrinking and warping.

When setting a fiducial or reference point, the software can calculate the more accurately the closer

you set these points to the corners of PCB.
In case, if the components’ coordinates are gathered and there is distance from one fiducial marker,
delete coordinates of fiducial markers and arrange rest of coordinates, then create fiducial markers

manually. In this way, components’ coordinates can be set more accurately.

6. If the CAD data contains fiducial markers coordinates, you can create main fiducial marker and

sub fiducial marker from the coordinates by setting them as fiducial point and 1st reference

point. In this case, click on the fiducial point or 1st reference point by pressing control keys.
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5-2-6

(Screen 2)
(Screen 1)

Then blue fiducial point changes its shape into square, and red 1st reference point changes its
shape into circle. (Screen 6)
* Reference points can be reset by pressing clear key, however fiducial can not be undo.

Click the OK button, the apply stamps window will appear.

V¥ 5-2-6 Applying Stamps

The next step is applying stamps to Parts Name or Z number. When importing NC data, if the data has
Parts Name, then Parts Name is displayed in Stamp Applying Window than Z number. "Zxxxx" represents
the data without a Part Name. The software automatically names the components without Part Names.

"xxxx" begins from 0000.

Stamp Applying Window (Screen 1)

1. Parts name or Z number in NC Data file is listed.

2. Total number of the parts.

3. Column to place the applicable stamp.

4. If stamp library is loaded in advance, displayed here. The stamp in blue color represents Pack stamp.
5. Click on a Pack stamp, then stamps to configure the Pack stamp is displayed.

6. After applying a stamp from Stamp List, press this button. Then copied stamp is created with new
name of "Applied stamp name _ Parts Name". Or an action is performed which you set in Action set-
tings window.

*In case, applying stamp simply to Parts Name, you do not need to press this button.
* Press this button with option key, then the action is applied to all stamps on Applying List.
Be careful not to execute this after "Name to Name", because these stamps also have "Parts

Name" following their names.
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5-2-6

(Screen 3)

(Screen 4)

7. Action settings window (Screen 2). The window can set actions when New Stamp button is pressed.
New stamp has master picture
Snap master picture automatically during Teach Mode (first inspection after quitting this Window.).
New stamp is created in Parts Name
On default, new stamp is created with the name of "Stamp name_Parts name", but with this option,
new stamp is created with the name of "Parts name". It is useful when you would like to manage
stamps in original CAD names.
New stamp is created in root folder of Stamp List
This is an option when New stamp is created in Parts Name is active. On default, new stamp is
created in the same directory as applied stamp. If this option is active, the new stamp is created in the
root directory of Stamp List. The advantage of creating new stamp in root directory is that you can
apply stamps by "Name to Name" next time.
Enable ‘Ends with’ searching when NameToName
Normally, when applying stamps by Name to Name, whole Parts name should match to stamp name.
But, when this option is on, stamp with same end-text can be applied.

8. Move buttons. Display coordinates of selected Parts Name in Work Area. If you can not guess a
component from Parts Name, it is possible to confirm the shape by moving with these buttons.

9. Apply stamp automatically if Parts Name is equal to Stamp Name.

10. Undo applying and delete newly created stamps.

11.Search stamp(s).
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Basic procedure when applying stamps. (Screen 3)

- When you have no stamp library, do nothing and click OK.

- When you load stamp library, and there are stamps with same name as Parts name, execute "Name
to Name".

- When you load stamp library, and apply stamps from Stamp List, drag & drop (or double-click) the
stamps onto Applying List. If you want to apply a stamp to more than one components, select
by pressing shift key or command key.

- If you like to apply copied stamp from original stamp, press "New Stamp" button after drag & drop a
stamp.

Once applying is complete, click "OK". When there are no corresponding Stamps, a message "Some
CAD name was not applied any stamp. Are you sure to continue?" pops up. By pressing OK,

a message to ask Cell Optimization (Combine Cell) pops up.

V¥ 5-2-7 Cell Optimization and converting Parts names to comments

In the message, you can select to optimize Cells now. (If no stamp is applied to any component, this
message does not be displayed because optimization is impossible.)
By executing Cell optimization, you can reduce inspection time because the number of Cells are

decreasing by combining Cells.

In case stamps are applied to all components, another message pops up. The message asks you to
execute only Cell Optimization (Optimize) or Cell Optimization + converting Parts names to comments
(Opt.+Comment). If you select Opt.+Comment, the Message Bar will display the Part Name during the
inspection in G/NG Confirmation Mode. If you only execute Optimize, you can not execute converting
Parts names to comments any more in following process.

* In case, some components are not applied stamps, the selection of Opt.+Comment is not displayed.

Then, Stamp Applying window will disappear, and many squares (cells) will be displayed on the Cell Map

(Screen 4).

V¥ 5-2-8 Teaching

Click the Start button to start Inspection for Teaching.

Components without Stamps will show red cross marks, and the Inspection will pause here. The mes-
sage "No frame. Draw or pick stamp" will be displayed in the Message Bar. (Screen 1)

You can select a Stamp from the Stamp List

* To create a new Stamp from existent Stamp with a Part Name from CAD Data. Select a Stamp and

click the Copy button to activate the copy stamp option
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5-2-8

(Screen 2)

(Screen 1)

(Screen 3)

In order to create a new Inspection Frame, Draw a Frame on the component with the Inspection Frame
Tool. Once a Frame is drawn, the inspection will proceed to the next component. When drawing a frame
by mouse, a pattern matching type frame will be created. But, if you switch Inspection Frame Tool to Se-
lection Tool (Screen 2) and draw a frame, Stamp Creation Wizard will be displayed and you can create
Pack stamp or Passive Component stamp (Screen 3).

* For detail of Stamp Creation Wizard, please read Chapter 7.

When stamp is assigned to all coordinates, teaching is completed
* Please move on to the next step even if there are NG points due to stamp misalignment Later, mis-

alignment can be adjusted.

V¥ 5-2-9 Changing Stamp Angles

With the Stamps created during NC Data import, all the same Stamp placed in the Work Area can be ro-
tated. Select a Stamp you want to change the angle and select Flip/Turn > Rotate Right/Rotate Left
in the Edit menu by pressing the Option key.

* After applying the Stamps, please make sure that the Inspection Frame is correctly overlaid on the
component in the Work Area. If the Inspection Frame is at an incorrect angle, the Stamp’s 0 degree

can be different from component in CAD data’s 0 degree.

5-3 Convert Part Names to Comments
If Part Names are not converted into Comments, execute this process right after.
Select Part name to comment from the Edit menu. This process should be executed before Combine

Cells After Import. After Combine Cells After Import, Part name to comment can no longer be se-
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lected.

5-4 Combining Cells

After creating Inspection Frames, sometimes the positions of Cells are not ideal. Therefore, it is best to
merge cells together to improve efficiency. Select Combine Cells After Import. Neighboring cells will be
merged into single cells or optimized.

* If Combine Cells is not executed, a warning message will be displayed every time at file opening.

5-5 Confirming position of Inspection Frames

Click on the Cell one by one in the Cell Map Area to check if the Inspection Frames are placed in the cor-
rect positions.

* If all the Inspection Frames are misaligned toward a certain direction, press the command and op-
tion keys and drag the Work Area in order to adjust the components to the Inspection Frame using

the Pointer Tool.

5-6 Importing Additional CAD Data

After Combine Cells After Import is complete, additional NC Data that has been created separately, can
be imported into the same Inspection program. Additional imports are possible only after Combine Cells
After Import. It is impossible to apply a different Stamp to a component to which a Stamp has already

been applied in the first NC Data import procedure.

5-7 Placing Fiducial Marks
In general, the NC Data does not contain Marker locations. If Markers are necessary, manually add the
Fiducial Marks.

* The sample screens of NC Data contain Marker locations.

5-8 Editing Stamps

Inspection Frames that did not have corresponding Stamps become new Stamps automatically. The cre-
ated Stamps have names of Part Names. "Zxxx" should look like "Z0012". Double click on the Stamp
Name shown in the Stamp List Window to change the Stamp Name.

If the stamp in the Stamp Library has an angle other than 0 degrees, the Stamps positioned in the Work

Area will be at an unexpected angle. In this case, refer to Chapter 10, "Stamp".

5-9 Filter Settings

Automatically created stamps are not optimized in filter settings. It may be necessary to set up filters for

each stamp (refer to Chapter 8 for Filter Settings).
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When setting up a filter for a Stamp which is placed on a component, changes to the filter can be applied
to the Stamp in the Stamp List. In this case, the change will be applied to all of the same Stamps located
in the program. Click on the Stamp Update button displayed in the top right of the Master Picture Area
after editing Stamps and select Update All.

* If there are any stamp misalignments, improve the position.

* This chapter has covered the first half of Chapter 4, "Quickstart Guide". Please see 4-6 "Test Run/

Improvement" to continue.
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Note: Importing Gerber Data

Gerber Data converted by GBtmz software for Windows® can be handled like CAD Data importing.
Import the Gerber Data, and switch to one of the 3 buttons Solder Paste Inspection Frame, In-
spection Frame, and Positioning Only in the Position adjustment window for setup (Screen 1).

The Solder Paste Inspection Frame button automatically positions all of the frames as for Sol-
der Paste Check. At this time, the Stamps are created depending on the size of the Inspection
Frames.

The Inspection Frame button automatically positions Inspection Frames. However, since the
Gerber Data converted by GBtmz does not contain Part names, Stamps cannot be created auto-
matically.

The Positioning button does not create Frames. Press the Start button. When the inspection
is paused on the component marked by red cross, apply a Stamp from the Stamp List. Inspection

points that seem to be the same size, will have the same Stamps applied automatically.

The all zoom button is active on default. This means that all inspection frames will be Zoomed
frames. This button can be OFF by clicking. This means that frames which width or height is more
than 12 pixel will be non-Zoomed frames, and rests will be Zoomed frames.

* It is not possible to create Markers from fiducial/1st reference points.

Create Solder Paste Inspection Frame]

Create Inspection Frames

Positioning Only

(Screen 1)
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6. Fiducial Marker and PGB Side

When handling PCBs that have Fiducial Marks, you should set up the Fiducial Markers first for smooth

inspection data creation, and giving offset to PCB.

6-1 Create Fiducial Markers
First, move the camera with the Move tool in order to set a Fiducial Point in the center of the Work
Area, and draw a frame with the Inspection Frame tool. Then select Assign Fiducial Mark from the

Edit menu. Now, this frame will be recognized as a Fiducial Marker.

Fiducial can be assigned maximum 3. Assigning only one fiducial compensates XY position shifting,
assigning two fiducials compensates XYW position shifting and assigning three fiducials compen-

sates XYW and stretching/shrinking..

6-1-1 Limitations

- 3rd fiducial frame must be created at the coordinate where X or Y of 1st and 2nd fiducials
crosses (Fig.1), and all fiducials must be at the 1/6 corner area of PCB to align large PCB
preciously. When assigning the 3rd fiducial, software allows a little distance from the exact XY
crossing position. However if there is large distance, an error message is displayed and you

can’t proceed the operation.

- When there is component (inspection frame) out of fiducial alignment area, you can’t assign the
3rd fiducial (Fig.2). If you still like to align such PCB with 3 fiducials, it is possible by following

operation; Create (Add) inspection frames_after assigning fiducial frames.

(Fig. 1) (Fig. 2)
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(Fig. 4)
(Fig. 3)

However, the alignment for components out of fiducials is less precision than components
within fiducials. Plus, the selected Cell on Cell Map won’t be painted for these components (this

is only the matter of appearance, no problem in function).
- PCB tilting or shrinking/stretching is possible to align, but PCB warping irregular can’t (Fig.3).

- You can’t define the 3rd fiducial in Block. For aligning panellized PCB at 3rd fiducial, please

assign to the PCB sheet.(Fig.4)

6-1-2 Streching/Shrinking offset with 2 fiducials

Often it is difficult to assign the 3rd fiducial. The accuracy is low but you can still giving stretching/shrinking

offset with 2 fiducials.

Create fiducial frames on main and sub fiducial. In setting window of sub fiducial, there is “stretch/
shrink” button at the right-bottom of OK button. Click this and you will be asked “Enable to
compensate size offset in addition to theta offset?”. Click OK, the button is turned to blue color

and stretch/shrink offset is enabled.

* If main fiducial and sub fiducial is too close (closer than 25mm), the button is not permitted to press.

* Not possible to assign when the fiducials are in block.

-
Memo: PCB extremely shrinking/stretching

The fiducial frame can't find the fiducial with PCB
which is extremely shrinking/stretching.

With such PCB, activate "Picture Search" in setting window.
Frame searches fiducial position by picture at first,
then starts to read the mark.
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6-2 Marker Setting Window

The Marker setting Window will open when you click on the frame of Fiducial Marker (Screen 1).

H Shape Select Button aj+|

Select the shape that matches the shape of the Fiducial; oval, rectangle or cross.

M Binarisation Button .nT ;E ;E ;|

In the Fiducial Marker, the Marker must always be converted to 2 colors (ex. black and white).
The default AT shows automatic binarisation, which is recommended. If binarisation does not work
well in AT, click on either red, green or blue. In this case, the Fiducial Marker is binarised based on

contrast of the selected color.

H Black and White reversing button @El

Click on the appropriate icon depending on whether the inside of the Fiducial Marker is white (bright)

or black (dark).

B Contrast divergent Lever | & |

This lever can be used to set the contrast divergence point. If the value is X0 YO (+/-1) when you press

down the mouse while dragging, it means that the color has been binarised.

H Centering button

This button moves the Fiducial Marker to the center in order to set the Marker accurately. Clicking on
this button will change the value under the lever to a number close to X0.00 Y0.00. This button can
only be used when creating Fiducial Markers. Once you close the setting window, you can no longer

press the button.

6-2

(Screen 1)
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H Filter button

When binarisation does not work well due to lack of contrast, use this button to open the Filter and

adjust the contrast. Refer to chapter 10 for details on filter handling.

M Size limit

Limits the size of Fiducial Markers.

H Capture delay

This is the waiting time for the mechanical vibrations to subside after movement. The waiting time can

be set from 0-3000 (mm seconds), with the default value being 66.

Hl Retry Number

Designates the frequency of retries when Marker reading fails. It can be set from 1-10, with the default

value being 2.

H Low contrast control

This option widens the range of Fiducial Mark samplings by applying edge detection when binarisa-
tion in AT mode. The preset value is 5, and is turned OFF by default. In AT mode, turn this function
ON when the border changes drastically when the Contrast divergent lever is only slightly moved. You
should first adjust the lever with this control unchecked and check it ON only when necessary.

The default level is 5, and in order to make lever adjustments more gradual, increase the level 1 unit at
a time. Note that if you increase the value too much, it will have the opposite effect.

If there is a lot of noise near the Fiducial Marks, lower the level.

Ml Use virtual center

To find the center of the Fiducial Marker, the deviations are usually defined at the pixel level. Even if
there is no deviation, if the center lies across pixels, there may be some deviation. This pixel deviation
can be prevented by using Virtual Center to calculate the deviation using a non-pixel-dependent pro-
cess. Use this function if the point is not stabilized with the Centering button.

In order to use this function, an accurate Virtual Center must be obtained. In addition, even if this set-

ting is ON, it will not run if a Virtual Center has not been set.

In order to obtain the Virtual Center, check Use Virtual Center during AT mode and press down on

become a single line (this feature is available only when creating Markers).
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M Auto length/width verification

This feature records the length and width at Marker setup as well as the dimensions. Level adjustment
is made automatically to adjust the detected Marker to the recorded size and dimensions. Since the
way the Marker shines tends to vary after reflow and may cause errors from time to time, it is recom-

mended that you leave this item checked in AT mode.

H Side lamp

When there is little difference between the colors of the Fiducial Mark and its surroundings, or when
the edges cannot be detected and Marker correction is unstable, turn on the side lamp to improve de-

tection accuracy.

M Picture Search

An option “Search fiducial with Master Picture”. With this option active, at first the fiducial frame
searches position with Master Picture, then binarizes the fiducial. This option is inactive on default and can

be active / inactive by each inspection program.

* This machine is not equipped with a polarizing filter for Marker identification. If the Fiducials are the
type that are embossed by lighting, they may be difficult to identify. Do not create Markers if they are

unstable or there is not enough surrounding space to apply contrast with a Fiducial..

6-3 Fiducial Marker Status

Fiducial offset becomes active when you inspect the program once. Normally the program must be
created / debugged in this status. Fiducial status is shown as following (Screen 1);

1. The cell including fiducial marker is shaped Oval in place of Rectangle in Cell Map Area.

2. Keeping Offset is displayed on bottom of fiducial marker frames, if fiducial offset is active.

3. To release the fiducial offset, press Stop button, or click the marker frame by mouse. A

message will be shown. Press Release to unlock (Screen 2).

Sometimes, you accidentally press Stop button, and make program without fiducial offset. As a result,
inspection frames are placed at unexpected position, and inspection result would be incorrect. There is an

option to prevent such careless mistakes (Screen 3).
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6-3

(Screen 1)

(Screen 3)

(Screen 2)

6-4 Fiducial Marker Setting by Pattern Matching

When it is hard to read the Fiducial Points on PCBs, the binarisation method is not recommended. If
you must use the Fiducial Marker, it is possible to treat the Fiducial Marker as a Pattern and use Pat-
tern Matching. In this case, you do not necessarily have to select Fiducial Marks on the PCB. Any
part/component reliable enough to be a reference position can function as a Marker. Follow these

steps:

1. Since the frames for the binarisation method Fiducial Markers are too big to be used for pattern
matching, adjust the frame size to be slightly larger than the Fiducial Mark.

2. Select a Fiducial Marker and place the mouse pointer on one of the 4 corners of the Fiducial
Marker while pressing down the Control key, and the pointer icon will change. Then drag the
frame outside to set up the area to be searched (Screen 1).

3. The frame size will not change, but a line will be extended outside the frame. The position to
where the line is extended will be the area to be searched (Screen 2).

4. To confirm whether the Marker is recognized correctly, double-click on the frame. A red cross
will appear in the center of the frame (Screen 3).

5. The Master Picture Area will now show 1/1:50 at the top. The number 50 means OK with 50%
matching (Screen 4). To change this value, double-click the value, change the reference value
in the window, and click Apply (Screen 5).

* A Marker cannot be changed back to a Binarisation Marker once it has been converted to a Pattern
Matching form.

* The position is set when converting a frame to a Pattern Matching Marker. Make sure in the Machine
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6-4

(Screen 1) (Screen 2) (Screen 3)

(Screen 4) (Screen 5)

offset that all Inspection Frames are in the correct positions before setting Fiducial Marker(s).
* This method is not suitable for reflective solder-plated patterns, or parts that differ by PCB.

* The search area settings defined here can be applied to all Inspection Frames.

6-5 Manual Positioning at Reading Error

If a Marker error occurs, there are 3 corrective measures; Stop, Skip or Manual Adjustment.
Stop will terminate inspection, Skip will continue inspection without position correction by Fiducials,
and Adjust Manually will continue inspection by forcing the Fiducial Marker to be in the center of the

screen. Manual Positioning is effective for handling extremely unstable Markers.

Hl Manual Positioning Procedure

1. If a Fiducial Marker reading error occurs during inspection, an error message will appear, and
then a dialog, shown in Screen 1, will be displayed.

2. If you click Adjust Manually, the part to be inspected (Fiducial Marker) will be displayed on the
screen, with a red cross pointer. The Start and Stop buttons will also be shown in red (Screen 2).

3. Drag the Fiducial Marker to the center of the screen. Click the Start button and the distance

dragged will be regarded as the offset, and inspection will be resumed.

H Eject PCB at reading error

There is an option to eject PCB as defect when failing to read fiducial marker. This is useful for inline AOI
without operator where line must not be stopped by any reason. Activate "Eject PCB as NG when failing
to read fiducials".

Zy
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6-5 6-6

(Screen 1)

(Screen 1)

(Screen 2)

6-6 PCB Top/Bottom Side Recognition

One program can include data for both A (top) and B (bottom) sides. In this case, Stamps and preferences

will be shared. Set up according to the following procedure:

1. Find a place that clearly differs on side A and side B near the Fiducial Points and select it with
the Inspection Frame Tool (rectangular).
2. Double-click on the Frame, and reduce sensitivity using the Blur and Resolution filter so that
minor differences in the PCB will be judged OK, but the B side will be judged NG.
. Select Edit > Assign to A side.
. The letter A will be displayed on the Frame (Screen 1).
. When setting up steps 3 - 4 for side B, switch over to side B using the Swap A/B Side Button.

o o0 A~ W

. When inspecting, the side will be recognized first and the data will be switched to the matching
side. If neither side matches, a message window will be displayed saying that the side could not
be recognized.

* To change data from side A to side B, go to Edit > Side Edit > Swap A/B Side.

* To copy data from either side, go to Edit > Side Edit > Side Copy.

H A/B auto swap mode

To switch A/B, A/B... automatically, press Swap A/B Side Button with option key.
In version 4.9.9 or later, it is enable to apply Block barcode to B side which had read at A side when using
auto A/B swap mode.

* For each PCB, apply the same Block number for A side and B side.
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7. Easy & Speedy Stamp Creation

With this software, you can create your own stamp library from zero by setting filters and parameters (de-
scribed in the later chapters). On the other hand, there is wizard and special stamps for AOI beginner to
enable to start PCB inspection soon after buying. In this Chapter, you can learn easy and speedy stamp

creation functions for beginner.
7-1 Stamp Creation Wizard for Beginners

An wizard creating stamp by selecting component by mouse, without learning filter and parameter

settings.

* This function is for recent AOI (type DL, HDL, HML, ML, FDL), because this is for AOI beginner.

V¥7-1-1 How to Use

1. Select the Move Tool to move to the area where the most top left of the component is displayed.

2. Switch Move Tool to Selection Tool and press mouse down and drag on the component/parts
in Work Area (Screen 1).

3. The dragged area will be surrounded by dot line. Do not release the mouse button. Dot line
turns to blue line after holding mouse button for more than 0.75 second (Screen 2).

Blue lines turn back to dot line by dragging again.

4. Release the mouse button while frame is blue line. Stamp creation wizard runs and “Stamp
Selection” screen opens (Screen 3).

5. Select suitable template from Template List. Here | use U22X-HDL350, therefore select "HDL

>

(Screen 1) (Screen 2)
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Body (position shift)"

6. ress OK button, a dialogue to input New Stamp name will be shown (Screen 4). Input name and
stamp will be saved in Stamp List.

7. This stamp is already preset for inspecting "component" on AOI with "HDL type's illumination”.
You can immediately start inspection.

8. Create stamps for the other components as well by moving with Move Tool or Pitch buttons.

9. The stamps are saved in Stamp List, select Stamp Palette from Stamp menu to confirm.

When creating Inspection Frames, if the frame is too large, it will lead to slower inspection speed and to an
increase in False NGs. It is important to understand the characteristics of each component/part to create

proper Inspection Frames. Here are the typical methods for creating Inspection Frames:

+ Body of capacitors/resisters
Create a frame on the body in a bit smaller size, including lead (Screen -a)

* Polarity of tantal capacitor
Create a small frame on the body where polarity color is (Screen -b)

*Text
Create an accurate frame not to include too much empty space. (Screen -c)

*Lead of QFP
Use IC Lead Gap stamp (Screen -d)

The preset filter parameters is for beginner. PCB varies on each customer. For more accurate inspection,
please tune-up filter setting to meet your PCB condition by reading following chapters.

Some templates uses Histogram algorithm, these templates requires 2 steps tune-up. The tune-up

(Screen 4)

(Screen 3)

(Screen -a)  (Screen -b) (Screen -) (Screen -d)
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procedure is described in later page.

Now, we show you how to program one component. The example is creating stamps for inspecting
Aluminum Electrolytic Capacitor with M22X-FDL350. With Aluminum Electrolytic Capacitor, you need to

create 4 frames "Component", "Text", "Fillet" and "Polarity".

1. First, create frame for "Component". Draw a frame on component by Selection Tool. Select
"FDL Body (position shift)" from Template. Save the stamp with new name (Screen 10).
This stamp will detect component "existence", "wrong" and "shifting". You do not need to adjust
this stamp. If there is false detection or detection failure after testing some pieces of PCB,

please adjust at the timing.

2. Next, create frame for "Text". Draw a frame on text. Select "Text (metal)" from Template. Save

the stamp with new name (Screen 11).

Open Filter Set window by double clicking the frame, and confirm if the text is clearly detected.

Press Brightness bar, the filtered image will be shown in screen (Screen 12). If the text is unclear,
slide Brightness or Contrast bar until you get the clear image. When adjusting levers doesn't

improve, test the other Text template. There are 4 kind of template to detect text.

(Screen 10) (Screen 11) (Screen 12)

(Screen 13)

(Screen 14)
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(Screen 15) (Screen 16)

3. Create frame for "Fillet". Draw a frame on fillet. Select "Fillet DL,HDL,FDL" from Template. Save
the stamp with new name (Screen 13). This stamp is Histogram stamp. Double click the stamp's

frame and open window (Screen 14).

1. There is a trap frame. Move the trap frame to the position where image changes obviously

at defect. Resize the frame size if necessary.

2. There is a list to set the threshold of color tolerance at the right-middle in the window.
Select each RED/GREEN/BLUE color and press “Auto” button. Threshold will automatically

be set.

3. At the end, press check button and confirm if the result is OK. Paste the stamp on the fillet
at the opposite side by selecting from Stamp List and press space key twice to rotate 180

degrees.

4. Create frame for "Polarity". Draw a frame on polarity. Select "Polarity (Component, clear)"
from Template. Save the stamp with new name (Screen 15).

This stamp is Histogram stamp. Adjust trap frame and threshold as same as when you create

stamp for fillet.

5. Now all stamps are created. It will be easier to handle to make these stamps in a package as

Pack Stamp when pasting.
To make Pack Stamp, select all stamps by dragging mouse. Select Stamp Pack from Stamp

menu. Save the package with new name (Screen 16).

* Stamp Template is not included in 22X software. It must be installed by Installer together with 22X
software. If you upgrade software manually by copy and paste, template won' be installed and Stamp

Template list will be empty.
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V7-1-2 Window

In Stamp Selection list, there are 3 methods to create a new stamp.

1. From Stamp List

If there are already stamps in Stamp List, the similar stamp(s) is listed from Stamp List. Selecting

the stamp and pressing OK button will paste the stamp.

* No similar stamp will be listed when size, shape or color is different. Thus, drag the mouse carefully

not to include unnecessary area.

2. Stamp Template

Major inspection libraries are supplied such as Solder Fillet, Component, Polarity or Text. There
aren't too many template but the templates for inspecting component are supplied for all

camera type because these cameras' color sensitivity is different.

- Normally the stamp made from template is non-zoom frame, however if the short side of the

rectangle is less than 0.6mm, the frame will be made zoomed.

3. Special Stamps

You can create special stamps such as measuring angle, detecting scratch or barcode.

7-2 Create Stamps by Wizard from CAD data

With Stamp Creation Wizard, you can easily create stamp libraries after importing CAD data.
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(Screen 2)

(Screen 1)

(Screen 4)

(Screen 3)

(Screen 5)

V¥7-2-1 How to use

1. Open For Supervisors menu from Configuration in Settings menu. Move to Assistant tab,

check on " Create program from CAD data in simple way" (Screen 1).
2. Import CAD data (Screen 2).
3. Arrange CAD data to meet the actual PCB in CAD coordinates arrangement window (Screen 3).
4. Assign stamps if there is any pre-loading stamp library in Stamp Apply Window (Screen 4).
5. Message to start teaching will be displayed. Press START button. There is an option "Parts
name always be stamp name". We recommend to check-on this option (Screen 5).
* By activating this option, you can create duplicated stamp easier. For example, if the second
component is very similar to the first component, by pasting the stamp for 1st component, it is
automatically duplicated in 2nd component's parts name. Without activating this option, by pasting

1st component's stamp is simply pasting stamp, new stamp for 2nd component isn't created.

6. The first component is shown in the center of Work Area. Draw a frame on the component body
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(Screen 6)

(Screen 8)
(Screen 7)

7-2-2

(Screen 1)

by mouse. Keep the mouse holding for 1 or 2 second, light-blue line will be shown. Release the

mouse. Stamp Creation Wizard will be displayed (Screen 6).

7. Screen is still stopping at the component. You can adjust more filter settings or even add

stamps for inspecting fillet, text or polarity.

* When you are not satisfied with the frame size, press Cancel button in the wizard window. You can

re-draw the frame.

8. Press START button to move to the next component. Create stamps in same procedure (Screen

7).

9. Press START button to move to the next component. Create stamps in same procedure (Screen

8).

10. If there are similar components in different parts name such as 0402 size MLCC, paste
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existent stamp from stamp list. Stamp is duplicated in new parts name with same setting.

V7-2-2 Window

The window's contents is different from usually at creating stamps (Screen 1).

1. Template
Template recommended for component inspection. Standard filter setting is already set. All

stamps are created in Pack stamp.

2. Special Stamps
There are 3 selections; Pattern matching Pack stamp, Histogram Pack stamp and Passive

Component stamp.

3. Directory to save stamp in Pack
Because Pack stamp is created in parts name, the stamp must have another name. Therefore,

the stamp is saved in the folder. You can change folder name. Default folder name is _body.

4. Zoomed-in
At assigning "Pack(Matching)" or "Pack(Histogram)", you can select to create in Unzoomed or
zoomed.
* When this option is greyed-out, this means that the stamp is not possible to flip zoomed /

Unzoomed.
7-3 Special Stamp for Passive Components

This is a special stamp for capacitors/resistors. You can choose this [Passive Components] stamp from

7.3 Lead
oK NG
Fillet Body
Configuration: two fillets, two leads and a body Rotating: default limit is within 6 derees.

Direction to be corrected

oK N

G
I
QI
j40%

Position shifting: more than 66% of lead edge has to touch the fillet.
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pull down menu of [Special Stamp] in the Stamp Creation Wizard,

The basic premise of this stamp is a capacitor/resistor contains two leads (glectrodes) at both sides. This
stamp recognizes a capacitor/resistor by finding two leads first, then it assumes and finds capacitor/
resistor body between the leads and fillet outside of each lead.

Each part of capacitor/resistor is judged OK/NG by whether the matching rate of its color and area is
within the threshold or not.

This stamp also can check rotating and position shifting by detecting the center of each part.

*This function is not applicable for models without Side lighting and DOAL (Diffuse-On-Axis LED)
lighting: M22X-Fw/Fx/Fv, M/L22X-CL, M/L22X-DL, U22X-Fw/ML/W. (menu is not shown in the Stamp
Creation wizard of these models.)

*This function may not work properly when inspecting a red PCB under RGB layered illumination.
*Detection may not work properly on the customized RGB layered illumination machines which RGB

lighting position is reversing. (normally RGB, but became BGR)

V¥7-3-1 How to Use

To use this stamp, detecting leads (electrodes) is the essential point. Therefore, make a stamp with a

component whose leads are easily distinguished.

1. Be sure that the mouse function is Selection function. Surround the component by dragging
the mouse and hold the mouse for a second. Stamp Creation Wizard runs. Choose [Passive
Components] from the bottom left pull-down menu of [Special Stamp].

*Be sure to surround the component a little bit bigger than the original component size so that it can
detect position shifting. (Screen 1)

*Be sure not to include silkscreen inside the frame with wave soldering PCB.

7-3-1

Do not surround this side too big.
Otherwise, cannot detect properly.
1 ]

I 1

Surround this side
» to be +30% of
the original

Consider the area in case

component shifts or rotates

(Screen 1)

(Screen 2)
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2. If the stamp recognizes the component as capacitor/resister, color and area information of each
part is immediately captured and shown in Stamp Setting Window. (Screen 2) If not, an error
saying [Unable to find component] appears and stamp creation is rejected. When pressed [Test]
button, you can confirm the detection level.

3. Click [Create] button if detection level is OK. When you make no change in Step 2.,default
threshold is automatically input in the threshold column.

Default threshold is as follows:

Color Difference Area Difference
Fillet 0.4 (40%) or less -> OK 0.5 (50%) or less -> OK
Lead (electrode) 0.6 (60%) or less -> OK 0.6 (60%) or less -> OK
Body 0.3 (30%) or less -> OK 0.7 (70%) or less -> OK

*When the value is "0.0" it means it matches 100% and when the value gets closer to "1.0" it means
the matching rate is getting worse.
*The default is [OFF] (not to inspect) for Fillet Area Difference. This is because fillet shape is not

uniform even in "GOOD" components and it is often not reliable to include it as inspection point.

4. Name the stamp in Stamp Name window and the stamp is created.

V¥7-3-2 Stamp Debugging

The stamp created is not always having the standard color and size of all the same components. Paste
the stamp onto all the same components of the PCB and start inspection for debugging.

1. Press [Start] button and inspect all the frames. Usually, not all the components pass and you
will find some false NG.
2. Double click one of the false NG stamps. Stamp Setting Window opens. At the left bottom, a

pull-down menu is available to improve false NG.

*Add current color: Body Color
*Merge current color: Lead/Fillet Color
*More tolerant: Body Area Limit

*More tolerant: Rotation Limit

*More tolerant: Shifting Limit

3. [Add current color: Body color] is one of the typical method to reduce false NG. This means
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that actual body color is different from the master body color. Unlike the other methods, this
does not change any thresholds or settings but simply adds a master color. The added color is

displayed in [+Body Color] window.

*The stamp can have maximum 24 colors.

*If you want to delete a color, double-click the color in the [+Body Color] window. When a dialog
appears, click [OK] to delete.

*Passive Component stamp has automatic positioning function. (searching for 8 pixels around the
component in the default setting.) In case a big difference lies between the master and the actual
component about the color or the whole image, the automatic positioning function will not work. To
solve this, the stamp will automatically add the actual component image as a master picture when
added the actual color.

*In Passive Component Stamp, Master picture is only used for automatic positioning fuction and not
used for matching criterion.

*When handling a warping PCB and there is more than 8 pixel position shifting, you can set a wider
search range by following method: select the stamp and drag the bottom left edge of the stamp to the

outer area with pressing [Control] key.

4. After improvement, click [OK] button and the setting change will be automatically applied to all
the frames of the same stamp and they will be reinspected automatically.
When the inspection result is changed from [NG] to [Good], the inspection frame color will be
changed from Red to Blue.

5. If any of the False NG frames remain unchanged and still colored red, additional setting change

or body color addition is needed. Go back to Step 2. and debug the stamp again.

V¥ 7-3-3 Limitations

7-3-3

Very tiny component

Lead color other than silver Large pad as bright as lead

Square Leads difficult to be recognized Components with  Body having multiple colors
more than 3 leads

Awkward lead shape
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7-3-4
Special setting A

@ @ @ @@@@ @ Special setting B
)

@
® ® ® ®

Below are limitations for [Passive Components] stamp.

*Capacitor/resistor having multiple body colors cannot be detected by this stamp.

*Capacitor/resistor whose body color is similar to leads color cannot be detected.

*This stamp may detect falsely and cause false calls as position shifting those capacitors/resisters
whose solder pads look like a part of lead, whose pad is as bright as lead or whose lead is shaped
awkward, not rectangle.

*Capacitor/resistor whose leads are difficult to be distinguished may not be detected.

*Under HDL illumination, a capacitor/resister having non-lead free solders is difficult to be detected by
this stamp.

*Resister values cannot be inspected with this stamp.

* Not possible to detect solder ball.

*You can make this a Pack Stamp. Filter setting, however, cannot be done from pack stamp

setting menu.

V7-3-4 Passive Components stamp setting window

1. Parts

The parts detected by Passive Components stamp is listed here. Usually it consists of the

following: Fillet (left), Lead (left), Body, Lead (right) and Fillet (right).

2. Master Color

Master color of each part is shown here. Master color is the color of the component when you first
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create a stamp.

3. Target (Actual) Color

This is the color of the inspection frame you are opening now.

4. Difference between Master and Target color

This is the difference between Master color and Target color. Value ranges from 0.0 (100%

identical) to 1.0.

5. Difference between Master and Target area

This is the difference between Master area and Target area. Value ranges from 0.0 (100%

identical) to 1.0.

6. Active / Deactive Color inspection

You can define whether to activate / deactivate color difference detection. The default setting is

"ON" (activated).

7. Color Limit

This is the threshold setting of color detection. Directly input the value you want.

8. Active / Deactive Area Inspection

You can define whether to activate / deactivate area difference detection. The default setting is

"ON" (activated) for "Body" and "lead".

9. Area Limit

This is the threshold setting for area detection. Directly input the value ranging from 0.0 (100%

identical) to 1.0.

10. +Body Color

When you add applicable body color besides the Master body color, the color you add is listed in

this window. You may have maximum 24 different colors in one stamp.

11. Rotation Limit

Shown here is the angle difference limit between the master and the current component.

Threshold can be set by directly by inputting the value or by selecting value from drop down list.
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12.

13.

14.

15.

16.

Position Shift Limit

Shown here is the position difference limit between the master and the current component.

Threshold can be set by directly inputting the value or by selecting value from drop down list.

Improve False Error

After inspection, open the inspection frame and change the settings and threshold to improve
False NG errors if needed. Color difference, area difference, rotation difference and position shift
can be improved by changing the threshold of each settings. Body color difference NG can be

improved by adding current body color in this menu.

Test

When you click this button once, you can check the detection conditions of each part in the

setting window. If you click one more time, it is undone.

Cancel

When clicked this button, setting window is closed without updating the setting.

Create/OK

When clicked this button, setting window is closed updating the settings. When closed the
window by this button, the update setting is applied to all the inspection frames having the same

stamp.

17. Copy

18.

19.

When you click Copy icon, you can create another stamp with the same settings. A new window
to input new stamp name appears. Name and click [OK], and it replaces the master picture and

master colors and make it as a new stamp.

Special setting A

Option menu to adapt the the same setting automatically to the opposite side when either the

left or the right fillet/lead setting is changed.

Special setting B

Option menu to change the detection level of fillet. When the lens is extremely dirty, this stamp
cannot detect the fillet properly. Change the level from this menu in such case. Otherwise, no

need to change this level.
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8. Stamp Operation

Basically, this software performs inspection by detecting differences between Master Picture of Inspection
Frames and actual components. Normally Inspection Frames are saved as Stamp in Library.
When inspection frame is saved as stamp, it is called stamp. The Stamp can be selected from the Stamp

list, and once the frame is saved as a stamp, you can use it anytime when needed.
8-1 About Stamp and Inspection Frame

In this manual, the words “Stamp” and “Inspection Frame” is often seen. The definition of “Inspection
Frame” is “a pattern matching frame not saved as stamp”. To say, “Inspection Frame” is a “non-reusable”
frame, and “Stamp” is a “reusable” frame. In functionally, there is big difference between them, that in-
spection frame has master pictures, but stamp (the ones pasted in Work Area) does not have master pic-

tures instead it refers master pictures of stamp in the stamp library.
8-2 Create/ Operate/ Rotate/ Zoom/ Save/ Update/ Replace

To create an Inspection Frame, first select the Inspection Frame Tool. The Inspection Frame Tool is set
to the Rectangle by default. Press down on this tool with the mouse, to display a pop-up window where
Rectangle, Oval and Polygon can be selected (if there are Stamps, Stamps can be selected too)

(Screen 1). Select the tool according to the shape of the component/part to be inspected. The behavior

will be different depending on the tools.

V¥ 8-2-1 Create/Operate/Rotate/Zoom

8-2-1

(Screen 1)

(Screen 2)
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H Rectangle

* Create

To create a Rectangle Inspection Frame, select Rectangle and drag the mouse over the Work Area,
starting from the corner of the component/part. After dragging, a square frame is drawn on the compo-
nent/part and the Inspection Frame is selected (a frame is active when Handles are showing on all 4 cor-
ners). Picture under the Inspection Frame will be displayed in the Master Picture Area (Screen 2).

* Move

Move the mouse pointer over a Frame, the mouse pointer will change to a cross icon. Move the Frame by
dragging (Screen 3).

® Resize

Move the mouse pointer over the Handle on the upper left or the lower right of the Frame, and the mouse
pointer icon will change to an arrow icon.

Drag the mouse to enlarge or reduce the frame size. (Screen 4).

* Rotate

Move the mouse pointer over the anchor point on the top of the frame, the mouse pointer will change
to the Rotate icon. Drag the mouse and the frame can be rotated left/right to +/-180 degrees (Screen 5).
Dragging while pressing down the Shift key will limit the rotation angle to 15 degrees steps for each rota-

tion.

Hl Oval

¢ Create

To create an Oval Inspection Frame, select Oval and drag the mouse over the Work area. This creates
and selects an Inspection Frame (a Frame is active when Handles are showing on all 4 corners). The pic-
ture under the Inspection Frame will be displayed in the Master Picture Area (Screen 2).

* Move

(Screen 3) (Screen 4) (Screen 5)

(Screen 7)

(Screen 6)
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Handles will appear in all 4 corners when the Oval is selected. The mouse pointer changes to a cross icon
when moved over the lines around the Oval, allowing the frame to be moved.

® Resize

Move the pointer icon over the Handle located in the upper left or the lower right to Resize the frame.

* Rotate

Enable to set angle from Filter Set window. Please refer Chapter 8 for detail.

H Polygon

To create a Polygon Inspection Frame, select Polygon then click drag and release the mouse to create the
first side of the polygon. Then, move the mouse pointer and click to add polygon corners. Click on the first
point of the polygon or double click to complete the Polygon Inspection Frame.

* Move

When the mouse pointer is moved over the edge of a selected frame, the pointer changes to a cross icon,
and the frame can be moved.

e Change Shape

For Polygons, the corner points will become Handles. The shape can be changed by clicking and drag-
ging the Handles (Screen 6).

¢ Rotate

Enable to set angle from Filter Set window. Please refer Chapter 8 for detail.

* Zooming the Screen when creating Inspection Frames

When drawing an Inspection Frame, pressing and holding the mouse at the first point will zoom the
screen 200%. This is useful when you wish to accurately create small Frames.

* When moving Inspection Frames, other Inspection Frames can be Hidden. Check Hide near frames
in Object Frame in Configuration from the Settings menu (Screen 7).

* Press the Capslock key to hide all Inspection Frames.

H Change resolution Zoom/Non-Zoom

Normal frame is Non-Zoom, you can flip this to Zoom frame. By flipping to Zoom, the length and width is

double and resolution is 4 times more.
However it is not good idea to create all frames in Zoom, if resolution is too high, the false calls will be in-
creased. Create body frame in zoom for component smaller than 0603 (mm), and fillet frame smaller than

1608 (mm).

l How to set
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8-2-1

(Screen 8)
(Screen 9)

Select Zoom-in from Zoom menu. The yellow frame will be shown around Work Area. View will be
switched to zoomed. By creating frame in this status, frame will be zoomed frame (Screen 8). You can

switch zoom/non-zoom by F1 key.

You can change non-zoom frame to zoomed frame except some special stamps by Flip zoom/un-zoom

button (Screen 9). The frame color will change from green to yellow. Work Area will be shown in zoom.

While zooming, the whole image from camera is not possible to see in Work Area. However, in the mas-
ter picture area, the whole image is shown and the area now zoomed is indicated by red frame. You can

move the view by dragging red frame by mouse.

* Zooming while selecting a frame, the master picture of the frame is shown in Master Picture Area. In
this case, make the frame in un-selected by clicking any of free space of Work Area.

* Zoomed frame will be shown in zoomed while G/NG confirmation mode.

H Copy / Paste

Copy / Paste, Rotate and Flip are available from the Edit menu or by using shortcut keys.

H Selecting Multiple Frames

Using the Pointer Tool, click and drag over all the frames to be selected. Handles will appear on the
Frames within the area, showing that they are selected. Now the Frames can be moved or resized. To
resize, select the handle located on the upper left or the lower right and drag the Frame. To select all In-

spection Frames in a Cell, choose Select All from the Edit menu.

H Copy

Select an Inspection Frame with the Pointer Tool. Press down the Option key, while the mouse pointer is

over the Inspection Frame, the mouse pointer will change to a Stamp icon. Drag and drop the Inspection
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Frame to create a new copy .

Press the Shift key while to limit copying vertically and horizontally.

Hl Row Copy

When components/parts of the same shape are aligned with equal spacing, the Row Copy function is
useful. Select an Inspection Frame using the Pointer Tool, and choose Row Copy from the Edit menu.
The Row Copy dialog will be displayed. Define how many pictures and the direction and spacing for each
copy. Once the values are entered, the copy locations are displayed as a preview in the Work Area. Check
Duplicate Master Picture on when copying master pictures (Screen 10). This dialog is displayed with

the previously entered values (default value is 0).

* If Pixels per 1cm is not set to an accurate value, the position of copies will become more misaligned
the farther the copy is from the original. In this case, Pixels per 1cm should be reset to a more accu-
rate value. In addition, depending on the type of the component, components may appear distorted

due to differences in perspective.

M Duplicate Selection

When Duplicate Selection is selected from the Edit menu while the Inspection Frame is selected, the
selected Frame is copied by Cell units. The Inspection Frame will be copied, but the copied Inspection
Frame will belong to a different cell. The position and number of copies can be set up in the Duplicate dia-

log. To copy to the right or down, enter negative values for the Pitch (Screen 11).

8-2-1

(Screen 10)

(Screen 11) (Screen 12)
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If no Inspection Frames are selected here, this menu becomes Matrix Copy into Cells, and copies all In-

spection Frames in the cell.

H Arrange

Using the Arrange feature allows to align selected Inspection Frames to the top / bottom / left/ right / cen-
ter or same height/width. Select Align from the Edit menu and select the type of alignment. A preview is

displayed when the Frame is selected. Press OK to execute alignment (Screen 12).

V¥ 8-2-2 Save as Stamp

Save the inspection frame as stamp.

1. Select the Inspection Frame that you would like to make a Stamp.

2. Select Stamp list from the Stamp menu to display the Stamp list.

3. Click the New button in the Stamp list.
A message window "Input a new name” will be displayed, enter the name of the Stamp here
(Screen 1). If a Stamp with the same name already exists, you will not be able to click OK. If you
would like to create directories, insert a : (colon) separator (Ex. Capacitor:0603 creates a Stamp
with the name 0603 in the folder Capacitor (Screens 2, 3)).

- You can also select Stamp name from folder list which is registered beforehand (Screen 4). With
this procedure, you can create the Stamp more easily by omitting the manual input of folder
name and part name at the time of importing CAD data.

B Procedure
1. Create inspection frame for less than 1mm around Packed Stamp.
2. Display Stamp name registration window.
3. You can find Stamp name list from pull down menu.

8-2-2

(Screen 2)

(Screen 1) (Screen 3)
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(Screen 4)

(Screen 5)

B Stamp name registration window which will show Stamp name
- Create Stamp from Stamp template.
- By pressing F3 key, registrating Stamp name of inspection frame which has no registered name.

- "New Stamp" in the window for updating Stamp setting.

B Format of Stamp name in the list

- Stamp name is configured with "Folder name: Pack name".

B Addition or modification of folder name displayed in the list
- To change the folder name in the list, open "stampFolderList.txt” in "/User/Share" folder with text
edit, and overwrite save with any folder name. (Screen 5). Maximum folder names which can set
for "stampFolderList.text" is 1000. This file is created when the function is used for the first time.
Folder names with initial status are as follows.

"_Body", "_Filet", "_Polarity", "_Short", "_Text"

The Stamp is now registered. The Stamps with rotated pictures will be displayed in italics, As this, you can

create stamp from zero, but you can easier create by Stamp Creation Wizard introduced in Chapter 4.

V¥ 8-2-3 Update Stamp

Once the Stamp settings are changed by resizing the stamp or editing filter settings, the settings can be
applied to all Inspection Frames using the same Stamp.

1. Select the changed Inspection Frame (Stamp)

2. Click on the Stamp icon on the top right corner of the Master Picture (Screen 1), and the mes-

sage window shown in Screen 2 will appear. If you would also like to change the angle when
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8-2-3

(Screen 2)

(Screen 1)

changing Stamps, check 0 deg reset. If the Master Picture size has been changed, a Size
change OK check box will appear. Checking here will change the size, but note that the Master
Picture before the size change will be deleted.

3. If you select Update all, the same settings will be applied to all Inspection Frames with this
Stamp applied.
Click NewStamp to treat the updated Stamp as a different Stamp. This new Stamp will not af-

fect the other Inspection Frames.

V¥ 8-2-4 Replace Stamp

If you have applied an incorrect Stamp when applying from numerical data, or if you need to replace some
of the Stamps due to spec changes, you can replace all the Stamps at once without changing their posi-

tions.

1. Set the PCB and move to the position of the Stamp that you would like to replace in the work
area.

2. Display the Stamp list, and place the mouse pointer over the Stamp to be replaced.

3. Press down the mouse button on the Stamp list, and drag it to the frame of the Stamp (to be re-
placed) in the work area. If the angle is incorrect, rotate it with the Space bar.

4. Place the mouse pointer on the line of the Stamp frame, and the pointer icon will change (Screen

1). Release the mouse button here.

8-2-4

(Screen 2)

(Screen 1)
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5. When the confirmation message is displayed, click OK to replace (Screen 2).
* When the message “Some frames couldn’t be replaced” is displayed, some of the Stamps could
not fit in the cell screen. In this case, those Stamps could not be replaced, and the former Stamp will
remain.
Please be careful when replacing a small Stamp with a big Stamp.
* The Stamp to be replaced with will only be applied to the side currently displayed. If the Inspection
Program has another side (side A or B), that side won’t be affected by this replacement.

* Replacement with the same Stamp is not possible.

V¥ 8-2-5 Stamp

In version 4.9.9r1 or later, you can display programmer name on Stamp Palette to identify when and who
updated the Stamp. Open “Settings for Supervisors” window from menu Settings > Configuration > For
Supervisor. Open Assistant tab. Put check mark on “Display programmer name who modified the Stamp”
(Screen 1). Then set programmer in Operator Account window, and log in with set programmer. Program-

mer name is displayed on the bottom left.

8-3 Stamp List
Select Stamp list from the Stamp menu and the Stamp list will be displayed (Screen 1).

All the stamps that you create is saved here.

(Upper tier buttons)

H Auto list sliding button

This button is shaded by default, and at this setting, the Stamp list will move automatically according to

following procedure. The button can be highlighted by clicking and the Stamp list will not move.

8-3

... 00600
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- If the Stamp overlaps with the Work Area, move the mouse pointer off of the Stamp List, and the Stamp
List will move aside.
- If the Stamp List extends off the screen, place the cursor inside the list to view the entire contents of the

list. (Screen 1)

B Expand / Collapse directory button

Stamps can be managed in hierarchical directories. + adds a level, and - removes a level. The number
of levels must be a minimum of 1 and a maximum of 4. The display width can be changed by placing the

mouse pointer over the top right corner of the frame of each level.

B Ascending / Descending order button

Stamp names can be sorted in ascending or descending order.

W Stamp name

The currently selected Stamp name is displayed here (the stamp name will not be displayed if there is only

1 level even if the Stamp is on the lowest level.).

(Within list)
Bl Master Picture Status (Screen 1-(1))
Except some special stamps, every stamp uses Master Picture(s). Double clicking the small image of the

Master Picture can switch some special stamps to be not using the Master Picture(s).

H Level/Holding horizontally flipped Master Picture (Screen 1-(2))

When using directories, a folder icon is displayed here.

With Stamp names, the rotation icon can be displayed by double-clicking. If this icon is displayed, a
180-degree rotated Master Picture will be contained in the Stamp, thus the Stamp will have 2 Master Pic-
tures; original and +180 rotated. This is efficient when inspecting objects that are not largely affected by
the orientation, such as the fillets of resistors. This can be applied at any time. Once it has been applied,
deleting the rotation icon will not decrease the number of Master Pictures. If you would like to delete the

rotated master picture, you need to go to the Master Picture menu.

Bl Stamp Name/ Level Name (Screen 1-(3))

The Stamp name or the level name is displayed here. The name can be changed by double-clicking on it.

The Stamp name for zoomed-in objects is displayed in an orange color.
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(Lower Tier Buttons)

B C Button (Display selected stamp only/Stamp list for debugger)

[

By clicking this button after selecting the Stamp, only the selected Stamp will be displayed in the main

area (this is the same feature as View Selected Stamps in the Stamp menu). To return to the main

screen, select Return to main view from the Selected Stamp menu.

Enable debugging stamplist with ‘C’ in the For Supervisor menu should be activated.

H New Button D

Register new Stamp. It will become active when the Inspection Frame is selected.

Bl Open Button E‘

Open StampDB (Stamp library for database). By pressing Option key, it works as Load Stamp File.

H Delete Button

Deletes the Stamps. You can also select Delete from the Stamp menu.

* Deleting All Unused Stamps at Once

Stamps can be loaded easily, but since they can only be deleted one at a time, the Stamp list will be-

come longer and longer if you do not update it frequently, making it harder to find the necessary Stamps.

Unused Stamps can be deleted in one action. Press down and hold the Delete button and all unused

Stamps will be deleted.

W Magnet Button

Be active by clicking. While active and a stamp is selected, if there are similar component in Work Area,

the mouse cursor moves to the component as magnet.

8-4 Paste Stamps

8-4-1

(Screen 1) (Screen 2)
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8-4-2

(Screen 2)

(Screen 1)

V¥ 8-4-1 Paste Stamp manually

1. Click on a Stamp name in the Stamp list. The Inspection Frame Tool will switch to the Stamp
Tool (press down on the tool button to switch back to the Inspection Frame Tool). At the same
time, the name of the currently selected Stamp will appear in message bar.

2. When you move the mouse pointer inside the screen, a frame showing the size of the Stamp
will always be displayed. The magnification of the screen will switch automatically to match the
Stamp. Even when the Stamp is Round or Polygon, the frame will be a square. Place this square
over the part/component to be inspected (Screen 1). If the Stamp has a master picture(s), the
master picture(s) will be displayed in the Master Picture area. If not, a picture under the Stamp
position (called local picture) will be displayed.

3. In order to rotate Stamps, press the Space bar before placing the Stamp. It will rotate 90 de-

grees clockwise each time you press the Space bar (Screen 2).

V¥ 8-4-2 Paste Stamp by Magnet tool

Magnet tool helps you to paste stamps in good position easily. Stamp sticks on similar component/pars

magnetic.

1. Activate "Magnet Tool" on Stamp List . Select a stamp from Stamp List.

2. Move mouse cursor closer to the similar component. The mouse will stick onto the component
and blink in blue frame. The thickness of blue frame changes in 3 levels. The thicker the line
is the higher maching level.

3. Click the mouse, stamp will be pasted in the good position.

* Magnet Tool does not recognize the component in different angle.
In below picture, there are two transistors. Left one is 0 degree and right one is 90 degrees.
While holding stamp in 0 degree, the magnet doesn't act for the right one.

Press spacebar while holding stamp, then stamp is rotated 90 degrees to clockwise.

* Magnet doesn't work to angled component (such as 30 degrees, not 0/90/180/270 degrees).
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8-5

(Screen 2)

(Screen 1)

V¥ 8-4-3 Paste Stamp automatically

Please refer Chapter 4-4 for detail.
8-5 Loading Stamp Files

To load a Stamp file, select Open Stamp File from the Stamp menu (Screen 1). Select the data and
open. If a Stamp already exists with the same name as the loaded Stamp, a list will be displayed asking
you whether the Stamp with the same name should be replaced or not (Screen 2).

The default setting replaces all Stamps with the same name in the list, therefore all Stamp names that al-
ready exist will be highlighted. To replace all, click Replace all. If there are Stamps that you do not want
replaced, click the corresponding Stamp name to remove the highlighting. If you click again, it will be high-
lighted again and will be replaced.

When replacing, position, size and angles will not be changed, but all filters and mask settings will be
replaced. These changes will be applied to all positioned frames However, when replacing a Stamp with
Master Picture(s), the size will also be replaced. Resizing will be executed with the existing frame as the
center. The Cancel button in the list terminates loading.

* If there are no Stamps with the same name, every Stamp will be added.

* A grouped Stamp cannot be replaced, nor will it be displayed in the list.

* While creating data from CAD data, if there are coordinates where no stamp is assigned, you can’t

load stamp.
8-6 Stamp list for debugging

You can switch to the Stamp list to display the Stamp list for debugging When this Stamp list is shown,
you can select the Stamps to be shown and to be inspected (you can select multiple Stamps by clicking

while pressing down the Shift key). Tasks such as Filtering, resizing the frame or Masks, or adding Master
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8-6-1 8-6-2

(Screen 1)

(Screen 1)

Pictures can be performed as usual, and the changes will be saved even when you go back to the original
palette.

The Stamp list for debugging will have the same buttons as the Stamp list with some exceptions.

V¥ 8-6-1 How to Display

1. In order to activate the Stamp list for debugging, select Settings > Configuration > For supervi-
sor > Assist tab, and activate “Enable debugging stamp list with “C” (Screen 1) .

2. When you click on the C button in the Stamp list window, it will switch to Stamp list for debug-

ging.

3. In order to switch back to the original palette, close the Stamp list for debugging window.

V¥ 8-6-2 Function

The Stamp list for debugging interface is shown in screen 1. The differences between this list and the nor-

mal list are explained below.

H Select Button (S button)

By highlighting this button, only the Stamps selected in the list will be displayed in the Work Area.
H Search

Enter the Stamp name here and press Enter to search for Stamps from the list.
H Search History Button (Magnifying glass icon)

Click here to display the search history, from which you can select Stamps.
ETYPE

Shows the type of each Stamp. Descriptions are as follows:
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Short Name Stamp Type Short Name Stamp Type
GROUP Group Stamp PACK Stamp Pack
BC39L Barcode 39) BC128 Barcode 128
BCDM Barcode data matrix BCQR Barcode QR code
BCIL Barcode data BC39 Barcode 39
EP EP Stamp CELLA Cell aid Stamp
ICGAP LeadGap Stamp for IC BADM BlockMark Stamp
SOLDM Mask for SPI SOLD Solder print inspection
PTPCB Stamp to Paint CAPT Captured picture
RECT Rectangle HISTs Histogram Frame
OVAL Oval RGN Region (area, mask)
POLY Polygon STO5 Extremely narrow frames
MKOK OK Mark Stamp MKNG NG Mark Stamp
MKAW Always Mark Stamp

ETTL

Acronym of TOTAL. This is a value that shows how many of these Stamps are currently being used. This
value is updated at the beginning or the end of inspection, and will not be updated immediately. It can be
manually updated by double-clicking on the number.

H NG

This value shows the number of NG (defects). The value is O before inspection. After the inspection has
been completed, the total number of NGs will be displayed. By default, if there are more than 5 defects,
the number will be displayed in red. Double click on the cell to temporarily change the default value of 5 to
another value within the range 1-9.

B NAME

This is the Stamp name. Font styles and background colors conform to the original Stamp list.

8-7 Stamp Pack

There is a way for binding multiple Stamps as one Package Stamp called Packing. Packing generates one
Stamp virtually from multiple Stamps. It will appear like one Stamp in the Stamp list window, but it does

not contain the actual stamp data.

V¥ 8-7-1 Pack
M Packing

1. You can create a Pack Stamp from multiple Stamps, but not from Frames.

2. Select the Stamps in the Work Area, and select Create Stamp Pack from the Stamp menu
(Screen 1).

3. A window asks you to input a Pack name (Screen 2). Packs can be made from 1 Stamp. Fidu-
cial Marks and Marks assigning Side cannot be packed.

4. Packed Stamps will be shown on a blue colored background with embossed characters on the
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8-7-1

(Screen 1) (Screen 2) (Screen 3)

8-7-2

(Screen 4) (Screen 5) (Screen 6)

Stamp list (Screen 3). Pack names can be changed in the same way as Stamps.
5. In order to confirm each Stamp’s settings, the Pack must be in edit mode. Select a pack in the
work area and double-click on the frame. A Pack Setting window will be displayed.

* Pack Stamp is almost same as normal stamp, however resizing and set Offset Limit is not possible.

H Pack Inspection and verification

Inspection will be run on each frame even if they are Packed. Packing is possible to include different
inspection criteria. For example, zoomed /unzoomed Stamps, stamps for Fillet Inspection, and Stamps
with different Lightings can be put together. If there are NG of more than one stamp in Pack stamp, only

one voluntary NG reason is displayed during G/NG confirmation

However, if the option “ Show multiple NG reasons in Pack stamp” is active in For Supervisors menu
Mode tab, more than one NG reasons can be shown. In case, if there are too many NG stamps, or if
Pack stamp is too large and not enough free space to show many NG reasons, “... More” will be added

after NG reason(s), this means there are many NG but can’t display all.

* When showing multiple NG reasons, the Reference Designator and Comment is displayed on the
upper. (On default, they are displayed together with NG reason.)
* Inspection result sent to Production Management Software Rc22x or CS-Center, does not include

multiple NG reasons even this option is ON. Only one voluntary NG reason is sent.

V¥ 8-7-2 Pack Setting Window

The Pack Setting window includes the Pictures tab (Screen 4), the Matrix tab (Screen 5), and the Du-
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plicate tab (Screen 6). If you input angle value on left-bottom Rotation field, Pack Stamp rotates +/-180
degrees. By pressing up/down buttons, +/-15 degrees are automatically input. Extra Settings enhance

functions of Pack Stamp.

pPicture tab

This shows the Inspection Frames and their Master Pictures contained in the Pack.
There are 3 menu buttons positioned at the bottom right.
* The master picture assigned as NG is shown with red frame, locked picture is shown with blue frame

and both assigned as NG and locked is shown with rose frame.

H Filter Button

This button is used to edit filters of selected Stamps (blue on this screen). Click here, and the Set filter win-
dow will appear (the Set filter window can also be displayed by double-clicking on the STAMP NAME or
the numbers in the image).

l ADD pict.

This adds a Master Picture to the selected Stamp. Added Master Pictures will be displayed immediately.
H Position
This is used to change Stamp positions contained in the Pack. Click here and the mode will change to

Edit Stamp Pack mode.

pMatrix tab

This window enables a combination of inspection criteria within the Pack.

In general, in order for a pack to be judged as OK, all the Stamps must be judged OK. However, by setting
up search criteria here, you can allow a pack to be judged as OK even if components are judged as NG.

* Maximum 32 stamps can be used for matrix, however by activating “or setting in Pack more than 32
(matrix deactive)”, all stamps in Pack can be used for ‘or’ condition. However, A, B, C... matrix table is

not possible to use.

Hor

Default value is 0. By changing this value from 1 to 99, the stamp with same number is in a group. Stamps
in the group has a relation of OR condition. This means that if one of the stamp is judged OK, the inspec-
tion result is OK whether the rest of stamps are OK or NG. In Screen 5, if one of the stamp No.1 or No.2
is judged OK, then total inspection result of this Pack is OK.

HA,B,C..f

By using Matrix criteria, you can set more complex. These combinations can be set for up to 32 condi-

tions from Ato F. In Screen 5, A is set to be “If 1 is NG still OK”, B is set to be “If 2 is NG still OK”.
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Hl Pack Matrix Usage

Printed texts on parts vary by manufacturer. By using Matrix, the difference between characters by manu-

facturer can be accounted for while checking for defect parts.

pDuplicate tab

Here you can duplicate Pack Stamp. When copying Pack, you can select if you use original child stamp,

or create new stamp from original child stamp by succeeding size/filter settings etc.

For example, if there are same size resisters with different text, or if there are same size capacitor with dif-
ferent body color, you may like to use same child stamps for fillet and different child stamp for bodly.
In such case, it is time consuming to create a new pack from the first, but with Duplicate function you can

create speedy.

H Stamp Name

Display names of original pack stamp and its child stamps.

Bl CHECK

Checked child stamp is replaced in newly generated stamp.
Un-checked child stamp is used in new Pack without change.

Hl New Stamp Name

The field is editable. Input new Pack/child stamp names on which you check . (Screen 7)

Hl Auto Check/Input

If there are multiple child stamps with same name, check on one of them and change its name. Then,
press this button. The rest of this child stamp’s name will be changed, and all checked on.

H Duplicate

This button executes duplication. While executing, master pictures are automatically taken for newly cre-

ated Pack and child stamps

8-7-2 8-7-3

(Screen 8)

(Screen 7)
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Hl Pack Duplicate usage

Screen 7 is making a new pack stamp “Pack:R0805_364" by copying the pack stamp “Pack:R0805_472"
- | want to use the same stamp for fillets (Fillet:R0O805_472).

- | want to use the new stamp for text, because the number is different.

At first, paste the pack stamp “Pack:R0805_472” onto the target component (resister with text 364) in
Work Area. Open Pack Setting Window.

1. Checked on child stamp No.4, and input new stamp name.

2. Input new pack stamp name.

3. Press Duplicate button

Then, the pack stamp in Work Area is changed into “Pack:R0805_364I". On stamp library, there are new
stamps saved automatically, “Pack:R0805_364" and “text:364”

V¥ 8-7-3 Position (Editing Pack)

1. Press position button to get into Edit mode using, all other Inspection Frames will temporar-
ily be invisible, and the Packed Frame will change to a purple color (Screen 8). By placing the
mouse pointer on the Packed Frame, the pointer will change to an x icon, this will allow you to
make individual changes to Filters, Size and Position. You can make a copy of the Stamp by
pressing Option key while dragging the Stamp within the Pack. Each frame can also be deleted.

2. After editing, select Edit Stamp Pack from the Stamp menu or double-click on the Packed
Frame to return to the un-editable Pack state. This will now apply changes to the Pack and
child Stamps. If you would like to terminate the task while editing, change the Packed Frame

back to Edit Mode and press the Esc key.

V¥V 8-7-4 Pack Master

In many cases, the Pack method is used to gather Stamps for the component’s body, solder and elec-
trodes. Since there are electrodes and solder near the body, if by inspecting the body, the amount of
misalignment will be reflected to the electrodes and the solder, the entire cluster can be handled more effi-
ciently. In this case, the body will become the Pack Master (the Anchor Inspection Frame) within the Pack,

informing other frames of the offset. This is called the Pack Master Method.

Screen 1 shows how Pack Master Method is applied in case a. First, the component misaligned from the
original data position is detected, and then, according to it’s correlation to the component, the similarly

misaligned electrodes and solder junctions are inspected.
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8-7-4

(Screen 2)
(Screen 1-a) (Screen 1-b)

(Screen 3) (Screen 4)

Meanwhile, case b shows an inspection not using the Pack Master method. The component is being
inspected, but since the correlation between the body and the electrodes/ solder junctions is not recog-

nized, it will be judged NG.

H Pack Master Setup

1. In order to use the Pack Master Method, go to Settings for supervisor >Action, check Enable
the follow Pack Master function (Screen 2).

2. Now, create a Pack, and press down on the Pack Icon on the Stamp list for more than 0.5 sec-
onds. The Stamp name background will change from light blue to light green. This shows that
the Pack Master method has been applied.

The Master Inspection Frame (anchor Inspection Frame) within the Pack will have a small light
blue mark on the top right corner (Screen 3). This mark is displayed for the frame created first.

3. While the Pack is selected, the master (anchor) can be changed by pressing Shift+Tab. Deter-
mine which part should become the master.

4. Within the Pack, the pack master will be inspected first, and the amount of misalignment de-
tected here will be applied as an offset to other frames within the Pack. The range for “Find” of
the frames that receive the offset will all be replaced to 2 pixels temporarily even if each frame
had a designated the range for “find”, and find will be run for only up to 2 pixels. This is because
with chip part inspections, finding too wide from the body position may result in missing NGs.

5. If you do not need a Pack Master, for example, when you have packed a row of BGA solder
positions, each must be inspected individually. In this case, press the small Packed Stamp
icon in the Stamp list for 0.5 seconds to remove the Pack Master feature. This will change the
background color of the Stamp list name from light green to light blue, and the corner mark will

disappear from the Pack in the work area (Screen 4). Pressing the small Stamp icon again for 0.5

76
8. Stamp Operation




seconds will change it back to the Pack Master Mode.

These settings will be saved and applied when creating the next new Pack.
* The number of the stamp assigned as master by shift + tab keys is colored in purple in Pack window.
* Pack master is not automatically applied to new packs even Enable the follow Pack Master function
is activated. Please set individually.
* Histogram stamp can’t be anchor, if Pack contains only histogram stamps, Pack master not applied.
* The Pack Master cannot be applied to frames with Special Camera Settings.
* If the Pack Master inspection result is NG, all other frames within the Pack will ignore the offset of
the Pack Master.
* If Pack Master function becomes unnecessary, you can undo all pack stamps’ anchors by pressing

Option key on one of the pack stamp’s master picture icon in stamp list.

V¥ 8-7-5 Extra Settings No.1 Search Area

This function lets Pack Stamp search component by master picture of Pack Stamp.

* Take good master picture when using this function.

Hl How to set

1. Open Pack Settings window. Click Search tab in Extra Settings (Screen 1). Search area
can be selected from Non (don’t search), 0.1, 0.2 ... 0.5.

2. After selecting area, thin green line will be shown around the Pack Stamp (Screen 2).

3. When large area such as 0.5 mm is selected, thin blue line will be shown at the frame of
Pack Stamp picture (because it is too wide and can’t display in picture). (Screen 3)

4. If Pack’s master picture is featureless, or less different from surrounding, Search area can’t
be set. In this case, the master picture is crossed out, and Search area will compulsory
be Non (Screen 4).

H Caution

(Screen 1) (Screen 2) (Screen 3) (Screen 4)
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- Master picture of Pack Stamp may include not only component also PCB. If various shape
of silk print is painted around components, Pack Stamp may not find the correct place.

- Searching of Pack Stamp takes 2 Ms per inspection point. For example, if Search is acti-
vated on 1,000 inspection points, inspection speed will be decreased 2 seconds. Do not.
set Search on unnecessary points.

V¥ 8-7-6 Extra Settings No.2 Measure/offset Angle
This is the function to inspect component’s position shifting (especially theta rotation). Without complex
settings, theta rotation of the components/connectors can be detected.Also, assign the detected angle for

rotation offset.

* Power Mac G5 or earlier Mac (without Intel processor) can not use this stamp. Angle Limit tab
is greyed out, and can’t access.

* NG points can not be confirmed in NG Cell View mode.

Bl How to set (Measure)

1. Open Pack Settings window. Click Angle Limit tab in Extra Settings (Screen 1). Angle
limit can be selected from Non (don’t search), 0.5, 1.0 ... 6.0.

You can immediately start inspection with this setting, but you can also limit area to mea-
sure the angle. Select “mylimit” in Angle Limit (Screen 2). Window for optional angle set-
ting is displayed (Screem 3), and you can set the angle with 0.1 step from 0.1 to 6.0. For
the machine with DOAL lighting, DOAL is displayed for selection. When you select DOAL,
switching of main lighting and DOAL lighting is possible, so please use the function de-
pend on the place and parts.

2. Select Area at the bottom of pull-down menu (Screen 4). Option settings for Angle Limit
window will be displayed (Screen 5a). In this window, you can set “Angle detection area”
or enhance “Image processing”.

3. The area that angle should be detected is shown by red frame. As below picture, Pack
Stamp which includes solder fillet, should exclude solder fillet area from red frame
(because solder shape varies and this gives bad effect to measurement). Detection area

should be component body only.

Click down arrow of Expand/Shrink long side, long side of the red frame will be shrunk,
click until solder fillet is excluded. Click upper arrow of Expand/Shrink short side, the
other side should be enlarged, in order to detect the edge of component stable.

4. Start inspection. The component which exceeds angle limit is judged Not Good and angle

is shown (Screen 5b).
5. You can even know the angle of good component by re-inspecting or analyzing. Result will

be displayed in message bar (Screen 6).
6. If Pack Stamp picture has less difference to compare with surrounding, the master picture
is crossed out, and Angle Limit will compulsory be set Non (Screen 7).

7. If angle can not be detected well, test Image Processing in Option settings for Angle
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8-7-6

(Screen 3)

(Screen 4) : (Screen 5a)

(Screen 1) (Screen 2) :

(Screen 5b) (Screen 6) (Screen 7)

(Screen 8) (Screen 9) (Screen 10)

Limit window. It can be improved. For detail of the options, please refer to the following

item “Option settings menu”.

Hl How to set (Offset)

Select offset from pull down menu. Now up to maximum 12 degrees rotation is detected
and assigned as rotation offset. If it is failed to detect rotation, inspection continues with-

out offset.

H Notice
- Component such as 0201 size (0402 in millimeter) is too small, as a result Angle Limit pull-
down menu is greyed out and unable to select (Screen 8). At least 36 pixels are necessary
for long side. (To convert in millimeter, approx. 0.9mm with 25 micron lens, 0.7mm with
18.8 micron lens and 0.35mm with 10 micron lens.)
- If the component edge is not sharp (trapezoid or rounded), the line for measuring angle can
not be clearly detected and an error message will be shown (Screen 9). Also if component

color is similar to PCB color, angle can not be detected.
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- Angle is detected along long side. Therefore the Pack Stamp which shape is nearly square
such as SOP, can not exclude solder fillets even shrinking long side as much (Screen 10).
Such component is not suitable to detect angle in Pack Stamp setting. Try the method “In-
clude AngleCheck stamp in Pack Stamp” described on next.

- Angle Limit function requires 15 Ms per inspection point. However, the calculation is car-
ried out in the other thread. Therefore, this will not affect to inspection speed much.

- Angle limit can be set in 0.5 steps, nevertheless actual measurement accuracy is 0.08 de-

gree.

- NG pictures are not sent to Rc22X/CS-Center in NG Cell View or Auto send for all NG
in faster mode.

M Include AngleCheck stamp in Pack Stamp

Though Pack Stamp already has the function to measure angle, there is an exclusive stamp to measure
angle called AngleCheck stamp. This stamp can be included in Pack Stamp, and in Pack Stamp this
can work as “Measure angle of desired area”, and “Able to use Image Processing options such
as Emphasize Contrast that AngleCheck stamp does not have”.

For example SOP mentioned in Notice on Page 7, is nearly square shape and can not exclude solder
fillets. But this can be measured well by using AngleCheck stamp in Pack Stamp (Screen 11).

* Expand/Shrink long side and Expand/Shrink short side is not possible to use when AngleCheck

stamp is included in Pack Stamp, because AngleCheck stamp can be resized flexibly.
H Option settings window (Screen 13)

1. Expand/Shrink long side

Make area of long side where angle is detected be longer/shorter. The area is displayed in red rectangle.

8-7-6
(Screen 11)
Various lines exist, could not detect angle. Could detect angle because detection area was limited.
(Screen 12) (Screen 13)
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There is limit to expand/shrink.

2. Expand/Shrink short side

Make area of short side where angle is detected be longer/shorter. The area is displayed in red
rectangle. There is limit to expand/shrink.

3. Test

Confirm how line will be detected in current condition.

4. Default

Clear increase/decrease of item 1 and 2. Set detecting area to be on default size.

Below options can be selectable after checking “Custom settings” on.
5. Emphasize contrast

Enhance detection level.

6. Exclude color element

In order to avoid detecting unclear/thin lines, exclude RGB color and binarize in black/white.
7. Reduce noise

Exclude unclear/thin lines, and set only clear/thick line to be the measurement target.

VW 8-7-7 Extra Settings No.3 Measure Distance

Normally 22X operation software detects the position shifting of components whether the expecting color
was correctly found in correct position. With this function, we can measure the shifting distance by setting
the point to be base (Start Line). We can obviously see the shifting amount numerically.

* Shifting to X direction can not be measured in current version. To Y direction only.

* If you can not find a good line to be Start Line, you can not use this function.

* This function is to detect slight position shifting in small area. This will not be suit to detect wide
position shifting, then the inspection result will be 'not found'.

* Because the usage of this function is very limited, menu is greyed out until activating in For

Supervisor's menu.
Bl How to set

1. First of all, activate this function. Open For Supervisor in Configuration menu. Select Plus
tab, check on Enable measuring [Distance] in Pack window. Press OK button in, then
quit For Supervisors settings (Screen 1).

2. Open Pack settings window. Check Distance on, then click Settings button (Screen 2).
Settings for measuring distance window opens (Screen 3).

3. Please refer Settings below, how to set measuring distance.

* When using Distance function, activate Search function also in Pack Settings window. If no Search
area is set, distance is measured from coordinates where you placed the pack stamp. By activating
Search, pack stamp searches component, and actual distance from the center of component to Start

Line is measured.
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(Screen 2) (Screen 3)

(Screen 1)

(Screen 4) (Screen 5) (Screen 6)

For example, below LED component is shifting 0.1mm downward. If no Search is set, the distance
is measured from the position where Pack Stamp is placed (Screen 4). If Search is set, Pack Stamp
searches LED component, as a result correct distance is measured from correct position (Screen 5).

The pack stamp’s position after searching is shown by thin black frame by re-inspecting/analyzing. The

measurement accuracy is 0.01mm.
H Start Line settings window (Screen 6)

1. Detect Area

The black square indicated by red arrow in above picture is Detect Area. Start Line should be found in
this black area. Set the size, default value is 100x100 pixels. It is possible to set smaller value, however
the information to detect Line will be not enough and the detection will be unstable. Set 100x100 or
200x200 pixels. Maximum value is 300x300.

2. Distance (mm)

Rose color line, that runs from the center of pack stamp to Start Line. This defines the position of
Detect Area. In above picture, Start Line is set to be the border of the pattern, -7 in Y direction (7mm to
upper), +2 is set for X (2mm to right) in purpose of avoiding yellow silk print.

3. Tolerance (mm)

Limit of shifting. Component will be judged as defect when distance between the center of pack stamp
and Start Line exceeds this value.

4. Start Point (mm)

Set Start Line’s distance from the center of Pack Stamp. This defines the standard distance. Normally
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(Screen 7) (Screen 8)

you do not need to input here manually, because after inputting “1. Detect Area” and “2. Distance
(mm)”, length is automatically calculated and result in “5. Current Point (mm)”. (If no line to be Start Line
is found in Detect Area, 5. Current Point (mm) will not have result.) Press “6. set Current to Start”
button, then the value in Current Point will automatically be copied in Start Point field.

5. Current Point (mm)

Distance between the center of Pack Stamp and Start Line is automatically calculated after inputting “1.
Detect Area” and “2. Distance (mm)”. Input is not permitted in this field.

6. set Current to Start

The value in “5. Current Point (mm)” will automatically be copied in “4. Start Point (mm)” by pressing this
button.

7. Method

Start Line is detected by Edge method. The method is selectable from brightness high to low or vice
versa by switching H -> L and L -> H. Select either that line can be detected clearer.

8. Minimum luminosity

For detecting Edge steady, the brightness of 128 level is necessary. Normally do not change this value.
Nevertheless, according to PCB color, you may decrease this level when you can not get enough
luminosity, even after switching Edge method or activating Emphasize contrast.

The level can be decreased at 64 minimum. When luminosity is not enough, a number is displayed
with error message ‘No Line’ while setting (Screen 7). Sometimes, detection may be succeeded by
decreasing luminosity level (Screen 8). However, brightness is not enough therefore some inspection
points may fail to be measured.

9. Emphasize contrast

When detection of Edge is not successful, try this on. Sometimes Edge can be detected well.

H Caution
- Measure Distance function takes 1.5 Ms per inspection point. For example, if Distance is
activated on 1,000 inspection points, inspection speed will be decreased 1.5 seconds.
Plus, Search function must be used simultaneously, additional 2.0 seconds are required.

Do not use Measure Distance function on unnecessary points.

- It is not possible to set Start Line in the other FoV (Cell).

8-8 Masking (Non-inspection area)
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8-8-1

(Screen 1) (Screen 2)

(Screen 3) (Screen 4)

If there is an area within the Inspection Frame that should not be inspected, apply a mask over that area
to eliminate from inspection. The Mask is used to designate non-inspection areas. Masked areas will be
treated the same as the Master Picture, meaning that masked areas will have a 100% OK ratio, and only

the unmasked areas to be compared.

V¥ 8-8-1 Mask Settings

1. Select the Inspection Frame (Screen 1).

2. Select Edit Mask from the Pull-Down menu in the Master Picture Area (Screen 2).
3. Use the Edit tools beneath the Mask window to define the masked area (Screen 3).
4. Click OK to apply the Mask.

5. The masked area will be shaded (Screen 4).

B Rotating rectangle mask

There are the Rectangle, Oval, Pencil and Line tools in Mask tools. The Rectangle mask can be rotated.

Draw a mask area with the Rectangle tool, at the end of drawing, press Option key. While pressing Option
key, release your mouse. Again press the mouse button, and move the mouse to the direction where you
want to rotate the rectangle mask. When the mask area reaches to the desired angle, release the mouse.

The angle is shown at the message bar in Main screen. Pencil and Line tools can thicken lines up to x3
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by clicking x1 button. Undo is possible by pressing delete key (above return key).

B Editing mask size

In version 4.9.9r1 or later, you can change the size of “Rectangle” and “Oval” mask for “Pattern matching”
and “Scratch setting Stamp” . Use the Edit tools of “Rectangle” and “Oval” at the bottom of Mask Editor

window to define the masked area, then drag the anchors on Mask edge.
8-9 Reference Designators and Comments

Ref.Des. (= Reference Designator) and Comments can be applied to Inspection Frames and Stamps. For
example, when the component/part name is set as a Ref.Des., it is easy to work intuitively by looking at
the component/part name when importing NC Data. It is also possible to search for components/parts by
the Ref.Des.

Inspection Frames include the Ref.Des. and other data such as unique number, position information, num-
ber of inspections, number of NGs, data created and data updated (refer to “14-1-1 Exporting Data” for

details). The data can be displayed in Map View and exported to a text file.

V¥ 8-9-1 Input Ref.Des.

Select an Inspection Frame and select Input Ref.des. name from the Master Picture menu (Screen 1)

8-9-1 8-9-2
(Screen 1) (Screen 2) (Screen 3) (Screen 1)
8-9-3
(Screen 1) (Screen 2) (Screen 3)
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to display the Ref.des. name Input dialog (Screen 2). For example, a frame with the Ref.Des. “P1005R”, “1/1:
P1005R” will be displayed on the upper part of the Master Picture Area (Screen 3). Ref.Des. should be no
longer than 15 single byte characters (7 double byte characters).

If a Frame with a Symbol number is duplicated by Duplicate Selection, (X. Y) will be added at the end of
the copied Ref.Des.

* In screen 2, two OK buttons are displayed. The Apply button with the Stamp mark applies the same

comment to all frames using this Stamp. This will not affect the Ref.Des.

B Set Ref.Des. name in consecutive number

In version 4.9.9r3 or later, you can apply Reference Designator number by fixed rules when you place the
Stamp. Open “Settings for Supervisors” window from menu Settings > Configuration > For Supervisor.
Open Assistant tab. Put check mark on “Set Ref.des. name in consecutive number”. When you place the
Stamp, Ref.Des. name is assigned with the rule “Stamp name — consecutive number”.

Ref.Des. name is assigned as same as for “Row Copy” function.

* If you place the Stamp more than 9999, consecutive number is not updated. All number will be 9999.
* This rule is not applied for the function of “Duplicate Selection” , “Matrix Copy Into Cells” , and “Multi
Duplicate” from the Cell menu.

* If Stamp name has more than 10 characters, Stamp name after 10th character will not be displayed.

V¥ 8-9-2 Find Ref.des.

List of all reference designator is displayed in ascending order when selecting Find Ref.des. in the Mas-
ter Picture menu (Screen 1). Number which is included in symbol name is displayed by numerical value
order, not character code. You can move to Symbol by clicking Jump button or Symbol name. Only the

Symbol including the input character is displayed when you use Search window.

V¥V 8-9-3 Show/ Enter Comments

When the operator judges OK/NG in the G/NG Confirmation Mode (See “13-4 G/NG Confirmation Mode”),
misjudgments may occur if the operator does not understand the programmer’s OK/NG concept correctly
Therefore, comments and orders of up to 30 single byte characters or 15 double byte characters can be
entered when creating Frames (Screen 1).

To apply a comment to all the same Stamp Frames, click on the OK button with the Stamp mark.

In the G/NG Confirmation Mode, this comment can be displayed in the Map view by checking Result with
Ref.Des comment in the Mode tab of the Settings For Supervisor window (Screen 2).

When importing NC Data containing Part Names, the Part Names can be converted as Comments. After
importing the data and before executing Combine Cells After Import, select Part Name to Comment

in the Edit menu (Screen 3) and click OK. Note that once Combine Cells After Import is executed, Part

86
8. Stamp Operation




(Screen 2-a)

(Screen 2-b)

(Screen 1)

(Screen 3)

Name to Comment cannot be selected.
8-10 Frame Type and Show / Hide Setting

Select Show / Hide Object Type from the Window menu to display the Show/ Hide Object window.
In the Show / Hide Object window, Inspection Frames are categorized by type and user can set frames

to be visible or invisible

V¥ 8-10-1 Frame type assignment

There are 2 tabs in the Show / Hide Object window, default tab lists frames/stamps by shape and type
which this software defines such as Rectangle, Oval, Masked, Cell Aid, Solder paste, Custom 1 to 8...

In original tab, user can set the original frame type from ID 1 to ID 9 (Screen 1).

* Please refer Chapter 8-1 Inspection Frame / Stamp Filter Settings how to apply original frame type
to frame/stamp.
* Frame type defined in original tab is saved in software, therefore it is not possible to define per each

inspection data.

In order to define original frame type, input text in the columns of type and error. Be careful not input too

long text. Long text may not be displayed fully or be messy when displayed.
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8-10-5

3

(Screen 4)

V¥ 8-10-2 Display my original error message

Error message defined in error column is displayed together with machine original message after back

slash (/) when Display original NG error message, too is checked (Screen 2).

V¥ 8-10-3 Send Original ID as NG-ID to Rc22x/CS-Center

If you use Rc22x/CS-Center, inspection point judged as NG is marked NG ID O usually, however if you
assign frame types, the ID number is sent instead of 0. Define frame type per inspection area like fillet,
body, etc, and define NG ID in Rc22x/CS-Center also the same. This is very powerful if you are activating
“Auto send for all NG”, because even sending NGs automatically to Rc22x/CS-Center, you can still roughly
recognize the defective trend on Watch22x/CS-Watch. Also it can be good reference when reviewing
defects on Rep22x/CS-Repair or Watch22x/CS-Watch. When using NG ID in this way, check "Assign NG
ID input0-9" on.

* If a number is input from Tenkey, the number is sent to Rc22x/CS-Center in stead of frame type ID.

* If there are more than one defective stamps in Pack stamp, the younger ID number is sent.

* If you set frame type on both Pack stamp itself and stamps to configurate Pack stamp, the frame
type ID for Pack stamp is sent to Rc22x/CS-Center. Thus, "number from Tenkye" > "Pack Stamp

frame ID" > "youngest frame ID of a stamp in Pack stamp"

V¥ 8-10-4 Stamp ID correspondence list

This list is displayed when clicking on ID to the stamps... (Screen 3). On this list, you can confirm which
stamp is assigned to what kind of original frame type.

However this is correspondence list for stamp, thus frame (not saved as stamp) is not listed.

Stamp with no ID, stamps which can not be assigned original frame type (Pack stamp, ExtraParts stamp,

New Cell Aid stamp and etc.) has ID:0.

By inputting ID number from 1 to 9 in correspondence list, you can define assign ID to stamp. By this

method, stamps such as Pack, ExtraParts, NewCellAid can also be assign ID.
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8-10-6

(Screen 5)

V¥ 8-10-5 Hide / Show

Since Show / Hide can be applied by Frame type, it is easy to temporarily eliminate certain types of In-
spection Frames from inspection.

Clicking on the Eye Icon, closes the Eye, hiding the inspection area of that Category. Hidden areas will not
be inspected. Click again to open the Eye and show the Category, allowing that Category to be inspected
The value next to the frame type shows the number of Inspection Frames. For example, for Solder Paste
Check Inspection, the Inspection Frame will be counted as both Rectangle and Solder Paste, which

means that the total number may not be equal to the number of Inspection Frames (Screen 4)..

V¥ 8-10-6 Control Tendency NG by NG-ID

Possible to set the number of NG inspection frame by each type in Show/Hide Object window. Possible
to show the alert when NG inspection frame more than set value is detected. This function is available

when Tendency NG function is activated.

/ N
Memo: Advice when applying spot inspection to registers' value

If you apply spot inspection for a number on register,

you should better create a frame for body inspection to
check presence and reversing.

Filter Setting for the body frame can be very tolerant,
because it is only to check if the component is not
missing or is not reversing. Set higher blur level, and set
lower saturation and resolution.
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l How to set
1. Display “Tendency/Ignore NG report” window from menu Settings > Configuration > Tendency NG.
2. Put check mark to “Active” at "Tendency NG" tab, and click “OK”.
3. Select "Show/Hide Object Type" from the "Window" menu to display the Show/Hide Object window.
4. From Original tab, set the number of inspection frame at NG column to display alert.
* NG column appears when Tendency NG function is activated.
5. Execute the inspection.
6. Following alert message is displayed when NG inspection frame more than set value is selected

(Screen 5).

8-11 Assign Spot inspection

V¥ 8-11-1 How to set

You can set spot sampling in Show/Hide window’s original tab. Inspection for registers’ value or laser text
on IC are often detected NG by AOI because of misalignment or flux remaining on surface, though most of
them are actually Good. In PCB production line, if there are too many false NG, the whole line speed gets
slower and the rate of rolled through put yield is down. This function enables the spot testing of specified
inspection point such as text, register’s value. The setting is as following.

Input number in spot column where you want to assign spot inspection. Check Activate spot inspection
on the bottom of the window (Screen 1). In case you input 500 for type "r-text", the inspection for "r-text" is
executed on 1st time, 501st time, 1001st time... (Screen 2)

* All frames are inspected on the first time inspection.

* Number input in spot column is commonly used for all inspection program as well as type name
or error message. It is "Activate spot inspection" checkbox to decide whether spot inspection is
necessary for the inspection program or not.

* Count is initialized when closing inspection program or open other inspection program. If you want

8-11
1st inspection 2nd to 500th inspection
(Screen 2)
(Screen 1)
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to initialize during inspection, select Delete Logdata from Initialize in Edit menu. Be careful when

deleting Logdata, other logs are also deleted.

8-12 Automatic Positioning

When opening programs made by other 22Xs or making Cell copying or importing CAD data, position
misalignment may occur, it is time consuming to align one by one. Therefore, this software has an Auto
Reposition function. Select the Inspection Frame, and select Auto Reposition from the Edit menu or press
F4. The Inspection Frame will move to the position where it matches the Master Picture.

Also, pressing F9 aligns all Inspection Frames within the current Cell without selecting these Inspection
Frames. F10 aligns every Inspection Frame displayed within a Cell (including white Inspection Frames
which belong to other Cells), and include these white Inspection Frames into the Cell.

These Auto Reposition features will not function well if the difference between the Master Picture and the
local picture is too big, or the difference between the local picture and its surroundings is too small. Check

the positions with your eyes after Auto Reposition, and if it has not worked well, reposition manually.

8-13 Fixing Position
Opposite to the need of "Auto Reposition”, some of you need to "inspect at exactly same position as P&P
placed components" or " move back the frame exactly the same position after moving frame and adding
picture in pattern matching frame". There is an option to fix the frame position.
1. Open ForSupervisors menu from Configuration in Settings menu. Move to Action tab, check on
" Do not unlock fiducial offset ".
2. Open an inspection program. Debug the program. After debugging, frame position may change.
Press Start to check the program (Screen 1).
3. If there is any stamp which position has changed, an alerting message will be shown (Screen 2).

Select Back to Original position will move the frame(s) back to the original coordinates.

8-13

)

(Screen 1)

(Screen 3)

(Screen 2)
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Select Update position will update the frame(s) position to new coordinates.

Pressing Cancel button will cancel the inspection. Also Cancel button can use to confirm which frame
is moved, the Cell including moved frame is colored in red in Cell Map Area. The moved frame is also

colored in red (Screen 3).

8-14 Load Program of Another AOI and Reposition

Misalignments caused by importing NC data or CAD data or from Duplicate Selection, can be corrected
by adjusting the offset of the Cell. To apply the offset only to specific cells, select the Move Tool and move
the Cell while pressing down the Option key (Screen 1).

To apply the offset to all Cells, press down the Option and Command keys while moving the Cell.

H Automatic Offset-- Reading programs made by different model machines.

When reading programs from machines with differing PCB sizes, the offset must be set because the Ori-
gin positions are different. In this software, the movement range of the machine is written in the program. If
the movement range of the program is different than the movement range of the current machine, a dialog
will be displayed asking if an offset should be set up or not. If this dialog is not displayed, the movement

range of the machines match.

8-14

(Screen 1)

(Screen 2) (Screen 1)
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When you press OK in the dialog, a rough offset will be set up.. The default offset values are X=0, Y=0,
please contact your local distributor for the proper values. To change these values, select For Supervisor

from the Settings menu and change the Machine Offset in the Movement tab (Screen 2).

However, since each machine is slightly different, final adjustments must be made manually by moving the
Cell or the Frames. In addition, if a programs for large PCBs are opened by a machine for small PCBs,
then a message, Position beyond movement limits, will be displayed. This means that the offset limit is

out of acceptable tolerances, making offset impossible.

H Automatic Offset — Reading programs made by machines of the same model.

Even if the machines are the same model, Origins vary by machine. So, when reading data created by
another machine, an offset will need to be set. If there are several machines of the same model, designate
one as the standard setup, and apply that offset value to the other machines.

The offset value should be entered in the Machine Offset dialog in the Movement tab in the Settings For
Supervisor window.

* Please be aware that when the offset value is changed, the offset will be applied to all of the Pro-

grams that has been created to date.

8-15 Other Methods to Adjust Position

When reading programs created by the other machine, use the Warp position to correct distortions that
cannot be corrected by the methods explained in previous chapters.

1. Read the data, execute the offset described in 6-3, and use the Move tool to display the upper
left corner of the PCB. The Work Area must contain a fiducial mark or a component in the upper
left corner.

2. Select Warp position in the Initialize sub-menu of the Edit menu, to display the Warp position
window. Click the Memory button to save the current position.

3. Then move the screen using the Move tool until the Frame for the fiducial mark or the compo-
nent are positioned properly, The memorized screen will be displayed like a shadow of the cur-
rent screen. Align the upper left position first and check the check box on the upper left of the
Warp position window. The upper left corner’s coordinate will be corrected.

4. Click Memory again and repeat the process of position checking and memorizing for the other
corners as well (lower left, upper right, lower right).

5. Align all 4 corners and click the Start button to apply the repositioning (Screen 1).

* Correction will not be applied outside the area within these 4 corners.
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(Screen 1)

(Screen 3)

(Screen 2)

8-16 Convert stamp resolution

This function is useful for re-using stamps on new AOI with high resolution lens which is made by old AOI
with low resolution lens.
* If AOI model is different, the illumination may differ. In this case, you need to re-take master pictures
or tune-up histogram settings of all stamps in addition.
1. With New File, select "Open Stamp File" from Stamp menu (Screen 1).
2. Finder is displayed. Check on the "Convert" at the bottom left, and select the inspection
program that you want to convert (Screen 2).
3. Convert window is displayed. Select the resolution of this inspection program and the resolution
to output. Press Execute button (Screen 3).
4. Stamp will be converted. Some special stamps are not converted and their name are listed on
text file.
* This function is to re-use the stamp by converting the resolution. You can't convert the inspection

program itself, so that there isn't Convert checkbox when there are stamps in Work Area.

94
8. Stamp Operation




9. Pattern Matching Method

Pattern Matching Method is an inspection method to verify component by comparing with good reference
picture. In pattern matching method, you should emphasize the differences when there is no big difference
between good reference picture and bad component. On the other hand, when there is slight difference
between good components, you should increase the tolerance. In pattern matching settings, you can

change such settings by parameters.

9-1 How to Use

Pattern matching method is suitable for components inspection, detecting position shifting amount, slight

difference of color, and enable to set tolerance for detection by setting Filters.

9-2 Settings Window

V¥ 9-2-1 Set filter Window

Select the Pointer tool in the Work Area and double-click on the Inspection Frame, and the Filter Window
will appear (Screen 1). Filters that can be set for each Inspection Frame as following. These settings can

be confirmed in the Work Area in real-time.

H Brightness

Brightness can be adjusted within the range of -16 to +15.
The Special setup button is used when changing photographing conditions on machines with digital

cameras. For detail please refer “20-2 Special Camera Settings”.

H Contrast

The contrast value can be adjusted within the range of -16 to +14. The highest value will be binarised into

9-2-1

(Screen 1)
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black and white (BW). When converted, the brightness lever will be used to determine the divergence

point. The contrast can be changed using the Emphasis Area button to the left of the Contrast fader.

Ml Hue

Hue (color condition) sensitivity can be adjusted. Moving the lever to the right (+ direction) will increase
sensitivity, and moving to the left (- direction) will decrease sensitivity.

Since monochrome images (white, black, gray) tend to react easily even to the slightest noise, sensitivity
should be lowered. An X will be shown when the value is set at the minimum, and the hue will not be de-
tected. When setting this item, the preview of the frame in the Work Area will be divided into two, showing
the range of acceptable colors (for example, with yellow parts, the left side may show red, and the right
side may show blue colors). The higher the sensitivity, the smaller the color difference in the two displays

will be (Screen 2).

H Saturation

Saturation (the shininess of color) can be adjusted. Moving the lever to the right (+ direction) will raise sen-
sitivity, and moving to the left (- direction) will lower sensitivity.

An X will be shown when the value is set at the minimum, and the Saturation will not be detected.

When setting this item, the preview of the frame in the Work Area will be divided into two, showing the ac-
ceptable range of brightness. The higher the sensitivity, the smaller the color difference in the two displays
will be (Screen 3).

* Optionally you can use Human Saturation instead of default saturation. Human Saturation's sensitiv-
ity is very much like human eyes. The option is selectable by checking on Apply Human Saturation

in General in Setting menu. The option is applied per each inspection program.

H Text

9-2-1

o

(Screen 2)

o

(Screen 3)
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This setting binarises the Inspection Frame in black and white. This is used for inspecting text printed on
IC packages. When this box is checked, the left levers will change to those used to adjust brightness,
contrast and letter sensitivity (Screen 4). The Letter Sensitivity lever will change to AT when moved to the
far right, and will automatically binarise in black and white.Ilt will change to AV when moved to the far left,
and will become a grayscale image. An another option button will be shown next to Text with RGB light

type AQOI. For detail of this option, please refer Chapter 20-7 Text filter for AOI with RGB LED.

H Fillet

Check this box when executing solder fillet inspection. Refer to Chapter 21 Solder Fillet Inspection.

M Position

Inspection Frames in which position misalignments occur depending on the PCB, can be made to be
judged OK by widening the inspection area, or, conversely, to be judged NG by limiting the acceptable
range of misalignment. Select the Position option for this setting.

* For details on this window, refer to 8-2 Position Limit/Tolerance Settings.

B NG is OK

When making judgments based on the existence of parts, an image with no parts can be recorded as the

Master picture, and be used as an OK when something is found. Check Match NG in this case.

M Edge

This filter extracts the outline of the picture in the frame. The extracted outline will be displayed in a light

9-2-1

(Screen 4) (Screen 5)

(Screen 6)
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color (normally white). When there is noise, both Blur and Edge should be used.

H Chase selection tab

This button sets the range for tracking a component/part. A component/part will be looked for within this
range, until inspection is OK. Click on the button to select the range of pixels to be tracked (Screen 5). If it
is set to 0, Track will not be executed. When you set Track, the actual range will be displayed for approxi-

mately 1 second (Screen 6).

H Resolution selection tab

This is used to designate how many pixels an Inspection Frame should be partitioned by. The default value
is the Default grid size in the Settings for supervisor window. It can be set within the range of 4 — 32,
and the smaller the number is, the more detailed the inspection will be (Screen 7). Select a small value to
look at details such as the shapes of letters, and select a large value to ignore details. When a small value
is set here and inspection becomes more detailed, false reports may increase. In this case, you may need
to lower the hue and saturation.

Inspections with high variances such as solder fillet inspection tend to have more false reports when the
frame is partitioned into grids. In this case, the frame can be partitioned into horizontal/vertical, or not be

partitioned at all (max). Inherit is used

M Special %

This corresponds to the Match Rate for OK in General Settings. You can set what % of a match will be
judged as OK, therefore it will be possible to detect even the slightest misalignments in miniscule parts, or
ignore slight misalignments. The default is OFF, and in this case, the Match Rate for OK will be applied. By
highlighting this button, the match rate within this filter can be changed within the range of 1 — 100% (Screen
8). Click again to remove the highlight, and the Match Rate for OK will be highlighted.

H Blur level

The following 4 types of blurs will be selected by clicking:
Blur All : The entire image will be uniformly blurred. This is effective for decreasing false reports.
Horizontal Blur : Strong blur only in horizontal direction. Used to eliminate noise on a flat surface.
Vertical Blur : Strong blur only in vertical direction. Effective for deleting letters.
Electrode Blur : Blurs electrodes to decrease false reports.

The blur level can be changed up to 48 using the triangle icons on the right. Also, when you click inside
the Blur Range frame, an arrow will appear. Dragging the mouse in the direction of the arrow will change
the level (Screen 9). If you would like to ignore slight differences based on the condition of the parts, the

blur level should be set as high as possible.
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9-2-1

(Screen 7)

(Screen 8)

(Screen 9)

Hl Show in real time

When this button is checked, inspection will be done in real time when changing filter settings. However, if
this button is activated, blur or Letter extract condition will not be displayed. We recommend to check-off

button when creating frames, and check-on when debugging.

H angle

Field to input component angle. By pressing up and down button, input +/-15 degrees automatically.

M Frame type (Un-setup)

A pull-down menu appears by pressing None button. If you define original frame type in advance in Hide/
Show in Window menu, the original frame types are selectable.Please refer Chapter 6-7 Frame type and

Hide/Show settings to define original frame type.

H color emphasis
This is used to inspect brightness (the percentage of light). This is mainly used in solder fillet inspection.
Please refer to Chapter 20-3.

M light Selection

This feature only works in AOI with multi lightings. Refer to 8-3, “Image Filtering by Lighting Selection”.

M debug mode

Sample all stamps in Work Area and debug them. For detail, please refer Chapter 8-4.
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H Camera Button

Renew or Add Master picture by clicking this button.

M test / analyze

Confirm inspection result or see inspection step.
M clear

Set filter to default.

V¥ 9-2-2 Cautions When Setting Filters

M Re-inspection

When filter settings have been adjusted, make sure to confirm the results before moving on to the next
task. After changing filter settings, you can re-inspect and analyze the selected Inspection Frame with the
test button and the analysis button In the Set filter window

* When there are multiple Master pictures, re-inspection will be executed for all Master pictures, but
analysis will be run only for the one displayed on the screen. To analyze other Master pictures, switch

over Master picture displays and press the Analysis button.

M Sensitivity Setting

Please note the following when setting sensitivity.
There are many ways to set sensitivity, but in general, raising Contrast will increase sensitivity, and reduc-

ing the Resolution value will increase sensitivity to fineness.

+ When sensitivity should be increased Defects tend to be missed in the following cases.
In these cases it is better to set sensitivity to a high level.
1. The PCB color is dark, and components/parts are also dark
2. The components/parts are mainly black and white (monochrome), with little differentiating char-
acteristics

3. The frame is small (inspection target is small)

* When sensitivity should be decreased False reports tend to increase in the following cases.
This can be avoided by setting the sensitivity to a low level.

1. The color condition of the components/parts varies

2. Electrode area too large

3. The frame is large (inspection target is large)

Bl NG judgment
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Steps in NG judgment by pattern matching are:

1. Pattern matching of each RGB element --> 2. Hue judgment --> 3. Saturation judgment.

Judgment must be OK in each step in order to move on to the next step. When judged as NG, a message
window will appear showing where the problem was found (up to which step was OK). The messages in-

clude the following:

1. Mismatch

Does not meet specified value in RGB pattern matching.

2. Mismatch by Hue

Does not meet specified value in Hue judgment. (OK in RGB pattern matching.)

3. Mismatch by Saturation (too low) Mismatch by Saturation (too high)

Does not meet specified value in Saturation judgment (OK in RGB pattern matching and hue judg-

ment.)

H Text Extraction

The Master picture and the Inspection Frame picture must overlap to a certain extent to make the Track
feature (Find target object feature) function well.

When making judgments based on letter extraction or binarising, if positions of pictures or text do not
overlap correctly, activate Find. It will be highly sensitive to differences when comparing binarised pictures.
In general, in order to prevent false reports, Blur All should be activated. If there are still false reports, try
lowering contrast (Screen 1).

If Letter B/W threshold in Settings for supervisor is O, the image will automatically become mono-
chrome. This setting will consider white objects as text even if the actual color of the text is black. In this

case, the sensitivity lever will be used to adjust the surrounding noise level.

H Limit of Text Extraction

Binarising (black & white) will be executed when Letter is selected, but in order to convert correctly, a more
than 5% difference in brightness will be necessary. If the text is blurred, it may be difficult to accurately
display by conversion, change letter sensitivity to AV. The picture will change to a grayscale image. Adjust
brightness and contrast here before applying Blur to eliminate excess noise. The effect by this process
is different from the binarising process. However, this method is not versatile. Please think of this as one

possible option.

H Position settings
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9-2-2

(Screen 1) (Screen 2)

9-3-1

(Screen 1)

When finding the misalignment of text in the horizontal direction, the Find will be more efficient if the area

is larger horizontally. In this case, you should set a Find area for each Inspection Frame.

Hl Show Matching%

When inspecting without speed priority, re-inspecting and analyzing each Inspection Frame, the inspec-
tion results can be displayed in %. Normally this may obstruct the view of the inspected object, so % is

hidden. To display, go to Settings for supervisor > Mode and check Hide Matching%. Remove the check

M Binarising Using Contrast Adjustment

When the contrast adjustment lever is set at a maximum, the value will be binarised in black and white,
and if Text Extraction is not selected, the saturation lever will change to Automatic Correction and be used
to adjust conversion levels (Screen 2). This will not change on the negative side but only on the positive
side, and the larger the value, the wider the accepted range will be.

When you continue to press down the button where you set the lever, the screen and the Master picture

will show the range of correction.
9-3 Position Limit/Tolerance Setting

When Position is selected in the Set filter window, the Position tolerance setting window will appear. You
can set the tolerance value here (Screen 1).

Position is mainly applied to items that are easily misaligned but would like to ignore the misalignment of,
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such as text printed on a chip. If the Position Limit is designated, the misaligned distance can be obtained
when the results are displayed. You should set offset limit with chip parts that you would like to judge as

NG if misalignment exceeds this level.

V¥ 9-3-1 Position tolerance setting Window

The following items can be defined in the Position tolerance setting window. Input values.

H Chase setting only

When this is selected, no searching or position limit is set (default).

W Default search range

The rate designated in Default find range frame in the Sensitivity tab of the Settings for supervisor will be

applied as the seeking range for Inspection Frame (default is 200%).

l Set search range

You can designate the seeking range in pixels. The values can also be confirmed and adjusted here. Use
the pull-down menu below to automatically set values depending on the proportion to the Inspection
Frame (1/2 - 1/5). If this value is 1/2, the seeking range will be 1/2 the length of the lateral side of the In-

spection Frame added to each side of the Inspection Frame.

H Set offset limit

The position limit can be designated in mm. When the limit is set here, the distance of misalignment will
be displayed with the results. The limit can also be designated by Command + drag. In addition, as with
Range designation, you can use the pull-down menu to automatically set the values by the proportion to

the lateral side of the Inspection Frame.

V¥ 9-3-2 Position tolerance setting Using the Mouse

9-3-2
(Screen 1)
(Screen 2)
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M Set search range

To set the search range, select the Inspection Frame with the selection tool, and place the mouse pointer
on the bottom right corner. Press the Control key and the pointer icon will change. Press down the Control
key while dragging the mouse to set the range. The range will be displayed as a line extended from the In-

spection Frame (Screen 1).

H Set offset limit

To set the offset limit using the mouse, select the Inspection Frame with the selection tool, place the
mouse pointer on the bottom right corner and press the Command key. After the icon has changed, press
down the Command key while dragging the mouse. The limit will be shown as a frame with 4 corners
(Screen 2).

* The maximum search/offset limit is 127 pixels.
9-4 Image Filtering by Lighting Selection

This feature only functions on AOI with multi lighting which can be switched off/on individually.

Settings for lighting at inspection can be selected on devices equipped with DOAL (Diffused On Axis
Lighting). Depending on the inspection, you can select from 6 options: Default, Main, Main + DOAL, DOAL,
Side, and Side + DOAL. Multiple settings can be applied to the same cell (these settings will not increase

the number of camera movements).

V¥ 9-4-1 Light Selection Window

Click on the light selection button in the Filter Setting window, and the lighting selection window will be

displayed (Screen 1).

H Default

Main light only. Select this to reset the other settings.

H Main

9-4-1

(Screen 1)
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Main light.

H Main + DOAL

When the DOAL is shined on the PCB, the convex sections of parts will appear black since the light does
not reflect back. This setting combines the image from the main light to this part. When inspecting parts
that have colors similar to the PCB, Main + DOAL will enable stable inspection by making the PCB surface
glitter and make parts stand out.

Il DOAL

This lighting shines on the PCB vertically and reflects back only the flat parts, with the flat parts appearing
white, and the convex parts black. It will be easier to check for the presence of solder or scratches that

are hard to detect with the main light.

M Side

The lamp shines from the side to vertically reflect light that hits objects with angles. It makes solder fillet

forms and text prints with laser markers stand out.

H Side + DOAL

This combines the side lamp red image with the black DOAL image. It is easier to see the condition of the
solder of the leads that are difficult to distinguish with only DOAL or side lamps because the image be-

comes all black or all red.

H + Color

DOAL is designed to reflect on flat parts and appear white when inspecting non-soldered pads, but some-
times the pad does not appear white and thus the non-soldered parts cannot be detected. In that case,
designate + Color to add the pad color to the image obtained by DOAL, and you will be able to easily de-
tect non-soldered parts. This feature can be used with Main + DOAL or DOAL. This is also effective when

inspecting solder fillets with Main + DOAL.

9-4-1

(Screen 2) (Screen 3)
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* To use + Color, select Settings -> Configuration -> Settings for supervisor -> Action and check
Enable color with DOAL, and click OK (Screen 2). If this is disabled, + Color will not be available.

* If the PCB color is reflected in the solder fillet, you can delete Red, Green or Blue as the - Color so
that the color will not be emphasized (Screen 3).

* With inspections that allow less solder in the pad, it may be judged as NG depending on the amount

of solder.

V¥ 9-4-2 Settings of Light Selection

1. Double-click on the Inspection Frame to display the Filter Setting screen.
2. Click on the light Selection button on the bottom left to display the Lighting Selection window.
3. Click on a button and the Work Area will change to the selected lighting..
4. Choose the proper lighting, and click OK to close the window.
5. Lighting selected here can be confirmed with the status icon located at the left of the Lighting
Selection button.
6. Press the Camera button to change the Master picture, and set filters if necessary.
7. After all the settings are complete, press OK and close the window. If the Master picture has not
been replaced, a warning window will appear.
Place the mouse pointer on the Inspection Frame for which you set the lighting selection, and the screen
will change to the selected lighting.
* If there is problem with captured image because of a flash synchronization, press the Renew DOAL

Timing button in the calibration window to make corrections.

9-5 Measurement against escaping NG and false NG
While debugging pattern matching stamps, if defect is escaped or if there are too many false NG, please

change filter parameters accordingly;

- If there is little difference in color tone between an OK and NG component, select only the distinctive
part as the Inspection Frame.

- If the colors of both the component/part and the PCB are similar, use histogram algorithm.

- Change grid from default 8 to 6 or 5 to detect the details.

- Increase Hue/Saturation level to catch the slight difference of the color.

- The Chase Limits setting allows slightly misaligned parts to pass the inspection process. However, if

the range is set too wide, parts that should fail will be passed. Decrease the Chase level to be judged

as NG or set Offset Limit in “Search” setting, in case the component is misaligned.

V¥ 9-5-1 Filter Adjustment

Check the analysis results, then adjust the filter. Inspection results will change depending on the settings
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of the filters. To find the optimum settings, it is important to execute a re-inspection every time the filter
setting is changed for improvement. Set Filters by double-clicking on the Inspection Frame (Screen 1).
Handling false NG is to say in another word, “increase tolerance”. Set blur or increase blur level to absorb
the slight difference of lead area. Decrease Hue/Saturation level to absorb the slight difference of colors.

In addition, changing grid number is also effective. Default number is 8, this means OK/NG criteria is done
per 8 pixels. If you increase the grid pixel number such as 12 or 14, OK/NG criteria is done per 12 or 14

pixels. As a result, criteria becomes more tolerant.

V¥V 9-5-2 Adding Master Pictures

A quick way to reduce False NGs is by adding an additional Master Picture, that has been found to be
False NG. The problem with this is, the more pictures there are for comparison, the longer the inspection
time will be, and it also narrows the choices of future adjustment methods. If possible, we recommend us-
ing techniques like Filter Adjustment, that have been explained above. Master Pictures can be added by

the following procedure (Up to 24 Master Pictures can be saved.).

1. Select the frame.

2. Select Add Picture in the Pull-Down menu on the Master Picture Area.

3. The added picture will appear next to the existing Master Picture. Each Master Picture can be
activated using the slider bars below (Screen 1).

4. In order to Delete a Master Picture, display the picture to be deleted and select Delete Picture
from the Pull-Down menu on Master Picture Area. Please be careful because this process

cannot be undone.

V¥ 9-5-3 Change lighting

This is a feature limited to systems equipped with multi lighting. When inspecting a small component
mounted on a similar colored PCB, a common technique used to emphasize differences is to increase the
brightness and contrast settings. However, the disadvantage of this technique is that the system will be
overly sensitive to the uniformity of the components/parts themselves, resulting in increased False NGs. In
addition, non-uniformity in the brightness of the solder area affects the shape and size of the surface area
in solder print inspection, resulting in non-uniformity upon inspection. Therefore, in order to make it easy
to see the difference between each image, change lighting or use combined lighting. This feature can be

accessed from the Filter Settings Window.

V¥ 9-5-4 Assign as NG picture

Adding Master Pictures will reduce False NGs, but since this process requires the pattern matching of all
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Master Pictures, it will result in longer inspection times. Therefore, an effective way to reduce inspection
time is to assign Master Picture as NG picture. If there is a certain pattern that is judged to be, you can
register that pattern as an NG picture. Since the system first compares the picture with NG pictures, the
NG points can be judged NG before detailed analysis. This is effective, for example, in cases where errors
follow a certain pattern such as parts not being where they should be or part B being located where part
A should be. NG pictures can be added as Master Pictures, and then set as an NG pattern by selecting

Assign as NG picture from the Pull-Down menu in the Master Picture Area.

* Color replacement cannot be used for Inspection Frames which have the Master Picture assigned as

an NG picture..

After these changes are made, inspect again. In order to improve accuracy, inspect at least 5 PCBs and

make filter adjustments to reduce False NGs.
9-6 Stamp Sampling Debugger
Sample all pattern matching type stamps in Work Area for debugging. Show all pictures per stamp, enable

to debug within one window, very efficient for debugging.

* Large RAM memory requires to collect all stamps' pictures.

9-6-1

(Screen 1)

(Screen 2)

(Screen 3)

(Screen 4) (Screen 5)
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V¥ 9-6-1 How to use

1. Open Filter setting window from Window menu (Screen 1). Press Stamp debugger button
(Screen 2).

. Window changes to red debugging window (Screen 3).

. Start inspection, whem finished, re-open Filter setting window from Window menu.

. All stamps' pictures are sampled in the window, select stamp and debug one by one (Screen 4).

a W DN

. It will be easy to debug by referring NG (indeed false NG) pictures in picture list. If you change
the filter setting, you can see the effect on sampled pictures. Adjust filter setting to every stamp
be Good. When debugging has completed, press Toframe button to update the stamp.

6. If changing filter setting does not improve false NG, select false NG picture then press jump

button or double-click. Then camera moves to Work Area (coordinate) where the picture

(component) is. You can add picture by pressing camera button in filter setting window or

adjust position by slightly dragging and moving the stamp's frame.

8. If true NG picture is sampled in list, delete it from list by pressing - button for accurate debug.

V¥V 9-6-2 Debug window (screen 5)

1. Stamp List

Stamp name, sampled stamps number is listed. Select any stamp, filter setting area on sampling list
changes value to the selected stamp.

2. Picture List

When selecting a stamp on Stamp List, all local pictures of the selected stamps are listed. Right side
shows inspection results; Good represents matching % in blue color, NG represents error reason in red
color.

3. jump Button

Select a picture from Picture List, press this button. Then, camera moves to the component.

4. - Button

Delete picture or stamp from lists. This only delete sampling data, the actual stamp or picture is not
deleted.

5. Total Stamp

Display number of sampled stamps.

6. Memory Consumption

Indicate memory consumed by sampling. When bar is colored in green or blue, memory is not much
consumed, but when bar is colored in orange or red, memory is almost fully used, must not debug,
because there isn't enough memory left for debugging.

7. only NG

If this option is ON before sampling, only defective stamps are sampled. If this option is ON while
debugging, only defective stamps are debugged (re-inspected after changing filter settings).

8. erase

Release sampled stamps and pictures.
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10. Histogram Analysis Method

Histogram Inspection judges Good/NG if the amount of Brightness of the target color out of Grey/Red/

Blue/Green is within the specified range of histogram.

22X software uses the pattern match principle for inspection, which is to compare RBG colors of parts/
components with which of a good sample pixel by pixel in Brightness, Hue and Saturation, and judge
Good/NG by matching level. However, the inspection frames applied Histogram Stamp are judged by His-
togram algorithm.

The best advantage of Histogram Inspection is that its inspection time is faster, because Histogram In-

spection checks only one color (Grey/Red/Blue/Green) and checks only the amount of the light.
10-1 How to Use

We recommend to use this inspection method for the unstable shaped parts which the inspection can be
result in False NG or escaping NG, such as solder paste or solder fillets.

Also, applying this for inspecting the color code on resisters or for inspecting simple color such as polari-
ties can make the inspection speed faster. This stamp can increase the inspection accuracy and perfor-

mance to use with the combination of pattern matching inspection.

10-2 General Procedure

1. Set a PCB (It is better if the board is a good one or if you already know the NG points.)
Draw a frame, go to Window -> Histogram Analyzer and open the window.
* Do not draw trap frames at this stage.

2. Open Sampling tab and press Sampling button. Press OK and quit the window.
A dialogue to input a stamp name appears, input stamp name.

3. Paste this stamp where to inspect, then start inspection.

4. After inspection, open Histogram Analysis Window and open Stamp tab.
Check images on sampling list, if there is any image which is widely shifting or obviously
defective, delete from the list by sub menu [Delete from list].
(Next procedure is creating composite image. NG picture should not be mixed.)

5. Press [sample image] button, and create composite image. Draw trap frames on the composite
image. Press [debugging] button in order to check if all sampling image can be OK.
Adjust trap frames until all sampling images to be OK.
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10-3 Limitations

You can treat Histogram stamp as same as pattern matching stamp, however these are not possible.
- Set offset limit for position tolerance settings.
- Hold horizontally flipped master picture.
- Flip Zoom/Unzoom.
- Create from Oval/Polygon Frame.
- Rotate stamp with Option key

10-4 Settings Window

Each function in this window is shown below;

1. Work Area

The area framed by the histogram stamp is displayed. Create trap frames by trap frame tools. (The term
"trap frame" represents the area to be inspected for criteria.)
Trap frame is colored in blue when Good, and colored in red when NG.

* Drawing trap frame in white area in Work Area is not included in criteria.

2. Histogram Area

Each graph of Grey/Red/Blue/Green colors, percentage, and target range are displayed.

The grey scale bar on beneath is a reference for brightness/darkness.

H Graphs

The color chosen for inspection target is represented in bar graph. The others are represented in line

graphs.

H Percentage %

Display the amount of light between the target range in percentage. It is colored in blue when the amount

is within OK percentage, and is colored in red when the amount is out of OK percentage.

H Target range

The range between the dot lines is the target range for OK/NG judgement. The range can be enlarge/nar-
row by dragging the dot lines. The target range can be moved without changing the width by dragging on

the letters of [%]. The exact positions of dot lines are displayed on [< >] in trap frame condition.
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3.Trap frame tools

Tools for creating the trap frame. Default tool is Rectangle tool. Oval and
=8 oot :

Polygon tools are also selectable. Maximum 31 trap frames can be created.

* Select a trap frame by pressing Option key and drag, then you can duplicate the trap frame.

k Select tool. Drag mouse on to multiple trap frames with this tool, then you can make these

trap frames in group. Group ID [gr] is automatically set.

Doughnut tool. Make the square or round trap frame to be outlined. Select a trap frame, and

press this button. The slider will be displayed.

Synchronize tool. Changes on a trap frame can be applied to all trap frames with the same

group number [gr] or ID number [id] When pressing this button, you are asked "Apply to

"group number" or "id number" ?", then select one of them.

* Default [gr] number is 0, the trap frame numbered 0 is regarded as not belonging to any
group. Thus, the trap frame numbered 0 in [gr] column does not synchronize each other.

ex. Create a trap frame, then duplicate it. Then change the original trap frame in condition,

and press this button. The change of condition also is applied to the duplicated frames.

The button will reduce your time for debugging.
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--I[ Trash. Selected trap frame is deleted. Trap frame is also deleted by 'Delete’ key.

It is not possible to delete multiple trap frames at once.

4. Trap frame attribute list

Set an attribute for each trap frame; ID [id], Group [gr] and compare detection result [< >].

*The line colored in grey is selected trap frame in Work Area.
mid
ID number. Unique numbers are automatically set when you create trap frames.

By manual keyboard input, you can change this number.

Copied trap frame has the same id number as original trap frame.

mogr

Group number. Number O is the default value when you create a trap frame. By inputting another number,
you can change this number. You can make trap frames with same number in a group. There is 'OR con-
dition' of inspection criteria in this group. Usually, in order for a histogram frame to be judged as OK, all the
trap frames must be judged OK. However, by setting up a criteria here, you can allow a histogram frame
to be judged OK if one of the trap frame is OK even if the others are judged NG.

ex. The image contains 2 trap frames with [gr] number 1, in this case there is a condition 'if one of the trap
frame is OK, the other can be NG'".

* [id] and [gr] numbers can be set from 1 to 32.

m<>
Possible to compare the detection result using multiple trap frames. It can be applied for such as the in-
pection of polar component mounting direction.

5. Trap frame condition table

This is the table for trap frame's condition; target range <>, % to be OK, inspection target color (RGB), re-

versing the function of OK and NG, add/delete condition(s), and target range adjust buttons.

HEN
The roll of OK and NG changes. The target range not reached to OK % (=NG) results in OK.
Same function as NG=0OK in filter setting window of pattern matching frame.
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H Target range (<>)

The histogram graph is from 0.00 to 1.00. The value in [<] is the position of left dot line. The value in [>] is
the position of the right dot line.

These values change automatically by moving dot lines by mouse. Manual value input is also possible.

Ml ok%
Percentage which should be judged OK. Default value is 50%.

H RBG (inspection target color)
Selectable from GREY / RED / BLUE / GREEN. The colors out of selection are out of inspection.

Bl Add/delete condition buttons [ -/+ ]
[ - ] button deletes a condition, and [ + ] button adds a condition. They are useful when you'd like to
inspect more colors or inspect under multiple conditions. Maximum 31 conditions can be added.

l AND/OR

In case if a trap frame has multiple conditions. you can select their criteria condition to be AND condition
[&], or to be OR condition [or]. In AND condition, all settings should be OK. In OR condition, if one setting
is OK then the rest can be NG.

Default condition is OR [or]. It can be switched to AND [&] by clicking on the symbol.

M Auto button and enlarge ( 4 P) / narrow ( I+ 4 ) buttons

Auto button sets target range and color automatically. Enlarge button enlarges target range +0.03 to both
side, and narrow button narrows target range -0/03 in both side.

Enlarge button does not spread when the range is over 50%, narrow button does not shrink when the
range is less than 5%.

6. Control Panel

There are 6 items; Check (test inspection), Search for histogram frame/ trap frame, Filter for Saturation &

Polarity and Extra settings,

H Check (test inspection)
Test-inspect all trap frames in the Work Area.

H Search

Left item decides the pixel(s) amount for the program to track the parts/components positions.
Right item decides the pixel(s) amount for the program to search the histogram matching area.
Default values are 5 for Left and 2 for Right.
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W Filter

[Saturation]

Checking this increases saturation balance of image in Work area. Check when you can not see enough
contrast on the image.

[Polarity]
Checking this reinforces image contrast. Check when you can not distinguish a polarity mark.

H Extra settings
Menu for advanced settings.

Lighting

On AOI with multi lighting, Main lighting , DOAL. Side lighting,

Side lighting + DOAL, Main + DOAL is selectable from tab.

On AOI with single light this menu is inactive, and you can
not select. Some model has Custom camera setting.

* After changing Lighting, you are asked to take a new
picture because lighting has changed.

Press “Take a new picture” button.

Angle

Set an angle on histogram inspection frame. Enable to input 1 to 89.

By check on “To all” option, the same stamped frames in Work Area change into angled frames.
Also this stamp on Stamp Library will change into angled stamp.

Frame Type
As same as pattern matching inspection frame, original frame type can be set.

Customize default settings
Possible to customize the default value for search area. “Trap has all colors in AND condition” is, normally
one color is selected to analyze, with this option all 4 colors are selected in AND condition.

Picture display option

Image in Work Area can be displayed in only inspection target color. Blend (%) is the percentage that the
original image is blended. Activate this option when you are new to histogram inspection, and if it is

difficult to decide where to create trap frames.

7. Sampling List

The list for debugging efficiently. If [Sampling] button in 8. Sampling tab is ON, then inspect or re-inspect,

same stamps pasted on PCB is all collected and displayed here.
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M Picts
Display picture(s).

W %

Display matching %. It there are multiple trap frames in Work Area,

The minimum matching OK% from all trap frames is displayed when OK.
The maximum matching NG% from all trap frames is displayed when NG.

* If Search for trap frame is set, % displayed here is the % after searching

and moving. Therefore the value can be different from which of shown

in histogram graph area

Hid
0:NG Red
1:0K Blue
2 : sample image Right Green
3 : master picture assigned as NG picture Rose
4 : master picture Dark Green

* List can be arranged in descending/ascending order by double clicking on [%] or [id].
M Sub menu Move to select frame
When double clicking on the picture, a sub menu pops up. Delete from list

:'.. .-. 15 : | . . I i-_ ;

Move to select frame:  Move to the position in Work Area.
Delete from list: Delete from the list.

(Does not mean to delete stamp in Work Area)
Add as NG pic: Save the image as NG pic in stamp.

*Add as NG pic function is not active and un-selectable when saturation filter is ON.

8. Sampling drawer window

A window is opened by clicking grey ¥ button next to OK button.

Debugging +Master /NG pics |

H Sampling

All histogram Inspection frames are sampled by inspection with this button on.Possible to activate from
Window menu. Shorcut key is option+command+F. When sampling is ON, the icon is displayed in mes-

sage bar.
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* Sampled data is deleted from sampling list. It does not mean that actual frames in Work Area are

deleted.

H Debugging

By pressing this button, you can re-inspect all frames in sampling list.

M +Master/NG pics

Read [master picture] and [master picture assigned as NG picture] on sampling list.
* Save many NG pictures in the stamp, and when debugging, read them on sampling list, and check if

all NG pictures surely be NG.

9. Stamp drawer window

A window is opened by clicking grey ¥ button next to OK button.
Sampled stamps are listed by name with placed numbers. By double clicking on stamp name, sampled

images of the stamp is listed in sampling list.

# Stamp
15 | Fillet:C0603
m#
11 | Fillet:RO603
Display the collected stamp number. 3 Fillet-:QFP_laad
If there is NG stamp, the number is colored in red. 4 Polarity:tan
Hl Stamp

sampla image

Name of stamp

W Sample image

Create a composite image from all sampled images. The composite image has id number 2.

Once you press this button, composite images are generated not only for selected stamp but also for all
stamps. Because the composite image is the average of all, it can be the best example for drawing on
trap frames for the first time.

* Please reload the sampling list by double clicking on the stamp name. Without reloading, composite

image is not displayed on sampling list.
10-5 Hints for creating/adjusting trap frame

When creating trap frames, it is the most important to understand the feature of NG parts/components.
Place trap frames where differences between good part and defect part is obviously caught.

Here are the examples of trap frames to detect major defective phenomenons. (By Model22X HDL-350)
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V¥10-5-1 Tombstone (Machine: M22X HDL-350)

Such error can clearly be detected with lighting combination of MAIN + SIDE + DOAL.

Paste histogram stamps on fillets of both side.
Good fillet is skewed, and skewed area is colored in red because of SIDE lighting detection.
Bad fillet is not soldered, thus not skewed and red.

Therefore, create a trap fame as below.

- All color except red is gathered around the middle of histogram. Select Blue/Green/Grey as inspection
target color. You may like to select Red because the image is Red, but in deed the graph of Red is not
characteristic enough.

- Press 4 Pbutton a few times to increase tolerance slightly.

- Check the trap frame on bad fillet, it is detected as NG. The histogram is very bright in all colors, the

graph shape is very different from good fillet.
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10-6 Measurement against escaping NG and false NG

If the traps allow NG to escape or if there are too many false NG, adjust accordingly.

1. [enlarge / narrow] target range. [increase / decrease] ok%.

2. Change the target color.

3. Add a target color. ex. Create 2 conditions by AND/OR; 'should be more than 50% of red in brighter
area' and 'should be more than 50% of blue in darker area'.

4. Increase numbers of trap frames, and create a group from them. By placing multiple trap frame, you
can increase/decrease criteria tolerance. Also this is effective for position shifting.

5. If you have NG PCB, make trap frames which detect the NG correctly.

10-7 Convert pattern-matching stamp into histogram stamp

You can convert pattern-matching type stamp into histogram type frame by following procedure. This
is very useful. For example, in case if you want to change fillet inspection frames in Pack stamp into
histogram frames in current program, by using this function, you do not need to create new stamp and

replacing it to current stamp.
V¥ 10-7-1 Limitations

1. Stamp in Pack Stamp can not be converted from Pack Editing. The only way to convert stamp
in Pack is placing the stamp in Work Area and convert. Then the stamp in Pack also changes
into histogram stamp.

2. Stamps with custom setting (Custom 1 to 8, which can be set by clicking sun icon next to
Brightness adjustment bar in Set filter window) can not be converted into histogram stamp.
If you even want to convert, reset the custom settings.

3. Oval and Polygon frames transform into rectangle frames when converting into histogram.

4. The stamp holding horizontally flipped master picture can not hold the flipped master picture

anymore.
V¥ 10-7-2 How to convert

1. Select stamp in Work Area. Select Histogram Analyser from Window menu (Screen 1). A
message asks "Create a histogram-type inspection frame?", press OK.

2. Histogram Analysis Window opens. Set and quit the window.

3. The pattern matching type stamp in Work Area is converted into histogram type stamp. And
stamp in stamp list is also changed into histogram stamp (Screen 2).

* The change on stamp list can not be seen immediately, unless stamp list is updated, for example by
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10-7

(Screen 1) (Screen 2)

(Screen 3)

(Screen 4)

adding new stamp or by deleting a stamp.

V¥ 10-7-3 Inherit illumination for histogram stamp

By converting pattern matching stamp into histogram stamp, some special illumination can now be used
for histogram stamp. "Fillet" and "DOAL +color", "MAIN+DOAL +color" is available on DL/HDL Series. For

setting inherit illumination, follow the procedure. The example is setting "Fillet" illumination on DL series.

1. Open Set Filter window. Check Fillet on (Screen 3).

2. Close Set Filter window, and select Histogram Analyser in Window menu.

3. The picture in Histogram Analysis Window is displayed in Fillet illumination and the lighting
setting in Extra settings is set to be Inherit (Screen 4).

* fv/fw/CL Series also have "Fillet" illumination, but they can not inherit "Fillet" illumination.
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11. Cell Operation

One Cell is the area the camera can cover in one shot. In this software, the Inspection Program consists
of Cells. Since this software is highly automated, most tasks can be performed without paying too much
attention to details. However, in order to perform tasks efficiently, it is important to learn about the concept

of Cells.
11-1 Basic Cell Operation

When executing operations such as creating Inspection Frames in the Work Area, the screen of that Work
Area will be recorded as a Cell containing the Inspection Frame. When creating another Inspection Frame
after moving by using Pitch buttons or the Move Tool, the Inspection Frame created there will be stored in
a different Cell. In other words, a Cell is always what the “camera can display in one shot”. Cells can con-

tain multiple Inspection Frames. Cells will not be created in areas where there are no Inspection Frames.

Cell positions will be displayed in the Cell Map Area at the lower right. Clicking on a Cell on this map will
display the cell in the Work Area (Screen 1). To edit Cells, drag the mouse over the Cell (Screen 2). The
Cell will become shaded, showing that it is selected. The selected Cell can then be edited using the Pull-

Down menu in the Cell Map Area to perform tasks such as Assign to Block, Duplicate, Delete, Flip and

(Screen 1)

(Screen 2) (Screen 3)
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Turn (Screen 3).
* Shaded Cells mean that they are selected. Cells displayed in black are the Cells currently displayed
in the Work Area. This status does not activate the Pull-Down menu, therefore the Cell cannot be ed-

ited. Drag the mouse over the Cell to edit it.

If you want to perform the same task on multiple Cells, select multiple Cells. Press down the Shift key
while dragging the mouse over areas that are not selected yet to add to the selection. If there are Cells

that you want to eliminate from the selected area, click on the Cell while holding down the Command key.
11-2 Duplicating Cells

Multiple Cells can be duplicated in a bundle using the Multi Duplicate command. When working with mul-
tiple PCBs, once you set up an Inspection Frame for one PCB, the other PCBs can be set up by copying.
The procedure is as follows:

* Some special stamps may not be copied, barcode stamps will not be copied unless they belong to

block Cellss.

1. Select the Cell to be copied in the Cell Map Area, and select Multi Duplicate from the Cell
Menu, or select Matrix Copy Into Cells from the Edit menu.

2. When the Multi Duplicate dialog appears, designate how many copies will be made along the

(Screen 1)

Cell Map before Duplication Cell Map after Duplication
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X- and Y-axis at the desired pitch. When duplicating from upper left to lower right, the pitch
should be set to a negative value. When Including Local Pictures is checked, the Inspection
Frames will be copied with the local pictures.

If Including Local Pictures is not checked, only Frames will be copied.

3. The Multi Duplicate dialog contains a Preview Map that shows how the selected Cell will be

copied. The copied Cell will be positioned in black, and if you click on the Cell in a position
where a copy is not needed, the Cell will change to white and will be removed from the copy

series (Screen 1).

* When there are too many copies to be displayed on the preview map, it is not possible to remove

copied cells from the copy series.

4. If there is a Cell in the exact same position that a copied Cell is to be placed, that Cell will be

replaced. In addition, if the gap between the existing Cell and the copied Cell is very small, the
Cell will be replaced. The Merge Nearby Cells trigger value, which sets the amount of mis-
alignment allowed to replace cells, can be changed from the Merge Nearby Cells in the Dupli-
cate window (the value of Merge Nearby Cells must be between 0.25 - 2.5mm).
With this feature, if you duplicate Cell A and make Cell A, when you modify the Cells, you only
need modify either Cell A or A’ and duplicate the modified Cell on the other Cell.

5. After copying, confirm that the Cell is positioned as intended on the Cell Map. If the position

*

is noticeably wrong, select Undo from the Edit menu, or press Command + z and repeat the
procedure.

If you want to copy the Barcode Stamp, open Copying window, and click “OK” with pressing Option
key. If there is check mark in “Apply for barcode in Block* function, Block number is assigned auto-

matically. For the detail of Block number, please refer to chapter “24-1-5 Block Assignment”.

(Screen 1)
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11-3 Adjusting Cell Position

When the PCB is warping or parallel errors, misalignments occur. In this case, Adjust the Cell position.

1. Select the Cell you want to adjust in the Cell Map Area.

2. Select the Move Tool in the Work Area and drag over the screen while holding down the Option
key. The cursor icon will change, and as you move, the position of the Cell will move in the Cell
Map Area (Screen 1). If you want to move only along the X-axis or the Y-axis, drag while holding
down the Shift + Option. This will prevent the Cell from moving in other directions.

3. To adjust the spread (the spacing between Inspection Frames), drag while holding down Con-
trol. The origin point will be the center, and the area will spread towards the right along the
X-axis and downwards along the Y-axis (adjusting the spacing will not change the size of the

Inspection Frame).
11-4 Rotate/ Flip Cells

By selecting the Cell and then selecting Flip Horizontal, Flip Vertical, Turn +90 or Turn -90 from the
Cell menu, the Cell can be flipped or rotated. In all cases, the center will be the center of the selected area.
With the case of 90 degree rotation, the Inspection Frame may be out of the Work Area due to differences

in the aspect ratio. In this case a new Cell will be created in the vertical direction.
11-5 Creating Cell Blocks

In general, this software executes inspections starting from the location closest to the current position, but
this is not necessarily the most efficient method. Therefore, there is a feature that allows multiple Cells to
be unified as a Block and inspection can be executed by Block. Each Block will have a Block Number de-
fined, and the inspection will start from Cells not assigned to Blocks and continue on to lower numbered

Blocks.

(Screen 1) (Screen 2) (Screen 3)
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If the original Block contains a fiducial mark(s), duplicating the entire Block will create a new Block that
contains a new fiducial mark(s). This feature is useful when the relative position of each Block differs slight-
ly in the multiple PCB.

When copied without creating Blocks, the fiducial mark(s) will be copied as a regular Inspection Frame.

H In order to create Blocks, select the Cells that you wish to unify in the Cell Map, and select Assign to
Block from the Cell Menu.

B When you click on the Cell Block in the Cell Map and hold down for longer than 0.5 seconds, a
Block Control menu will be displayed. The Block Number can be confirmed here (Screen 1).

H In order to exclude a Block from inspection, select Disable Block. In order to delete a Block, select
Remove Block.

l Block can be optimized. For example, if the order to Block the Cells are as Screen 2, camera moves
around as a result time is more consumed. By executing Block Optimizing, the Blocks are re-numbered
as Screen 3. Setting procedure is, select any block in Cell Map, display Block Control menu, click

Block Number, then a dialogue is displayed. Click “Optimize block position” button.

In order to change the number of a Block that has already been created, you must create the Block again.
* The Block Numbers will change when you choose Assign to Block, Delete Block, Assign Fiducial

Mark or set Cell Aid Stamps or Block Mark Stamps.

11-6 Block Mark Stamps

This software includes a special stamp called the Block Mark Stamp. This stamp is used to skip Block (or
Cell) inspection if the inspection result of this stamp is NG. Block Mark stamp is inspected first. If it is NG,
other area of the Block (Cell) where this stamp is belonging will not be inspected. This has been designed

to eliminate unnecessary inspections. This stamp is effective especially when inspecting penalized PCBs.

Normally the result of skipped PCB is NG, however you can change the result to be OK in ForSupervisors
menu "Result of Block skipped by ‘Bad mark’ should be OK” .

* Up to version 3.4, this stamp must have to be used within a Block
Block Mark Stamps should be used according to the following procedure:
1. Load the Special Stamp, BlockMark.

2. Select BlockMark from the Stamp List Window ), and place it on the part that will be criteria to

inspect or not (often called Bad Mark). Click OK when a message This stamp should become
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(Screen 2)

(Screen 1)

(Screen 3) (Screen 4)

part of a Block is displayed. Block Mark placed has a checkmark on the upper left (Screen 1).

3. As well as normal Frames, align the position and resize the Block Mark to fit. When you enlarge
the Frame, a message “Is this an inclusion frame?” will appear, but do not select this.

4. Start inspection. BlocMark stamp is inspected first, if the result is NG, the Block (Cell) that this
stamp is belonging will not be inspected. If the result is OK, inspection is executed as usual.

In case if you want to apply Block Mark stamp not to Block or Cell, but specified area, please set Block
Mark stamp as followings.

1. Select the message “Is this an inclusion frame?” displayed when resizing the stamp (Screen 2).
Drag the frame then target area (inclusion frame) is set, and the 4 corners of the Block Mark will
become rounded (Screen 3).

2. If you want to rotate the area (Inclusion Frame), select “and frame which has an angle?” instead
of “Is this an inclusion frame?”. Then a small window to input an angle will be displayed. Input
an angle, then the area (inclusion frame) will be rotated.

6. This process can be repeated as many times as you are succeeded.

* This Block Mark will be applied only on Inspection Frames which are contained “completely” within
the Inclusion Frame.

* When the target area (inclusion frame) is defined to be smaller than the Block Mark, it does not work
as inclusion frame, but work as normal Block Mark.

* When making continuous copies of Blocks that contain a Block Mark Stamps, the Block Mark
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Stamp will not be copied unless Assign to Block is executed.
* Block Marks cannot be grouped or packaged.

* If Block Mark’s inspection result is NG, it is displayed bigger in Map View than other NG.
11-7 Cell Optimization

The fewer the number of Cells, the faster and more efficient the inspection will be. By using Cell optimiza-
tion in the Cell menu, you may be able to reduce the total number of Cells. In order to use this feature,
select multiple Cells that you want to optimize, and select Cell Optimization from the Cell menu. Unnec-
essary Cells will disappear, and the Inspection Frames that were contained in the eliminated Cells will be
merged into other Cells.

However, in order to optimize cells, the screen ratio settings must be accurate. Make sure that the Inspec-
tion Frames are overlaid correctly on the components/parts before performing this task. If not, change the
Pixels per 1 cm value in the For Supervisor menu, making adjustments so that the Inspection Frame

will be overlaid on the components/parts.

11-8 Merging Cells

H Merge Inspection Frames into One Cell

When Cells have many overlapping parts, you can manually merge Cells to reduce the number of Cells for
more efficient inspection.

For example, when a Cell is displayed in the work area, an Inspection Frame belonging to another Cell
may be displayed in a white frame. In this case, use the Pointer tool to select all the Inspection Frames
while holding down Control key, and those Inspection Frames will be merged to become Inspection
Frames belonging to the same Cell (Screen 1).

Even if the Cells do not have overlapping parts, you can use the same procedure to select Inspection

(Screen 1)
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Frames belonging to adjacent Cells and unify them into one Cell (In order to perform this task, the Pixels
per 1 cm ratio must be accurate)
Inspection Frames that do not fit in one Cell due to minor misalignments can be merged by individually

clicking and dragging the frames while pressing down the Control key.

M Merge All Inspection Frames Within the Work Area

In order to fit all Inspection Frames in the screen into one Cell, click in the Work Area while pressing down
Control + Shift. A square frame will appear momentarily, and the Cells will be merged. The size of this
frame will be determined by Pitch, which is defined in General Settings. If the value is 80%, then the frame
length will be 80% of the screen width. The Cells can be optimized by merging Inspection Frames using

Control + Shift click.

H Correct Misalignment and Merge Cells

Pressing F10 will correct all misalignments of frames currently displayed on the screen and merge them
into one Cell.

* If a function is assigned to F10 by Mac OS, this feature cannot be used. With Mac OS X 10.3 or later,
F10 is assigned to the show Application Window function. In order to remove this assignment, you
must change the settings in the Dashboard and Expose panel in System Preferences so that there

will be no function assigned to F10.

11-9 Cell Map Operation

(Screen 1)

(Screen 2)
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The buttons on the Cell Map Area are useful for Cell Map operations.

H Expanding Cell Map

In order to zoom into a part of the Cell Map, use the Cell Expansion Tool. The mouse pointer will change
to a magnifying glass. Select this tool and drag over the area to expand. The mouse pointer will change to
a hand icon. Click and drag the mouse to move around the expanded Cell Map area (Screen 1).

If you press down on the mouse button for longer than 0.5 seconds, the mouse pointer will switch back to
the magnifying glass, and the designated area will be zoomed further.

In order to reset the zoomed view, select the Cell Selection tool and click outside the Cell in the Cell

Map.

H Blending Pattern

If you have already created a Map View, you can use the Blend tool. The blend rate of the Map View and
the Cell Map will be displayed in "%" when you click the Blend tool. In general, this is set to "none" or at
about "60%" (Screen 2). Pattern blending is used to show the approximate position, and does not ensure
an accurate position.

This tool will not be available if you do not create a Map View.
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12. Verification after Inspection

After inspecting, the result is displayed OK or NG in the screen, and instant result (number of total inspect-
ed frames, number of NG frames or cycle time) is displayed in message bar. NGs can be verified/identified
in many ways such as by displaying in the entire PCB picture (Map View) or displaying by list. This soft-
ware also has a mode to visually verify the actual PCB after inspection.(This software uses the expression

“Map View” to include all these display modes.)

12-1 Map View Mode

V¥ 12-1-1 Create and display Map View

¢ Click on the Eyeglass Button under the work area to display the Map View picture (Screen 1). If it is
after an inspection, NG points will be displayed in red circles. (If you set 13-4-2 Prevent continuous Good
button clicking, the NG which must not be classified Good is displayed in red square.)

e |f there is no Map View, a verification dialog "Create Map” will appear. Click OK or By high density.
Then the frames will be taken sequentially starting from the bottom right corner of the PCB.

After the Map is created, click again on the Eyeglass button to display the Map View (View window).

e |[f you create Map in normal mode, PCB Map is included in inspection program file, however if you create
in high density mode, the PCB Map is created in another file named “program name_hdgv_A(B)". When
you save the inspection program, a folder with 22X logo is automatically created in the same directory
where the insection program is (Screen 2), and both inspection program and high density PCB Map is put
in the folder (Screen 3).

* The size of the Map View picture is determined by the monitor that was connected when the map was

created (screen pixels). If you would like to change the size due to monitor changes, recreate the Map

12-1-4

(Screen 1)

(Screen 2) (Screen 3)
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View using the NewMap button (or press Command + N in View window).

* The larger the Map View becomes, the more memory it requires

V¥ 12-1-2 Map View Window (View window)

The Map View Window looks like Screen 1. Descriptions of each button and menu are as follows:

H Info Item Button

Click here and a pull-down menu will appear (Screen 2). Select the items to be displayed from the 8 items
above, and they will be displayed next to the NG points that are shown with red circles. Error rate 0.00%
and Error rate ppm cannot be displayed at the same time.

The Map View can be flipped using Vertical reversing and Horizontal reversing.

H Info File

A pull-down menu that corresponds to Export Data in the File menu will be displayed (Screen 3). Infor-

mation, Position, Past (history) and Stamp information can be exported.

M Inspection Count Bar

The current total number of inspections, number of points and NG points will be displayed (Screen 4).

Clicking here will display the Inspection History.

12-1-2

(Screen 2)

(Screen 1)

(Screen 3)

(Screen 5) (Screen 4)
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M Grid Button
Click here and the grid will be displayed (Screen 5). The address will be displayed in letters for horizontal,
and in numbers for vertical directions, making it easy to locate the defective area by the address. This ad-

dress will be shown in the format of “A01” for Print and Information output.

H Inspection Area Display Button (Blue/Purple)

In general, the Map View will show NG points in red circles, but when you click the blue and purple but-
tons in the top right corner, the function changes. The blue button will show points that were never judged
as NG in past inspections, and the purple button will show points that have been judged as NG at least
once in the past. Click again to hide the circle points. If you set Unable to click Good button in G/NG con-

firmation mode, the NG which operator can’t press Good is displayed in red square.

Il NewMap Button

This is used to create a new picture for the Map View. If a new cell(s) is created due to added inspection
points, the added points may not be displayed, in this case you will need to recreate the Map View.

* When the display is zoomed, the Circle Mark may become misaligned from the zoomed section of
the Map View picture. This is due to the misalignment between the actual dimensions and the number

of pixels. This can be resolved by editing Pixels per 1cm and recreating the Map View picture.

H Print Button

Click here and the Page Setup dialog will be displayed first, followed by the Print dialog.

B View Mode Switch Menu

You can switch over to list view or cell view, and you can also display the Map view settings Window.
When the setting is switched here, the window will be closed once, and opened with the selected display

mode the next time.

M Freeze

If Freeze is checked, the Map View picture and the NG lists will not be deleted even when the machine

starts a new inspection. Use this when verifying NG points during inspection.

H Close Button

This will close the Map View window.

V¥V 12-1-3 Display Operations in the Map View Mode
H Go to the specified point in the Work Area
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When you double-click on any point in the Map View, the Map View will be closed and the place that you

clicked will be displayed in the work area. This is useful when making corrections to the inspection frames.

Bl Zoom into the specified area

¢ |f Info Items in the Map View are overlapped and hard to see, they can be zoomed in. Drag a part of the
Map View to select it (Screen 1), and that area will be enlarged (Screen 2) (you can also hold down the
mouse button at any given place until the mouse pointer changes to the magnifying glass icon).

* During zoom, the cursor will change to a hand shape when you drag the screen, and the entire screen
can be moved while it is zoomed.

Hold down the Shift key while dragging to move faster.

¢ Inspection points displayed in a circle can be displayed in the Work Area by double-clicking (if you dou-
ble-click on other areas, the Map View display window will simply close).

® The buttons on the top of the window will not be shown during zoom display.

® You can go back to the normal state by holding down the mouse button somewhere outside of the circle

mark until the mouse pointer shows “x1”.

* The Zoom display simply enlarges the picture, so the resolution will be low quality unless high den-

sity Map is created.

M Inspection Frame Offset

If the component/part in the picture and the position of the circle that designates the inspection area is

misaligned, hold down the Option key in the zoomed screen and drag to the correct position.

V¥ 12-1-4 Check results in the past

The Map View can display NG points found in previous inspections. Up to 1024 sets of inspection data

can be recorded, and the 1025th picture will be recorded as the 1st picture.

12-1-3

)

(Screen 1)

(Screen 2)
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M Display results in the past
1. Press the Inspection Count bar on the top right corner of the Map View window, the list of
past inspections and the corresponding number of defects will be displayed in the pull-down
menu (Screen 1).
2. Select the number of the target inspection to display the NG points. You can also enter the
number of the target inspection in the “Jump to” dialog in Setting. Please note that images of
the NG points are not saved.

3. When you display the Map View next time, the current result will be displayed.

H Settings

Select Setting from the Inspection Count Bar on the top right of the Map View window, and a dialog will
appear (Screen 2). You can set the number to be displayed in the Pull down menu (up to how many pre-
vious inspection results should be displayed).

In general, the Map View displays the current result first, but you can make previous results display first.
To do this, hold down the Option key while selecting the start position from the pull-down menu with the

Inspection Count Button. Once selected, the value will be displayed in bold letters.

To cancel this setting, hold down the option key again while selecting the current number.

* The number of PCBs to be displayed is always the number from the first inspection, but here, the
designated number of pictures preceding the current inspection will be recorded.

* These settings will be recorded in the parameter file, and will be effective for other Inspection Pro-
grams when launched next time.

* NG points’ pictures will not be recorded in the past history. Pictures cannot be viewed, and picture

lists cannot be displayed.

V¥ 12-1-5 Defect Warning

This software counts the number of times a frame is judged as NG, and frames consecutively judged as

NG and frames that have a high number of cumulative NGs can be displayed in a special way in the Map

12-1-4

(Screen 1) (Screen 2)
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12-1-5 13-2-1

(Screen 1)

(Screen 2) (Screen 1)

View: Consecutive NGs will flash in yellow, and cumulative NGs will flash in pink in the red circle (Screen 1).
The flashing count will be cleared when the next inspection starts or when the Stop button on the screen
is pressed, and will be counted from zero at the next inspection.

In order to activate this feature, select Configuration > Tendency NG and check Active in Tendency,
then set the number of Continued NG and Total NG in the NG report setting Window (Screen 2). De-
fault is 3 for Continued NG, 5 for Total NG.

12-2 NG List View Mode

Select NG List View in the View Mode Switch Menu, and the List Display Window will be displayed with

the Eyeglass button. The list will also be displayed after the inspection instead of the Map View.

WV 12-2-1 NG List Window

NG List window (Screen 1) will display NG points as a list. The small Map View picture will be displayed
on the left, followed by the picture judged as NG, followed by the Master Picture. In the Map View pic-
ture, only the target point will be displayed as a red circle. As with the Map View, results in the list can be

viewed during inspection.

¢ When Freeze is checked, Map View pictures and NG Lists will not be deleted even when the machine
starts the next inspection.
If you would like to verify the defective areas during inspection, check here.

e This NG List View requires a large amount of memory to run. If there are a significant amount of defects,
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pictures of NG points may not be displayed due to insufficient memory.

¢ \When an area of the small Map View picture is double-clicked in a list, that area will be displayed in the
Work Area, and the NG frame will be selected.

¢ When the NG List View is selected, the NG List Window will be displayed after the next inspection is
complete or after the eyeglass button has been pressed. To go back to the Map View mode, select Map

View from the pull-down menu.

12-3 NG Cell View Mode

The NG Cell View mode is “Enable Good/NotGood verification by operator while inspecting next
PCB" This mode specializes in viewing previous results during inspection. This allows human verification

without stopping bench-top AQI.

V¥ 12-3-1 Advantages of NG Cell View Mode

- Defective component is displayed large in the center of window as well as G/NG confirmation
mode (See next chapter 12-4), operator can check one by one easily.

- Operator can confirm without stopping AOL.

- Send data to CS-Center/Rc22X in small packet after each component's verifying. Therefore it

requires less time to wait for data transmission.

V¥ 12-3-2 Interface

NG Cell View has a white Flip View button at the right bottom of operation window. This button switches
inspection window and verification window.

* Normally window is automatically switched to verification window after inspection.

PCB count lamp is displayed at the right bottom of Work Area. The lamps are on (colored in white) when

PCB is waiting for verification. Maximum 2 PCB data can be stored.

12-3-2
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If you like to skip verifying current PCB and move to next PCB, press end key, then inspection result will
be aborted.

At the right bottom corner of Work Area, there is Status Lamp. The lamp shows inspection progress.

Red: Memorizing NG pictures while inspecting. If AOl is connecting to CS-Center/Rc22x,
the blinking interval can be measure of data transferring speed.
Store the result after inspection

Blue: Clear the result when verification is completed

Master Picture and PCB Map can be switched by clicking Master Picture Area. If you display PCB Map,
the position of component currently verifying is highlighted by red circle.

If both 2 lamps are occupied, and start inspecting 3rd PCB, the result of 1st PCB will be aborted.

However if you set Update by Start button to be OFF (in Map view setting's NG cell veiw setting), a
warning message appears and the result will not be aborted.
* If Update by Start button is OFF, operator can not start next inspection unless completing

verification. To skip classification and start next inspection, press end key to abort.

Bl Remarks: inspection speed

- In this mode, AOI is creating images of defective components while inspection. It takes 40 to 50

mm/sec per 1 point to create, this will affect inspection speed.

Bl Remarks when CS-Center or Rc22x is connected

- The inspection result of 1st PCB is automatically sent to CS-Center/Rc22x if you start inspecting

3rd PCB while 2 lamps are occupied, while Update by Start button is ON. This data is just

12-3-2
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inspection result from AOI because it is not verified by operator. However no images of NG
components is sent.

- Also if you abort verification by pressing 'end key', just AOl's inspection result is sent and no
NG components image is sent.

- If Auto send ALL NG is used and all data is sent without verifying by operator, or operator does
not press Good button for good PCB to fix the result, correct inspection data will not be sent.
PCB number and inspection results may be combined incorrect or result may be sent double.

* NG Cell View can not be remotely controlled on CS-Center/Rc22x.
* Inspection result is NG if the inspection is skipped by BlockMark, evenif you check on the option

"Result of Block skiipped by ‘Bad mark' should be OK" is checked.

V¥ 12-3-3 Basic Operation

1. Select this mode. Change view mode by pressing eye glasses button to NG Cell View.

2. Start inspection.

3. Screen changes to verification window from inspection window after inspection is completed.
One of PCB count lamp is on. If no defect is found, OK is displayed in the center of screen.
Press Good button to fix the result (Screen 1). If there are defects, operator should verify by
pressing Good/NG buttons (Screen 2).

4. When no PCB is waiting for verification, 'Ready' is displayed on screen (Screen 3). Start

12-3-3
(Screen 1) (Screen 2)
(Screen 3) (Screen 4)
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inspection on this status, you can see the process of inspection penetrated on behind (Screen 4).

V¥V 12-3-4 Enable options

Some options in Map view setting can be applied to new NG Cell View.
2 Settings for previous NG Cell View, Show with master pic and Thickness of frame / color, can no

longer be used.

NG cel view settings ... Update by START button

G/NG Confirmation Mode ... Zoom pictures, Assign NG-ID input 0-9,
Show whole group if NG, Show NG reason

Enable options in Extra settings for G/NG mode...  Unable to click Good, Interval timer

* Screen will be shown on selecting light when Stamp uses Lighting Selection.

* For detail of each option, please refer to 12-5 Map View Settings Window. For detail of Enable option

in Extra settings for G/NG mode, please refer to Chapter 22.

12-4 G/NG Confirmation Mode

In this mode, defective frames will be displayed one by one after the inspection. You can verify defective
points Good/NG after machine’s inspection. You can even re-judge Good/NG by going back using the

previous button. The mode can display comments for operator to refer to the programmer’s instructions.

V¥ 12-4-1 Basic Operation

Check G/NG Confirmation Mode in Map view settings (Screen 1). This setting will become effective

(Screen 2)

(Screen 1)

(Screen 3)

(Screen 4)
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after closing the View Window.

1. When the inspection finishes in G/NG Confirmation Mode, 4 buttons; Good, NG, Previous and
Next will be displayed in the Cell Map Area (Screen 2). A shortcut key is allocated to each but-

ton. Verify using the 4 buttons while camera is displaying defective points one by one.

e Good (up arrow) ... Judge the currently displayed point as Good

e Good + Shift (up arrow +shift) ...Judge as Good and add as master picture
¢ NG (down arrow) ...Judge as NG the currently displayed point

¢ Previous (left arrow) ...Go back to the previous point

¢ Next (right arrow) ...Move to the next point

* When inspecting Pack stamp, if there are multiple NG stamps, simply one voluntary NG’s error mes-
sage is displayed, however all NG stamps in Pack stamps is framed in red..

* Press the Esc key to exit from the G/NG Confirmation Mode and the rest of defective points are
automatically judged NG by the machine.

* Please note that if Auto send for all NG is selected in Map view settings, all defective points will
be judged as NG. This option is for verifying on Rep22x/CS-Repair afterwards.

* The Mark number limit for machines equipped with marker pen unit will be ignored in the G/NG

Confirmation Mode.

2. G/NG Confirmation is complete when the progress bar on the Good button has moved up to
select the last Good/NG. Results will be reflected in the verification history. The same results
will be reflected in the Map View picture. If Auto Printing is selected, the results will be printed

out to roll paper printer, or if data is set to send to Rc22x/CS-Center, will be transmitted.

In the NG List View mode, points judged as Good will be included in the list but with a blue
frame. When you click on a defective picture with a red frame, the frame will turn blue. This is

the same as a Good judgment, and this judgment will be reflected in the history (Screen 3).

If the component judged NG by AOQI is actually Good, you can add this as master picture to
the inspection frame by pressing Good+shift. This can decrease false NG while inspecting.
The picture is only added to the frame, however if you check “Add master pic. to stamp” on
in Map view setting window in advance, the picture is added to stamp. In this case, if the pic-
ture matches to any of master picture which the stamp already has, the picture is not added
because it is waste of memory to add unnecessary master picture. If the picture is not added,

Good button blinks in green (Screen 4).
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V¥ 12-4-2 Customizing text/master picture appearance

You can change the comment text size, display/not display master picture, etc in 12-5 Map View setting

Window. While verification, you can temporary hide comment or frames when they hide components.

tab: hide red frames which indicate defective area
space: hide comment and master picture
control: pattern matching frame with Text filter is displayed with filter. However the image quality

is less than when you adjust in filter settings window. NG Cell View mode not possible.

you can see through all master pictures by scrolling mouse wheel or clicking the picture.
Scrolling: Forward / Rewind by scrolling wheel up / down.

Clicking: Forward by clicking. Rewind by clicking with shift key pressing.

* Master picture assigned as NG picture will be skipped.
* G/NG confirmation mode only, not possible in NG Cell View.
* Only one master is sent to Rc22X/CS-Center. Therefore only one master picture can be seen on

Rep22X/CS-Repair.

V¥V 12-4-3 Display Comment

It is helpful to include comments (or Ref. Des. name) in order to accurately communicate the intentions of
the programmer to operators after inspection. Comments can be set up with the following steps. Com-

ments added here can be displayed in the Map View.

1. Check Setting for supervisor > Mode > Result with Ref.Des. comment (Screen 1).
2. Click on the Inspection Frame in the work area (Screen 2).

3. Select Input Ref. Des. name from the Master Picture Menu and enter comments. Up to15

12-4-3

(Screen 1) (Screen 2) (Screen 3)
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characters in double-byte, or 30 characters in single-byte, may be entered.

4. These are set up for each Inspection Frame, but if you input a comment in a stamp, click on the
Stamp Update button. Comments (and Ref.Des. name) will be entered in all Inspection Frames
with the same stamp in the Work Area (Screen 3).

Since these settings will not be registered to the Stamp in the Stamp list, comments will not be
included in the Stamps placed after this instruction. With Group Stamps, the comments will all
be deleted if a Group Edit is applied.

5. Check Show NG reason in the Map view settings.

6. If you want to display your original message, refer to Chapter 6-7 Original Frame Type.

7. If you want to display multiple NG reasons in Pack, refer to Chapter 8-7 Stamp Pack.

WV 12-4-4 NG-ID Setting

In the Good/NG Confirmation Mode and the NG Cell View Mode, an ID can be set to NG. Check Assign
NG-ID input 0-9 in the Map view settings Window, and press 0 = 9 on the numeric keypad instead
of clicking Not Good and the keys you pressed will be set as an ID for each defective point. To assign as
false NG, press comma (,) or period () keys. The results will be displayed in the Map View picture, and

printed from the roll-paper printer. The following will be printed:

New File [01.2.20 10:20 AM]

Total PCBs checked[20] block<0> (Thomas)
Total NG PCBs [14] block<0>

Current result (check 272 NG 3) Spent time 9
BarNum 356512110

SYN TTL NOK/NG_ID
C101840
R682 8 4 1
C301841

V¥V 12-4-5 Verify all points

On this mode, you can verify all points no matter if they are NG or Good. Even you can verify all points
without inspecting by AOI (AQI just captures images). This mode is for testing P&P machine or for testing

new PCB before mass-production. Also effective in case you want to send all images to Rc2x/CS-Center.

1. Check Setting for supervisor > Others > Verification Step Mode.
2. Click inside the Message Area, and a Magnifying Glass Icon will be displayed. Start inspec-
tion, AOI will not inspect at all, all points will be shown for G/NG confirmation.

3. Click again the Glass icon, the Glass icon will be colored blue (if you click again, the setting will
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12-5

(Screen 1) (Screen 2)

be disabled. In this case, set Verification Step Mode again). Start inspection, AOI will inspect,

however not only NG but also Good points will be shown for G/NG confirmation.
12-5 Map View Settings Window

Most view settings can be set in this window (Screen 1). Select View Settings from View Mode Switch

Menu in the Map View (or other view) Window to access this window.

l Keep map view during Inspection

When this is selected, the previous inspection results will be displayed during the next inspection. Since
machine power is mainly devoted to inspection, response will be slower than with just the Map View Pic-

ture. If there is insufficient memory, the picture may not be displayed.

H Show pictures on map

When this is selected, the pairs of defective points and Master Pictures are displayed in the Map View if
there aren’t too many defects. Maximum 24 is possible to set. When there are too many pictures to be

displayed, they will not be displayed on the Map View, but only when the cursor is placed on the red circle.

l Show yellow circle after checking

When this is selected, the red circle (defective points) will turn yellow after verification and the number of
remaining points to be verified will be shown by a number and a progress bar. When the pointer is placed
on the red circle, it will turn yellow, and after every point is verified, the buzzer will sound and the Map View
Picture will momentarily go dim. If Change only after mouse click is selected, the color will not change
unless you click on it. This is intended to check whether you have verified all points (this may not function

depending on the size of the Map View Picture).
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M Grid color of map address

The grid color can be changed. Click on the black square to select colors from the color palette.

Bl G/NG Confirmation Mode

Sets the G/NG Confirmation Mode.

H Beep

In the G/NG Confirmation Mode, if Good or NG is not specified within the time frame set here, an intermit-

tent warning will beep. The beep will not sound if O is entered. The default is 30 seconds.

l Optimize check sequence

Click here to display the menu and select sorting by XY (Coordinates), Comment, New Stamp, NG type,
Stamp Name or Location No. The default is No sorting. No sorting is basically the order when stamp is
pasted.If you would like to match the order of G/NG Confirmation and List display, select No sorting. Co-
ment, Stamp Name and Location No. is ASCIl order. (In brief, special characters such as | or * -=> number
-> Capital Alphabet -> Small Alphabet) Please note that this setting will affect the defect marking feature
regardless of the G/NG Confirmation Mode settings.

H Dim Surrounding

This option makes the area surrounding the target in the center of the screen darker for easier verification.
This is disabled by default.

* This effect is deactive on AOI with angular cameras.

Bl Zoom pictures

This option will automatically zoom the picture to 2x display. This is disabled by default.

M Assign NG-ID input 0 -9

When setting up NGs in the OK/NG verification mode, IDs can be assigned using the numeric keypad.
Also number keys on main keyboard can be used. By clicking twice, the check mark changes to bar

check mark. A.B.C...Z keys will be ID numbers 10,11,12...35.

H Auto send for all NG

Automatically sends all judgments in the Good/NG Confirmation Mode as NGs by one click. By clicking

twice, the check mark changes to bar check mark, and fast data transfer is enabled.

H Show pic. without mask
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This shows master pictures without masks in the G/NG Confirmation Mode.

M Display by selected lighting

In the G/NG Confirmation Mode, this shows the image with the lighting set up in the lighting selection. By
click, you have 3 selections; “No”, “Yes” and “Yes, NG stamp in Pack in NG Cell View”. By selecting “Yes,
NG stamp in Pack...”, normally NG pack stamp is displayed in standard illumination, but if this is selected,

illumination of NG stamp is used in NG Cell View mode.

Hl Add master pic. to stamp

While G/NG Confirmation Mode, add master picture to stamp instead of adding to frame when pressing

Good+shift.

Hl Update by START button

This button is checked on default. If this is checked, and 2 PCBs are already waiting for verification, then
press START button, the oldest PCB data is aborted without warning. If this is un-checked, and 2 PCBs

are waiting for verification, then press START button, a warning message pops up. You can not start next

12-5
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inspection unless verifying one PCB.

l Show whole group if NG

A group will be displayed as one frame in the G/NG Confirmation Mode and the NG Cell View Mode.

Bl Show NG reason

The defect reason will be displayed in red in the G/NG Confirmation Mode and the NG Cell View Mode. If
you click this option once, defect reason and master picture is displayed (Screen 3). If you click twice, che

check mark becomes bar mark, and only defect reason is displayed (Screen 4).

* If you want to see the PCB area hidden by NG reason comment, press space key to invisible NG
reason. To make it visible, press space key again.

* You can change the size of defect message from 9 to 48 pixel. Click on the message, then sub-
menu is displayed, to make smaller, press small and vise versa (Screen 5).

The change of text size also attect to text size in NG Cell View mode.

* If the picture displayed in Work Area is too small and difficult to check, drag on the picture by

mouse, zoomed picture is displayed in Master Picture Area.

H Show fillet pictures colorized

When this is selected, the fillets in the Inspection Frame will be displayed in red, and the other parts will be
displayed in blue. This setting is available in the G/NG Confirmation Mode.

On 22X Fv/Fx model, click this checkbox with pressing Option key, a hidden sub menu is shown. Select
Show Side Light, then Side Light will be active while G/NG confirmation mode with stamp in camera spe-

cial settings with Side Light and Fillet.
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12-6 About Instant Result displayed in Message bar

After inspection, the brief inspection result is displayed in message bar.

(Screen 1)

TTL: Total number of frames inspected

NG: Number of defective frames

AV.: Average time spent for inspecting one frame

LAP: Total time spent for inspecting this board

* If "Show result in message bar on counting Ref.Des" is active in Mode tab of For Supervisors menu,

TTL, NG and AV is calculated based on Pack stamp number.

Clicking message bar once will change the contents and the text color turns to blue (Screen 2).

Point: Total frames inspected side A: total frames inspected side B: total number of stamps (count stamps
in Pack too)

Pict.Total master pictures used for inspection

AV. Average % of total frames which results in % / total frames of side A+B

Use Memory spent for this inspection

Clicking message bar again will change the contents and the text color turns to black (Screen 3).

Point: Total stamps inspected side A (count pack as 1 stamp) : total stamps inspected side B (count pack
as 1 stamp): total number of stamps (count pack as 1 stamp)

Pict. Total master pictures of Pack used for inspection

AV.Average % of total frameQOs which results in % / total Pack stamps of side A+B

Use Memory spent for this inspection

12-6
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13. Settings

Please note that these settings are applied to all inspection programs that you will create.

13-1 General Setting

To display General Setting, sclect Settings menu > Configuration > General.

B OK %

This is used to designate the percentage for making matching judgments. If the value is too high, even the
slightest differences between parts may be judged as defective, increasing the number of false reports.

The default value of 60% is a standard value, suited to all inspections.

H Pitch X% / Pitch Y%

This is used to designate the pitch % to move the PCB using the pitch button. If you set this to 100% and
press the pitch button, the displayed area of the PCB will be changed without overlapping

Around 80% is the most convenient value.

Bl Emphasis Area

This is used to designate the area to be emphasized. Icons with bigger white spots in the center will have
stronger contrast. Since the emphasis area can be set for each Inspection Frame, this should be left as

NO under normal conditions.

W More Emphasis

This will increase the contrast already emphasized in the Emphasis Area. Since false reports will in-

crease when this box is checked, this should be disabled under normal conditions.

B NG Re-inspect

A good PCB may be judged as defective due to noise in the camera and for other reasons. NG Re-
inspect is used to avoid such situations. By inputting re-try number in yellow box, camera moves to the
position and take picture again. By inputting re-try number in rose box, you can set how many additional
capturing should be taken when re-trying. Recapturing the same position for a designated number of
times, to make sure the judgement is correct. This can reduce false reports.

* When a high value is designated here, inspection will take more time. This value should be kept to
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(Screen 1)
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around 3 - 5.

* When using older versions of this software, the NG Re-inspect value will be set to 100x.

M Find first an object

This setting detects misalignments of all Inspection Frames before starting inspection. This is an old func-

tion, thus it is recommended to set “Find” in each Inspection Frame.

M Speed Priority

This mode stops displaying the currently inspected Cell and prioritizes inspection. Speed Priority allows a

25 — 30% increase in inspection speed.

M Apply Human Saturation

Saturation sensitivity of pattern matching frame becomes closer to the sensitivity of human eyes.

H Display NG on Map

Check here to automatically display the Map View after inspection if there is an NG point, showing the

position and details of the defect. This is set to OFF by default.

Hl Warning frame Size

There will be redundancies if the Inspection Frame is too big, while on the other hand, if it is too small,
it will be difficult to detect differences. To be consistent with the usage of comparing only characteristic

points, this box should be checked under normal conditions.

H Auto Printing

If NG points are contained in the results, this setting will automatically print the details of that NG. To ex-
ecute automatic printing by activating this setting, you must have completed the printer settings in Page
Setup from the File menu in advance. If a color printer is connected, it will be printed in color. Inspection

will continue during printing, but its speed will be reduced significantly. Printing takes much longer than
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inspection.
If printing instructions are issued frequently, do not check this box, and print manually. You will not experi-

ence any problems with a simple high speed type printer.

Hl Move via closest cell

If this box is checked, inspection will be performed by moving to the cell closest to the current position
regardless of the order in which the cells were created. When this is disabled, the camera will move in the
order the cells were created. If you create cells keeping in mind the order they should be inspected, in-

spection with this box unchecked will be performed more efficiently than when it is checked.

M Reduce light

Reduce gain of illumination, by clicking twice, it turns to “Increase light” and works to gain light. For de-

tails, please refer to chapter 20-5.

13-2 Frame Color Settings

Select Object Frame from the Configuration menu (Screen 1).

M Result OK, Result NG, Not Inspected, Out of Cell

These are all used to designate the Frame color. Double-click inside the Frame to display the color picker
and select the color.
* The description is based on the default values (Inspection Result OK = blue, Inspection Result NG =

red, Waiting for Inspection = green (yellow if zoomed) and Outside Inspection Cell = white).

H Narrow/Bold Buttons

Click on these buttons to change the width of the Frame with the above color settings applied. Select the

optimum line width here.

M Hide near frames

Hides all other Frames when moving Frames. This is useful when the PCB is hard to see.

H Picture blend

When placing Stamps with Master Pictures, they will be shown blended in the work area. The blend rate

can be determined here. 0% will not show the Stamp Picture, and 100% will hide the PCB.

13-3 Setting for Supervisor

Select Settings > Configuration > For Supervisor.
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ltems in Setting for supervisor do not need to be changed in general.

V¥ Movement
M Eject Position

This is the position that the carrier moves to when the Eject button is pressed.

H Light Calibration Position

This is where calibration will be performed.

M Pixel/ cm Position
This is where mm vs. dot settings will be applied.

M Carrier fiducial top-left

This is the position for the top left Fiducial of the carrier. This is used to correct the distortion.

H Carrier fiducial

This is the distance between the fiducials of the carrier.

H Maximum movement

This is the maximum value for mechanical movement.

H Minus limit

This is the minimum value for mechanical movement in the negative direction.

H Data offset

When reading Inspection Programs on other machines that have different carrier sizes, the offset value

13-3
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can be set here.

H Machine offset

When reading Inspection Programs on another machine that is the same model, the offset value can be

set here.

H Carrier Origin

When sending data to CS-Center, input Carrier origin coordinates here.

Hl User Home Position

There is Home button in sub menu of Eject button. You can input favorite value here to be Home.

H Current Position

The position will be displayed as X, Y coordinates. This value will be updated to the current position by

clicking on this button after changing the position in the Main Window.

M Pixels per icm

This sets how many dots correspond to 1cm on the screen. The blue number on the side is the value at

the fiducial of the carrier that is used to correct distortion.

H Reset Origin interval

If cumulative errors are suspected due to a missed pulse in a machine driven by a pulse motor, you can
give instructions to reset the origin. Here, you can designate the number of PCBs to be inspected before

the origin is reset. If this value is 0, Reset Origin Interval will not be applied.

Hl Dwell Time

This is the standby time to wait for the mechanical vibration to cease and can be set in 0.1 second incre-
ments. When entered negative values, the time becomes shorter. Enter the value n (-1 - -5) to set -(-n x
0.016) seconds. When entered positive values, the time becomes longer. Enter the the value n (1-5) to set

(n x 0.1).

V¥ Mode
H Print mode

Select whether the automatic printing should be executed in NG List format or Map View format.

H Analysis mode
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Select the display mode during analysis. You can choose from Grayscale, Hue and B + H + S.

¢ Display Mode
H Hide matching %

Hide the matching rate displayed on the Frame after inspection. This is useful for high density PCBs.

M Inspection Step mode

When Inspection Step mode is enabled with the NG Pause button pressed, inspection will pause every
time each inspection for 1 screen (1 cell) is complete. When Inspection Step mode is disabled, the inspec-
tion will pause only when a defective point is found.

To activate the Inspection Step mode, the Speed Priority in General Setting must be disabled.

Bl Result with Reference Designator

After inspection, place the cursor near the Frame and the Reference Designator (Symbol) will be dis-

played along with the inspection results.

B Show result with Block Number

A block number is displayed next to the Symbol name on G/NG confirmation mode when you make an

inspection area a block after inputting Symbol.

Ml Show result with comment

After inspection, place the cursor near the Frame and Reference Designator Comment will be dis-

played along with the inspection results.

H Optimize Cell by pitch %

When optimizing Cells, optimize by pitch % set in General settings.

13-3
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l Do not use live images while debugging
If AOI gets vibration influence by P&P machines, you can stop image capturing while debugging. Camera
only takes shot soon after moving to the Cell. While inspection, this is deactivated automatically.

* On older machine which unables to use Light Selection, the fillet light will not be shown correctly.

l Show multiple NG reasons in Pack Stamp

When Pack has multiple NG stamps, one voluntary NG reason is shown. But if this is active, as much as

NG reasons are shown.

H Show inspection time except PCB loading time

Normally inspection time includes the time while PCB is draw in. If this is active, inspection time is count

excluding PCB drawing in time.

l Show result in message bar on counting Ref. Des.

When checked this, Pack is simply counted as one even when it contains multiple NG frames.

V¥ Sensitivity
H Alert too big frame at file open

If Warning frame Size in General Setting is checked, a warning will be displayed when a frame over

the pixel size (width) set here is created.

M Alert too small frame at file open

If Warning frame Size in General Setting is checked, a warning will be displayed when a frame below

the pixel size (width) set here is created.

H Default grid size

If the resolution is not set in filter settings, this value will be set as the default value.

l Matching allowance (%)/ Maximum allowance area (%)

Each resolution grid must meet the OK % set in General Setting, but they can be set to be OK even if
some grid boxes are less than the OK % value.

The Matching allowance determines the percentage of these grid boxes.

For example, if the Matching allowance is 20%, up to 2 grids out of 10 can be below the OK % to be
judged as OK. However, those 2 grids must fit within the area designated in the Maximum allowance
area. Maximum allowance area sets the range to be judged OK even if the result is under the OK %

value. For example, if OK % is set to 60% and the Maximum allowance area is 10%, grid boxes that fall
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within the range of 50% - 60% will be subject to the Matching allowance.
In other words, “OK % 60%, Matching allowance 20%, Maximum allowance area 10%” means that
the matching % of grid boxes is set to 60%, and up to 20% of the total grid boxes are allowed to be 50-

60% matched.

H Small/Big frame Search threshold

This is an optional parameter for Find. The Find method differs by Frame size. This setting is for the
threshold of the size. For small Frames, all pixels in the Frame will be searched. For big Frames, some

sampled pixel groups in the Frame will searched.

H Small frame search range (1/..)

When searching a small Frame with Find, the size of the search area (how many times larger than the

Frame) is set here.

H Big frame coarse search

Since the Find for big Frames is time-consuming, the value to reduce searching accuracy according to
the size can be set here. A small value will result in a rough search, and a large value will result in a de-

tailed search.

H Text Black/White threshold

When letters are extracted, they are extracted based on differences in brightness. If that brightness does
not exceed the value set here, it will not be regarded as a brightness change. The default value is 5, and

the smaller the value, the higher the sensitivity. The range is between 1 and 96.

M Default Hue tolerance

This value defines the tolerance to hue differences between the Master Picture and the picture in the In-

spection Frame. This can be set within the range of O - 65535.

H Default Saturation tolerance

This value defines the tolerance to saturation differences between the Master Picture and the Picture In-

spection Frame . This can be set within the range of O - 65535.

M Brightness Variation range

If there is a hue defect, or the saturation is too low, you can set how much compensation can be applied

with brightness.
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H Default Pixel Search

This designates the number of searches (tracks) made to identify misalignment. Each search will look at 8
pixels around of the object. For example, if the value is 5, it will search up to 40 pixels, searching in places
up to 5 pixels away from the object.

The maximum search distance is displayed on the right in mm.

H Red auto adjust range

This sets the upper limit of Auto Adjust on Fillet inspections.. 2 means 20%.

M Limit number of used picture

In Fillet inspections, Find is performed using the Master Pictures first. This designates the number of Mas-

ter Pictures used for inspection, including the pictures used for Find

H High Speed Search

When using Highspeed Search for misalignment compensation, if the machine cannot find the coordi-
nates where the matching rate is lower than 50%, it will terminate the search and start inspection at the

original coordinates.

W Fillet search by red

The fillet part will be searched using a red LED.

H Search text carefully

When letter extraction is set in the filter settings, it will run a very strict search so that letters written in fine
lines can be found. However, since this affects inspection time significantly, if the print is thick and unsta-

ble, disable this option.

V¥V LAN
M Port, IP Address

When connecting to Rc22x software via LAN, input the terminal port and the IP address to be used. Press

the Connect button on the right to connect.

M Status

Displays the current connection status.
Wait (sec.) is the time to wait the reply from CS-Center/Rc22X of connection. Default is 10 seconds. If Mac
fails to connect CS-Center/Rc22X because it takes more than 10 seconds to receive response, input here

longer time such as 120 seconds.
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H Enable LAN for Rs22X/CS-Center

Check here to connect to Rc22x via LAN at software startup and activate the following items:

—Show remote G/NG screen
Remotely operates G/ NG confirmation from CS-Center/Rc22X. The Simple mode, is an abbreviated
version, and Real mode, is the same screen as displayed on the Mac. Select image quality according to

the communication speed or the performance of the PC. This must be checked for sending data.

—Send inspection result text

Inspection results will be sent to Rc22x in text format. The contents will be the same as that of the out-

put to the roll-paper printer.

—Enable remote Start/ Stop

The machine can be stopped/started from the terminal. Press Tab + C to stop and Tab + G to start up.

—Send barcode number too
The inspection result will be sent to the server after reading the barcode.
—Read before inspect (oy USB reader)

When this is checked, the operator should read the barcode before inspection.

—Send Good data too (dx, dy)

Send not only NG results but also OK and False NG results including shift information.

—Send stamp name too

The stamp name will be added as NOTE column.
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—Send Cell images (CS-Center only)

When connected to the CS-Center software, send Cell images, too.

—Unable to start inspection when LAN-off

When disconnected to the Rc22X/CS-Center software, inspection can not be started.

—Decode barcode by Rc22X/CS-Center engine
Normally barcode is decoded in 22X software, however special barcode such as MicroQR must be de-

coded on Rc22X/CS-Center software.

—Send data without waiting eject (inline only)
Normally data is sent after ejecting PCB, however activating this function will allow to send data right

after inspection. Do not activate this unless the decision of manufacturer.

V¥ Other
H Auto lighting calibration settings

Automatic adjustment of Brightness and White balance will be made at minute intervals defined by the
settings. This correction is for the software to set an approximate value. It is not intended for hardware ad-

justments.

e | ighting Calibration Warning
M Alert regular calibration (hour)

When performing calibration regularly, the time to show warning can be set here.

Bl Show warning if alert ignored (min.)

When regular calibration alert is ignored, show warming message.

B Alert if Gain value is too high (not enough light)

When Gain value is high at calibration, there is possibility that florescent light must be replaced.

Bl Use Barcode Scanner

Change barcode reader settings here. You can set up the device type and its purpose.

H Do not save files when opened by barcode scanning

When file is opened by barcode scanning, the file is opened in read-only mode. Message to confirm save
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or not save file isn’t displayed.

H Settings for In-Line AOI

This is available only when connected to an in-line model machine.

V¥ Action
B Enable Apple Remote Desktop

When this item is selected, inspection machine workload will be reduced automatically when operating

remotely using Apple Remote Desktop. It will return to it’s original state when remote operation finished.

B Alert when 22X starts to use virtual memory

When the amount of memory used exceeds the actual memory capacity, virtual memory (hard disk)
is started to use. When this option is activated, a warning window will be displayed 3 times when the
machine starts using virtual memory. When the message is displayed, operation will be slow

The amount of memory is measured by Mac OS, and it is sometimes not reliable, we recommend not to

activate this option.

H Enable color with DOAL

When inspecting solder pads with no solder paste using DOAL, it may not be able to make a judgment
since the expected over exposure does not occur. Use this option to add the color to the image obtained

by the MAIN LED, making it easier to detect solder pads with no solder paste.

Bl Use wide screen

This is available only on digital camera models. This feature enables inspection of all inspection Frames to

be run in the standard Frame cell size, saving inspection time even with the zoom option active.

B Enable cache for faster inspection

13-3
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By using the cache, the matching rate at inspection will become slightly wider and redundancies in the
matching process will be eliminated, reducing inspection time. Filters for the Master Picture will also be

stored in the cache.

M Save all files at quitting (Enable RAM)

When switching files by barcode, they will be stored in memory without being saved as files each time,

data is saved when the software is shut down.

B Activate Pack Master function

Check here to inspect using the Pack Master Method. For example, when inspecting a resister, body,
solder joints and polarity are inspected as a Pack. Since the body has the widest area, it will become
the Anchor inspection Frame, and the same amount and direction of misalignment compensation will be

applied to the joints and polarity (see 9-11-1, Package Master Method for details).

B Frames keep the original position

If this is active, and any frame is moved during programming, an alert is shown when pressing Start

whether move back to original position, or update the position.

B Keep fiducial offset anytime

Keep fiducial offset even Stop button is pressed.

H Check 'Bad Mark' first (before fiducial)

Inspect blockmark stamp before inspecting fiducial marks.

H Result of Block skipped by 'Bad mark' should be OK

Option for G/NG confirmation mode. The result of PCB skipped by Block Mark is OK when this is on.

l Read barcode in Block skipped by 'Bad mark'

Normally the barcode pasted in the block skipped by '‘Bad mark' is not scanned, but if this option is

active, the barcode is read and sent to Rc22X/CS-Center.

H Do not change file name after importing CAD data

After importing CAD data file, 22x inspection program name is automatically changed to the name of the
CAD data. It is because many customer used PCB name for the inspection program name.

But if you do not like, activate this option on. Then file name will not be replaced by CAD data name.
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H Close Filter Set window by clicking OK

Filter Set window is the floating type window. If this option is active, window closes by pressing OK like a

dialogue window.

H At start, open the file used last time automatically

When starting up software, automatically open the file which is opened last time.

M Eject PCB as NG when failing to read fiducials

Activate this when you do not like to stop the line at fiducial reading failure.

V¥ Plus
M Verify all locations without inspection (Step Mode)

You can check parts/components only by using the G/NG confirmation mode without inspection. This is
useful for PCBs where the parts/components are mounted for the first time after switching PCB models.

Please activate “G/NG confirmation mode” in Map view ssettings.

H Enable measuring [Distance] in Pack window

Activate [Distance] function in Pack Stamp. For detail, see 10-10 Pack Stamp

H Prevent inspecting incorrect PCB by assigning barcode

Function to prevent human mistake of opening incorrect inspection program.

H Limit barcode number when reading by USB reader

Enable to limit the input from barcode or keyboard for preventing USB reader’s encoding error and
operators’ mis-typing. Select the desired number from list. You can select more than one. To cancel,

press Clear at the bottom. Only effective for Read before inspect (by USB reader)

H Automatic file saving

Save file automatically at background per setting minutes. If there is no change on file, file is not saved.If

you are editing filter/stamp at saving timing, save will be skipped by next timing.

B Create square stamps automatically from CAD data

Create square stamps from CAD data without size information for inspecting component present/absent.

Bl Machine number of separation data
Activate this when you want to split inspection area for the inspection with multiple AOI's. You can split the
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inspection program up to 3 AQI's.

V Assistant
H Create program from CAD data in simple way

Create stamp during CAD teaching in simple way by using Stamp Creation Wizard.

B Alert inspection reset by stop button while AD teaching

Show alert when pressing stop button twice during CAD data.

H Set Ref.des. name in consecutive number

Activate this when you want to put consecutive number to Ref.des. name automatically for same Stamp
name.

* Consecutive number you can set is from "0001" to "9999".

l Display programmer name who modified the Stamp

Activate this when you want to display programmer name in Stamp detail who modified the Stamp.

B Enable debugging stamp list with “C”

When this item is checked, the Stamp list for debugging window will be displayed when the C button is

clicked in the stamp list. This will make debugging work easier.

B Active pop-up toolbar

Check this item to display a toolbar when the mouse pointer is placed near the right edge of the screen (at
the lower end if the Dock is placed on either edge of the screen). Tools and stamps related to Inspection
Frames can be selected from this toolbar. The 3 most recently used stamps will be displayed. Hold down
the mouse button while pressing the Control key on the toolbar to display Clear stamp info. Selecting this

will clear the list.
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(Screen Bottom Inspection) (Screen Add-ins)

Bl Manual move by HELP key + mouse

When this option is selected, you must use the Help key + mouse for all operations relating to movement
on the keyboard. This is intended to prevent operational errors. When the HELP key is not pressed, a

warning window will appear on the screen.

B Alert update of stamp after resizing

This is for the beginner. To show update dialogue automatically after resizning for user to prevent forgetting

update.

B Create fiducial frames always in zoomed

Always create fiducial frames in zoomed even they are made in non-zoomed frame.

H Alert deletion of inspection frame

Prevent human mistake to delete frame unexpectedly.

H 'or' setting in Pack more than 32 (matrix deactive)

Maximum 32 stamps can be assigned 'or' condition in matrix tab of Pack setting. However activating this

option enables to assign 'or' condition to all stamps in Pack. If this is active, matrix is deactive.

V¥ Angular Camera (This menu is not displayed on AOI without Angular Cameras)

Please refer Chapter 28-2 "Settings Menu of Angular Cameras (Option)",

V¥ Bottom Inspection (This menu is only displayed on AOI inspecting from bottom)
W Movement Limit

Limit for Z axis up/down to prohibit the camera hitting jig or carrier.
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13-4

(Screen 2)
(Screen 1)

(Screen 3)

(Screen 4)

V¥ Add Ins (Add ins in this menu is pay option)
H OCR Add-in

Enables optical character recognition function.

13-4 Tendency NG / Ignore NG

Alert when defect is counted consecutively/cumulatively, or count as NG only when continuously NG.

V¥ 13-4-1 Tendency NG (Screen 1)
W Active

When same location is NG consecutively in multiple PCB, the inside red circle to mark NG location on

Map View is colored in blinking yellow. In case of NG cumulatively, is colored in blinking rose.

l Stop conveyer

Stop conveyer too in addition to the mark on Map View.
Bl Number of NG

Maximum NG location in one PCB.

H Continued NG / Total NG

Number of NG occured in the same location consecutively/cumulatively.

* Any of Continued NG / Total NG or Stop of No. exceeds limit, the count will be reset.

V¥V 13-4-2 Ignore NG

This is a function “Count as NG after reaching to the setting continued NG number”, is use-
ful for high speed inline AQI to inspect text on components.The text inspection is tend to generate false

calls because text is not always beautifully printed. The text inspection before reflow is often done for
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confirming if correct reel is set to the feeder. This means that you do not need to inspect all PCB for text.

By activating this function, AOI only reports NG when NG is reported continuously.

1. Select a stamp in Work Area.Open Settings -> Configuration -> Tendency NG/ Ignore NG

2. Check on "Active" and input number of after how many continuous NG is occurred (Screen 2).

3. The stamp not only selected but also in the same name will have the counter at the bottom left
of the frame.(Screen 3)

4. Start inspection. When frame is NG, the count will be increased (Screen 4).When the frame is
NG on next PCB (means continuous NG), the count will be increased. But when the frame is
OK on next PCB, the counter will be reset to 0. As well, if the filter is adjust, it is regarded as
debugging, the count is reset to 0. Count is also reset 0 at closing file.

5. The stamp frame will regarded OK until it reaches to continuous NG setting number even it is

actually NG.
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14. Menu and Shortcut List

14-1 Menu

V¥ File Menu
H New

Create a new Inspection Program.

Hl Open

Open an Inspection Program.

Il Open Recent File

An easy way to open recently used files. Up to 50 files are stored here, and older files will be deleted as

more files are added.

M Import Data File

Import the NC data (Numerical Control Data) of the pick and place machine to make an Inspection Pro-
gram. Select the NC data file from the file dialog and import by selecting Open. In version 4.9.8 or prior,
you can select Matching, Histogram, and Passive Component for special stamp. In version 4.9.9 or later,

you can also select Scratch and OCR function besides the previous three special stamps.

H Save

Save the Inspection Program.

141

(Screen File Menu)
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M Save As

Save the Inspection Program as a new file by changing its name. The current file will remain, but if that file

is not saved after editing, the changes will not be saved.

H Export Data

Exports information such as NG, position and Stamps.

¢ Information output

A file output dialog will be displayed and you can select options such as Format. The output will be in a
text format that can be used in spreadsheets and other applications.

e Position output

This is used to export the numerical coordinates of the Inspection Frames.

e Past out put

Outputs result data for each PCB in a text format that can be used in other applications.

e Stamp information

Outputs information for Stamps used by Inspection Programs converted to text data.

H Snap Shot

In the snapshot menu, there are 3 items: Save, Open and Blend. These are used to export the screens as
files, and to import picture files.

* Save

Saves the currently displayed Work Area as an image file.

e Open

Opens pictures saved with Save or created in other applications.

¢ Blend

Pictures imported using Open will be blended with the picture currently displayed in the Work Area.

e Open virtual PCB

Create PCB images be used in the Offline Teaching Software.

l Page Setup

Before printing, make sure to perform Page Setup. You can set paper size and, if a color printer is con-

nected, ink settings. The dialog displayed here will vary with the installed printer driver.

H Print

The NG List or the defect locations in the Map View can be printed. These can be selected in Print mode
of Settings for Supervisor. O will print the NG List, 1 will print the Map View, and 2 or higher will output

simple inspection results for a roll-paper printer. The default is O.
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H Preview

You will be able to confirm the NG List preview here. The preview header will include the total number of
inspected PCBs, the total number of defect areas and the total number of inspected areas, so you can

also use this command to inspect those.

B Authorisation

The Authorisation item in the File menu contains the Operator, Programmer and Supervisor Modes. The
Operator Mode allows operations needed for inspection only, the Programmer Mode allows Inspection

Program editing, and the Supervisor Mode allows unlimited control of the machine.

V¥V Edit Menu
Hl Undo

Cancel the previous operation. Please note that some actions cannot be undone.

H Cut

Delete the selected objects and stores it in memory (clipboard).

H Copy

Store the selected objects in memory (clipboard).

H Paste

Paste the objects stored in memory (clipboard).

H Select All

Select all Frames displayed in the Work Area. The shortcut key is Command + A.
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(Screen Edit Menu)

168
14. Menu and Shortcut List




l Row Copy

Place multiple copies of the selected Frames at specified intervals in a row., used to place the same

Frame, such as solder shorts between IC leads, in a row. Copies can be made across cells.

M Duplicate selection

Copy selected Frames by cells. If nothing is selected, everything contained in the cell will be copied.

H Arrange

Align selected Inspection Frames.

H Auto Reposition

Automatically align Inspection Frame positions based on the stored Master Picture.

M Flip/ Turn

Rotate or flip selected Frames using the sub menu. Rotate Right and Rotate Left have shortcut keys.

H Initialize

¢ Delete Log Data

The number of PCBs inspected, the number of total points inspected and the number of total NG points
and the records of each Frame are stored as Log Data for each Inspection program. This command de-
letes all the data. This command cannot be undone.

e Clear Local / Master Pictures

Clear all Master Pictures stored in each Frame in the Work Area, or clear the Local Picture.

e Clear Objects

All Frames will be deleted. Stamps on Stamp Lists and others will remain.

e Automatic Positioning

Performs the same task as Auto Reposition to All Frames.

¢ Picture Replacement (Not available for V4.9.5 or greater)

Picture Replacement can update or add the Master Picture. Referring to the Master Picture for each
Frame, the area that best matches the Master Picture will be found. If the Match % is within the preset
limit, you can update the Master Picture or add it as the Master Picture. Frame positions also can be up-
dated. You should use the reference PCB for Picture Replacement.

* Warp Position (Not available for V4.9.5 or greater)

When you use the Inspection Programs used with other machines, this command corrects distortions that

cannot be fixed using only the X, Y offset.
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H Side Edit

e Swap A/B side

Side A and side B can be switched.
e Copy this side

Copy the selected side.

H Assign Fiducial Mark

Set the marker reading Frame.

H Assign to A/B Side

Allow one file to retain data for both A and B sides and automatically switch sides.

V Settings
H Calibrate

Perform calibration to maintain a consistent display color.

H Configuration

* General

Set software’s general preferences.

* Object Frame

The Inspection Frame color and line thickness can be changed here.

e For Supervisor

Set preferences for the inspection machine. In general, this does not need to be changed.
e Tendency NG

Issues special warnings in the Map View for Frames that are continuously judged as NG or Frames that
have many cumulative NGs.

e Operator Account

Create operators account.

* Mode to start next time (available on OFF-Line Teaching Software)

Enable to select 4 modes; VGA (640x480), SXGA (800x600), UXGA (1600x1200) and FHD (1920x1080)

141
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e Tact Simulation (available on OFF-Line Teaching Software)
Open Tact Simulation window.
¢ | oad _vs file by Cell (available on OFF-Line Teaching Software)

Open all Cell images, load necessary Cells when moving

H Calibrate Pixel/cm

This item defines the actual size (in mm) of the picture displayed on the screen.

M Machine Setup

® Parameters

Sets parameters for the machine.

* Mechanical Calibration

There are Fiducial Points set at an accurate pitch in the four corners of the carrier to correct distortion of
the machine and by reading these Fiducial Points, the physical position can be converted into a logical
position, and even if the desk or the floor is not flat, it can be moved to the correct position by performing
Mechanical Calibration.

® Reset Camera

If signals from the digital camera could not be sent correctly and the image is distorted or deleted, this
command resets the signal from the camera.

e Keep Door/Table Closed

To kill door/table movement while debugging on Model U series with auto-table and Model DL/HDL-
460/650. This menu is not displayed in the other models.

V¥ Stamp Menu
l Stamp list

Open the Stamp list Window.

141
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B View Selected Stamps

Display only selected stamps.

Hl New Stamp

Register a new stamp.

H Change

Click here when you want to apply the changes you made to a Stamp to all of the Frames with the same

Stamp.

l Make Stamp Reversible

The picture of the selected Stamp and the one rotated 180 degrees can be registered as Master Pictures

at the same time.

W Use Stamp Picture

This applies a Master Picture to the Stamp. This feature makes it easier to manage programs because

each Inspection Frame does not need to have a Master Picture.

l Open Stamp File

Open Stamp file.

l Automatic Paste (Current View)

Paste stamps automatically in current view

l Automatic Paste (Map View)

Paste stamp automatically in map view.

Hl Ungroup

Ungroup the selected group.

B Edit Group

Make the selected group editable. You can resize and reposition each Inspection Frame.

l Copy Group

Copy the selected group.
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Bl Renew Group Picture

Update the Master Picture of the selected group.

H Create Stamp Pack

Make selected Stamp Frames into a Stamp Pack.

M Edit Stamp Pack

Make the selected Pack Frame editable. You can resize and reposition each Inspection Frame.

V¥ Window Menu

Bl Hour Counter

e Cumulative hours, operation hours, inspection hours and lamp hours are displayed in the Hour Counter.
Press the mouse button and hold on the Hour Counter Window to display the pull-down menu. Then
select the item that you would like to view.

The colors of the numbers will change for each item.

e Ground total time (TTL) and clearable total time (TTL2) can be displayed. This is useful for daily and
weekly status management.

e The Lamp Alarm can be set up using the pull-down menu (Screen 1). When TTL2 exceeds the time set
here, the lamp display will change to red.

® The size of the Hour Counter varies by monitor resolution.

H Solder Paste Check

Open the Area Edit Window to convert Inspection Frames for solder paste inspection.

l Conveyer operation

Display the Conveyer control panel for in-line machines.

M Show/ Hide Object Type

Categorize Inspection Frames by type and set up whether each Frame should be shown or hidden. This

14-1 14-2

(Screen 1)

(Screen Window Menu) (Screen Zoom Menu)
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is useful when confirming the type of Inspection Frames. With this feature, you can check the Inspection

results by type, and you can also exclude Inspection Frames temporarily by type.

H LAN Window

Display the ports on the Mac, the IP address of the PC where the RC22x software is installed and connect

button when used with the Centralized Control Software (RC 22X).

H Edit Recent Files

Display files which have been opened using Open. You can input the barcode number, lot number and

NOTE.

H Histogram Analysis

Open window for histogram method

M Filter Setting Window

Open window for pattern matching method
V¥ Zoom Menu
Il Zoom In

The Zoom mode can be switched between standard magnification and 2x magnification here.

M Hide Zoomed-in Objects

Frames set with zoomed-In mode can be temporarily hidden.

M Hide Unzoomed Objects

Frames set with standard mode can be temporarily hidden.

H Flip Zoom/ Unzoom

The selected Inspection Frames will be changed to other mode. Standard mode will change to zoomed

mode, and 2x mode will change to Standard mode.
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14-2 Shortcut Key List

* Alt key is represented as Option key here.

File Operation

Item Operation

New Command + N
Open Command + O
Save Command + S
Print Command + P
Quit Command + Q

Frame Operation

Item Select m-gll:?e Il\:l'l‘g\?ement Cursor Operation

Undo J J J Command + Z

Cut J J J Command + X

Copy J J J Command + C

Paste J J J Command + V

Select Al J J J Command + A

Row Copy J J J Command + D

Automatic Stamp Paste J J Command + G

Ungroup J J Command + U

Edit Group J J Command + E

Rotate Right J J J Select Frame |Command + R

Pack J J Command + K

Edit Pack Position J J Shift + Return

Histogram J J Command + F

Rotate Left J J J Select Frame |Command + L

Rotate Right J J J Select Frame |Command + R

Move frame by pixel J J J Select Frame |Command + < T—]

Move camera by pixel J J Command + shift + < T—]

Copy J J + Option + drag

Copy (X, Y directions only) J J + Option + drag + shift

Move Frame (Update Master Picture) J J + drag

Move Frame (Maintain Master Picture) J J + Command + drag

Change Frame Size J J drag

Rotate + Update Master Picture J J Option + drag

Rotate Frame by 45 degrees J J Option + Shift + drag

Set Search Range J J Control + drag

Set Offset Limit J J Command + drag
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Item Select m'glr(:e ﬂg\?ement Cursor Operation

Save New Stamp with master pic. J J Select Frame |F3

Add Master Picture J J Select Frame |F7

Open Filter Setting J J Select Frame [return (enter)
Change Stamp Name (Update stamp) J J Select Frame Eéémc;:(;;;gd;t;;;aegp
Offset Al (all cells) J Command + Option + drag
Offset Selected Cells J Option + drag

Cell Optimization (Pitch area) J Control + click

Cell Optimization (drag by Control) J Control + drag
Hide frames temporarily J J J caps lock

Optimize selected Frame position J J J F4

Optimize position within cell J J J Fo

:)gir:ri]ze cell import position within J J J F10

Operation

Item Location Operation

Zoom In/Out F1

To Previous Position (_) F5

To Next Position (_) F6

Select Pointer Tool 1

Select Frame Tool 2

Select Move Tool 3

Force Flip A/B Side Option + A/B Side Button (A/B)
Find Origin Option + Eject

Output Map View to File Map View Close + Command + Shift
Re-create New Map View Map View Command + N

Output Filter Setting Screen to File

Filter Setting Screen

Stop + Command + Shift

Linear Encoder Setting

Message Column

Display Window + Option

Resize Window in NG Cell View Mode

Cell Confirmation Mode

Tab

Display Full Screen in NG Cell View Mode

Cell Confirmation Mode

Shift + Tab

Blend Snapshot Screen

Command + B

Auto Add False Report Picture

Option + Start

Show/Hide in G/NG Confirmation Mode

Space key

Extra setting in G/NG Confirmation Mode

Option + Clock Icon

Add picture in G/NG Confirmation Mode Shift + Good
Manually Enter Barcode Number Space key
Show/Hide Stamp List F8

Search in stamp List for debugger

On debug stamp list

Command + G
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Errors

Typical error messages are listed here. When there are OK/Cancel buttons in the dialog box, make your
selection then take actions to fix the error based on the information below:

General

Message Action

Cannot be completed because | This message is displayed when dots per cm is not set up. Confirm Settings
dots/cm value not defined for Supervisor.

Imported data file incom- This message is displayed when you try to import an unsupported format’s
patible. NC data. Confirm that the data is Panaformat compatible.

This message is displayed when the Inspection Frame size is too small. To

Size is too small. . o .
create a small frame, uncheck Warning frame Size in General Setting.

This message is displayed when the Inspection Frame size is too large. To

Size is too large. . o .
9 create a large frame, uncheck Warning frame Size in General Setting.

This message is displayed when the camera movement could not be
completed within the allotted time. The inspection machine may have been
powered off, or the communication cable may have become loose.

Movement finished unsuccess-
fully.

Position beyond movement

limits (Correct position within This message is displayed when Stamps are placed outside the inspection

area. Delete those Stamps.

limits)

Attempt to copy beyond This message is displayed when Stamps are copied outside the inspection
movement limits. Copying area. The Stamp copy location may be too far away or there may be too
stopped. many copies to be made.

There was an object that can This message is displayed when some areas can not optimized by Cell
not be distributed to a part. Optimization after NC data (Numerical Control Data) import.

This message is displayed when the PC cannot receive data from the
machine due to the inspection machine being powered off during Inspection
Software startup, or because the communication cable is disconnected.
Check the power switch and communication cables.

No ID reply from controller.

This message is displayed when the Inspection Frame does not fit inside
the Work Area after being rotated. Confirm the position of the Inspection
Frames.

When rotating, frames go out
of the cell (screen).

This message is displayed when Cell Optimization is executed but not all of
the Stamps are allocated coordinates. Allocate all Stamps before executing
Cell Optimization.

Not all positions assigned to a
frame. Run again to complete.

This message is displayed when you try to add 25 or more Master Pictures
to a Stamp. Delete unnecessary Master Pictures before adding new
pictures.

Cannot store more than 25
Master Pictures.
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Message

Action

Map View has not been
created.

This message is displayed when you try to display the Map View when no
Map View has been created. Create a Map View first.

Cannot copy to the same
position.

This message is displayed if the Pitch for Duplicate is set to O when copying
Inspection Frames. Make sure that the pitch is appropriate.

Side Marker already defined.

This message is displayed when you try to create multiple Side Recognition
Markers. Delete old markers before creating new Side Recognition Markers.

Parameter for distortion is
inappropriate.

This message is displayed when the value for correcting distortion, “Top
left carrier fiducial” or “Carrier fiducial distance” is inappropriate.
Confirm these values in Settings for Supervisor.

Frame too close to the edge of
the cell (screen)

This message is displayed when you try to place an Inspection Frame at the
edge of the screen. Make sure that the object is displayed near the center of
the screen before placing the Inspection Frame.

There is no data for side A (B).

This message is displayed when sides are switched while only one side
contains data.

There is no discrimination
between side A(B).

This message is displayed when Side Recognition Markers have not been
set up. To execute automatic recognition, set up side recognition markers
first.

Cannot recognize board side

This message is displayed when side marker Recognition fails. Set the Side
Recognition Markers in a more easily recognizable location or readjust the
filter settings.

Marker Errors

Message

Action

Marker is not adjusted. Select
marker and adjust B&W.

This message is displayed if binarisation level adjustment for markers is not
performed. Double-click on the marker Inspection Frame and adjust the
binarisation level of the object.

Size is too small. Redefine.

This message is displayed if the Fiducial Mark size is too small to perform
center measurement after binarisation. If the center cannot be measured
even after binarisation is adjusted, position cannot be corrected with that
Fiducial Mark.

Size is too large. Redefine.

This message is displayed if the Fiducial Mark size is too large to perform
center measurement after binarisation. If center cannot be measured even
after binarisation, position cannot be corrected with that Fiducial Mark.

Main and Sub Marker both
defined. Delete before creating
a new one.

This message is displayed when you try to create a new Fiducial Mark after
the Fiducial Mark has already been set up. Delete the old Fiducial Mark
before creating a new Fiducial Mark.

Failed to find marker.

This message is displayed when there is no Fiducial Point to be found, or
when binarisation and other adjustments are made inappropriately. Confirm
the Fiducial Points position and double-click on the Fiducial Reading Frame
to readjust the binarisation level.
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Warning Query Dialog

Message

Action

Local picture(s) not stored.
Continue copy?

This message is displayed when you try to copy the Frame even if there is
no Master Picture contained in the Frame.Register Master Picture from a
good PCB before copying.

Create Map

This message is displayed when the Eyeglass Button is clicked after
Inspection Data has been created. Click OK to create the Map View Picture.

Save changes to the data
before quitting?

This message is displayed when you try to close the inspection software
without saving the program. Click Save to save the program.

Erase logged data? Cannot
undo this operation.

This message is displayed when Edit > Initialize > Delete Log Data is
selected. Since this operation cannot be undone, be careful when selecting
OK/Cancel.

Erase all local Master Pictures?
Cannot undo this operation

This message is displayed when Edit > Initialize > Clear Local Master
Pictures is selected. Since this operation cannot be undone, be careful
when selecting OK/Cancel.

Erase all objects? Cannot undo
this operation

This message is displayed when Edit > Initialize > Clear Objects is
selected. Since this operation cannot be undone, be careful when selecting
OK/Cancel.

Mechanical calibration values
renewed. Existing value will be
lost.

This message is displayed when Settings > Machine Setup >
Mechanical Calibration > Update is selected. When Mechanical
Calibration has already been executed once, this does not need to be
updated unless you move the machine.

Execute new mechanical
calibration. Caution: Older data
may need some adjustments.

This message is displayed when Settings > Machine Setup >
Mechanical Calibration > New is selected. When Mechanical Calibration
has already been executed once, you do not need to execute this function
unless you need to create new, machine specific, preference data.

Ignore Marker and continue?

This message is displayed when Fiducial Mark Recognition fails. You can
ignore and continue or manually adjust the position, but we recommend
that you go back and readjust the Fiducial Mark settings.

Move to calibration position?

This message is displayed when Calibrate is selected from the Settings
menu. Click OK to move the camera to the calibration position.

Move to measure position?

This message is displayed when Calibrate Pixel/cm is selected from the
Settings menu. Click OK to move the camera to the scale position.

Pictures with NG results will be
added automatically.

This message is displayed when inspection is executed while holding down
the Option key. This message notifies you that the mode is currently set to
automatically import the Master Picture from an Inspection Frame that will
give false reports.
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Macintosh to AOI connection

Message

Action

Cannot Video Initialize.

This message is displayed when the software and hardware for video
capture are not functioning properly. The image cannot be displayed when
this occurs. Make sure that video capture boards and driver software are
installed properly. Take extra caution when you have reinstalled your OS. In
addition, video will not function properly if have an incompatible combination
of capture board, video camera and driver softwares. If you are unsure of
your configuration, please contact your sales agent or the manufacturer.

Machine Setup

Message

Action

Received a message of an
unidentified error.

This is an error that has no specific error messages. This may be displayed
when the inspection machine is turned ON/ OFF while the inspection
software is running. If this message is displayed frequently in other
circumstances, please contact the manufacturer.

A system error occurred in
movement control device.

This is a system error in the internal controller board of the inspection
machine. If this message is displayed frequently, please contact the
manufacturer.

A command error occurred in
movement control device.

This is a command error in the internal controller board of the inspection
machine. If this message is displayed frequently, please contact the
manufacturer.

Movement parameter error.

This is a parameter error in the internal controller of the inspection machine.
If this message is displayed frequently, please contact the manufacturer.

Must set Origin Position.
Continue?

This message is displayed when you try to move the position before setting
the Origin Position, or when you try to move the position after activating
emergency stop or the security system. Press the Origin Position button to
set the Origin Position.

Servo error

This message is displayed when the motor RPM is slower than the preset
value. This may happen when the upper camera hits an obstacle while
moving, or when dust on moving parts has caused motor problems. This
message will also be displayed when operating power for the motor is
insufficient due to reduced power voltage or for other reasons. Pay attention
if the unit is plugged into an extension cord with multiple outlets.

Movement attempt beyond
minimum X value.

This message is displayed when the PC sends an instruction to move in the
negative direction on the X axis from the origin position (a position that is
physically impossible to move to). This will not generally happen with regular
data creation, but you will need to be careful when data is created from
imported NC data. When this error is displayed, please confirm the Frames
Position.

Movement attempt beyond
minimum Y value.

This message is displayed when the PC sends an instruction to move in the
negative direction on the Y axis from the origin position (a position that is
physically impossible to move to). This should not happen with regular data
creation, but you will need to be careful when data is created from imported
NC data. When this error is displayed, please confirm the Frames Position.
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Message

Action

Movement attempt beyond
maximum X value.

This message is displayed when the PC sends an instruction to move
beyond the movement limit in the X axis direction from the origin position
(a position that is physically impossible to move to). This should not
happen with regular data creation, but you will need to be careful when
data is created from imported NC data or when transferring data from a
large inspection machine. When this error is displayed, please confirm
the Inspection Frame position. In addition, this error may be displayed

if the value for Maximum Movement has been changed in Settings
for Supervisor. In this case, please confirm the Maximum Movement
settings.

Movement attempt beyond
maximum Y value.

This message is displayed when the PC sends an instruction to move
beyond the movement limit in the X axis direction from the origin position
(a position that is physically impossible to move to). This should not
happen with regular data creation, but you will need to be careful when
data is created from imported NC data or when transferring data from a
large inspection machine. When this error is displayed, please confirm the
Inspection Frame position. In addition, this error may be displayed if the
value for Maximum Movement value has been changed in Settings
for Supervisor. In this case, please confirm the Maximum Movement
settings.

Security system activated.

This message is displayed when front cover, door cover or Area Sensors
are activated. After canceling, you will need to set the origin position. If
this warning is displayed unexpectedly, check the connection of the Limit
Switches on the covers.
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15. Export/Print data, Handle Similar
PCB by One Program

This software can export various inspection programs’ information in text format.
By using these files, you will be able to check the data in a spreadsheet and easily save the results of pre-
vious tests. This Chapter explains how to export inspection data (Refer to Chapter 5 CAD Data Application

Guide for import).
15-1 Exporting Data

3 kinds of information can be exported from the Export Data of the File menu or Info File button in the
Map View window. You can select Information output, Position output, Past out put or Stamp In-

formation. When Stamp Information is selected, you can edit it.

V¥V 15-1-1 Information Output

The data of each frame (serial number or address, Ref.des. name, number of inspections, number of de-
fects, date created, date updated) can be selected for export. Select the delimiter (Tab or comma), sort

sequence and output items in the dialog that is displayed when Information Output is selected (Screen 1).

* No.

This is the serial number assigned automatically in the order of creation (excluding Marks for side recog-
nition and Fiducial Marks). This number changes when frames are deleted or Marks for side recognition/
Fiducial Mark/CellAidStamps are added. The newly added frame will be assigned the latest number. Fi-
ducial Marks are handled differently, with the main marker being -1, and the sub-marker -2. Marks for side
recognition will be number 0.

* Map

15-1-1

(Screen 1)
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This is the Address displayed when the Grid Button on the top right corner of te Map View is clicked.

® Ref des.

If Ref des. names are assigned to Frames or Stamps, the Program will include Ref des. names. If Ref des.
names are not assigned, this field will be left blank. If CAD Data has Ref des. names, frames will automati-
cally have Ref des. names assigned to it.

e TTLchecks

The cumulative number of times the frame was inspected.

e TTL NG

The cumulative number of times the frame was judged as NG.

e CreateDate

The date that the frame was newly placed or copied will be entered. The format at file export will be YY/M/D.
e UpdateDate

The date that the Frame was updated, by size change, filter change, picture addition, etc.

¢ False NG too (For printer)

Print False NG points in addition to NG points on paper roll printer.

® Add extra information

Stamp name is also output. If there is pack stamp, the list and number of stamp contained in pack stamp

is output. If there is stamp which original frame type is set, type name and error messages are listed.

B Export Format

The file to be exported will have the name of the inspection program and the date of export in line 1, col-

umn headers in line 2, and details from line 3 onward.

(Ex.)

newest / PCB TTL3/NG1 POINT TTL228/NG83 [ 06.11.2 4:52 AM ]
SYM,% ,ppm,TTL,NG,Begin,Modify

,0.00,0,2,0,06/10/19,06/10/19

,0.00,0,3,0,06/10/18,06/10/18

V¥ 15-1-2 Position output

This exports the coordinates of Inspection Frames as NC Data.

The output format will be available in 3 types from the pull-down menu (Screen 1):

Pana format (N1X-12345Y6789W09021)
22X Data Format (X-1234Y567W90Z00;R01 \Stamp)
CSV (Comma Separated Values) Format (X,Y,W,Z,Ref des,Stamp)
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15-1-2

(Screen 2)

The opening line of the output format will be $, data will start from line 2, and the last line will be * (except
CSV format, CSV format has no head line and end line). 22X Data Format and CSV format can be re-
imported to 22X without editing as CAD data.

Data is sorted by stamp number, which is automatically set by this software. The coordinates start from
the front left of the PCB and increase towards the back right corner, with the position units being fixed

decimal points in 1/100mm increments. The position shows the center of the Frame.

(Ex.)

$
N1X-38189Y12378W000Z-1
N2X-37700Y11838W000Z0

H Note:

1. If the ratio of actual dimensions and the displayed image (pixels per 1cm) is not accurate, the
accuracy of the positioning in the exported file will be low.

2. The further away from the center position of the Work Area, the lower accuracy of position in-
formation will be.

3. There can be around a 0.1mm error, though it depends on the frame positioning accuracy.

V¥ 15-1-3 Past out put

The Inspection history can be exported for each Inspection Frame. The Export format will be tab sepa-
rated. Rows (horizontal) will have Ref. des. names (these will be left blank if there are no Ref. des. names)
sorted in descending order of total NGs, and columns (Vertical) will have the number of inspections dis-

played in descending order. OKs will be O and NGs will be 1.
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V¥ 15-1-4 Stamp information

Stamp information can be edited as well as exported. When you select Stamp Information, the Stamp in-
formation Window will be displayed in list format (Screen 1). Some parameters of Stamps can be edited
on this list. This is effective when you would like to set the matching ratio higher for more strict inspections,

or to change certain parameters of multiple stamps at once.

B Format of Stamp information

When Stamp information is selected, the Stamp information Window will appear.

Check Edit to edit the information, and click on each item to edit (Screen 2). However, the items shown in

gray after selection cannot be edited.

Detailed information and the settings ranges are as follows:

Item Contents Type Edit
name Stamp Name Text No
type Type of frame Text (rect,oval,poly......) No
zoOoMm Zoom property Numeric (O=noZoom , 1=zoom) No
group Group ID Numeric (O=no group) No
sizeX Horizontal Size Numeric (Pixels) No
sizeY Vertical Size Numeric (Pixels) No
pics Number of master pictures | Numeric (O=non, 1-24) No
percent Special % Numeric (0 — 100) Yes
resolution Grid Numeric (4 — 16, O= o) Yes
lightness Brightness Numeric (-16 - 15) Yes
contrast Contrast Numeric (-16 — 15, 15=black and White) Yes
hue Hue Numeric (-16 — 15, -16=invalue hue) Yes
saturation Saturation Numeric (-16 — 15, -16=invalue saturation) Yes
blur type Blur Type Numeric (O=Full , 1=horizontal , 2=vertical , 3=side side) | Yes
blur level Blur Level Numeric (0 - 4096) Yes
edge Edge Numeric (0=off , 1=on Yes
letter Extract text Numeric (O=off , 1=0n) Yes
NglsOk Judge NG as OK Numeric (0=off , 1=0on) Yes
seek Seeking range Numeric (0-255< Pixels>) Yes
findX Seeking range X Numeric (0-255< Pixels>) No
findY Seeking range Y Numeric (0-255< Pixels>) No
limitLong Offset limit X Numeric (0-255< Pixels>) Yes
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limitShort Offset limit Y Numeric (0-255< Pixels>) Yes
fillet Fillet Numeric (1=Wave type) Yes
wavelevel |Fillet waves Numeric (1 — 3) No
waveVolume | Fillet volume Numeric (1 = 3) No
waveDir. Fillet direction Text No
cameraNo | Special camera setting Numeric (O=non, 1 - 8) No

l Stamps that cannot be edited
The following stamps cannot be edited:

cellAid, code39, solPrint, solReject, stdLight, capture, markNG, markOK, markBoth, barRead, QRcode

H Sort

Stamps can be sorted by item. Place the mouse pointer on the item that you would like to sort and hold

down on the mouse button to select descending order or ascending order (Screen 3).

l Batch Copy

15-1-4

(Screen 1)

(Screen 2) (Screen 3)

(Screen 4)
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When you would like to set the same value for multiple Stamps, the value can be copied easily. Select
the copy source value and hold down the Option key while dragging up or down. Items that cannot be

changed will remain unchanged (Screen 4).

* When you close this window after editing is complete, settings for all Stamps included in the data
currently displayed will be changed. This change will apply to both side A and side B.
* When invalid numerical values or text have been entered, they will be replaced with valid figures.

* ltems that are displayed in gray when you click cannot be changed.

V¥ 15-1-5 Stamp Information Export

Stamp information can be exported as text data. By using the exported data, Stamp Information can be
managed offline. Click Export in the Stamp information Window. A comma separated (CSV format) file

will be saved.

l Format of Exported File

The output file will have headers in line 1, item names in line 2, data starting from line 3, and the terminal

symbol at the last line.

(Ex.)

% STAMP_INFO_HEADER x.x

name,type...... cameraNo
1005B,rect.,1,,28,50,1,60,10,0,0,0,-10,3,1,0,0,0,5,,,.,,5,

% END_OF_STAMP_INFO

15-2 Editing and Importing Stamp information

In general, Stamps are created based on Inspection Frames, but it is also possible to create a Stamp with
only the name and size from text data. When creating Inspection Programs from CAD Data (NC Data), you
can prepare a blank Stamp with just the part name first, then set up Master Pictures later. ltems that can
be set up are name, size and some filter values only. Since information such as picture rotation is not in-
cluded, these need to be set up later on when looking at the screen.

Since this is text data, it can be created from scratch using a text editor, but it is recommended that some

sort of data be exported first because Stamp information and correction will be applied based on the text.
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1. Open the exported Stamp information File with a text editor.

2. Do not edit the header in line 1, the item names in line 2, and the end line. Enter parts/compo-
nents names and values separated by commas in the data lines. The parameters for each part/
component are separated by a line break.

3. At least, the parameters for name, sizeX and sizeY must be set. Data must always be sorted
from the left in the order of name, type, zoom, group.... A separating comma will be needed

even if an item may not have any values to be set.

For example, if name is 1005 and group is 1, but there are no values for type and zoom, the value will be
1005,,,1......

with each item being set to default values.

4. sizeX, sizeY, limitLong and limitshort will be interpreted as pixels if integers are entered, and as
millimeters if decimals or mm are added. i.e. if 1 and 2 are entered, the values will be 1 pixel
and 2 pixels. If 1.0 and 2mm are entered, the values will be 1Tmm and 2mm.

5. Do not edit line 1, the end line and item names. Save in the CSV (comma-separated) format.

6. Select save CSV data from Import Data File in the File menu.

7. The Update Stamps window will be displayed. Check Add and press the New button.

* If Add is not checked, the New button will become an Update button, and the current Stamp will
be replaced with a new one.
* Group, pics, fillet, wavelevel, waveVolume, waveDir and cameraNo cannot be defined.

These items will be ignored when imported.

15-3 Print information by roll paper printer

If you use roll paper printer for AOI, you can print NG inspection points automatically soon after inspection.
Printed paper may be useful to confirm or repair NG points afterwards.

If you PCB has no barcode, 10 digit number is automatically given to each inspection result.

15-3

=
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M Applicable printer

Citizen CBM-910II1-40RJ100-A (width 60 phi, 40 characters possible to print a line) Serial communication
Citizen CBM-910I1-24RJ100-A (width 60 phi, 24 characters possible to print a line) Serial communication
Star Micronics TSP143GT (width 79.5mm, enable to print 2 byte character) USB communication

Star Micronics TSP143GTIIl (width 79.5mm, enable to print 2 byte character) USB communication

* Serial communication printer requires KeySpan to convert to USB.

* Star Micronics printer can not be used on Mac OS9.

H Serial Printer Settings

1. Set dip switch of the printer 2, 3 and 7 to be ON, the rest should be OFF.
2. Install KeySpan driver on Mac.
3. Connect KeySpan to the printer, power on the printer. Connect KeySpan to Mac USB port.
4. If your Mac OS is greater than 10, check System Preference's Network as if KeySpan is
recognized. If you Mac OS is 9.x then check Apple System Profiler as if KeySpan is recognized.
* Roll paper printer is automatically recognized on Mac, so that you do not need to set Page Setup in

File menu.

* If you use special characters in file name, Mac name or stamp name, they are not printed correctly.

l USB Printer Settings

1. Install printer driver for Mac from attached CD-ROM.

2. Connect power cable and USB cable to the printer. Connect the other side of USB cable to
Mac's USB port. Power on the printer.

3. Start 22X software, select file menu then Print set (Screen 1). Change from Any printer to TSP***
in Format for setting (Screen 2), change Paper size from A4 to 72mm*20000mm (Screen 3).

4. If other printer is already used on this Mac, change default printer in Printer and Fax menu in

System Preferences.

15-1-3

(Screen 1) (Screen 2) (Screen 3)
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* The advantage of this USB printer is that this can print with Italic-bold if there is defective Pack

Stamp component which contains more than one defect.

Hl 22X Application Settings

1. Open Setting menu's For Supervisor, select Screen/Print tab, check on roll paper and set max.
print.

2. To set auto-print, open Setting menu's General, check "Auto printing" on. If you print manually,
select Print in File menu. When previewing, select Preview in File menu.

3. Set information to print. Select Information Output from Export Data in File menu. Or open
Map View and select Information Output from File menu. File saving dialogue pops up. Check

items on and quit this dialogue by Cancel. Please refer chapter 13-1 for details of each item.

H Print False NG

You can also print out false defect points too by option. Activate this in case you want to check PCB after
AQl inspection and human judgement if there is no mis-judgement.

Check on False NG too (For printer) option in Settings step 7. False NG point is marked ? on the head.

H Print barcode number as scannable barcode on roll paper

By installing barcode font in Mac, code39 type of barcode can be printed on roll paper.Please contact
your local reseller to get the font.
* This function is only for USB roll paper printer by STAR micronics. Mac OS must be greater than 10.7

to use barcode font.

15-3

-

M Printing format

General inspection information is written on header, NG (and False NG) points follows.

M22XDL-350

MacPro

TEST [ 2008.8.1 10:33:41 ]

Total PCBs checked[35] block<0> (Thomas)
Total NG PCBs [3] block<0>
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Current result (check 455 NG 2/3) Spent time 11
BarNum 1234567890

SYM ADRS TTL NG Begin NG_ID

C3 BO02 35 4 06/04/25 3
?2C5 BO05 35 1 06/04/25 -

R41 CO1 35 2 06/04/25 0

15-4 Handling Similar PCB by One Inspection Program

Some of you may handle PCBs which are almost the same but a few components are ‘not mounted’ or
‘different components are mounted’. You can manage these PCB by one inspection program with Model
Variation function. Model Variation function is like link files to the inspection program and you define the

difference of each PCB in these link files (named variation files).
V¥ 15-4-1 How to create Variation Files

1. Create an inspection program to be a basis of all similar PCBs. What you do in variation files is
to define "Inspection skipped component(s)". Therefore all necessary stamps must be
located in this inspection program.

* Of course you can add stamps later at any timing. It is OK not to locate stamps for all kind of PCB

now.

2. Next, create variation files. Select Model Variation from File menu. Select Create/Edit Variation
File (Screen 1). A window "Welcome to Model Variation menu!" will be displayed. Create the first

variation file by following the description and click OK (Screen 2).

3. Model Variation window will be displayed (Screen 3). The left side is Variation File list, and the
right side is the Reference Designator list. You can designate the skipped location, however
now we are on the way to create variation files, so we move to next operation. Please read the
following pages to learn how to skip.

* Maximum 400 variation files are possible to create.

15-4

PCB: Model A PCB: Model B
(not mounted)
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15-4-1

(Screen 2)
(Screen 1)

(Screen 3)

-

(Screen 4)

4. The second and more variation files can be added by + button (Screen 4).

5. Press OK button and close the window. You can open variations from Model Variation in File

menu (Screen 5).

6. Variation files are saved in the folder which is automatically created at the same directory as

inspection program. Do not move/delete/change name the variation files from Finder (Screen 6).

7. The variation file is virtually treated as an inspection program. File name is displayed
"Inspection Program name _ Variation File name". The variation file opened once can

be opened by "Open recent file" from next time (Screen 7).
* The inspection file name sent to Production Management Software (Rc22X or CS-Center), is also

"Inspection Program name _ Variation File name".

8. After editing variation file, you will be asked to save the file. The file name being confirmed here

is Inspection Program name, not variation name. Please save file.
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15-4-1

(Screen 6)

(Screen 5)

(Screen 7)

V¥ 15-4-2 Designate to skip
You can designate the stamps to skip in 2 ways.

Stamp Direct Operation

1. Open variation file. Move to the stamp to be skipped.

2. Select the stamp by mouse.

3. Select "Designate to skip" from Model Variation. The skip mark is displayed on the stamp
frame, and the frame will be skipped from inspection (Screen 1).

4. There is shortcut key "command + y" to do the same operation.

5. Skip can be reset by "Revert" from Model Variation.

Designate in Model Variation window

1. Open Model Variation window.
2. Check on the variation file name on left list (Screen 2).
* You can select all variation files by Check on All from pull-down at bottom left.
3. Check boxes for all Reference Designators will be shown on right. Check on the Reference

Designators which you want to skip the inspection (Screen 2).

15-4-2

>

(Screen 1)
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15-4-2

(Screen 2) (Screen 3)

4. As same as Stamp Direct Operation, the stamp will be designated to be skipped (Screen 3).

V¥ 15-4-3 Information that you can define in Variation Files

Even the PCBs are quite similar, there are some informations must be independent from the others. In

variation file, you can define below informations individually:

- PCB Number (barcode to open program) / LOT / NOTE [In Recently used programs]

- Inspection history [in Map View]

* It is not possible to have Map View or Virtual PCB map in variation file.

V¥ 15-4-4 Export skip setting in CSV file

You can export the skip setting to CSV file.
1. Open Model Variation window.
2. Check on the variation file name on left list.
3. Press Export button at bottom. CSV file will be output.
4. In CSV file, 0 represents Skip and 1 represents Not Skip.

* Only the Variation you had checked in Variation list will be exported.

V¥ 15-4-5 Import skip setting in CSV file

You can import the setting contents of Model Variation which is edited by external editor.

1. Open Model Variation window.

2. Click "Import" button in bottom screen, and select the file (.csv) which you want to import.

15-4-3

(Screen 1)

(Screen 2)
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3. File contents will be imported to the setting window of Model Variation.

4. Setting will be applied when clicking "OK".

*

All setting will be overwrote and displayed after import. If you want to keep the setting, please

export the file previously, and create the file for restoration.

*

This function is available from V4.9.6r2 or greater. CSV file which is created with prior version

cannot be imported.

WV 15-4-6 Practical Application

Model Variation is a function to designate the components to skip from inspection. However, you can

apply Model Variation to PCB on which “different component” is mounted.

On below example PCBs, the capacitors of different capacity are mounted. In such case, create
inspection program based on PCB A. Then paste the stamp for PCB C’s capacitors: overlap stamp for
grey capacitor onto stamp for brown capacitor.

(Below example image is slightly not overlapping, but it is for easier to understand. Actually, you should
paste stamp C exactly on stamp A))

After pasting stamps overlapped, it is difficult to designate to skip by direct operation. It is better to

designate from Model Variation window by check box.

V¥V 15-4-7 Limitations

* Model Variation is a function to define stamps to skip. Therefore, if you delete/add stamps in
variation file, it is reflected to the inspection program. By same reason, the file name to be displayed
to confirm the file save, is also the inspection program name (not variation file name.)

* This function is not possible to use if "Save all files at quitting (Enable RAM) is active.

* Saving inspection program as different name will duplicate variation files too.

* Variation file will be swaped also when executing A/B side sswap, however model variation will not

copied when executing Copy this side.

15-4-6

PCB: Model A PCB: Model C Paste stamp C
(Different components mounted) on stamp A
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16. Special Stamps and Functions

Some Stamps are called Special Stamps, and have special features. Special Stamps are displayed in
outline type in the Stamp list. Loading and other procedures for Special Stamps are the same as Stamps.

Special Stamps are included in Installation CD named StampLibVxxx.
Activate/Deactivate “Use Master Picture”

Normal stamps (pattern matching or histogram) always uses master pictures. Only stamp in Stamp List

has master pictures and the stamps pasted in Work Area are referring the master pictuers.

But there is an exception. Some special stamps (BlockMark, PanelBlockMark, TagetFrame, CellAid,
NewCellAid, Doughnut, SlitWidth, Scratch, AngleCheck, KadoSta) can deactivate "Use Master Picture",
and also is possible to activate. The default condition is deactive, because often these stamps are better
not to use master pictures. When "Use Master Picture" is deactive, each stamp pasted in Work Area has

individual master pictures.

To switch active/deactive "Use Master Picture", please click the small picture in Stamp List. When the

picture is fine, "Use Master Picture" is active. When the picture is blur, "Use Master Picture" is deactive.
16-1 CellAidStamp for Location Correction

(Since NewCellAid Stamp was introduced, CellAidStamp is now less used.) The fundamental concept of
PCB inspection is to compare the PCB with the Master PCB, but when the comparison sensitivity is too
high, slight warping or misalignments may be judged as NG. Therefore, this program has a special Stamp

called the CellAidStamp. When this Stamp is used, the characteristic points within the PCB are found first,

>
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16-1-1

(Screen 1) (Screen 2)

and the overall inspection screen (Cell) position will be given offset, then the inspection will start. With this

Stamp, PWBs (Printed Wired Board) can be inspected efficiently in one Inspection Program.

* CellAidStamp is used to adjust the offset by Cell units (in order to adjust the offset of the entire PCB,

use NewCellAidStamp).

* If there is a variance in light reflections, do not use this stamp because matching will not be stable.

V¥ 16-1-1 Using CellAidStamps

1.

Place the CellAidStamp in a place that will be the reference point of the inspection screen (Screen
1). The line surrounding the rectangle shows the range for Find. Images inside the frame will be
searched for within this range and they will become the reference point to provide offset for the

entire cell.

. Double-click on the frame to open settings. The range for Find is defined by “Enter cell find

range” (default value is 8 pixels).

. For screens containing the CellAidStamp, the CellAidStamp will be verified first before inspec-

tion. The CellAidStamp searches for a picture that matches the Master Picture. The position will
be corrected by taking the gap between the position of the picture found and the master’s posi-
tion, providing this as an offset to the frame positioned in the screen to be inspected. Offset can

be made inactive in the settings screen.

The CellAidStamp has a different shape than regular Inspection Frames. The line surrounding the rect-

angle designates the range for Search. This area can be changed by pixels in the dialog that is displayed

when you double-click on the Frame (normal value is 8 pixels) (Screen 2).
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16-2 NewCellAidStamp for Location Correction with Flexible PCBs

NewCellAidStamp is an extended version of CellAidStamp. It does not depend only on a characteristic
point image like the CellAidStamp. It provides offset for the entire PCB based on the initially stored char-
acteristics, which makes it capable of handling stability problems when setting PCBs (Screen 1). A cross
mark in the center of the frame when positioning the Stamp indicates that NewCellAidStamp is in use (this

will not be displayed with a CellAidStamp).

V¥ 16-2-1 The principle of NewCellAidStamp

NewCellAidStamp executes the offset by the following procedure (if there is a CellAidStamp, positioning

will be corrected first using the Cell Aid Stamp, then the NewCellAidStamp will be activated).

* The whole cell image is checked, and if offset is necessary, the correction amount, in pixels, is obtained.
e [f it differs greatly from the original image (for example, if the PCB type is different), it will fail for position
alignment.

¢ |f the Stamp contains a characteristic point, it is possible to adjust the position only using the Stamp pic-
ture in the NewCellAidStamp. In this case, the overall image will not be used.

e Store images includes a silk screen image. In order to correct the relative misalignment amounts be-
tween the silk screen image and the pattern, further tuning will be made using Inspection Frames con-
tained in the cell (more than 3 Inspection Frames with special characteristics and the appropriate size will
be necessary). If there are no silk screen images, or this adjustment is not necessary, this process can be

skipped.

To use these procedures efficiently, you may skip Fiducial Mark inspection, which may result in improved
tact time, and you may get virtual zero mechanical position differences, which may result in stable inspec-
tion results.

* If large corrections are made with this Stamp, the frames located at the edge of the screen may be
cut off from the offset and be judged as NG during inspection.

* This feature is screen-size dependent. Since data formats are different, there is no compatibility be-

tween different model of AOI. (Read/write is possible, but data will be initialized)

16-2
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(Screen 1)
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* Inspection time with CellAidStamp will not change much with machines. Processing may feel slow

depending on the CPU (inspection time varies by the number of cells).

V¥ 16-2-2 Use NewCellAidStamp

1. Load Stamp Library from Open Stamp File from the Stamp menu.
2. Place PCB to be the master. This Stamp should be positioned somewhere on a cell that does
not have Fiducial Marks or Marks for side recognitions on a completed Inspection Program
When a characteristic part is surrounded by a frame, you can use this Stamp as the characteristic point
(similar to the CellAidStamp) (however, when correction by Stamp is used, correction by overall image will
not be executed).
3. Select the NewCellAidStamp Frame and double-click on it. A pop-up menu will appear, so se-
lect the appropriate menu (Screen 2).
« When Use Stamp picture is checked, correction will be made only by the characteristic points within
the NewCellAidStamp frame.
* Under Use stamp picture, there is an option Enable Angle Offset (Angle Offset Impossible). This is a
special option, and normally do not use.
* When you activate “Correct Angle too with AngleCheck stamp”, shifting of component during the
inspection is corrected with X-Y direction and rotating direction. Corrected value will be shown in
NweCellAid Stamp by the order of X, Y, 0 after inspection. Please create the Stamp with follwing

procedure before activating this function.

- Move the camera to the position which the offset center of the rotation will be placed in
the center of the screen.

- Place AngleCheck Stamp, and place NewCellAid Stamp surrounding AngleCheck Stamp (Screen 3).
Please use AngleCheck Stamp with no angle shifting since the image in AngleCheck Stamp is used
for offset value.

- After placing, select and put check mark on ”"Correct Angle too with AngleCheck stamp” in
the setting of NewCellAid Stamp.

* This function corrects the angle after X-Y offset.
* AngleCheck Stamp is placed for setting angle offset of NewCellAid Stamp, not for angle shifting
inspection.

* When Apply to all cells is selected, the same NewCellAidStamp Frame will be positioned to all cells

except cells with CellAidStamp, Fiducial Marks and Marks for side recognition.

16-2-2

(Screen 2)
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16-2-2

Angle Check Stamp

(Screen 3)

N

Correct Angle too with AngleCheck Stamp (No correction) Correct Angle too with AngleCheck Stamp (After correction)

+ Correction by positioned Inspection Frame (Trigger by inspection frame) and correction by

Stamp picture (Use stamp picture) can be all set at once from Trigger by inspection frames

and Use stamp pictures.

. Press the stop button on the machine or on the screen, and then press the inspection start

button. Characteristic Data will be extracted while inspection is being run. When Speed Prior-
ity is selected in the configuration, this setting will be removed temporarily, making the process
extremely slow. This is because it attempts to obtain an accurate image by waiting for the ma-

chine to completely stop vibrating. The actual data creation does not take very much time.

. During Characteristic Data extraction, an error message, “Insufficient positioning triggers re-

quired correction” may be displayed, causing the software to pause. You can ignore this and
press start, but if possible, move the frame to a distinguishable place before starting. In this
case, avoid silk screen areas. If overall adjustments do not work well, the picture in the Stamp
will be used for recovery (this feature can be utilized effectively if Stamps are set up to include

characteristic points).

. The process is complete if inspection can be executed. Just in case, make sure that the New-

CellAidStamp is placed in an appropriate position for correction.

V¥ 16-2-3 Appearance

The NewCellAidStamp Frames will differ in appearance depending on the status (Screen 4).

1.

When the center icon is gray, there is no picture stored in this frame. This is how the Frame will

200

16.Special Stamps and Functions



look when Update including stamp picture is selected.

. When the center icon is blue, the frame stores picture data. Since the picture inside of the frame

is not characteristic, corrections cannot be made by the picture in the Stamp.

. Since the frame contains a characteristic point, an antenna icon is shown on the upper part of

the frame. Correction by Stamp pictures is possible (however, turning this feature ON will dis-
able correction by the overall picture). Even if there are characteristics, if the frame size is too
small, it will be considered unstable, thus the antenna will not appear, and corrections to Stamp

pictures cannot be made.

. The rounded corners indicate that Trigger by inspection frames is active. Normally, correction

by overall characteristic detection will be sufficiently accurate, but the relative position of the
silk screen image (white letters printed on the PCB) will be misaligned in many cases. However,
since this silk screen is considered to be a characteristic in this program, printed letters or en-
closure lines may be judged to be misaligned. By selecting Trigger by inspection frames, the

Inspection Frames will be actively adjusted by the saved Master Picture, avoiding this problem.

. After inspection. The background of the letters of the corrected values will be shown in red.

This means that since overall characteristic detection was not good enough, it was inspected
more strictly. If you see this often, move the frame position a little. By doing so, the Character-
istic Data will be updated. However, it is not recommended to frequently update Characteristic

Data by moving or changing sizes.

. This status is after inspection. The background of the corrected value letters will be shown in

green. This means that since the overall correction was not good enough, correction was made

by the picture of the NewCellAidStamp.

7. This status is after inspection. This shows that position correction was attempted using various

methods, but the process failed. This means that the PCB is totally different, or the characteris-

tic points are not found.

. When positional correction has failed, the component(s) that are out of alignment will be shown

with a red line.

16-2-3

(Screen 4)
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9. When the center icon turns yellow, it means that the NewCellAidStamp is turned off . You can
toggle on/off all NewCellAidStamps at once by checking on/off Position correction active.
This is generally used to confirm the effects of the NewCellAidStamp.

10. The antenna mark in the upper part of the frame designates the characteristics level. This
figure is a “bad” example since it is a picture of silk screen characters, but since the picture is

characteristic, the characteristic level is 3.

V¥ 16-2-4 Other Functions

When you press the Command key while the NewCellAidStamp Frame is displayed and placed the mouse
pointer on the frame, the status of this Stamp can be confirmed in real-time.

* With solder print inspection, it may be better to set Trigger by inspection frames off and choose
Use stamp pictures in some cases. This is because the printed solder section may be corrected and
it may be unable to detect overall print misalignment.

* The current maximum correction offset is +/- 24 pixels with normal models and +/- 16 pixels with
VGA size camera models.

In millimeters, maximum correction will be +/- 0.4mm with 10x screen models.

* The Master Picture will be used only when a Search Antenna is displayed, in this case, only the first

Master Picture will be used.

16-3 ICLeadGap Stamp

ICLeadGap Stamp is a Special Stamp for Detection of Solder Shorts/bridges between IC leads (ICLeadGap
Stamp) This Stamp does not search for locations or compare with pictures. Detection is made by a totally
different method. To change settings, after positioning ICLeadGap Stamp (Screen 1), double-click on the
frame and display the Lead gap inspection setting window.

* Can’t use for the component with 2 leads (more than 3 leads required).

16-3

(Screen 1) (Screen 2)
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V¥ 16-3-1 Lead gap inspection setting Window

The following items can be set in the Lead gap inspection setting window (Screen 2).

H Short detection

This is a level setting for the binarisation of the lead gaps area.

H Lead detection

This is a level setting for the binarisation of the lead area. The lever should be set so that white will be the

lead and black will be the gap.

M 2 pixel pass

A green line passes through the gap between leads. This line can pass through a 1 dot (pixel) gap. When
the lead gaps have been binarised in black and white and there is a 1 dot gap, this can be filled to prevent
the green line from passing and judging as a defect with the 2 pixel pass check box. You can detect Sol-

der shorts more strictly with this feature.

H Blur leads

Leads and lead gaps contain a lot of noise, causing false reports. By blurring leads, the noise can be
reduced using software processing. However, since the blur process is slow, it should be kept to a mini-

mum.

H Auto Brightness

There will be differences in brightness in the overall inspection area at set up time and at actual inspection
time, which may affect the detection level and make it unstable. Auto Brightness will stabilize the bright-
ness of the Inspection Area, thus reducing variances in detection level. However, since the detection level

differs significantly when this setting is applied, check this item first before moving on to other settings.

H Glue leads

When setting the intensity of stripes (the leads and the lead gaps), the lead may split into two parts. This
happens because the entire lead does not shine, and the center is projected as a black shadow. This fea-

ture unites split leads and deletes fine white lines shown as a noise.

M Reduce flux

If there remains much flux on the PCB, the Stamp recognizes the flux’s white reflection as a lead. In such

cases, check this on. Reduce flux recognizes the flux and subtracts it. However, it will increase the inspec-
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tion tolerance and, as a result, the solder dust between the leads can be passed over.

Hl Reduce pattern

If there are patterns in IC lead gaps, the pattern color will be eliminated to improve detection accuracy. Do
not use this setting for PCBs without patterns.

This option has one more function, when component color is white (bright), IC Lead Gap stamp tends to
detects the white area as short when component is slightly shifted. By activating this option, this false de-

tection is prevented. Activate this for white body color components.

M Integrate Lead

Dirt or roughness on the surface of IC leads may cause 1 lead to appear as if it is split into 2, this increas-

es the blur level. However, increasing this too much will prevent lead detection, resulting in false reports.

H Detour limit

Even though there may be some white spots (solder or noise) on the green line passing through leads, if
there is enough space for the line to pass through, it can detour such spots. Normally, it will be judged as
good area if the line can reach from the starting point to the end point even with detours. It is also possible
to judge the area as bad if a straight line cannot pass without detours. It is also possible to judge as good
if there is any gap whatsoever. These settings can be defined here. The default value is 5 (up to 5 direction

changes). The minimum value is O (straight line only) and the maximum is F (no limit).

Bl Max pitch diff.

Since a solder bridge is detected by lead gaps and their positions, if the lead gap is completely filled with
solder, the lead gap cannot be detected. In such cases, judgment can be made by distinguishing a lead
gap pitch that clearly differs from an average lead gap pitch. The default value is 50% (ex: if average pitch

is 12, with pitch 18 and higher or 6 and lower set as NG), and the range is from 50 to 20.

H Test corner shorts

Inspection can be executed even if the leads at both ends have completely bridged and may appear to be

1 lead.

M Include fillet check

In order to execute solder bridge detection and fillet check simultaneously, it is not necessary to set a Fil-
let Inspection Frame to every lead. Check this box and it will find 1 Fillet Inspection Frame contained in the
ICLeadGapStamp Stamp, apply that to all leads to run inspection. Only 1 fillet inspection frame needs to

be positioned, and the zoom property must be the same.
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H Count gaps

Check this to count the number of gaps after setting the Stamp. The number will also be checked con-
stantly during inspection. For example, if 2 leads bridge and appear to be 1 lead, the number will be differ-

ent, and be judged as NG.

H Continuous testing

The moment the picture was taken is not necessarily the best condition. Even with the same area, the im-
age changes gradually. By checking this box, an average setting can be applied to the gradually changing

conditions, enabling the optimum settings at inspection time.

l Camera Special Setting

For leads and flux reflections varies, the defect can be seen easier when capturing the image by chang-
ing camera conditions by using camera special settings. See chapter 20-2. You can also switch lighting
by pressing this button with option key if your AQI has lighting selection. This will be effective specially for
white PCB by using DOAL light.

* Since this is designed for IC lead gap inspection, it cannot be used for other purposes.

* If there are NGs in this Stamps, solder bridge areas will be shown on the screen in red circles in Map
View. You cannot compare the picture with Master Picture

* If the component’s body color is light, activate Reduce Pattern for preventing false detection.

* A complete bridge (lead gap filled up) will be detected as a lead pitch error (+/- 50%). Therefore, de-
tection accuracy will be lower than the conventional matching method.

* If silk screen is printed in the IC lead gaps area, detection by ICLeadGapStamp may be difficult.

* When the Stamp is positioned at a slanted angle, the solder bridge of the inspection result and the
displayed Fillet Inspection Frames may appear different from the actual components. In this case, the
bridge display can be corrected using the arrow button which may be added in the Lead gap inspec-
tion setting window when rotated. The Fillet Inspection Frame can be corrected using the Re-inspec-

tion Button.

16-4 Stamp for Solder Bridge detection

Solder bridge detection stamp is a stamp specialized in the bridge detection. It is effective for the
following cases.
- False calls with ICLeadGap Stamp and Doughnut Stamp when silk screen is printed around
through hole or between the leads of SOP , QFP, etc.
- False calls with Doughnut Stamp when inspecting bridged through hole.

- When you want to detect solder bridge between the components which cannot handle with
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Doughnut Stamp.

V¥ 16-4-1 How to use

Draw the frame with pointer tool, and start Stamp Creation Wizard for Beginners. "SolderBridge Settings"
window will appear when you select "Solder bridge detection". Place long and narrow window in the
center between two points for making the frame. It is detected as bridge when the solder exist across the

shorter side of the window.

V¥ 16-4-2 Description of window

H Settings
1. Light selection
Set the lighting for inspection. Need to select the different color for solder and its surrounding.
2. Less sensitive
Decrease sensor for detecting solder. Default value 16% is the most strict setting.
If you do not want to detect too small solder, increase this value.
3. Target color
Designate the color of solder for inspection. Red is selected for AOI model which has “White
main lighting + Red side lighting + DOAL lighting” configuration which uses Red lighting as
side lighting. Blue is selected for AOI model which has “RGB lighting + DOAL lighting”
configuration which uses Blue lighting .
H Color Reduction
1. Light selection
Set the lighting for inspection. Select the lighting which is easy to see the point which you do

not want to recognize as solder.

16-4-2
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2. Color pickup
Designate the exclusion color for inspection. Press color selection button, and the mouse cursor
becomes color picker. Drag the mouse onto the color in the stamp frame. By dragging,
the selected color will be painted in blue. Tolerance increases with more painted area if you drag
wide area. Exclusion color and tolerance will be shown at right side in Advanced setting window.
You can select maximum of 100 colors for exclusion color. If you have unnecessary color, click
trash can icon to delete.

3. Pixel expansion
You can extend the painted area by increasing the minimum number of pixels for painting.
You can use this function if the tolerance is too wide for color reduction variance, and failed to
detect the bridge.

4, Test
Check the present condition. Point with Bridge is displayed in red color, and other target color
is displayed in blue or green.

* Thin Bridge cannot be detected with actual size for few numbers of pixels. Zoom the Stamp
when you detect the thin Bridge. To zoom the Stamp, you need to register new Stamp by clicking

Revising Stamps button after selecting inspection frame, and click “Flip zoom/un-zoom” from

Z00m menu.
16-5-1
(Screen 1)
(Screen 2)
(Screen 3) (Screen 4)
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16-5 Special Blockmark Stamp

PanelBlockMark stamp

Stamp for handling bad mark to skip the inspection of useless panel(s) on PCB.

V¥ 16-5-1 How to use PanelBlockMark stamp

1.

Create Block Cells. When the Cells are grouped in Block, the Block is automatically set number

from 1,2...(Screen 1)

. Place PanelBlockMark stamp at the point where to check bad mark. Save master picture in

the stamp (Screen 2).

. Double-click on PanelBlockMark stamp and open sub-menu. Confirm if TargetBlock is

checked, then input applicable Block number by selecting Setting Number (Screen 3).
* Set filter if necessary by selecting Setting Filter.

. Start inspection. Block (s) that is checked as bad will not be inspected. (In Screen 4, No.4

yellow Block was not inspected because red bad seal was marked so that PanelBlockMark was

judged as NG)

V¥ 16-5-2 TargetFrame stamp

When there are more than 1 panels in a Cell (FoV), it is effective to use TargetFrame togather with

PanelBlockMark.

V¥ 16-5-3 How to use TargetFrame stamp

1. Place TargetFrame in Work Area, and resize to fit the panel size (see blue frames in below

picture). If the panel lies in multiple Cells, place TargetFrame in each Cell (Screen 1). Double-
click on TargetFrame, then sub-menu as TargetFrameNumber is displayed. Input number other
than 0 (Screen 2). If you place multiple TargetFrames for one panel, set them all the same

number.

16-5-3

(Screen 1) (Screen 2)
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2. Place PanelBlockMark on bad marking point. Save master picture in the stamp.

3. Double-click on PanelBlockMark stamp and open sub-menu. Switch the check of TargetBlock
to TargetFrame by clicking, then input applicable TargetFrame number by selecting Setting
Number.

* Set filter of PanelBlockMark stamp if necessary by selecting Setting Filter.
4. Start inspection. Within TargetFrame (s) is not inspected if the corresponding PanelBlockMark

is judged as NG.

16-6 Stamp for Measuring Angle to Check Theta Rotation

AngleCheck stamp

Stamp for detecting components’ position shifting and rotating.
This stamp can obviously catch slight rotation of components that used to be difficult to find by pattern

matching or histogram algorithm. Setting is very easy.

* Power Mac G5 or earlier Mac (without Intel processor) can not use this stamp.

* NG points can not be confirmed in NG Cell View mode.

* AngleCheck stamp is included in StampLibV440.

* Without using this stamp, you can measure angle by new function in Pack stamp too. For detail,

please refer Chapter 2. New Function for Pack Stamp (Measure Angle)

16-6-1

(Screen 1) (Screen 2) (Screen 3)

(Screen 4) (Screen 5) (Screen 6)
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V¥ 16-6-1 How to use

1. Load AngleCheck stamp (Screen 1).
2. Place the stamp on area where you want to detect angle. Resize the stamp to fit the target area.
When resizing, the direction to measure angle should be longer than the other side (Screen 2).

This stamp measures the angle of longer side of rectangle.

3. Double-click the stamp, list of the limit of angle from Non (no measurement), 0.5, 1.0...6.0
degrees will be shown. Select the limit (Screen 3). If you select "mylimit" function, voluntary
angle setup window will appear, and you can set the angle in 0.1 steps from 0.1 to 6.0 (Screen 4).
For the machine with DOAL lighting, DOAL is displayed for selection. When you select DOAL,
switching of main lighting and DOAL lighting is possible, so please use the function depend on
the place and parts.

4. Start inspection.

5. The component which exceeds angle limit is judged Not Good and angle is shown (Screen 5).
Angle is shown with minus (-) when component rotates in clock-wise.

6. You can even know the angle of good component by executing re-inspect or analyze. Result

will be displayed in message bar (Screen 6).

V¥ 16-6-2 Include in Pack Stamp

If AngleCheck stamp is in Pack stamp (Screen 1), the list of angle limit can be selected from

16-6-2

+

(Screen 1)

(Screen 3)

(Screen 2)
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Pack window (Screen 2). In addition, option settings for detecting angle can be selectable

(Screen 3). For detail of this option settings, please refer the chapter 10-10.

V¥ 16-6-3 Notice

- If the size of AngleCheck stamp is too small, it can't be measured. At least 36 pixels are
required for each side of the rectangle. (To convert in millimeter, approx. 0.9mm with 25 micron
lens, 0.7mm with 18.8 micron lens and 0.35mm with 10 micron lens.) When stamp size is too
small, the line color of the stamp will be faint.

If inspection starts in this condition, the angle limiti will compulsory be Non, and inspection
result will be "Could not detect angle"(Screen 1).

Enlarge stamp, then set angle limit again.

- Angle is result from measuring line which is abstracted the difference of brightness in the frame.
If there is no difference found, the result will be "Could not detect angle". You can confirm the
failure reason by analyzing stamp (Screen 2).

- If AngleCheck stamp can detect more than one line to measure, the line more bright and clear
will be the measurement target (Screen 3). Resize the stamp for correct inspection.

- AngleCheck stamp requires 15 Ms per inspection point. However, the calculation is carried out

in the other thread. Therefore, this will not affect to inspection speed much. (Our experiment

16-6-3

(Screen 1)

)

analyze

(Screen 2)

> >

analyze analyze

(Screen 3)
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shows, when 87 inspection points required 6.92 seconds, added AngleCheck stamp on each
point, the inspection speed for total 174 points was 7.32 seconds.)

- It is possible to include more than one AngleCheck stamp in Pack stamp. However, it does
not mean that all area will be measured. Only one voluntary stamp will be the measurement
target.

- Angle limit can be set in 0.5 steps, however actual measurement accuracy is 0.08 degree.

V¥ 16-6-4 Caution

This stamp is slightly different from the ordinary stamp.

- Do not adjust the position by master picture.

- Do not search position with master picture, do not have more than one master picture, do not
have reversing picture, because this stamp is not using pattern matching algorithm.

- Unable to set Search Area /Area Limit.

- Can be included in Pack stamp, however the setting window can not be opened from filter
button in Pack setting window.

- Not possible to set mask.

- Do not follow Pack Master in Pack Stamp.

- NG pictures of AngleStamp are not sent to Rc22X/CS-Center when using NG Cell View or

Auto send for all NG in faster mode.

16-7 Stamp for Wave Soldering Through Hole

Doughnut stamp

Exclusive stamp for detecting solder bridging between through-holes or leads, and detecting no
solder area on the pad, or inspecting solder fillet and existance of lead for wave soldering PCB

without complex settings.

* For DL, HDL, HML model only (AOI with LED lighting). The function "inspect solder fillet and lead"
is not possible on DL, and less accurate on HDL because Criterion of Solder and Lead is made by
analyzing RGB color elements, thus AOI with RGB+DOAL light is the best AOI for this function. HDL
type with White + Red + DOAL LED can also use this function, however the detection ability is much
lower.

* Detection may not work proper on the customized U22X-HML machines which RGB lighting position

is reversing (normally RGB, but is BGR).
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16-7-1

(Screen 1)
(Screen 2)
Q | o
)

(Screen 4

V¥ 16-7-1 Detect bridging

1. Paste Doughnut stamp on through hole. Resize the stamp to fit the hole size (Screen 1).

2. You can start inspection.

3. If the stamp escapes defects or too many false calls, double-click the stamp and adjust settings

(Screen 2).

H Test button

Show how solder is detected. Solder area is colored in Blue or Red (depend on model). White area is no

solder area 'Screen 3).
H Detection Area
By moving lever up, detection area is increased (Screen 4). (Ring of detection area becomes wider.)

H Less Sensitive

Decrease sensor for detecting solder. Default value 16% is the most strict setting. If you do not want to

detect too small solder, increase this.
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H6-7-1 Flux refrects as solder,
however red solder area does
not go through the ring. Thus
inspection result is Good.
Too much flux
Red area (solder) goes completely
through the ring. The line is shown
* in green.
Bridge to next hole
(Screen 5)
(Screen 6) (Screen 6)
Detect stable bridge only : OK Detect stable bridge only : OK Detect stable bridge only : NG
Detect all bridge 10K Detect all bridge :NG Detect all bridge :NG
H Area threshold

Represent % of solder area to be NG out of total area. Default value 1% is the most strict setting. If you

increase %, more solder is necessary to be NG, as a result, detecting setting will be tolerant.

W Target color

Normally this is automatically selected according to AOI's type. Red will be selected for DL/HDL models,
and Blue will be selected for HML model. However, if your AOI’s illumination is special model, change

color to fit your AQI.

W Detect stable bridge only

This is an option when you just want to detect bridge which is making two through holes be definete short
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circuit. This is useful in case solder amount/shape is unstable but still good, or in case flux is reflecting as

solder (Screen 5).

l Detect all bridge

If you put check and activate the function, all status which lead from the periphery to an inner periphery is
detectable as bridge (NG). (Screen 6)
* This "Detect all bridge" function cannot be used with "Detect stable bridge only" function. You can

only set either function.

W Deactivate bridge detection

Detection for short of leads is not executed. Check this on when you only want to detect "No Solder Area"

and execute "Inspect solder fillet and pin".

B Inspect solder fillet and pin

Inspect the solder fillet of through hole and existance of lead. Detail is described in Chapter 16-6-3.

H Solder area

The result % is shown when pressing Test button. If the result is good, shown in blue color, if not good,

shown in red color.

Bl Mask1 / Mask2 / No Solder

You can set mask (non inspection area) to the direction of pin. Mask can be set 2 directions (Screen 6).

Angle: Selectable from 0 (no mask) to 180 degrees.

16-7-2

Analyze *

(Screen 3)

Area colored in red is no solder on pad

(Screen 1) (Screen 2)

(Screen 4)
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Direction: Set direction to mask. 12 o’clock is O degree. Selectable from -180 to +180 degrees.
* Picture shows the example of masking when pin is down to the direction of 12 o'clock.

The detail is described below about No Solder tab.

H Default

Clear setting and get back to the default value.

V¥ 16-7-2 Detect No Solder

By new lighting combining and color arithmetic, no solder area is easily detected without complicated
tune-up. This stamp is especially ‘must to have’ item for users who have U22X-HML for inspecting wave
soldering PCB. Because, if histogram inspection method is used for detecting no solder, it is sometimes,
depend on pad color, very hard to see the difference between no solder pad color and less solder color
(Screen 1).

1. Place Doughnut stamp on a through-hole. Resize to fit the through-hole.

2. Select No Solder tab, check Enable on. Do not adjust settings at this timing.

3. Place this stamp to all through-holes on the PCB. Start inspection.

4. If lead passes through straightly in the center, and the edge of the lead is not wet, this will be
detected as no solder area. If you want to exclude this, activate "Exclude red colored area in
master pictures" (Screen 3).

5. After the inspection, if there is missing defect or false call, adjust as below technics.

* The smallest detection size is 4 pixels.

16-7-2

(Screen 6) (Screen 7)

(Screen 5)

(Screen 8) (Screen 9)
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Hidden Technique

On many flow soldering process PCB, there are various size of through-holes and fillets. You may
create multiple Doughnut stamps in different names such as "Big through-hole", "Medium through-
hole", etc. If there are false calls on "Big through-hole" and improve its setting, you may like to apply
the change to the other Doughnut stamps. On the other hand, it is time consuming to change the

setting one by one.

If you like to apply the change to all Doughnut stamps, press OK button with option key (Be
careful, you must press OK button while opening No Solder tab). Then, a message appear, and the

change will be applied to all Doughnut type stamp in the program.

* When "Exclude red colored area in master picture" is active, if there is real no solder area, this will

be escapiing from detection. Thus be careful when activating this function.

[How to treat escaping defects / false calls]

1. When_escaping large area of no solder on the pad, Doughnut may not detect the color of the

pad successfully. Slide the contrast lever next to Enable check-box from 0 to 5 - 10 (Screen
4). (This adjustment solves escaping problem especially when the pad color is not bright red,
instead dark or rather beige.)
If no solder area is still not detected, change Level of sensitivity from 65% to 70-80%.
When no solder area is slightly found by increasing any of contrast or sensitivity, increase the
effective lever until no solder area is clearly detected.

* M/L 22X-DL/HDL type and U22X-HDL type does not have the contrast leve. Adjust with sensitivity

Level.

2. When escaping small area of no solder, change Minimum size from 0.5 to 0.4-0.2mm. Then

small non soldering area will be detected as well (Screen 5).
3. On the other hand, if the line allows slight no solder area, expand the Minimum size.

4. When there are false calls caused by detecting thin soldered area, decrease contrast lever

next to Enable check-box from 0 to -5 or -10. If this does not improve the false calls, decrease

sensitivity Level from 65% to 55-50%.

217

16.Special Stamps and Functions




[Extending usage]

The area other than through-hole pad can be also insufficient soldered in the wave soldering process.

Here we show to apply Doughnut stamp to detect the no solder of component’s fillet.

1. Normally Doughnut stamp is Oval shape (Screen 6), but you can change its shape to square by
checking Rectangle on (Screen 7).

2. Resize the frame to fit the fillet size (Screen 8).

3. If the bridging detection is unnecessary, set Mask1 and Mask2 to make masking 360 degrees

(Screen 9), then bridging detection will be ignored.

V¥ 16-7-3 Solder fillet and lead inspection

The obvious defects such as below samples can now be detected by doughnut stamp.

16-7-3
(Blowhole)
(No Lead) (No Lead and No Solder)
(Screen 3)
(Screen 1) (Screen 2)
(Screen 4)
(Screen 5)
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[How to use]

1. Place Doughnut stamp on a through-hole. Resize to fit the through-hole (Screen 1).

2. Double-click the stamp, and open the settings window. Check on "Inspect solder fillet and
pin". The "solder fillet area" and "lead area" will be painted (in the sample picture, they are
painted in dark pink and blue). (Screen 2)

. Shrink the bridge "Detection area" as less as possible when enabling Solder fillet and Lead
inspection. Also, resize the stamp size as close as to be the TH size. If unnecessary area is included,

the inspection result may be incorrect.

3. Assign the master picture (Screen 3). Update stamp and save in new name.
* Master picture was not necessary for doughnut stamp in previous version. But for solder fillet and
lead inspection, the criterion is depend on the RGB color elements of master picture, therefore master
picture must be used and it is important factor.

4. Paste doughnut stamp to all holes. Start inspection.

5. There will be many false calls after inspection, because the shape of TH solder fillet varies.

Debug them in following procedure.

[Debugging]
16-7-3
(Screen 6)
l Analyze (Screen 7)
(Screen 8)

Result of "No Solder" is shown Result of "Fillet and Lead" is shown

when "No Solder" is inactive

=)

Addint defect picture can
prevent escaping of defect

(Screen 9)
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For killing false calls, add a few master pictures. The reason is because criterion is made by RGB
colors of master picture (Screen 4)

Doughnut stamp is using master picture, however, it is not copying pattern matching algorithm. Our
pattern matching algorithnm is, to divide frame by grid and make small squares of pixels, then compare the
squares to the ones of good master pictures. In doughnut stamp, area is not divided by grid, therefore

false calls will be improved by adding less pictures than pattern matching stamp.

* With HDL type illumination, the color is gray scale. You may have to add as much pictures as

pattern matching frame to Kill false calls.

You can also use NG master picture.(Screen 5) By adding NG master picture, the similar defect can be
certainly found. When creating the inspection program, use the PCB with defects so that better inspection

program will be made.

[Explanations in detail]

- Solder fillet and lead is not inspected if the TH is detected NG by "bridge".

- When executing analyze/re-inspection, the inspection result of "No Solder" is shown and
the result of "Solder fillet and lead" can't be shown. If "No Solder" inspection is inactive, the
result of "Solder fillet and lead" will be shown (Screen 6). Nevertheless, the inspection result of

"Solder fillet and lead"_just shows the tendency of color, means the color does not represent

the status of OK/NG, and even can't be used for debugging.

- With HDL type illumination, the detection algorithm is different. Therefore when showing the
result of "Solder fillet and lead", the shapes of solder is shown by edge filter, too (Screen 7).

- There is a way to see the inspection process of "Solder filet and lead" even "No Solder" is
enabled. Open settings window, select Mask 1 or Mask 2 tab and press Test button. If you are
in No Solder tab, the inspection process of "No Solder" will be shown.

- When the lead is not straight-up in the center, is bent, in such case the fillet shape would be
even vary and can be similar to the defect one. If you use "Solder fillet and lead inspection" on
such lead-bent TH, there is possibility that defect can escape (Screen 8).

- With HDL type illumination, if the brightness of the combination of fillet area and lead area is
similar, even the obvious defect can escape. Test those defects by debugging with defect PCB,

and if any defect escapes, add as NG master picture (Screen 9).

V¥ 16-7-4 Caution

This stamp is slightly different from the ordinary stamp.
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- Do not search position with master picture,

- Do not have more than one master picture and do not have reversing picture, because this
stamp is not using pattern matching algorithm.

- Unable to set Search Area /Area Limit.

- Can be included in Pack stamp, however the setting window can not be opened from filter

button in Pack setting window.

16-8 Stamp for Detecting Scratch/Stain/Crack/Solder Ball

Scratch stamp

Exclusive stamp for detecting stain/solder balls on ceramic board or pad, insufficient of gold pattern, or
scratch/crack of package components without complex settings.

There are 2 approaches; Detect foreign object by automatic binarizing in the frame, or detect foreign
object in selection color area. In case the area in the frame is mono color and the area is not tend to
shift position, automatic binarizing method is recommended for its setting is easier. In case the area in
the frame is including more than one color or the area is tend to shift position, selection color method is

recommended. Selection color method has Normal and Advanced mode.

16-8-1

Automatic binarizing and
color selection + +

(PCB color is false detected) (PCB color ignored)

3

(Screen 1)

(Screen 3)

(Screen 2)
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V¥ 16-8-1 How to use
[Automatic Binarizing Method]

1. Place the stamp on target. Resize the stamp to fit the target size (Screen 1).
It is better that target has real defect, so that adjustment will be easier.

2. Mask the area which will affect to the inspection (Screen 2). Scratch stamp detects defects
by comparing brightness per pixel, thus black text on white ceramics or white text/polarity on
black package component should be masked.

* Set mask larger than usual. If mask size is tight, false calls occur when PCB size slightly

changed or position changed.

3. Double-click stamp’s frame, setting window will be open. Input minimum and maximum size to
be found as defect. Press test button to confirm if the scratch is found. Start inspection (Screen
3). Area found as scratch/stain is shown with red frame.If the target is not found or too many
false calls, switch detection mode from Auto to Manual.Check-off Auto detection, then you
can slide bar for Manual detection. Find the best level by sliding the bar right to left, where
target is stably found and slight PCB color difference and camera noise is ignored.

4. Start inspection.

[Color Selection Method (Normal) ]

1. Press color selection button, the mouse cursor becomes color picker. Drag the mouse onto the
color in the stamp frame. By dragging, the selected color will be painted in blue. The painted area

is the target to measure.

2. Please pay attention to select color; target area must be painted evenly without including
unnecessary color. (Screen 4) By dragging mouse larger, the area painted in blue will be

increased. (If it is not possible to paint the target in blue evenly, the inspection result will be

b F'wr" : -Scr:.ntl:h "_-T:I:I:Lm-g y
MLl Advanced Al Thefaull
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wisisun: {0010 | gl oo
- L Side lighting
(Not Evenly) (Evenly) Madmum .00 e ol DO
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unstable. In such case, Scratch stamp may not be optimum method for your inspection)

3. To reset the color, click in the area other than inside stamp's frame by color picker. After color

selection is reset, the inspection method reverts to binarizing method.

4. In color selection mode, if you switch illumination other than Default, "Auto detection" is not
possible to use. With other illumination such as DOAL or Side Lighting, the edge between PCB
and pad is tend to be blurred or have more color gradation, and it is too difficult to find good

balance by automatic. Thus, you need to adjust manually (Screen 5).

[Color Selection Method (Advanced) ]

With Advanced mode, you can select maximum 100 colors though Normal method is only 1 color
possible. Also possible to designate exception colors.Moreover, if defect area is at the edge of the
inspection target area, it used to be quite difficult to detect because color near the edge blurred. Now it is

compared with good master picture to find the defect.

1. Switch to Advanced tab (Screen 6). Press color selection button, the mouse cursor becomes
color picker. Drag the mouse onto the color in the stamp frame. By dragging, the selected color
will be painted in blue. The painted area is the target to measure.

* When tolerance exceeds 25 to 30, tiny object or object in similar color won't be detected. Do

not increase tolerance instead add color.

2. By checking on 'N', you can designate sampled color as exclusion color. Inspection target color
will be painted in blue, and exclusion color will be painted in red (Screen 7).
* Because area painted by exclusion color is as same as masked area (non-inspection area),

defect in this area is not detected.

16-8-1

(Screen 6) (Screen 7)

223

16.Special Stamps and Functions




By activating "N checkbox for color list in Scratch designates NG color" in Action tab of For
Supervisors menu will change Exclusion color to NG color. Designating NG color will be useful

when you already know the defective color such as detecting the splash of bond on pad.

3. When using Advanced method, the stamp should be applied "Use Master Picture". Without

applying "Use Master Picture", inspection will be less strict.

4. If the tolerance of color is too wide, defect will escape. The text color of tolerance becomes

brown at over 25, and becomes red at over 40. Confirm the risk of escaping by text color, and it

is better to add new color than increasing color tolerance.

5. If there is color difference between the current PCB and master PCB, false calls will occur.
In such case, open settings window and press "Test" button. Confirm if there isn't area not

painted in blue. If there is non painted area, sample the area and add as new color.

[Color Selection Method (Area) ]

In version 4.9.9 or later, "Area" tab can be selected. This function judges whether the area of the domain
painted with the specified color has more area than set value (%).
1. Open Scratch Setting window, and click “Area” tab.

2. Input the setting value in percent (%) for “Area”.

Color Selection Method (Area)

(Screen 2)

(Screen 1)

(Screen 3)
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3. Click “Color Pickup” button, and display color picker. Drag the mouse on target color within

inspection frame. Colored area will be the inspection target.

Practical application 1

When you specify the color of target component, and if there is more area than set value, it is possible
to set the judgment result as Good. Function can be used for large area inspection such as component

presence. (Screen 1)

Practical application 2

Activate “detect each area” when you want to inspect smaller inspection area, such as stain and crack

at the surface of ceramics or blow hole, and splash of solder on pad before solder coating to special
package component. You can also execute the inspection by NG color when you activate “N” (NG is

OK) of specified color. (Screen 2)

You can refer to following image as example to detect small NG point from wide inspection area. If you do
not activate “detect each area”, the detection area will be small and causes escape.

Please select appropriate setting depend on the target to inspect. (Screen 3)

V¥V 16-8-2 Notice

- Resolution of 10 micron lens is required to detect object less than 0.2mm.

- Set search area when PCB tends to shift position.

- Use zoomed frame if tiny defective object is escaped. non-zoomed frame has less resolution.

- Inputting too small/big value in minimum/maximum fields will give bad influence to inspection
because this can cause many false calls.

- Scratch stamp finds all defective foreign object, however maximum 100 points can be
displayed with red NG frames. If there are more than 100 objects, some may not be displayed
with red NG frame.

- In Normal color selection mode, software tries to detect "foreign object" in the selected color
area. Therefore, "Large splash (more than the half of pad area)", "Mark made by paint", or

"Symmetric object" won't be detected.

V¥ 16-8-3 Settings Menu

1. Minimum
Set minimum size to be detected (either height or width).

The size less than this value will be ignored.
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2. Maximum
Set maximum size to be detected (either height or width).
The size more than this value will be ignored.
3. Color Selection button
Select color when detecting by Color Selection Method.
4. Result
Result of test or analyzing is shown. If the result is Good, shown in blue color, and if the result is
Not Good, shown in red color.
5. Angle
Enable to rotate frame from -180 to +180 degrees. By pressing up/down button, rotate by 15
degrees step.
6. test
Do inspection, during testing, the analyzing process is shown for 1 or 2 seconds.
7. Edit Mask
8. light
AOI with multiple lighting models can change lighting.
9. Auto detection
Checked on default. Detect scratch/stain automatically. Current detection level is shown on the
right after inspection.
10. Level
Auto detection level can up/down a little by sliding Level from 0 to +/-2.In Automatic Binarizing
method, detection is more tolerant by -, and is less tolerant by +. In Color Selection method,
colored area is larger by -, and smaller by +.
11. Manual detection

Check off auto detect, then this will be activated. Level can be selected from 16 to 240. In
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Automatic Binarizing method, his level does not represent the sensor of detection, this
represents black/white level. In Color Selection method, you can manually change the allowance

of area to be painted, larger than Auto detection (Color gradation allowance fixed)

V¥ 16-8-4 Caution

This stamp is slightly different from the ordinary stamp.

Unable to set Search Area /Area Limit.

Do not search position with master picture, do not have more than one master picture, do not

have reversing picture, because this stamp is not using pattern matching algorithm.

Can be included in Pack stamp, however the setting window can not be opened from filter

button in Pack setting window.

Do not follow the Pack Master in Pack Stamp.

16-9 Stamp for Measuring Slit Width

SlitWidth stamp

Exclusive stamp for measuring slit width with the accuracy of 0.01 mm, applicable to detect insufficient
Ni/Au printing or scratch on printing on multilayer ceramic packages. As well as Scratch Stamp, there
are 2 methods to measure. It is suitable to use Automatic Binarizing method to measure the area sand-
witched by a color for the setting of Automatic Binarizing method is easier. The rest of case, please use

Color Selection method.

16-9

(Suitable to Automatic Binarizing method) (Suitable to Color Selection method)

V¥ 16-9-1 How to use

[Automatic Binarizing Method]

1. Place SlitWidth stamp on the target (Screen 1).

2. Open setting window, and set the threshold of width (Screen 2).
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3. You can start inspection (Screen 3).

*

When placing stamp, pay attention by reading Notice on below.

If the area other than slit is too small, detection may fail (Screen 4). Enlarge stamp to increase

area.

If stamp is including silk print, pattern or components, color is not uniform, or color of slit and

non-slit area is very similar, detection may fail. An error message "No Measurement target

found" will be shown with minus result value (Screen 5).

Width is calculated by averaging measuring several points in stamp. If the stamp size is too big,

the result will be more standardized, and you can not get precise result. If you measure long

shape, do not enlarge stamp, but place many stamps (Screen 6)

[Color Selection Method]

1. Press Color Selection button, select the color of target in the frame. By pressing this button,

the mouse cursor becomes color picker. Drag the mouse onto the color in the stamp frame. By

dragging, the selected color will be painted in blue. The painted area is the target to measure.

* When selecting color, pay attention by reading Notice on below.

- Target area must be painted evenly without including unnecessary color (Screen 8). By dragging

mouse larger, the area painted in blue will be increased. (If it is not possible to paint the target

in blue evenly, the inspection result will be unstable. In such case, SlitWidth stamp may not be

16-9-1

>

(Screen 1)

(Screen 4)

>

(Screen 2) (Screen 3)

Open setting window and TEST...

A 4

(Screen 5: Area other than slit is too small, and area includes the pattern.)
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16-9-1

(Screen 6)

(Screen 7)

(Not evenly)

(Screen 8)

(Evenly)

optimum method for your inspection)

- To reset the color, click in the area other than inside stamp's frame by color picker. After color

selection is reset, the inspection method reverts to binarizing method.

- By binarizing method, the width is measured along the longer side of frame, on the other hand,

the shorter side of frame is measured by color selection method.

V¥ 16-9-2 Settings

1.

2.

3. Result / Average

Minimum

Maximum

Set minimum size to be judged Good. The size less than this value is judged Not Good.

Set maximum size to be judged Good. The size more than this value is judged Not Good.

Result of Test or analyzing is shown. If the result is Good, shown in blue color, and if the result

is Not Good, shown in red color. If the measurement is failed, result is shown in red with minus

value. Average shows the average of area in the frame. In color selection method, frame is di-

vided in 10 micron pitch, the value is the average of all divided area.

. Test / auto width

Show the result of current settings. By pressing auto width button, Minimum/Maximum target

size is automatically input. Place SlitWidth stamp on the target (not defective sample), press this

button. Minimum/Maximum size will be input based on the sample.

. Allowance for auto width

The allowance for automatic Minimum/Maximum target size input. The default allowance is
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16-9-2

(Screen 1)

(LPF OFF) (LPF ON)

>

(R.cut OFF) (LPF ON)

(Screen 2)

0.02mm. By pressing up/down button, you can increase/decrease allowance per 0.02 step. Our
recommendation is 0.04mm allowance.

6. light
AOI with multiple lighting models can change lighting.

7. angle
Enable to rotate frame from -180 to +180 degrees. By pressing up/down button, rotate by 15
degrees step.

8. Color Selection tool, Low Path Filter and R.cut
Use Color Selection tool when you want to measure width by Color Selection method. Low Path
Filter is the filter to ignore a little noise (Screen 1), selectable only in color selection method. In
case if you like to detect even tiny difference, please deactivate this option.

R.cut means “Round Cut” option to ignore the shape difference at edge (Screen 2)

V¥ 16-9-3 Caution

This stamp is slightly different from the ordinary stamp.

- Unable to set Search Area / Area Limit.
- Unable to set mask.

- Do not search position with master picture, do not have more than one master picture, do not
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16-10-1

(Image 1)

(Screen 1) (Screen 2) (Screen 3)

have reversing picture, because this stamp is not using pattern matching algorithm.
- Can be included in Pack stamp, however the setting window can not be opened from filter

button in Pack setting window.
16-10 PCB stop position adjustment stamp for inline AOI

If your PCB’s shape is somewhat like below sample PCB (Image 1), and unable to stop PCB on accurate
position because your PCB’s top left corner is not square or component like connector exists there, as a
result the stopper does not work well on inline AOI, you should try KadoSta

KadoSta detects the edge of PCB and give offset.

V¥ 16-10-1 How to use KadoSta

1. First, move camera by Move tool in order the PCB edge to be at the center (Screen 1), place
KadoSta to be in the center (Scren 2). In case using KadoSta for giving offset to Y direction, resize

KadoSta to be longer to Y direction. If it is resized, the mark <-- X--> changes into <--Y-->.

16-10-2

(Screen 1)
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* When placing KadoSta, select PCB area where no pattern or white silk printing exists near the edge.
If a straight white silk line is runnning near the edge, AOI mis-detect the white line as the edge.

2. Press Analyze button. When the edge is detected correctly, the green line is displayed on the edge,
and red line graph which represents the difference is peaked on the edge (Screen 3). If detection
fails, the green line is not displayed and orange line graph is displayed in stead of red graph.

3. If detection fails, error messages as "Not enough blank space" or "Image has too few characteristic

area." pop up. In such case, please adjust KadoSta by following 16-10-3 Adjustment.

V¥ 16-10-2 Display explanation

1. Red graph's peak (at edge) should be above this yellow line.

2. Blank area (where no PCB) should be below this yellow line. Also KadoSta should have at least

1/5 blank area.
3. This green graph is displayed where PCB edge is detected.
4. Red line graph represents the barometer of color difference.
5. Value of position offset. If the result is for example X2(96%) then 2 pixel position missalignment

to X direction and the position is 96% correct.

6. If AOI has multi lighting, you can switch lighting by clicking on the frame of KadoSta.

V¥ 16-10-3 Adjustment

1.Enlarge KadoSta frame size. Especially enlarge blank (non-PCB) area.

2.If white straight silk printing is running near the PCB edge, resize KadoSta smaller to exclude the

white color.
3. If PCB color is too dark and can not detect, select DOAL illunimation if your AOI is multi lighting

type.

16-11 Cell image Capturing Stamp for Rc22x

CaptureStamp allows any point on the PCB to be transferred to Rc22x as a JPEG image. This can be

16-11

(Screen 1)
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done by placing the CaptureStamp on the image that you would like to transfer (Screen 1). The image will
be captured at inspection, and transferred to Rc22x once the inspection is complete. The image will be
saved in the Rc22x \data \Mes \([PC name] [data name]) folder, and the file name will be saved as [Year]

[Month] [Day] [Time 1/1000 seconds] (ex: 2003 June 30, 14:15:30.123 sec 030630141530123.jpQg).
16-12 Solder Bumps and Pad inspection

The Solder Bump to mount the component such as SiP must be the same shape and height.

“BumpArray” stamp is an exclusive stamp for inspecting solder bumps, and pad before pasting solder.
This stamp can detect scratch or unexpected object on pad, and detects of the bump (size, no solder,
bridge and shape). In addition, BumpArray stamp can detect scratch or unexpected objects (such as dust

or solder balls) on the neighboring pad.

* Because the bumps are quite small, please select AOI with high resolution lens.
* For RGB layered illumination model only (HML or HMA model). Can't be active on the other model.
* Detection is not possible on the customized HML or HMA machines which RGB lighting position is

reversing (normally RGB, but is BGR).

V¥ 16-12-1 How to use

At first, sampling PCB position, bump numbers and bump position from master PCB. Master PCB must
be the good one without defect.

1. Set PCB on AQI, load StamplLibrary.

16-12-1

Bump OK 0/225

(Screen 3)

(Screen 1) (Screen 2)
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2. Move camera onto the target, paste BumpArray stamp.
3. You can resize the frame to fit the target size. This operation is different from case 1 “Bump

only” and case 2 “Not only Bump also neighboring Pad”.

[Case 1 (Bump only)]

3-1. Enlarge stamp size to include all bumps, large enough to include all bumps, but small enough
to exclude Pad area.

Caution: Select the best piece (target), because this is going to be the master. All bumps
must be in good shape, good size, correct number and in accurate position.

3-2. Open settings window by double-clicking the frame. When the inspection target is solder
bump, select Bump. When the inspection target is pad (before printing solder), select
Pattern. Press re-inspect button, and confirm the result to be OK. Mouse over the frame
of BumpArray stamp (Screen 1). A message “Bump OK 0/225” will be shown (225 is the total
bump number here). Confirm the last number (225 here) is as same as the number of bumps
that you count with your eyes.

* If the number of bumps differs, change the piece and re-take the master picture.

3-3. Next, set the Search Area. Move mouse cursor on the bottom-right corner of the frame,

drag the frame with pressing control key (Screen 2). Press the golden stamp button in Master

Picture Area and update the BumpArray stamp (Screen 3).

16-12-1

I (Screen 5)

(Screen 4)

(Screen 6)
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[Case 2 (Not only Bump also neighboring Pad)]

3-1. Enlarge stamp size to include not only bumps but also pad (Screen 4).

3-2. Let’s separate Bump area and Pad area. Drag the bottom-right corner of the frame to inside
(toward diagnostic side), shrink the frame until the mouse cursor comes to the bottom-right
corner of Bump area. Release the mouse button. A message “Resizing a stamp...” will be s
hown (Screen 5), press OK. Continuously, a selection menu pops up. Select “Bump and Pad
inspection”.

3-3. As well as 3-2, shrink the top-left conrner of the frame to fit the Bump area. Now the frame for
Bump inspection is created inside the frame for neighboring Pad inspection.

3-4. Open settings window by double-clicking the frame. When the inspection target is solder
bump, select Bump. When the inspection target is pad (before printing solder), select
Pattern. Press re-inspect button, and confirm the result to be OK. Mouse over the frame of
BumpArray stamp. A message “Bump OK 0/225” will be shown (225 is the total bump number
here). Confirm the last number (225 here) is as same as the number of bumps that you count
with your eyes.

3-5. Next, set the Search Area. Move mouse cursor on the bottom-right corner of the frame, drag
the frame with pressing control key. Press the golden stamp button in Master Picture Area

and update the BumpArray stamp.

[Case 3 (Big BGA Bump)]

1. Set PCB on AQI, load StamplLibrary.

2. Move camera onto the target, paste BumpArray stamp.

3. Select Sp.BUmp for Inspection Item. There will be Color selection tool in Detection setting.
Sample the solder area to be painted blue. (Screen 6)

4. Input bump size and minimum allowanced bump size in Size setting.

5. Set allowance of insufficient solder area in percentage (default 60% means if 60% area is

16-12-2
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printed by solder, it is judged OK.)

V¥ 16-12-2 Settings Window

Settings Window is shown by double-clicking the frame of stamp.

Size setting ( micron)

Standard diameter: The ideal size of a bump diameter in micron. The number on the right is
the number converted to pixel.
Minimum diameter: The minimum size of a bump diameter to be OK. The number on the right

is the number converted to pixel.

Detection settings (Menu differs whether Bump or Pattern is selected)

(CC.Bump: Solder Bump inspection after printing)

Too red: Detect “No Solder Area”. When pad color is gold and solder color is grey, this will be
effective. Enable to switch active/deactive.

Aspect Ratio: Detect the defect of bump by shape. Default 60% means, if the width’s and
height’s length is differ more than 60%, should be NG. Enable to switch active/deactive.
Exclusion noise: Specify the minimum size of object to detect as unexpected object. (Also has

affect to reduce noise). This setting influences also inspection of neighboring pad.

(Pattern: Bump Pad inspection before printing)

Exclusion noise (bump): Specify the minimum size of object to detect as unexpected object
on pad of bump.

Aspect Ratio: Detect the defect of bump by shape. Default 60% means, if the width’s and
height’s length is differ more than 60%, should be NG. Enable to switch active/deactive.

Exclusion noise: Same as selecting Bump, however the threshold is much more strict because

16-12-3

(Screen 1) (Screen 2)
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Defects marked by color circles

Red: Bump not found Rose: Insufficient (or No ) Solder Yellow: Bump Area too small

Green: Unexpected Object Light Blue: Bridge or Shape incorrect

it is pure pad inspection when selecting Pattern.

(Sp.Bump: Big Solder Bump inspection after printing)

Color Selection Tool: Select bump color
Aspect Ratio: Detect the defect of bump by shape. Default 60% means, if the width’s and

height’s length is differ more than 60%, should be NG. Enable to switch active/deactive.

Default: Reset all settings

Test: Confirm the inspection result in current settings.

V¥ 16-12-3 Inspection and Debugging

After the inspection, defects are marked by color circles. Mouse over on the frame line, an error message,

e.g. “Bump NG 3/255” will be shown (Screen 1). This represents “NG number / Total number” of bump.

When there are false calls, change the tolerance according to the cause of NG. For example, if a false NG
occurred by ‘Bump area too small (yellow circle), increase the value of “Minimum diameter” (Screen 2).
* In example, the minimum diameter is 45 microns (9 pixels). In 9 pixels, there is a margin of error of 1

or 2 pixels. Therefore, if you want to detect 45 microns bump, input 60 micron in practice.
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16-13 Length Measurement

Measure the distance between two objects by using pattern matching or Pack type stamp, the accuracy
of 0.01mm. Suitable to inspect the components such as sensor or LED which are requested to mount on

very accurate position.

V¥ 16-13-1 How to use

Prepare the PCB to be master. (If you have CAD data and the distance is specified in the CAD, you can
manually input the length.) Place pattern matching stamps or Pack stamps on the objects that you want to

measure the distance.

1. Activate "Length Measurement Setting" in Settings menu (Screen 1).

16-13-1
(Screen 1)
(Screen 2) (Screen 3)
(Screen 4) (Screen 6) (Screen 6)
(Screen 7) (Screen 8)
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2. Move mouse cursor near the center of the inspection frame. The cursor shape changes to pen

shape (Screen 2).

3. Mouse down and drag the mouse to the other frame . Yellow arrow will be displayed. Release

the mouse when reaching to the frame (Screen 3).

4. Setting window will be displayed. There are length and difference shown on the yellow arrow.
The length is measured from the center of each frames. The difference is defined 0.00 here,

because this will be the master (Screen 4).

5. Select if you like to measure length X, length Y or both by checkbox. Then input tolerance from
minus (shorter) to plus (longer).
Do not change the pull down menu "In Center". Do not also change the "length”, but if the length

is regulated in CAD data, input the value from keyboard.

6. Click OK. The dialogue to input the name will be displayed. Input name for the measurement

setting (Screen 6) you can't input the same name exist in the stamp list.

* The setting is saved, however this setting is not saved as stamp. It is saved in the inspection
program and not possible to re-use in the other inspection program. In this program, you can re-use

from top pull down menu (Screen 7).

* Setting is not saved/linked to the stamp, e.g. Set length measurement between stamp A and B in
a Cell. Then move to the other Cell and paste stamp A and B, but length measurement is not set
between the stamps in the other Cell.

If you want to duplicate the stamps and length settings simultaneously, please duplicate by Cell

Duplication or select stamp A and B, copy and paste them in the other Cell.

7. Setting is completed. Start inspection.

8. Length error will be displayed while verification (Screen 8).
* If stamp is NG by the other reason such as Mismatch or Mismatch by Hue, these error reasons
are prior shown than the distance error. Therefore, the stamp setting should be tolerant for not

to detected as NG by Mismatch or Mismatch by Hue.
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16-13-2

(Screen 1) (Screen 2)

(Screen 3) (Screen 4) (Screen 5)

V¥ 16-13-2 How to debug

Please debug when there are escaping or false calls.

1. Measurement for escaping.
Shrink the threshold. While Length Measurement Setting is checked (Screen 1), move mouse
cursor near the center of the destination frame. The cursor shape changes to pen shape. Click
the center of the destination frame (Screen 2), the setting window opens.

* The cursor shape changes to pen shape even if it moves closer to the departure frame, however
setting window will not open by double-click. In place you can create the 2nd setting to the
other object. The multiple measurement settings are possible to create from one departure

frame to multiple destination frames (Screen 3).

2. Measurement for false calls.
Please observe the stamps. The stamps position after searching is shown by rose lines at
the 4 corners. The rose cross hair is displayed in the center. Departure frame is linked to

destination frame by rose line, and current length and difference is displayed (Screen 4).

Confirm if rose lines at the 4 corners are in the correct positions. If positioning is not good,
the color difference between object and PCB is too less and it is difficult to position, thus
the object is not suitable for measuring distance. If tolerance is not wide enough, give more

tolerance.
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16-13-3

E4d B & &

(Screen 1) (Screen 2)

3. Confirming the result after changing value. Press re-confirm button to confirm in selecting both

departure and destination stamps. Analysis button does not work for this function (Screen 5).

V¥ 16-13-3 Window

Explains other window items which are not explained by here (Screen 1).

1. Selectable from "In Center", "Inside" or "Outside". Normally select "In Center", however if you
like to measure between the inside edge of objects, select "Inside" and if you like to measure
between the outside edge of objects, select "Outside" (Screen 2).

2. Reload the value by reading current value.

3. Reset (delete) the length measurement.

4. Save in the other name.

V¥ 16-13-4 Limitations

- Not possible to use in NG Cell View or Auto trace in faster mode.

- Pattern matching type stamp or Pack stamp only.

- Measuring other than rectangle shape may result in incorrect value.

- Not possible to measure beyond the Cells.

- Measuring between rotated cell in free degrees (not 90 or 180 degrees) may result in incorrect
value.

- Re-setting required after rotating Cell.
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16-14 Inspection Program Splitting Function for More Than One AOI

In version 4.9.9 or later, you can inspect the PCB by splitting inspection area for more than one AOL.
The inspection program can be split up to 3 AOI’s.

*Barcode setting is required to apply this function.
V¥ 16-14-1 How to setup

1. Open “Settings for Supervisors” window from menu Settings > Configuration > For Supervisor.
Open Plus tab. Put check mark on “Machine number of separation data”.
Assign the number to AOI’s.
First AOl:  AOI #1
Second AOI: AOI #2
2. Create the inspection frame.
3. Select the “AOI#1” from the menu displayed by clicking with pressing [Control] key on Cell Map
Area. Next, with same procedure, select “AOI#2” from the menu.
4. Copy the inspection program you had created in first AOI to second AOI. Then open the file.
5. Execute inspection in first AOl. Then, execute inspection in second AOL.

6. In Catch System, split data will be combined and displayed.

V¥ 16-14-2 Setting of Cs-Center

*Cs-Center V1235 is required to apply this function.
1. Set the address in Cs-Center. Set IP Address and Port individually as same as usual. Be sure to
set same AOI name if you use this function.
2. Go to menu Setting > General Settings. Put check on to “Use Combination” in Combination
setting tab. Set same Group number for AOI’'s which uses splitting inspection program.
For example, if you use splitting inspection function for two production lines, and each line has
2 AQOI’s, apply Group number 1 to the AOI in first line, and apply Group number 2 to the AOI in

second line.

Limitation

This function does not support RC22X.
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17. Extra Parts and Solder Balls

Normally the Inspection Frame must be pasted onto the part/component you want to inspect. However,
in the actual production process, the PCB may become defective due to unexpected scratches and extra

objects or solder balls. Therefore, this software has a special Stamps for inspecting the entire cell.

The stamp to detect extra objects and scratches is called the EP Stamp. In a cell with the EP Stamp, a
Master Image is created from several good PCBs to deal with the component’s slight differences in posi-

tion, shape and color. Then, the Master Image will be compared to the actual image to detect differences.

EP stamp is not suitable to detect small solder balls. There is Solder Ball Detection stamp for it.In this

chapter, how to use EP stamp and Solder Ball Detection stamp is discribed.
17-1 How to Use EP Stamp

The EP Stamp can be used in following procedure:

1. Paste the EP Stamp. Because position alignment is done by the stamp’s picture, paste the
stamp on where characteristic and not tend to differ per each PCB. Change the stamp size if
necessary to suite the target object (Screen 1).

2. Double-click on the frame and the EP stamp setting window will be displayed (Screen 2).
At this stage, you do not need to change parameters. But, if you wish the stable inspection,

change learning number from 10pcs to 30-50 pcs. The more PCB is learned, the more stable

17-1

(Screen 1) (Screen 2)

243

17. Extra Parts and Solder Balls




detection is possible.

. Set a good PCB and start Inspection This 1st PCB will be the master.

. Inspect PCB of learning number, while inspecting after learning a few PCB, observe if position

offset is working correctly and if the variation of PCB is absorbed.

. To observe the position offset, click the EP stamp frame and open setting window. There is

“Add/Delete fiducial markers” in Details tab (Screen 3). If one frame for offet is not enough, you
can add more frames to offset (Screen 4). If searching is not working well, expand search area

(Screen 5).

. The solder area such as QFP leads can vary because of reflection, it is better to mask them.

Open “Edit Mask”, select “Mask to decrease sensitivity”. Draw mask by edit tools. Sensitivity
100% means ignore inspection, sensitivity 30 means inspection is done but slight difference is

ignored (Screen 6).

. Continue learning.

. When completing learning, you can start real inspection.

* This process requires huge memory.. We recommend to use Mac with large RAM memory. The con-

sumption of memory is not depend on the learning number, it depends on the number of Cells where

EP stamp exists. If EP stamp is pasted to all Cells on large PCB, memory will be lacked. Because EP

stamp compares whole Cell image to learned image, it takes time to inspect than normal stamps.

* Depend on the combination of OS and Mac hardware, the number of PCB learned will not be up-

count after the first inspection when opening the inspection program which contains EP stamps that

were already inspected many times. Counter will be up on and after the second inspection.

17-1
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(Screen 3)

(Screen 6)
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17-2 EP Stamp Setting Window

ltems to be set up in the EP stamp setting window are as follows:

¢ Basic setting Tab (Screen 1)

M Start inspect after learning of “ ” pcs

Set the number of PCBs to be learned. When 10 is entered here, the first PCB will be recorded as the
Master PCB, and 10 PCBs starting with the next PCB will be used for learning. In other words, the actual

inspection will start from the 12th PCB.

<Setting of detection>
H Min. size of parts<

Set the minimum pixel value by size. If 80 is set here, a block of NG pixels with less than 80 pixels will not

be detected as an extra part. This setting prevents noise and minute dust from being detected.

H Max. width >

Set the maximum pixel value for width. If 500 is set as the maximum, a block of NG pixels whose width
exceeds 500 pixels will not be detected as an extra part. The default value is 9999, which will detect all

widths.

Hl Max. height >

Set the maximum pixel value for height. If 500 is set as the maximum, a block of NG pixels whose height
exceeds 500 pixels will not be detected as an extra part. The default value is 9999, which will detect all

heights.

17-2

(Screen 1)
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H Min. width <

Set the minimum pixel value for width. If 10 is set as the minimum, a block of NG pixels whose width is

less than 10 pixels will not be detected as an extra part. The default value is 1, which will detect all widths.

H Min. height <

Set the minimum pixel value for height. If 10 is set as the minimum, a block of NG pixels whose height is

less than 10 pixels will not be detected as an extra part. The default value is 1, which will detect all heights.

M height/width > width/height >

Set the aspect ratio of a block of NG pixels. If 5 is set in height/width, a block of NG pixels whose aspect

ratio (h/w) exceeds 5will not be detected as an extra part.

M detected / total <

Set the rate of the area of a block of NG pixels in relation to the area of a circumscribed rectangle drawn
around the NG pixel block. If 0.10 is set here, blocks less than 10% of all NG pixels in the area will not be

detected as an extra part.

e Both in Basic setting Tab / Details Tab
M Edit Mask Button

Display the editMask window.

<Learning information>
H PCB learned

The total number of PCBs learned, including the number of PCBs judged as OK will be displayed. The first

inspection will not be counted here since it is used for learning.

H Learning weight

Sets the weight of PCBs learned. 1 is the maximum value and represents a learning weight of 100%. As
the value moves closer to O, the impact of learned PCBs is reduced, in turn increasing the impact of the

original PCB.

M reLearn

Click here to open the reLearn window. You will be able to set the additional number of PCBs to be
learned after inspections, when you feel that more PCBs should be learned in order to standardize the

Master Image.
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l Apply to all

This function changes all allocated EP Stamps in the program to the same values after changing the set-
tings. Click on the Apply to all button, and click OK when the confirmation window is displayed. This
function is valid only after inspection or if you have opened the EP stamp setting window at least once.

This setting will not be applied to a stamp that has only been placed.

H Reset

Delete all learned images and mask details. The setting values will not be reset.

¢ Details Tab (Screen 2)
H Tolerance

Set the detection sensitivity here. When the value is set higher, the detection sensitivity will be reduced.

H Error weight

This adjusts the degree of detection for each RGB element. Normally, you do not need to change this.
When detecting by each RGB element, if the value calculated based on the set value exceeds the value
setin R + G + B >, it will be detected as an extra part (when detected by each element, the set value + set

value * rate of error (10%) will be the value assigned to R + G + B).

Hl Weight change

Set the timing (number of PCBs) in which to change the weight of learning. The weight up to this number

will be the value set in Learning weight in Learning information.

H Changed Weight

17-2

(Screen 2)
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Set the rate of how learning weight changes after it exceeds the number of Weight change. Once the
number exceeds the value set in Learning step, the weight will be Changed weight in Learning infor-

mation * Learning Weight. Set a value of 1 or less.

Hl Add/Delete fiducial markers

During inspection, EP Stamp works like a Fiducial because it offsets the whole cell, but if the image is un-
stable, you can add Fiducial Marks. \When adding the marker, use the Add/Delete fiducial markers
button. Click on this button to display the matching Rects window. Drag the mouse over the area you
wish to add, drawing a red rectangle. This will be the Marker, and it will enable you to apply offset even if

Cell offset by the EP Stamp fails (Screen 3).

H Show NG details

If the inspection result is NG, click here to display the setupDetails window for more detailed information.

This window shows a differential Image between the actual image and the Learned Images.

- Disp. frame
If you activate this function, a rectangle showing the area and the arrow of the inspection result will

be displayed.

- Clear

If you activate this function, the screen will black out all areas except for the NG area (Screen 4).

17-2

(Screen 3)

(Screen 4)
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17-2

(Screen 5)

- Place mouse pointer on the rectangle area of the NG point
Detail of the area will be displayed. The details include average values and maximum values of R/G/B,
the end points of the rectangular area and the number of pixels. Offset of Marker and current position

of the mouse are always displayed (Screen 5).

- Indicate the point exceeds the setting of Error weight
This function shows the point which exceeds the Error weight set value. While pressing [option] key
in “setupDetails” window, the point which exceeds the Error weight set value is shown in gray
(RGB:127,127,127), and the point which is less than set value is shown in red between 0 — 255.

*When the “Clear” is checked (activated), only the point which exceeds the Error weight set value is shown.

- Indicate the value of "Red” “Green” “Blue” and “Red+Green+Blue”
The total value of Red “R”, Green “G”, Blue “B”, and Red+Green+Blue “R+G+B” is displayed in
“setupDetails” window by putting mouse pointer on differential Ilmage between the actual image and
the learned image (Screen 6). It is possible to set the value of Error weight referring this value.

* Caution: In Mac OS, the position that mouse pointer shows is the black tip of the pointer. The value of “R”, “G”,
“B”, and “R+G+B” is the value of the black tip of the pointer position (Screen 7). It is not the white colored part

of the pointer.

(Screen 6)

(Screen 7) Value of black tip

0 oo

(Screen 8)

249

17. Extra Parts and Solder Balls




- Adjustment of “R + G + B >”

In EP Stamp setting window, click “Show NG details”, and “setupDetails” window will appear.
There you can confirm the result of “R+G+B>" while changing its value. You can change the value
by horizontal slider or vertical stepper. Changed value is reflected immediately to the image.

Possible set value range is from 100 to 500.

- Individual adjustment of “Red”, “Green”, and “Blue”

As same as the adjustment of “R+G+B>", you can confirm the result by changing the value “Red”,
“Green”, “Blue” individually in “setupDetails” window. You can change each value using vertical stepper.
Changed value is reflected after a while that certain time is necessary for calculation. Possible set value

range is from O to 127 (Screen 8).

H Edit Mask

Parts which have large differences between PCBs, such as components with text or glossy parts, can be
masked so that you can reduce false reports. It is grayed out at default, but will become active after an in-

spection.

17-3 Mask too sensitive area

In the EP stamp setting window, click on Edit Mask (which will become active once inspected) and the

edit Mask window will be displayed (Screen 1). You can edit masks here to reduce false reports.

H Pen Tool

Create masks by free hand.

17-3

(Screen 1)
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H Straight Line Tool

Create masks with lines.

H Square Tool

Create square shaped masks.

H Circle Tool

Create Oval shaped masks.

Bl Undo

The masks applied during the mask’s frame edit will be undone at one task per click.

H Pen Size

Sets the thickness of the masks made by the pen tool and the straight line tool.

M Sensitivity

This sets the opacity of the mask. The larger the value, the higher the opacity of the mask will become,
reducing the detection sensitivity. If it is set to 100%, the image underneath the mask will be completely
hidden. This setting should be applied before drawing the mask. This setting cannot be applied to existing

masks.

B Mask to decrease/increase sensitivity

This switches the mask type. This should be set before drawing the mask.

B Average/ upper/ lower

Average means the average of learned images. Upper/Lower are to show the insensitive area of learned

results. The stronger the white is, the less sensitive it will be.

17-4 Tune-up EP Stamp

When performing inspection, false reports may occur. In this case, apply the following adjustments de-

pending on the situation.

1. If the EP Stamp is judged as NG when inspected by Re-inspection button, make the current

picture to be learned by pressing command-+return keys..
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2. Inspect the PCB using the current picture in the G/NG Confirmation Mode. When you come to
the EP Stamp inspection result, click on the Learn Extra part data in Work Area or hold down
the Shift key + Good to learn. By pressing Shift key in G/NG confirmation mode, you can see
the image with NG detail filtering.

3. Learn several good PCBs using the Relearn button.

4. Apply masking to decrease sensitivity.

5. Adjust the tolerance with Setting of detection (Min. size of parts, Max width, Max. height...)
in Basic setting TAB.

17-5 How to use Solder Ball Detection Stamp

Detect solder balls bigger than 80 micron.

* The solder ball size telling in this stamp is not the actual size. The size is calculated from the
combinations of lightings, therefore the size maybe different from the size measured by ruler.

* Possible to use this algorithm from Stamp Creation Wizard.

* 10 micron resolution lens recommended. At least 18.75 micron lens required.

* Exclusive algorithm for AOI with Diffuse-On Axis LED (DL, HDL/HDA, HML/HMA, FDL/FDA, FML/
FDA) However, the Diffuse-On Axis LED for DL type is spot lighting type. Therefore the repeatability
of detection may be worse than the other types. AOI with RGB lightings such as HML/HMA and FML/
FMA may false detect white silk print.

* Not possible to detect solder balls on white PCB.

1. Select a PCB. Normally when create normal inspection program, we use "Champion PCB" (the
PCB without detect). But here we better to use the defective PCB with solder balls, so that you

can learn the tendency of solder ball shape/size while program creation and debugging.

2. Move camera to the area where solder balls exist. Create stamp at any place in the view,

because Solder Ball stamp detects all solder balls in the view (cell), the place is not the matter.

3. Draw a frame with selection tool. Stamp Creation Wizard will be displayed, select "Detect
Solder Balls" from pull down menu. Setting window will be displayed (Screen 1). Set the
minimum and maximum solder ball size. Click OK and save as stamp.

* As written in setting window with blue text, the setting change to this stamp is automatically updated

without pressing Golden Stamp button.
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4. Start inspection or press re-inspect button to confirm if the solder balls are detected (Screen 2).
* If solder balls are not detected or the other objects are false detected as solder ball, refer to the

following pages to tune-up the settings.

5. If this work is at the end process of data creation, open the setting window, and press Copy
to all cells button (Screen 3). If this work is at the beginning process of data creation, execute

"Duplicate Selection" from Edit menu, and duplicate this stamp to all over the PCB.

Meantime, you can delete unnecessary solder ball stamps when more than one solder ball
stamp exist accidentally in a Cell with Delete duplication in cells button. This is useful after

Cell optimization (Screen 4).

17-5

(Screen 1) (Screen 2)

(Screen 3) (Screen 4)
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17-6 Handling of Missing NGs and False NGs

The shape of solder balls differ depend on the mixture of solder agents or the condition of reflow oven.
The shape can be almost round or can be a bit mashed. Therefore, you need to tune-up the settings

when you face to the escaping or false defects.

V¥ 17-6-1 Missing NGs

1. Allow ball shape variation
On default setting, only the balls almost perfect round shape is possible to detect. In case, your solder

balls are not detected even they are within minimum/maximum size, increase “Allow shape irregularity/

variety” level (Screen 1).

Increasing from O -> 1 -> 2 result in (Screen 2);
detect solder balls -> detect something like solder balls -> detect something looks like solder balls

After changing the level, press Test button and confirm the result.
Circled by green: recognized as solder ball
Circled by yellow: nearly recognized as solder ball (detection may be unstable)

However, the other objects than solder balls can be also detected by increasing the level (Screen 3).
Please control these false calls by reading following pages. Nevertheless, false calls occur by level-up
the “Allow shape irregularity/variety” and it is quite difficult to control this completely.

2. Change the sensitivity

* This change will be saved in AOI settings (not possible to change per inspection programs).

Click the detail settings icon, the sensitivity adjust window will be shown (Screen 4).
The most important condition to detect solder ball is to catch the brightness of solder. You can change
the sensitivity of the brightness at the bottom item “White sensitivity (center)” (Screen 5).

17-6-1
Level O

Level 1

Level 2

(Screen 1) (Screen 2)
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17-6-1

Pad of empty component
Fillet of diode

(Screen 3)

(Screen 4)

(Screen 5) (Screen 6)

Press up/down the button and find the most suitable sensitivity. When there is enough brightness, the
solder ball is colored in green (Screen 6).

* The up/down button does not mean sensitivity up/down. So, without thinking moving to plus or

minus, find the best level to detect the solder balls.

Next, adjust the blue and red sensitivities (Screen 7). There is a correlation between these sensitivities.
Please adjust together by observing carefully.

In below example, there was no change seen by up/down blue sensitivity from -0.5 to + 0.5. Let’s reset
blue sensitivity to 0 and try red sensitivity.

17-6-1

(Screen 7)

(Screen 8)

(Screen 9)

255

17. Extra Parts and Solder Balls




By increasing red sensitivity, a solder ball is detected (Screen 8).
By increasing red sensitivity more, more solder balls are detected (Screen 9).
As this example, find the best sensitivities by observing the balance.

V¥ 17-6-2 False NGs

1. Less tolerant to maximum size
If your setting is “Allow shape irregularity/variety” increased, and “maximum diameter” is bigger,
software will detect the objects other than solder balls. (Screen 1)
To kill such false detections, set “maximum diameter” to as smaller as not to miss the solder balls.

2. Masking by inspection frame
There is an option named “Mask under inspection frames...” (Screen 2) If the part of fillet is detected
as solder ball, activate this option. Then, the area where inspection frame is pasted is masked (invisible)
and escaped from solder ball inspection (Screen 3).

There is proviso in this option, “(exclude PassiveComponent stamp)”, and you can set the “Detection
Area along chip body”. This proviso means;

Detect solder balls along the chip body on which Passive Component stamp is pasted

Solder balls are tend to attach to the capacitor/register chip body. In order not to miss these balls,
Passive Component stamp has special masking function.
Even Passive Component stamp is packed, it works as well (Screen 4).

17-6-2
Pad of empty component Fillet of diode
(Screen 1)
(Screen 2)
(Screen3)  False detection Masked by frame
Passive Component Press Test button in Solder Ball Detect stamp. ~ Solder ball detected
(Screen 4) stamp on capacitor Dark area is masked, red area is not masked. while inspection
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17-7 Limitations for Solder Ball Detection Stamp

This stamp inspects the whole Work Area (Cell), therefore slightly different from the other stamps.

- Not possible to pack
- Not possible to have master picture
- Not possible to edit Reference Designator or Comment

- Not possible to verify in angular camera view

Memo: When Passive Component stamp is not used for chip inspection ...

If you use pattern matching + histogram algorithms for chip inspection, but you do not want

to miss the solder balls on chip body, you can just use Passive Component stamp to detect
solder balls.

- Check off all boxes.
- Input 0 to Angle and Rotation check
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18. 2D Solder Paste Inspection

This machine is capable of inspecting the printed solder paste. By checking dimensions, positions and
shapes, it is very easy to detect solder paste errors. The area to be inspected can be set manually or
sampled automatically, and it can also be set up based on Gerber data (Gerber data must be converted
using the special conversion software included on the CD-ROM).

Since this is an optional function, the detection accuracy is not as good as with 3D SPI machines, but ex-
treme misprints can be detected with sufficient accuracy. It is also possible to inspect parts/components

and solder paste in one Inspection Program.
18-1 Preparation
Confirm the following 2 points before data creation.

1. Check that the size ratio between the PCB and the screen is correct at the PCB surface height.
If this ratio is not correct, size and position of frames may be misaligned when automatic cell
optimization is performed after frame positions are generated from the Gerber data.

Make the line width thinner with Setting > Configuration > Object Frame and create a frame
matched to the pad. The frame color will turn white when the screen is moved. Then compare
the position of the frame and the pad.

If they become shifted when moved, go to Setting for supervisor > Movement > Pixels per
1cm and change the value little by little to correct the position and set the ratio between the
PCB and the screen accurately (Screen 1).

2. Next, confirm the sensitivity to sample the solder paste area. When sampling with automatic
sampling mode, you will not detect the proper size of the solder if you do not make adjustments
to match the sensitivity to the solder condition.

Set a good PCB on the machine and move the camera to the inspection area. Then select Sol-
der Paste Check from the Window menu to display the Area Edit Window (Screen 2). The le-
ver on the left is for Sensitivity, and the lever on the right is for Size. Set the area to 0 (zero) and
slide the Sensitivity bar so that the paste area will be painted in yellow (the paint is displayed
only while you are sliding the lever with the mouse). In addition, use the lever to set the image to
be about 5% larger than the actual paste area (Screen 3). The values set here will become the

default values for Area Edit Window.
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18-1

(Screen 1)

(Screen 2) (Screen 3)

18-2 Creating Data

Hl Manual Settings

With this method, you will create a standard Inspection Frame and change that frame to a Solder Paste

Inspection (SPI) Frame.

1. Set a good PCB and move the camera to the inspection area.
2. Draw an Inspection Frame on a solder pad. After selecting the Inspection Frame, select Solder

Paste Check from the Window menu and click the Assign button.

*When an Inspection Frame is selected, the Sample button will become the Assign button (Screen 1).

After changes have been applied, it will become the Resample button.

3. Now, this inspection Frame has been set as the Solder Paste Inspection Frame. It can also be

registered as a Stamp.

259

18.2D Solder Paste Inspection




M Automatic Sampling

With this method, all of the solder paste areas will be detected automatically and be converted to the Sol-

der Paste Inspection Frame at the same time.

1. Set a good PCB and move the camera to the inspection area.

2. Open the Area Edit Window and click on setup of details to display the Recognition details
setting. Make sure that Restore split frames has been checked (Screen 2) and press OK.
This feature will make the shapes of Inspection Frames created by automatic sampling smooth.

However, it doesn’t work for frames with some shapes.

* Refer to 18-3 Frame Adjustment for details.

3. Confirm that the print area will be painted yellow using the Sensitivity lever and the Size lever
in the Area Edit Window.

4. If no Inspection Frames are selected, the button in the center will be shown as the Sample but-
ton. When you click on Sample here, all the yellow areas will be set as Solder Paste Inspection
Frames.

5. The Inspection Frame is now created, but lightness may differ depending on the area on the
screen, so you may need to change the sensitivity by frames. The Auto level button will al-
low you to automatically adjust sensitivity for each frame. Select Inspection Frames and click
the Auto level button. Adjusted frames will be displayed in blue, and those that could not be
adjusted will be displayed in red. If the red frame is a false report, you will need to make further

adjustments (refer to 18-3, Frame Adjustment).

18-2

(Screen 1) (Screen 2)
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18-2

(Screen 3) (Screen 4)

* Auto level is valid only for Inspection Frames with the same lighting and for the same target color.

H Using Gerber Data

1. The Gerber data should be converted using the conversion software before setting the PCB.

2. When you import the converted data by selecting Import Data File in the File menu, it will au-

tomatically be recognized that it is the data for Solder Paste Inspection, and the Position ad-
justment Window will appear. Make sure that the button at the upper right is the Solder Paste
Inspection Frame button before adjusting the position (Screen 3). The Solder Paste Inspec-
tion Frame button will automatically adjust all frames as Solder Paste Inspection Frames.

Stamps will be created here for each size (Screen 4).

. Select Auto Reposition from the Edit menu and the procedure is complete. If you would like to

reduce the number of cells, combine the frames in the screen into one cell by selecting Inspec-

tion Frames with the Control key. The screen cannot be rotated or flipped here.

* See 6-7, Cell Optimization and 6-8, Merging cells for details.
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18-3 Adjustment

Once you have completed preparation for the Solder Paste Inspection Frame, start inspection (this task is
not necessary for Frames created with automatic sampling). When you place the cursor near the Solder
Paste Inspection Frame after inspection, area/position/shape results will be displayed.

If the results are shown in red, it means that the value has exceeded the tolerance limit (Screen 1). If you

get false reports, you will need to adjust the values in the Area Edit Window. The procedure is as follows:

1. Select the Inspection Frame, and double-click to display the Area Edit Window.

2. Adjust the values in Set up area limits. The maximum limit represents the limit for solder
excess, and the minimum limit represents the threshold for solder insufficiency. X limit and
Y limit refers to the misalignment of the solder paste area from the center, which is defined in
mm. shape limit is used to define the tolerance level for the difference between the shapes of
frames and detected shapes in percentages (Screen 2). Enter values in the items you wish to
change and click Update.

3. If you wish to exclude the non solder paste area, select that area with a standard Inspection
Frame and press the Exclude button. Excluded frames will become shaded (Screen 3).

4. If you would like to change multiple Solder Paste Inspection Frames to the same status, select

those frames before applying the settings.

18-3
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(Screen 3)
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*When the Area Edit Window is opened without selecting a frame, the values will be the default val-
ues of this software. This default value is applied when a new application is opened, except for color

and lighting that will be Gray and Default, respectively.

M Reducing Shape Limit Depending on Frame Size

The shape limits of frames are automatically set when you create the data from Gerber data. For each
frame: The smaller the size, the lower the shape limit will be. This will save you the trouble of adjusting sen-
sitivity by varying frame sizes. However, since this is just an estimate, make adjustments as needed. Even
when Solder Paste Inspection Frames are set up by other procedures, it is common to reduce the shape

limit if the frame is small.

H Color Emphasis

During solder paste inspection, false reports may occur on printed patterns misjudged as solder paste
area. In these cases, it is possible to make adjustments in Other pattern exclusion Level, but it is also
possible to emphasize the Green/Red/Blue colors to highlight the differences between patterns and sol-
der paste. Hold down the mouse on the color that should be emphasized and drag up or down to change

the value (Screen 4).

* When frames are selected, the Green/Red/Blue rectangles will be colored, but if no frames are se-
lected, only the rectangle frames will be colored.

(The Update button will apply changes only to the selected Solder Paste Inspection Frame).

M Side Lamp

When inspecting solder printed on a solder-plated pad, you can improve the inspection accuracy by us-

ing the Side Lamp. Select camera special in the Area Edit Window, select one of the Custom 1 - 8

18-3

(Screen 4) (Screen 5)
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options and click Side lamp or blink (Screen 5). In general, Side lamp should be used for red colored
PCBs or pads that have bumps caused by printing, and blink should be used for PCBs with colors other

than red. Make sure to verify sensitivity after this setting has been applied.

* Refer to 20-3, Camera Special Setting, for details on the Camera Special Setting window.

H DetectingText by Selecting Target Color

Since gray is generally used for solder paste inspection, the default color is gray. You can also select
white, black, red, blue and green, so you can use this Solder Paste Inspection when inspecting parts oth-
er than solder pastes (Screen 6). For example, it is useful to detect text by setting the color of the letters

(such as white).

H Advanced Settings

You may not be able to apply paint to judge the solder paste area by only adjusting Sensitivity and Size.
In this case, click on setup of details to adjust the Recognition details setting (Screen 7) (hormally,

default values should be used here).

* These settings affect the entire system. They can not be set up for each frame.

<A setup for the detection>

* Min size (pixel/width)

Set the minimum area and width required for inspection. Raise the pixel value in case small objects other

18-3
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than the solder are detected, and increase the width value in case thin objects such as silk are detected,
so that they will not be recognized.

* Max aspect ratio (ratio min/fill)

This limits the maximum aspect ratio of the solder paste area. When long objects such as silk printed
lines are detected, the value in ratio min should be smaller. The number in the fill means the maximum
percentage. When you sample the solder paste area, it is possible that some points cannot be detected
and left as gaps. If the ratio of the gaps is within this number, it will be filled in. If this cannot be sufficiently
loaded due to roughness on the print surface, set a high value.

¢ Dot joint (while running sampling)

This sets the pixel unit to fill the space when inspecting (running) and when sampling If inspection fails due
to roughness on the print surface, set a high value.

® Restore split frames

When Automatic Sampling is performed, the solder paste area may not be displayed in the intended
shape. This check box will put them together into the intended shape. This may not work depending on
the shape.

¢ Defaults

All values will be set to default with this button.

<rendering settings>

e Other pattern exclusion level

Sets the saturation level other than the solder paste Area. For example, this can be used to exclude the
green color of the PCBs from inspection before solder inspection.

® Blur level

If the solder paste surface is rough and sampling is unstable, raise this level for adjustment.

® Frame separation

* Frame combination

These values are used to either split or combine adjacent solder paste areas.

¢ Display OK frames (in speed priority mode)

Displays the solder paste area in blue when speed priority mode is applied.

® + Try

Sets frequency of additional re-inspections only for the solder paste inspection area.

e Auto adjust

The reflection can cause false NGs. To prevent such false NGs, this software has an Auto adjust function
to compensate for the reflections.

The level can be changed in Auto adjust. The larger the value, the larger the compensation will be. This

feature will be disabled when O is selected.
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18-3

(Screen 8a) (Screen 8b)

e Frame position update
This is used to correct the data created by the Gerber data to match the actual PCB position. Perform in-
spection once, and then click on the button. Individual Inspection Frame positions will be adjusted based

on the misalignment values from the previous inspection results.

B Area Edit Window status

The values of the Area Edit Window will be immediately reflected in the Work Area.

When the Area Setting Window is opened without selecting a frame, all of the parameters will be set to the
default values of the entire application, but when a Frame is selected, only values belonging to that frame
will be displayed. It is very important to know whether this setting window is for the entire application or

just for one frame. There are a few points to look for to make sure:

<Window for the entire application> (Frame is not selected)

(Screen 8-a)

® The Red/Blue/Green are shown as the frame color in the Color Emphasis field.
* The Setup area limits field only says Setup area limits.

¢ The button on the top center is Sample instead of Resample.

<Window for a Frame>

(Screen 8-b)

¢ The Red/Blue/Green in the Color Emphasis field is painted out.

¢ The Setup area limits field says For every frame : Set up area limits (when the selected frames are
for solder paste inspection) .

¢ The button on the top center is Resample instead of Sample (when the selected frames are for solder

paste inspection).
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B Apply changes on a frame to the other framess

While debugging Solder Paste Inspection frames, if you change settings of one frame, now you can apply
the change to all frames in the same area group. Area groups are basically organized by the similar area
size frames. However, you can customize to split frames in many groups or in a few big group or even in

one group.

How to use

1. Select a frame that you would like to change settings. Change parameters in Area Edit Window.

2. Click on the grey arrow button on the left-top of Area Edit Window.

New window opens. The window lists all the solder inspection frames in this program. The frames are
grouped in simillar area pixel size automatically. The group colored in blue on the list is the group that
selected frame is belonging. All frames belongs to blue colored group are also colored in blue in Work
Area.

3. The number of groups can be increase/decrease by pressing up/down arrow buttons on the left-
bottom corner of the window.

4. Press Appl. button. Then, the frame setting change is applied to all frames which belong to the same
area group.

Set Area Limits

Set Area Limits menu (the lower half of the Area Edit Window) can be hidden by arrow key on the right-
middle. When changing items in Set Area Limits menu, if you press Appli. button with Set Area Limits
menu opens, the changes in Set Area Limits menu are also applied to frames in the blue group.

But, if you close Set Area Limits menu after changing some of its items, and press Appl. button, these

changes are not applied to the frames.

* Press grey arrow button on top-left without selecting a frame, the Apply Same Area window does

not open.

18-3
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19. Auto Program Creation Guide

This function is useful for creating simple component inspection such as missing, reversing, wrong in
few minutes without any stamp library, Create inspection frames for components automatically from
CAD data, if the data contains components' size X and Y. With this function, user can start component
inspection immediately because frame creation, saving frame as stamp and Cell optimization work is done

automatically.
19-1 CAD Data Format
Should be CSV or TXT format with comma or tab separators. Order of each information should be as;

coordinate X, coordinate Y, angle, casette No., reference designator, component name, size X, size Y

* Evenif there is no data of casette No., please input any text or number (for example, copying

component name).
19-2 Work Flow

1. Set a PCB on AOI. Import CAD data from Import Data File in File menu. If the data has
component size X and Y in column 7 and 8, Automatic inspection program creation window

pops up (Screen 1).

2. Press OK button. If you want to change the filter settings or want to create smaller frames,

change settings value.

3. CAD coordinates arrangement window pops up. Arrange coordinates to components. Press

complete button, then Stamp Applying window pops up (Screen 2). Confirm that new stamps

19-1
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19-2

(Screen 1) (Screen 2)

are created in Stamp List, and they are all applied to components (Parts Name list). Press OK

button.

4. In Main screen, inspection frames (stamps) are placed on components. Start inspection for

teaching. Create Main/Sub fiducial reading frames.

5. Execute inspection again with same PCB for verification. If there is false NG, add the
component's picture as master picture to stamp. If you activate G/NG confirmation mode with
"Add master pic. to stamp" option in advance, the work for debugging false NG will be very
much sofisticated.

If Pack Stamp is checked-on, do not "Add master pic. to stamp". Because master picture will be
added to Pack, and false NG won't be improved.

* If some components have no size information, no stamp is created for them. Draw inspection frames
by yourself while teaching.

* If you already loading stamp libraries for some components, new stamps are not created for these

components.

19-3
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19-3 Setting Window

All stamps created from X and Y size information have the same settings.

. If X or Y size of component is less than input value, Zoomed (High Resolution) stamp is created.

Default value is less than 0.5mm, then components such as 0402 or 0201 will be zoomed

stamps. Value can be input from 0.20 to 2.00.

. If X or Y size of component is more than input value, the square stamp is created instead of

actual XY size. QFP or SOP is often too big than FoV and if the frame is too big, the resolution
will be lowered and it will loose accuracy. To prevent these inconveniences, a smaller square

frame is placed. Value can be input from 1.00 to infinity.

. Size of square frame to be created as replacement. Value can be input from 0.20 to 5.00.

. Input ratio if you want to create smaller or bigger size frame than actual size. For example, to

make a bit smaller stamps, input 95 (%).

. Specify how small a frame should be divided into segments. Default value is 4, means a frame

is divided into 4 segments. If the frame shape is rectangle, then it can be divided into 8 segments.
Value can be input from 2 to 16. This value is the number to divid, thus it has no relation with the
value of resolution(grid) in Filter setting window. (In Filter setting window, if you set resolution 4,

then a frame is divided per 4 pixels segments.)

. Set searching area. The area can be set by frame size ratio. If you set 1/4, then component is

searched around its 1/4 outer area. No setting still search 5 pixels around.

. Check on if all components can disregard polarity. By checking on this option, all master

pictures has also 180 degrees reversing pictures when saving.

. Create Pack Stamp.

. Save the change to a setting file. Without saving, the change is applied to only current

inspection program.

19-4
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3

(Screen 2)
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10. By checking on Blur option, stamps are set level 1 blur. Brightness, Contrast, Hue, Saturation

level can be changed between -4 to +4.

19-4 One minute Tune Up for Better inspection

In case, you have some time, pleae do these additional tune-up. The inspection will be more stable and

accurate.
1. Resize frame to fit text or polarity of odd components such as QFP or SOP (Screen1).

2. Check on Letter if the text is not clear (Screen 2).

* Do not forget to press Golden Stamp to apply change (Screen 3).

19-5 Create Stamps Automatically even without Size information

This is the mode to create the square shape stamps automatically without component size information in

CAD data.

1. Open ForSupervisors menu, move to Plus tab. Check on "Create square stamps automatically

from CAD data".

2. At importing CAD data, the window for Automatic inspection program creation will be displayed.

In the center of the window, there is a field to input square size. Set the stamp size that you like

to create.

Automatically square stamps are created.

19-5
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20. Whole Pattern Matching Settings

This chapter explains settings in pattern matching filter which are not mentioned in Chapter 8. Some items
are not used on all models. Also some are old functions and seldom used in today’s inspection. Please

select and use functions only valuable for your production.

20-1 Replace Master picture Color

WV 20-1-1 Color Replace

Color Replace is a feature that reduces the number of false reports without adding Master pictures even if
the color differs. This is mainly used with capacitors, but it is effective with other components/parts if the
surface is uniform. Master picture has a Color List. The inspection area will be replaced with a pre-desig-
nated color before starting inspection. Even if there is only 1 Master picture, and even if it may be a stamp,
it can be matched to parts with various colors. With an Inspection Frame that has many Master pictures,

the color of the Master picture itself can be replaced for inspection.

V¥ 20-1-2 Color Replace Edit Window

The Color Replacement task is performed in the Color replace edit Window (Screen 1). Select an In-

spection Frame and select Replace color from the Master Picture Menu to display this window.

H Edit Menu

The following items can be set (Screen 2).
e Add

Adds the color of the current frame position to the list.

20-2

(Screen 1) (Screen 2)
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* New

Adds an empty Color List. Double-click on the Color Box and use the Color Picker to determine the color.

¢ Duplicate

Makes a copy of the color selected in the list.

® Delete

Deletes the selected color from the list. Colors that have pictures cannot be deleted.

o Fill

If the filter contrast is set high, the color may not be filled properly when the color is replaced. Select Fill
and the replacement area will be painted regardless of filter settings, thus preventing any false calls

* Apply to Masters

Replaces saved pictures with Master Colors at inspection. When this setting is selected, a red line will be
shown on the upper frame of the Color List box.

e Cancel this function

Cancels Color Replacement. The Color List Box will be dimmed. It can be reactivated under the same set-

ting by un-checking.

H Replaced Color

The colors in the Color List can all be replaced to this color. To change the color, double-click inside the
frame and select a color with the color picker. When changing to the Master picture color, select Master

picture from the Color List and then drag & drop into this frame.

H Check Button

The round green button is the Execution button, which is used to confirm the replacement status.

H Color List Box

In one frame, the color will be displayed on the right, and the Master picture on the left. If an object has

only color and no Master picture, the left half will remain blank.

M Paint area

The range to be replaced in the longitudinal direction can be designated in %. If the border between the

range and the electrode is clear, the range can be 100%.

W Sample area

The range for sampling the average color can be designated in pixels.

H Area of color
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Adjusts the range to be considered as the same color. The larger the number, the wider the range.

V¥ 20-1-3 Use Replace color

1. Select an Inspection Frame to apply Replace color.

2. Select Replace color from the Master picture menu in the Master picture area (Screen 1).

3. The Color replace edit Window will appear. First, press the Replacement Check Button to
confirm. You preview the Color replaced while the button is pressed down. It is a little hard to
see since the colors are similar, but the color should have become more averaged (Screen 2).

4. If the replacement range is small, use the 3 sliders to adjust the range.

5. Press OK.

6. If saturation has been lowered prior to this task, to prevent false reports, raise the saturation
sensitivity a little.

7. If the Inspection Frame has a stamp applied, a Change Button will be displayed on the top
right corner of the Master Picture area. If you would like to apply the Color Replacement to the
stamp, press this button and select Update All. This will apply Color Replacement to all Inspec-
tion Frames using the same stamp (Screen 3).

8. When a stamp has been changed, select View Selected Stamps from the Stamp menu and
press the Inspection Button (only the selected stamps will be inspected).

9. If there are NG frames (due to color differences), select the defective frames.

10. Open the Replace Color window, select Add from the Replace menu to add the Current Color
to the Color List.

11. Use the Check Button to confirm that the replacement has been made correctly.

12. Press OK and continue to change the stamp.

13. Repeat the procedure for Re-inspection.

14. If there is an NG, repeat the above procedure to add to the Color List.

WV 20-1-4 Precautions in Color Replace

1. When replacing colors, the Master picture must be cut out as accurately as possible. Avoid pic-

tures that contain parts a PCB, or that are nearly a defective.

20-1-3

(Screen 1) (Screen 2) (Screen 3)
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2. There is no limit to the number of Color Lists. It is recommended that you utilize them as Picture
Applied Stamps, since you can create multiple Color Lists as Picture Applied Stamps to use in
the inspection of various parts.

3. Color Replacement will be incomplete for parts with uneven surfaces (such as resistors with
printed text). It cannot be replaced, but inspection can be executed as usual.

4. If the Inspection Frame is misaligned, Color Replacement will only be half completed. In this
case, false reports may be created due to Color Replacement.

5. The area of the Paint area can be increased in length by using the lever. With a square frame, it
is not certain which direction this setting will be applied to.

6. Regular inspection will be executed beyond the Paint area (for example, electrodes). Do not
add colors to frames judged as NG even though the color was replaced correctly (the cause of
the defect may be due to different factors).

7. Set the Paint area so that it will contain some electrodes. If the range is smaller than that, some
parts will remain un-replaced.

8. If replacement has not been made correctly, a “?” will appear when the Replacement Check
button is pressed. This judges whether over 50% of the Paint area has been replaced or not.

Therefore, the “?” may appear even if the target area has been replaced sufficiently.

20-2 Camera Special Setting

This feature is available only for AOI with digital camera.

When executing inspections of tiny chips, inspection with older machines is executed by raising the bright-
ness and contrast filter settings to emphasize the difference between the body and the PCB if the body
color and the PCB color is similar.

The problem with this method is that it tends to create false reports since it shows high sensitivity to the
variance of the parts themselves. Even with solder print inspection, variance occurs due to the variance in
the brightness of the solder area.

Machines with digital cameras, camera gain, sharpness and saturation can be controlled to emphasize

the color differences when capturing the image, facilitating stable inspection.

V¥ 20-2-1 Camera Special Setting Window

In the filter setting window, press the Special setup button to the right of Brightness (Screen 1) to display
the Camera Special Setting Window (Screen 2). Default is Standard, but 8 different settings from Custom
1 to Custom 8 can be saved here. The selected setting will be recorded with each stamp (if the Inspection
Frame does not use a stamp, with each frame). However, on machines with a side lamp, Custom 8 will be

used only for solder fillet inspection, and cannot be used with regular Inspection Frames.

275
20. Whole Pattern Matching Settings




H Selection Button

Standard is selected by default, but to create your own settings, select one of the Custom items and move

the levers to change the settings. Use the Switch button to change from Custom 1 — 4 and Custom 5 - 8.

H Levers

From top to bottom, the levers are for gain, sharpness and saturation. All ranges are from 0 to 10.

Default is 2 for gain, 3 for sharpness, and 5 for saturation.

M Side lamp

If the machine is equipped with a side lamp, the Side lamp check box will be displayed.

If you put check, “White main light + side light “ is activated. If you do not put check, only White main light
is activated. If machine has “White main light + side light + DOAL” construction, light setting can be se-
lected from 3 types among “White main light only”, “White main light + side light”, and “Side light only” by

changing the status of check box of “Side lamp” (Screen 3).

H Lower 25% of the main lightning

A check box to reduce luminance by 25% will be displayed when the function is available.

H R G B Selection

With RGB lighting AOI, R, G and B check boxes appear. You can only light each lighting or complex light-
ings. With U series HML type, D box appears. Lighting D is special light for detecting “no solder”. Useful

for detecting wave soldering.

20-2-1
(Screen 1)
(Screen 2)
White main light only White main light + side light Side light only
(Screen 3)
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For stamps with master picture, these settings will be memorized in stamp. If the Inspection Frame does

not use a stamp, it will be memorized by each Inspection Frame.

WV 20-2-2 Camera Special Setting Procedures

1. Confirm calibration.

2. Double-click on the Inspection Frame to display the Set filter Window.

3. Press the Camera Special Setup button to display the Camera Special Setting Window.

4. Select the Custom No. to make adjustments.

5. Once adjustment is complete, enter the setting name for the Custom No. box.

6. Click OK. A warning dialog will appear. Click OK and close the dialog.

7. Click the Capture again button in the Set filter Window. This replaces the Master picture.

8. Click OK to close the filter setting screen. Modify or save the stamp and this procedure is com-

plete.

WV 20-2-3 Camera Special Setting in Solder Paste Inspection

Camera Special Setup in solder paste inspection is done according to the following procedures:

1. Select Solder Paste Check from the Window menu to display the Area Edit Window while the
Inspection Frame is selected (Screen 1).

2. Press the camera special button (Screen 2) in the Area Edit Window, and the Camera Special
Setting Window will appear. Make adjustments here.

3. Inspection will not be affected even if the Master picture is not replaced after adjustment.

When you start inspection, it will start from the Inspection Frame that has no special settings, execute all
the way to re-inspection and then move on to Custom 1, 2, 3, and so on. Even if the Inspection Frames
are in the same cell, if the Camera Special Settings are not the same, they will not be inspected at the
same time. Therefore, the more settings there are, the longer the inspection will take. When a frame with

Camera Special Settings is being inspected, the entire screen will be in Special Setting mode.

V¥ 20-2-4 Calibration

Calibration standard values need to be set for saved Special Camera Settings. This setting will be record-
ed in the inspection program file, so once the standard value is set, it will be corrected regularly even if the

tool or lighting conditions change, and inspection can be executed under the same conditions.

1. Select Calibration Settings in the Settings menu.
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20-2-3 20-2-4

(Screen 1)

(Screen 1)

(Screen 2)

2. Press the Auto Cal. button in the Calibration Setting window to set normal calibration.

3. If a Special Camera Setting is set, press the Special Setup button and select the registered
setting from the pull-down menu. The screen will change, and the position of the meters will
move (Screen 1). The position of the brightness meter will be recorded here and become the
standard value. The reference position will be shown as a red dot on the brightness meter.

(The red dot will be displayed the next time)

Confirm the meters here, and if they are off, click on the meters or adjust using the Gain lever.

When you have set a Camera Special Setting, make sure to set calibration and define the standard value.
If the standard value is not set, a warning message “The brightness calibration standard value is not de-
fined” will appear. Click Calibrate Now to start calibration. However, if the program has been transferred
from another device, the conditions will be different. In that case, click Cancel to terminate calibration,
confirm Special Camera Setting values in the device that the setting was performed on, enter that value in

the bottom left field of the warning window and then click Calibrate Now.

20-3 Gray Level Analysis

This is fillet analyzing function before histogram method is developed. The amount of light (white) is in-
spected in percentages while the image inside the Inspection Frame is converted to gray scale. Gray Level
Analysis enables stable inspection since the number of false reports can be reduced in spite of pattern

variance. To use this method, select Gray Anal./ Col. Emph. from the Set filter window.

WV 20-3-1 Gray Level Analysis
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20-3-1

(Screen 1) (Screen 2)

When Gray Level Analysis/ Color Emphasis is selected, a window (shown in Screen 1) will be displayed (only
features related to brightness are explained here. Refer to 20-4, “Color Level/ Hue Level Emphasis” for in-

formation about color emphasis).

H Disabled

Pattern matching inspection is executed without Gray Level Analysis.

H Pre-check

Gray Level Analysis is executed before executing a pattern matching inspection. If judged as NG in the

Gray Level Analysis, the pattern matching inspection will not be executed.

H Check after OK

Gray Level Analysis is executed after a pattern matching inspection. If judged as NG in the pattern match-

ing inspection, Gray Level Analysis will not be executed.

H Refresh

Resets the current values for the amount of light (white) when the Master picture in the Inspection Frame is

replaced.

H Live viewing

This is used to confirm the judgment of the current conditions by testing at other points. Click on the but-
ton and move the cursor inside the screen, and the Inspection Frame will be displayed, with the values
displayed under the frame. The value in () is the set value, and the value of the testing position will be dis-
played next to it in real-time (Screen 2). The color of the value will be blue if it is close to the set value, and
it will change from green to purple as the value moves away from the set value. The value will be displayed
in red if it is out of the acceptable range. The acceptable value can be set by sliding the lever next to the

Live viewing button.
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V¥ 20-3-2 Gray Level Analysis Setting

1. First, set the filters. Do not set the filters too strictly.

2. Press the Gray Anal./ Col.Emph. button.

3. Select Pre-check or Check after OK.

4. Press the Live Viewing button, place the pointer on the place that needs to be inspected and
adjust the acceptable values. Based on the standard value in the (), use the slide lever and the
+/- button on either end to set the acceptable range for + and -.

5. Press the Close button after making your settings. Once the Gray Level Analysis is set, the icon
next to the Gray Level Analysis/ Color Emphasis button will be colored.

* This setting is very sensitive to misalignment. If there are variances in position, you may need to ap-

ply some Find settings. Tracking is disabled.
20-4 Color Level / Hue Level Emphasis

If there is little difference in color between the PCB and the parts, apply strict settings , but these settings
will increase the number of false reports if the parts themselves have variances. Therefore, emphasizing
the slight color differences of certain color levels can facilitate inspection. The number of camera move-

ments cannot be changed with this setting.

V¥ 20-4-1 Color Level Emphasis Items

Of the Gray Level Analysis/ Color Emphasis, the following are color level emphasis items:

H Disabled

Color emphasis is disabled.

B Red/ Green/ Blue

Select the color that should be emphasized. Check the box and the image will change. Multiple colors can

be selected. Click again to cancel the setting.

H Low/ Med/ High

Select the emphasis level for the selected color.

H Color

This will emphasize the color .With this feature, you can make the color of a dark chip stand out from the
body, so it will be easy to detect the existence of components/parts and misalignments by checking for

the existence of that particular color
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H Remarks

The key to defect detection is the setting of Hue/Saturation in the Set filter Window. Therefore, it is tempt-
ing to lower hue/ saturation levels to reduce false reports, but this should be limited to around -2 since the
most important color detection sensitivity will be lowered. Brightness/ contrast can be 0 in most cases,
but this should also be kept at around +/-2 depending on the situation.

* Color level emphasis is effective especially for images obtained with white lighting. The inspected
parts are not necessarily always black chip (eg. 0402 resistor), but this specializes in parts that lack
color. Since final judgment is based on whether color exists or not, electrodes should not be included
in the inspection.

* The effect of this feature may not be obtained from components/parts in dark areas, such as in-

between parts, since hue emphasis elements are almost nonexistent.
20-5 White or Black PCB/Components Inspection

If the PCB or the component’s colors are close to white, normal lighting may cause overexposure, mak-
ing it difficult to inspect. In this case, Luminance can be reduced to obtain an image that is easier to see

and to inspect. On the other hand, if PCB color is too dark, the filter setting for black components such as

20-5-1
(Screen 1)
(Screen 2)
(Screen 3)
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SOT will be difficult, in this case, luminance can be increased.

This feature is available only on AQI with digital camera.

V¥ 20-5-1 Setting

If the PCB is white, check Reduce Light in General Settings. This setting will be effective for each Inspec-
tion Program (Screen 1). If PCB is dark, click Reduce Light twice, then it will change into Decrease Light
(Screen 2).If the components/parts are white, check Lower 25% of the main lighting in Special Camera
Settings in the Filter Settings. This setting will be effective for each Inspection Frame (Screen 3).

In order to avoid minor differences between machines, calibration will be executed for when Luminance is

reduced in addition to normal Luminance calibration.
20-6 Grouping for pattern matching stamps

Grouping combines multiple Stamps which are copied from original Stamps. Grouping is old style, and
has many restriction, therefore creating new group stamp and loading group stamps is prohibited now.
If you have an inspection program with Group Stamps created by old AQI, you can still edit group stamp.

To learn such operation, please read manual attached to the old AQOI.

20-7 Text filter for AOl with RGB LED

Models with RGB lighting can sometimes not detect text well because of position or component’s height.
This is caused by Layer structure of RGB light.

We developed new text detection filter only for RGB light model. This filter will decrease the difference of

20-7

(Normal condition) (With RGB text filter)

> »
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RGB lighting ratio in stamp area. When normal filter setting can not detect text well, try this new option.

* Limited to AOI with RGB LED models. The button is not displayed in the other models.
* This is effective only to normal lighting, will not be much effective to lightings created by lighting

selection

H How to set

Check Text box on. A new button will be shown next to Text box. Press this button. The color of button

will turn in grey. Now new text detection filter is activated. Sensitivity Level will be set AT (Automatic).

20-8 Fillet color emphasis option for FDL Series AOI

The laser text on odd component is difficult to read by default illumination. By changing illumination to
Fillet, laser text can be seen well. On FDL series, if laser text is still blur, there is an option to emphasize

the fillet color.

* Limited to U22X-ML/HML models. The button is not displayed in the other models.
* On Off-Line Teaching software, when Screen Mode is FHD and if you load the data created by other

AOI than FDL series, this option will be still shown, but there is no effect.

Hl How to set

Check on "Fillet", then lamp icon will be displayed. By clicking lamp icon, fillet illumination color will be

emphasized.

(Default illumination)

(Fillet illumination)

(Emphasized Fillet illumination)
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21. Fillet Inspection (old method)

As old method, you can inspect fillet by Pattern Matching or Wave Form methods. These old methods are
not often used because Histogram method is better nowadays.

* These features are available only on machines with red side LED lamps.

H The machine casts a red LED light on the PCB surface at an angle to emphasize the components/parts
on the curved surface of the solder in red and make the forms stand out. A high-speed rendering process
will be applied to the image and only the fillet will be extracted for matching judgment against an OK or
NG (Screen 1).

LED flashing synchronizes with image capture, capturing images when the LED is both on and off, allow-
ing simultaneous inspection of parts and fillets. In addition, with the machine red LED can be always on,

enabling inspection for areas such as laser markers that are difficult to extract with only the main lighting.

B When closing the Setting screen, a warning message, “Reflection from side light too low/high”, may be
displayed with fillet Inspection Frame’s for QFP and SOP leads (Screen 2). This means that the red area is
either insufficient or nonexistent. With the pattern matching method, the red area is insufficient when in-
specting small fillets, making it very difficult to get stable inspection results.

Therefore, this software is equipped with Waveform Inspection in addition to Pattern Matching Inspec-
tion. Waveform Inspection takes the sections that are picked up in red within the Inspection Frame and

displays the red sensitivity of both the horizontal and vertical waveforms. The intensity of red sensitivity is

21

>

(Screen 1) (Screen 2)

(Screen 3)
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determined by the angle at which the angled LED light (Side light) is reflected. In other words, if the fillet

has round edges, a mountain-shaped waveform will be displayed with a certain point being the peak. The

Waveform Inspection compares this waveform to the waveform of the Master Picture. This method is less

likely to be affected by variances in fillet forms and volume, and inspection is possible even with only a few

master pictures (Screen 3).

21-1 Pattern Matching

In this chapter, the programming of Components and IC Leads are described separately.

V¥ 21-1-1 Passive Component

5.

. Draw an Inspection Frame on the fillet. It is better to include not just the fillet but also the PCB

so that the red form will stand out inside the black Frame (Screen 1). If only the fillet is in the
frame, it is difficult to judge the difference in appearance between other parts, making it difficult

to adjust the filter. For 0402 size components, draw a Frame on the entire part.

. Select the Inspection Frame, open the Set Filter Window and check the Fillet button. Hue Sen-

sitivity and Saturation Sensitivity will be hidden and Red level and Auto Adjust levers will be dis-
played (Screen 2). The picture will be colored red as it is illuminated by the LED (Screen 3). Red
Level is used to adjust sensitivity when extracting red parts from the captured image, and Auto-

matic Correction is used to set acceptable tolerances of the red color in the Master Picture.

. Adjust the red sensitivity lever so that the fillet becomes more/less red. If the red area is too

small, a warning, “Reflection from side light too low”, will be displayed.

. Adjust the Track button according to the size of the fillet and pads. The default value is 3, but

change this to a value between 5 and 7 for components larger than 0603 size (Screen 4). Like-
wise, set the Resolution button. The default will split the Frame in grids, which can be changed
to stripes (Screen 5). If a red part is displayed at the edge, it may cause false reports, and
stripes are effective in this case (Screen 6).

If the shapes are varied, check Blur. The type of blur can be selected in the Blur area at the

21-1-1

(Screen 1) (Screen 2) (Screen 3) (Screen 4)
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(Screen 6)

(Screen 5)

(Screen 8)
(Screen 7)

bottom, dragging the mouse to the selected type, or use the A ¥ buttons on the right to adjust
the level.

6. Once the filters have been adjusted, click OK, and if an alert dialog to replace the Master Pic-
ture appears, click on “Capture again” and replace the picture (Screen 7). If the Fillet check
box is checked, the picture will be taken with the LED on. The Master Picture must be replaced
even if no changes are made to the parameters. You should make a habit of always replacing
the Master Picture with the capture again Button (the camera icon).

7. Once all settings are complete, register the frame as a Stamp. After registration, you should
double-click on the icon in the Stamp List Window to apply the picture (Stamps with master

pictures will be displayed in bold letters). (Screen 8).

V¥ 21-1-2 IC Lead

With IC leads, Inspection Frame’s can be placed effectively by using the standard ICLeadGap Stamp.
1. First, create one fillet Inspection Frame for each IC lead. The procedure is the same as with
components (Screen 1).
2. Place the ICLeadGap stamps to include the fillet Inspection Frame’s that you have just created
(Screen 2).
3. Double-click on the ICLeadGap stamp Frame and the Lead gap inspection setting IV window
will appear. Check Include Fillet check (Screen 3).

4. Once the ICLeadGap stamp is adjusted, close the window. When the ICLeadGap Stamp is in-

286

21.Fillet Inspection (old method)




spected, the Bridge Inspection and the Lead Fillet Inspection of the Stamp will be executed si-
multaneously (Screen 4).
* When adjusting Lead detection in the ICLeadGap Stamp, the white part will be considered as the
Lead. If the center of Lead is reflected in white, or if the silk and patterns in between Leads are dis-

played white, IC Lead inspection will not be performed correctly.

V¥ 21-1-3 Cautions on Adjustment
Hl Adding Master Pictures

¢ Understanding the Characteristics of components/parts

When you have expanded the tolerance to reduce false reports, make sure you check to see that defect
will be judged NG. Points that still cause false reports may be fixed by adding Master Pictures.

One thing to be careful about when adding Master Pictures is to add them in the order of those that are
most likely to be in the majority (an average OK picture). You may be able to resolve 100 false reports by
adding an appropriate Master Picture,, but you may also be able to resolve only 1 false report by adding
an inappropriate Master Picture. Needless to say, the more Master Pictures you have, the more inspection
time it will take, so it will be important to know the Characteristics of components/parts before inspection.
e | imit number of used picture

When many Master Pictures are selected, the inspection time will increase. To speed up inspection time,
you can compare only Master Pictures with a high frequency of matches. Perform inspections on a couple

of PCBs, and once you have learned the trend, designate the number of pictures by choosing Limit num-

21-1-2 Fillet Inspection Frame

IC Lead Frame ————

(Screen 1)

(Screen 2)

(Screen 3) (Screen 4)
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ber of used picture in Sensitivity from the Settings for supervisor window (Screen 1). This value
designates how many Master Pictures will be used for comparison, in order of highest matching frequen-

cy, and O will select all Master Pictures.

H Filter Settings

¢ | evel of Brightness

When Brightness levels are raised, points that should be judged NG may be judged OK. In this case, you
will need to verify the points that should be judged NG.

® Red level

For points where red reflections are too small, you may have to skip inspection of the point and inspect
manually, or you may have to include it in the inspection knowing that it will be a false report depending on
the level of red insufficiency. If you increase Brightness too much due to filter adjustment, this may cause
NGs to be judged as OK.

® Resolution grid

By splitting the Inspection Frame into Stripes, you can handle false reports caused by small parts at the
corner of the Frame. Click on the resolution button in the Set filter Window, and select Stripe-short/
long from the pull-down menu (Refer to 21-2-1 Passive Component).

e Auto Adjust

Auto Adjust (Red auto adjust range) is set at 20% maximum by default, which can be changed in Red
auto adjust range in Sensitivity in the Settings for supervisor window (Screen 2). 2 is equivalent to
20%.

e Color Removal

LED lighting may cause copper-foiled pads to be extracted and misjudged as if they were solder fillets.

In this case, the LED light can be flashed to take pictures when the light is ON and OFF, and you can re-
move the red of the copper-foiled pad from the OFF picture and inspect. To do this, click on the slider area
of the Red level while pressing the option key in the Set filter Window, and select Red is excluded from
the pull-down menu (Screen 3). The icon next to the Red level will be activated, and this icon will be able

to toggle red exclusion ON and OFF. This should be set for each Inspection Frame .

21-1-3

(Screen 1) (Screen 2) (Screen 3)
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21-2 Waveform

V¥ 21-2-1 Inspection Frame Settings

1. Draw a Frame.

2. Double-click on the Frame and open the Set filter window.

3. Check Fillet, press the waveform button next to it (Screen 1) and the display will switch to Fil-
let wave edit Window (Screen 2).

4. First, select the Analysis side on the left. Both is selected by default, and the waveforms for
both longer side and shorter side are displayed for the Inspection Frame. Select the vertical
waveform for QFP and SOP leads (if the shape is consistent, and you wish to perform an exact-
ing inspection, both may be selected). If the waveform looks like two mountains, select the In-
spection Frame again so that it looks like one mountain to make the settings easier.

5. Click OK to close the screen and register as a Stamp. Adjustment will be easy later on if you
register the Master Picture to the Stamp too.

*Waveform Inspection Frames are highly sensitive to positioning. We recommend that you set the
position tolerance for Find exactingly and use the ICLeadGap Stamp for QFP and SOP leads. Since
fillet Inspection Frames placed within the ICLeadGap Stamp will be inspected on the recognized lead,
there will be no misalignment in the lateral direction. However, the correlation between IC lead and
pads tend to show some variance in the vertical direction depending on the lead bend. In this case,
set the position tolerance in the vertical direction, and set the ICLeadGap Stamp exactingly. If the

lead is broken, multiple fillet Inspection Frame’s will be placed there and cause false reports.

V¥V 21-2-2 Fillet wave edit Window

The Fillet Wave Edit window (Screen 1) consists of the following items:

H Analysis Side

This is used to select the long and short side waveforms of an Inspection Frame. Under normal condi-

21-21

(Screen 1) (Screen 2)
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tions, select the waveform that is vertical to the part (Screen 2). If the form is stable and inspection is per-

formed exactingly, this setting can be left as Both.

M Blur

This is used to blur the image. The level can be adjusted by dragging the lever up and down, or by clicking
on the up/down buttons for fine adjustments. If the red parts vary by PCB, emphasize blur to reduce False
NGs (variable range is O — 6, default is 3).

Hl Wave

The Waveform chart indicates the distribution of the red area (this chart shows only the waveform, which
is not affected by the volume). This can be set as High/ Middle/ Low, with High creating sharp waveforms
useful for exacting inspections.

Low will create a smooth waveform, performing a less exacting inspection (waveform changes depending
on the amount of Blur, therefore waveform and Blur sensitivity should be adjusted at the same time).

H Volume

This sets the amount of consideration that should be given to the red area when judging OK/NG. When
judgment is attempted with just the waveform, differences in the red parts caused by varying amounts of
solder and misalignment may not be detected. Therefore, not only the difference in the waveform, but also
the difference in the red area is taken into consideration for this judgment. The level of consideration can
be set as High/ Middle/ Low in the Volume section.

High will put more emphasis on the differences in the area. If yellow numbers appear when the Analysis
Button below the cell map area is pressed, it means that waveforms match but the area does not.

H Chase

If the Inspection Frame is misaligned, it will search the surrounding area. This button is used to set the
range of tracking. When Find is set for certain ranges, this button will be disabled.

M Special %

Probability for OK (OK%) can be set for each Inspection Frame. If nothing is selected here, the %OK set-

tings in General Settings will be applied.

H Return to Pattern Matching Analysis

p1-2-2

(Screen 1) (Screen 2) (Screen 3)
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This will change the inspection method from the Waveform Inspection to Pattern Matching Inspection.
Check here and close the Fillet wave edit window, and the method will be changed to Pattern Matching.
H Red Exclusion ON/ OFF Button

This button determines whether Reject Original (Color Removal) should be applied or not (Reject Original
can be set in the Wave fillet setting for system Window). If the button is green on the outside, red elimina-
tion is active, if the button is red on the outside, red elimination is disabled, and if red elimination is not set,
the button will be grayed out and cannot be used.

H Supervisor Setting

Fillet Wave Edit Window is set for each Inspection Frame, but Supervisor Setting needs to be set for each
Inspection Program. Click the button while pressing down the Option key and the button will be activated.
Pressing the button again will display the Fillet Sensitivity Standard Value Setting Window (Screen 3) .

WV 21-2-3 Wave fillet setting for system Window

The Wave fillet setting for system Window (Screen 1) determines the standard value of the entire Inspec-
tion Program rather than for each Inspection Frame. The following items can be set up:

H Reject Origin.

The same operation as Color Removal in the Pattern Matching method can be applied here. Sensitivity
can be adjusted only for red.

H Show difference after analysis

This displays the difference between the Master Picture waveform and the inspection target waveform as
a red waveform when analyzing the Waveform Inspection Frames.

When the check is removed, they will be displayed overlapping (Screen 2).

H Auto red

Inspection can be performed after red sensitivity is automatically adjusted to the same level so that the
red color extracted from the inspected parts will be at an appropriate intensity compared to the Master
Picture. Put a check in Add red or Sub red to activate this. The Automatic maximum red level can be set
between 0 — 12.

H Volume define

Values to be allocated to Low/Mid/High for Volume in the Wave fillet setting for system Window can be
defined here. The value indicates the rate that the red area should be considered, and the defaults will be

15%, 50% and 75%, respectively.

V¥V 21-2-4 Adjustment for Waveform Inspection

1. After the first inspection, analyze the Inspection Frames that have been judged False NGs. First,
confirm whether the Position tolerance is set appropriately.
2. During analysis, the matching rate will be displayed in numbers, and if it is below 60%, it will be

displayed in red. If it is over 60%, it will be judged OK, and analysis will be terminated at this
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21-2-3
Show Difference ON Show Difference OFF
(Screen 1) (Screen 2)
21-2-4
NG by waveform NG by volume
(Screen 1)
(Screen 2)

point. If the number appears in yellow though the rate is below 60%, it means that the wave-
form matches, but the area matching ratio is below 60% (Screen 1).

3. Sensitivity should be adjusted depending on analysis results, and in general, major changes
should be made by Wave and Volume, with Blur being used for fine-tuning.

4. If adjustments cannot be made completely, confirm the effects of Auto red. Place the mouse
pointer on the Master Picture in the Fillet wave edit Window and drag it from side to side. Then
the Master Picture and Work Area changes to red-extracted mode, and the red sensitivity will
change according to the movement of the pointer (Screen 2). If the picture does not become
similar to the Master Picture, add a picture.

5. When inspecting using the IC LeadGap Stamp, and if either one of the Inspection Frames in the
IC LeadGap Stamps is judged NG, the Frame placed first will always become red. If the Frame

that was not placed first is judged NG, confirm using that Inspection Frame.

292

21.Fillet Inspection (old method)



22. Options for G/NG Gonfirmation
Mode

G/NG Confirmation Mode is simple easy-to-use display for operators. We offer some nice-to-have func-

tions, these will be useful when data programmer and operator is not the same person.
22-1 Prevent operator's mis-judgement

When using the mouse, you/operator may unintentionally judge an Inspection Frame as Good by clicking
continuously. In order to avoid such operational errors, you can set it not to allow the continuous Good
clicking "unless a certain amount of time past", "Move mouse pointer away from Good button”, or "Unable

to click Good button under certain conditions". The procedure is as follows:

VW 22-1-1 Set and activate

1. Select “Extra settings for G/NG Mode” in Map View setting window, or press the Option key
while Good/NG is displayed in the Cell Map menu. A clock icon will appear. Click on the icon to
display a setting window. Click on the icon to display a setting window (Screen 1).

2. Set to prevent Good button clicking.

3. If the click interval is set, the Minimum click Interval will be displayed dimly on the bottom left
corner of the Good button.

4. To set to unable to click Good button, select "Unable to click Good button" tab, a warning
message is displayed on screen, and it becomes not possible to press Good button (Screen 2).

* This minimum click interval is valid only for the Good Button.

22-11

(Screen 1) (Screen 2)
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* Normally when there are multiple NG stamps in a Pack Stamp, the voluntary NG error message is
displayed, but if "Unable to click Good button" is set, warning messages of all NG are displayed.
This can assist you strongly not to let escape any defects.

* Good button click interval and Unable to click Good button can also be used in NG Cell View..

V¥V 22-1-2 Setting Window

Each function is described below.

1. By inputting number, operator can not press Good button until the setting seconds past.

This helps operator to check NG points carefully. Maximum seconds is 3, and minimum is 0.1.

2. Click and activate this will make the operator unable to click Good or NG unless inputting o then
k by keyboard before pressing Good button (Upper arrow), and must hit n then g by keyboard
before pressing NG button (down arrow).

3. If this check box is checked, mouse pointer always comes back on NG button after clicking.
This helps operator to click Good button unexpectedly. If this is checked, Good button waiting
interval setting is invalid.

4. If this check box is checked, operator can not press Good button, when classifying NG which
corresponds to NG condition set on 6,

5. Recover settings to default status.

6. Change the character size of Error message.

7. Operator can not press Good button when types of NG checked here appear.

NGs written in black in NG Type column are NG types that this machine defined.

NGs written in blue in NG Type column are original NG message that user defined in Hide/Show
Object of Window menu. When the detected NG is corresponded to both machine defined NG
and your original defined NG, machine NG has priority and displayed.

For example, if the condition is just like above picture, and original frame type set to be text,

22-1-2
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and judged matching NG, the error message is "Lower than OK rate, must not.." instead of
"Text incorrect, must be NG".

8. As an exception, by activating this, user may press Good with pressing y key.

22-2 Alert too many false NG

Even AQI detects a defect, operator can classify it as Good by keep pressing Good button carelessly.
This option is, if an operator keeps classifying Good on where AQOI classified NG, an alerting message is
displayed after exceeding certain number of Good classification, and after exceeding final alert limitation,

operator can not press Good button anymore.

WV 22-2-1 Set and activate

1. Press the Option key while Good/NG is displayed in the Cell Map Area. A clock icon will appear.
Click on the icon to display a setting window. Or click Extra setting for G/NG mode in Map view
settings.

2. Select Alert False NG tab, check Set alert for too many false NG, and set accumulate false NG
number, alert message, etc (Screen 1).

3. If any of inspection frame exceeds the limit of alerting accumulative number, an alerting
message is displayed in Work Area from next inspection (Screen 2). If any of inspection frame
exceed the limit of final alerting accumulative number, a warning message is displayed in Work
Area and the operator can not press Good button from next inspection (Screen 3). If Good not
allowed is checked and any of inspection frame exceeds the limit of alerting number, a window
to request program improvement pops up every time after classification (Screen 4).

4. When the operator can not press Good button anymore, he should call the programmer to ask
improving inspection data.

5. The programmer debugs inspection frames with too many false NG. (For comfort debugging,
the program setting should be as followings: check on "Display NG on Map" in Configuration
General of Settings menu in order to display NG and false NG points in Map View after
inspection.) Double click on an orange circle of false NG in Map View (Screen 5). Then Map
View slides to right side and target frame is displayed in Work Area (Screen 6).

6. If the inspection frame is improved, the count of accumulative false NG for the frame is cleared,
and the operator can classify the frame again Good. To reset count for Good not allowed

message, press Clear false NG count button, and input password for releasing.

* Accumulate number and alert message can be customized freely.

* Map View slided to aside on procedure step 5 is disappeared when starting to edit inspection frame
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22-2-1
(Screen 2)
(Screen 1)
(Screen 4)
(Screen 3)
(Screen 5) (Screen 6)

in Work Area unless Freeze is checked on.
* When Show false NG in Map View is checked and false NG is displayed with orange circle mark,

number is shown on next. The number is accumulative number of NG and not of false NG.

V 22-2-2 Setting Window

Each function is described below.

1. Activate this function.

2. Accumulative false NG number to start alerting, and alerting message.

3. Accumulative false NG number and alerting message to start alerting and unable to click Good.
4. After accumulative false NG number for Final alert exceeds setting number, a window to request

program improvement is always displayed after Good/NG classification. On inline AQI, patlight

blinks.
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22-2-2

(Screen 1)

5. By single click, it is checked with bar. In this case, false NG inspection points which are ever
been classified as false NG are displayed in Map View after classification in orange circles
togather with NG red circles. By double click, it is checked and false NG points of the previous
inspection result are displayed in Map View in orange circles (Screen 1).

6. Clear all accumulative false NGs. When you press this button for the first time, you will be asked
to input a password. Because this button is protected by password in purpose of avoiding
dishonest count clear by the operator. If you check Good not allow on, you must set password.

* Even if you do not activate this function, false NG points are displayed in Map view by checking on

Show false NG in Map View.

V¥ 22-2-3 For inline AOI: Stop convey when Good not allowed message is displayed

To strongly alert the operator to improve inspection program when too many false NG, programmer
can set to stop AQOI's convey when improvement request window pops up. Select Tendency NG... from

Configuration in Settings menu (Screen 1). Check Stop conveyer on (Screen 2).

22-2-3

(Screen 1) (Screen 2)
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22-3 Auto saving PCB image and debugging afterward

In factory, if there are too many false calls while inspecting by in-line AOI, operator calls programmer for

debugging. While debugging, the PCB production line stops.

This function enables “If false NG / NG is too many, then create virtual PCB map automatically”.

Later, the programmer can debug inspection program with PCB images of false calls created by this
function on OLT (Off-line Teaching software), and get inspection program back to in-line AQI.

It is not necessary to stop the production line for long, because time spent on in-line AQI is only replacing
(over-writing) inspection program.

In addition, this function is not only effective for false NG debugging, but also effective for collecting NG

PCB pictures.

You can also save all PCB's virtual PCB map (PCB image) no matter it has defect or not. The PCB map
can be seen by free viewer software, and can be converted to jpeg format. For viewing PCB map, you do

not need Off-Line Teaching Software. This is for PCB traceability.

* False NG means the component/part judged NG by AQOI, but after all judged Good by operator.

* This function is available only in G/NG confirmation mode.

First, function “If false NG / NG is too many, then create virtual PCB map automatically”.is explained, then

"save all virtual PCB's map automatically" is explained

V¥ 22-3-1 Save PCB map when too many false NG or NG

1. Select “Extra settings for G/NG Mode” in Map View setting window.

2. Setting window is displayed (Screen 1).

3. Select Virtual PCB auto-creation tab. Check "Create Virtual PCB map when false NG / NG is
over setting number".

4. After inspection, if False NG / NG is more than setting number, a message pops up (Screen 2).

5. Select OK to start creating virtual PCB map. A folder named “program _vs” is created in the

same directory as inspection program. In the folder, sub folders are also created in specified

name (date_time is set here). In the sub folder, a master virtual file and vs virtual files (there

can be vs1 to vs3 files depending on your AOI illuminations) are created (Screen 3).
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22-3-1

(Screen 1) (Screen 2)

(Screen 3)

V¥ 22-3-2 Setting Window

Each function is as following;

1. Check on to activate this function.

2. Check on if you want to create NG Virtual Map while inspection.

3. Set limit of false NG / NG number from 1 to 99999. Set limit of file to be stored, number can be
input from 1 to 9999, if the file exceeds 9999, the oldest file is overwritten by the latest.

4. Set target for creating virtual PCB map from [false NG], [NG] or [false NG + NG]

5. Set sub folder name from [date_time], [number] or [barcode]. [number] is the historical
inspection number memorized in the inspection program, you can see it as TTL on top bar in
map view. For the detail, please refer Manual Chapter 13-1 Map View Mode.

6. Set Map Area. If you select [target], only false NG or NG area is captured. If you select [with
fiducials], in addition to false NG or NG area, fiducial markers are also captured. If you select
[all], all Cells are captured.

7. Set image format. If you select [22x], PCB map is created in non-compressed / high resolution /
big file size. If you select [JPEG], PCB map is created in compressed / low resolution /small file

size.

* If you select sub folder name to be barcode, barcode should be readable and AOI should be
connected to optional Rc22x or CS-Center software. If barcode is failed to be read, the sub folder is
created in date_time name.

* The less camera captures False NG (NG) area, the less virtual files' size will be in JPEG format. But if
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you select 22x format, the file size will be the same how many screens camera captures.

* When creating virtual map in JPEG format, it requires more RAM memory than 22x format because
of compressing operation.

* If your Rc22x software is older than version 1.4.3.4, a message "Create virtual PCB map?" does not

pop up in remote controlling window. Please upgrade Rc22x if you like to remote control this.

V¥ 22-3-3 Off-line debugging of false NGs

Procedure for debugging virtual PCB data on OLT.

1. Start OLT (Off-line Teaching software).

2. Select inspection program from Open... in the File menu. In the example Screen 3, TEST (with
inspection data icon) is selected.

3. Open virtual PCB map from Snap Shot in the File menu. In the example Screen3, the master
virtual file TEST (with OLT brown folder icon) in [080723_162030_vs] in [TEST_vs] is selected.

4. Debug the inspection stamps for false NG components (False NG points are marked by red as
same as NG points.

5. Open next virtual file.
Open virtual PCB map from Snap Shot in the File menu. In the example Screen3, the master
virtual file TEST (with OLT folder icon) in [080723_162342_vs] in [TEST_vs] is selected.

6. Debug the inspection stamps for false NG components. Open next virtual file and so on... At
last, save the inspection program and shut down OLT.

7. Copy (over-write) the inspection program in in-line AOI.

* If you open virtual PCB files by NOT selecting virtual file master , false NG or NG is not

displayed in red.

Next explanation is how to save and view all PCB’s virtual PCB map.
Different from “Create Virtual PCB map when false NG /NG is over setting number” function, Virtual PCB
maps must be stored in the exclusive HDD. Data can not be saved in the HDD where OS is installed.

This is because Virtual PCB map is full size and many.

* Viewer software requires MacPro, iMac or Macmini greater CPU than Intel Core 2 Duo, with OS

greater than 10.5.
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22-3-4

O

(Screen 1) (Screen 2)

(Screen 3)

V¥ 22-3-4 Create Virtual PCB map for all PCB

1. In Virtual PCB auto creation tab, check "Create Virtual PCB map for all PCB" on (Screen 1).

2. Selecting "Map for Main lighting only" will create only one PCB image taken by main light.
Selecting "Map for all lighting" will create also PCB images by side light or DOAL light on AOI
with those lighting.

* We recommend to select "Map for Main lightin only", because it takes time to take many _vs files.

3. Press Save to button (written as Un-setup), select HDD from the list (Screen 2). Even if you
forget to select the target disk, you will be asked to select a disk after the 1st inspection.

4. Start inspection. When inspection has finished, a message "Data sampling for debugging" is

displayed, and PCB images are saved.

Function "Create NG Virtual PCB map while inspection"

If you put check to "Create NG Virtual PCB map while inspection " function, you can prevent the
lowering of inspection speed by saving the Cell image detected as NG. Also smaller disk space is
necessary with saving only NG Cell image. Furthermore debug is possible when NG is detected in the

Cell using Z axis.

* Off-Line Teaching software is necessary for this function.
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22-3-4

Screen 4

How to setup

Put check to "Create NG Virtual PCB map while inspection " (Screen 4). This function is only for
following setting: “more than: 1, Target: NG, Folder name: date_time, Map area: target only, Format:
22X”. You can only change the number of maximum file to be stored.

You cannot use this function together with “Create Virtual PCB map when false NG / NG is over setting

number” function.

Operation of 22X software
1. Load the inspection program, and create the virtual map of whole Map view. This function
creates the Virtual map for each Cell based on virtual map of whole Map view.
2. Start inspection.
3. Create the virtual map for each Cell if it has NG. Folder [Inspection program name_cs] is
created automatically in the same directory of inspection program. Cell virtual map is created
in this folder with Master virtual file and Cell folder (folder only with numbers).

Folder name of saving location for Virtual PCB Map for each Cell differs depending on software
version. "[date]_[clock time]_cs" is used in version 4.9.9r2 or prior. On the other hand, PCB

side "A/B" is added on the folder name like "[date]_[clock time]_A_cs" in version 4.9.9r3 or later.

Operation of Off-line Teaching software
1. Activate “Load _vs file by Cell”.
2. Load the inspection program, and load the master virtual file from “Open virtual PCB map” in
File menu.
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* This function is not available with Special Camera Settings. Cell virtual map is not created even

the inspection frame with Special Camera Settings is detected as NG.

V¥ 22-3-5 Display false NG point in Virtual PCB Map for each Cell

In version 4.9.9r3 or later, Enable to display not only NG point but also false NG point.

In Cell Map area, red colored frame indicates the cell which contains NG points & Cell which contains
both NG points and false NG points. Blue colored frame indicates the cell which contains false NG points.
In Work area, red colored frame indicates the inspection frame of NG point, and blue colored frame
indicates the inspection frame of false NG point. False NG points of inspection frame inside the Pack is
shown by blue colored frame.

* Setting of Virtual PCB Map for each Cell should be completed to use the function for false NG

confirmation.

V¥V 22-3-6 View Virtual PCB map

A directory named "VirtualFiles_For22X" is created at root of HDD. PCB images are saved under this
directory in different folder "Inspection Program name + _vs". Under this directory, each PCB image is

named "Inspection Program name + _vs" and saved in "Date_Hour_vs" folder (Screen 3)

* In the folder, the master virtual file is always created together with _vs files..The master virtual

file created here does not include the inspection result like the master virtual file created by "Create

Virtual PCB map when false NG / NG is over setting number".

1. Start "vs_converter " software (Screen 1).

2. Select Open... from File menu (Screen 2), a Finder to open file will be shown. Select _vs file
(Screen 3). Or you can drag & drop a _vs file on software in Dock.

3. PCB image file will be opened (Screen 4). Window size is resizable. As well as Map view on 22X
software, you can zoom the area by dragging mouse (Screen 5). Zoom can be reset by pressing

mouse longer.

303
22.0ptions for G/NG Confirmation Mode




4. PCB image file can convert to jpeg file. Select Convert... from File menu (Screen 6).
5. A dialogue to save file will be shown. Select jpeg format (Screen 7). You can select format other

than jpeg, however only jpeg is possibly to save.

* It takes time to open and to convert PCB image more than 2GB.

22-3-6
(Screen 1)
(Screen 2)
(Screen 3)
(Screen 4)
(Screen 5)
(Screen 6)
(Screen 7)
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23. OFF-Line Teaching Software

This software is for programming data of Marantz Model 22X series Automatic Optical Inspection ma-
chines, without connecting PC to the machine.

23-1 Features

W Inspection program can be created as if the machine has being connected. Therefore if you have
knowledge of machine's operation software, you do not need any additional study for this software.

W Virtual PCB map (image data) from the machine is used for creating inspection program, thus there is
high compatibility between data created on this software and data created on operation software con-
nected to the machine. After creating data in office, you can immediately start inspection in the line by
copying the data.

W This software has a function named "Tact Simulator" to simulate/analyze inspection time.

23-2 Conditions and Cautions

H This software can be installed on Mac PC.

W Virtual files more than 2GB can not be created on OS less than OS10.6.

W The size of virtual PCB map is very big. When creating and opening image data, it requires large
memory. At least 3GB RAM memory should be installed in Mac PC for this software. The required
memory for AOI's Mac is different from PCB size and lens resolution (ex. 1).

W Virtual PCB map is created by jointing small pictures, "mm versus pixel" setting on the machine
should be accurate enough. The pictures of jointing area can be imperfect, if the component is in the
area, you may not able to create the good inspection frame. On the machine without telecentric lens,
the joints of small pictures does not become accurate when high components exist at the joint (ex. 2).

W This software is applied a protection system against illegal copy. USB key is required while running.

with 20 micron lens with 18.7 micron lens with 10 micron lens
PCB size 650x550 4GB 5GB 10GB
(ex. 1)
Images created by normal lens and telecentric lens
(ex. 2) Actual image By normal lens By Telecentric lens
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23-3 Installation

1. Install the driver for USB key following instruction in attached CD-ROM..

2.

Install "22xx_OLT" application from CD-ROM onto Mac PC. Put USB key in USB port.

23-4 Procedure for creating inspection program

Creating virtual PCB map (operation at PC connected to the machine)

1. Set PCB and execute calibration.

2.

o o W

Move to the position where PCB top-left corner is displayed. Create a frame. This frame is tem-
porary placed for creating virtual PCB map. After creating map, it will be deleted. (Screen 1)

. Move to the position where PCB bottom-right corner is displayed. Create a frame. (Screen 2)

. Save the program. Here we name the program, for example ABCD.

. Select File -> Snap shot -> Create Virtual PCB (Screen 3)

. A dialogue for creating virtual PCB map is displayed. If you would like to create high resolution

picture (big file size), press GO. If you would like to create low resolution picture (small file size),
check JPEG File on, then press GO.

In the dialogue, these are displayed: size of sampled virtual PCB in mm, available RAM memory,
required RAM memory, memory bar which represents the ratio of required RAM memory ver-
sus available RAM memory. (Screen 4)

. If there is not enough available RAM memory, Go button is not active, and you can not press

it. On 0S10.6, a warning message to inform insufficient memory is shown. In such case, create
smaller area of virtual PCB map by replacing 2 frames on top-left and bottom-right, or install
more RAM memory onto Mac PC. If each virtual file exceeds 2GB on OS other than 10.6, a
warning message is shown, and can not create virtual files.

. When checking JPEG File on, operation requires more RAM memory for compressing file, and

the image file's quality is not good, but file size is approximately 1/10.
* According to Mac OS's bug, if big size PCB virtual map is created in JPEG File, the picture will
be broken.

. After pressing GO button, the machine starts to create virtual PCB map. If the machine mounts

(Screen 1) (Screen 2)

(Screen 4)

(Screen 3)
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SIDE light, firstly PCB image is taken by MAIN light, then secondary PCB image is taken by
SIDE light. If the machine mounts DOAL light too, thirdly PCB image is taken by DOAL light.
While taking pictures, the status is displayed in the message bar.
10. After taking pictures, PCB image map(s) is automatically created. Each file name is, if it is tak-
en by MAIN light, ABCD_vsi, if it is taken by SIDE light, ABCD_vs2,
When JPEG File is checked on, each file has JPEG file extension
* There are two types of virtual maps. Small virtual map (one file size is less than 2GB and file length/
width is less than 3 million pixels Screen 5), and Big virtual map (one file size is more than 2GB or file
length/width is more than 3 million pixels Screen 6). You do not need to pay attention on difference,

however operation software more than version 4.4 is required to open Big virtual files.

23-5 Work on the inspection program + virtual PCB map(s)

(Operation at PC which OFF-Line Teaching Software is installed)

Startup and settings
Double click the icon of OFF-Line Teaching software. Adjust monitor resolution to be same as its of AOI's
PC (ex. 3). To apply the resolution change, quite and restart software.

Check Load_vs file Cell by Cell on. Then only necessary Cells’ images are loaded instead of loading
whole PCB image. It reduces time for loading files, and operation can be possible with less RAM memory.

* If you create virtual maps in JPEG format, load Cell by Cell is disabled because JPEG file can not be

clipped per Cell.

Loading
1. Load inspection program and virtual PCB map(s). If program and virtual PCB map(s) is in the

(Screen 5) (Screen 6)

(ex. 3)
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same folder, software automatically load virtual PCB map(s) ABCD_vs1 when opening inspec-
tion program ABCD. It is recommended to create a new folder named ABCD_folder and input
them. The better is to create PCB map by high density mode. Then folder is automatically cre-
ated and all related data is contained in the folder (Screen 1) .

. Open ABCD from menu -> File -> Open... Simultaneously virtual PCB map(s) is open. (Screen 2)
. While loading files (Screen 3), the specification data (Size, offset, mm versus pixel settings

of the machine where virtual PCB map(s) is created.) is also loaded, and PC where OFF-Line
Teaching Software is installed becomes same conditions as PC where virtual PCB map(s) is

created.

. Move to one of the frame which you drew during creating virtual PCB map(s) procedure. Con-

firm that the screen displayed is exactly same as the screen you have seen while creating (Screen
4). If moving to the area out of virtual PCB map, the screen is black out.

* If RAM memory is short for PCB size, inspection speed and display response will be extremely slow.

Programming and Saving data

Programming using these files is possible without any difference from programming by using
the machine.
However, camera special settings, calibration, etc the operations related to the machine are not

possible.

- After programming, save the ABCD inspection program, and get the ABCD program back to PC

which the machine is connected. It is not necessary to get virtual PCB map(s) back.

(Screen 1)

Loading...

(Screen 3)

(Screen 2) (Screen 4)
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Create program for PCB which needs to inspect surface and back

Create inspection program and virtual PCB maps for both surface (side A) and backface (side B) in
different name. Program these data on Off-Line Teaching software. On 22X software, open inspection
program of side A, then switch to side B by side switching button. Open inspection program of side B. A
message "Reading B-Side data..." is shown, click OK. Save the inspetion program. Now the program has
both side A and B.

23-6 Tact Simulator

Tact Simulator is a support tool for simulating inspection time on OFF-Line Teaching Software. Also it can
divide an inspection program into two. The divided programs can be used in two inspection machines, as
a result it can decrease total time spent in factory's production line.

Normally inspection time on OFF-Line Teaching Software does not count movement of camera and car-
rier, therefore it is shorter than the time spent on when inspection with the machine.

But, Tact Simulator calculates the movement time, and inspection time will be as close as real inspection
time.

After simulating, if inspection time is slower than expectation, Tact Simulator can divide a program into A
and B sides, and enable to share the inspection of one PCB.

(Normally A and B sides are used as surface and back.)

Limitation

1. When dividing a program into two programs, do not use the program which has Side B.

2. Group stamp can not be placed in Side B.

3. NewCellAid stamp or CellAid stamp will automatically be deleted when cells in Side A contains
no inspection frame after dividing.

4. Stamps like Fiducials or barcode stamp are copied to Side B too, in order to retain Side B pro-
gram to be as a complete program.

5. The technique of dividing a program is based on dividing stamps whether they belong to Side
A or Side B. Therefore you may not decrease inspection time with PCB which same stamps are
placed on many area. In such case, make cells into blocks instead of divide PCB into Side A
and B, (Screen 1) (Screen 2)

(Screen 1) (Screen 2)
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Tact Simulator Window (Screen 3)
1. Controller Panel

NON: Simulate inspection time for the whole program

A Simulate inspection time for Side A program

B: Simulate inspection time for Side B program

* After selecting radio button, press Appl. button

Reset: Undo distribution of stamps (All stamps are back to Side A.)
2. Stamp List

STAMP: All stamps are listed

N: Total number of each stamp

Tim: Time spent for inspecting the stamp in second

A/B: Checked stamp does not exist on that Side.

* Child stamp in Pack stamp is not listed. Pack stamp is listed as one stamp.

*When check is on B, and then switch it on A, the check on B is automatically
unchecked. On the other hand, if A is checked and switched the check on B,
the check on A is not automatically unchecked.

3. Parameter settings of virtual machine
Parameter settings of virtual machine (Screen 4)
4. maximum speed (Mm/sec)

Maximum speed of movement. Enable to input from 100 to 1000.

5. accelerator (sec/max speed)
Acceleration speed. Enable to input from 0.01 to 1.

6. others overhead (sec)
Time spend except machine movement. It is mainly time spent for capturing images. Enable to input

(Screen 3) (Screen 4)

310
23. Off-Line Teaching Software




from O to 3. This is the most of time required when inspecting with real machine.

7. Apply the change on each value, and write new value into ParaPreference file.
8. Reset the value to default.

Work Flow for Simulating inspection time

1. Open an inspection program by OFF-Line Teaching Software.

2. Select Tact simulation from Configuration in Settings menu. (Screen 5)
Tact simulator window opens.

3. Keep opening the window, start inspection. The inspection time displayed in the message bar will be
very close to the inspection with real machine. (Screen 6 "Normal inspection time")
(Screen 7 "Inspection time by Tact Simulator")

Work Flow for dividing inspection program

1. After simulation, divide stamps into Side A and Side B by referring time spent for inspecting each
stamp.

2. Simulate Side A and Side B by switching A and B buttons on the Control Panel.

3. If the result does not match to your expectation, adjust stamps to which side they belong.

4. If the result matches to your expectation, quit the window by pressing red button on the top-left.
Then, a dialogue pops up. (Screen 8). Selecting Quit without dividing PCB will just quit Tact
Simulator. Selecting Divide PCB into A/B sides will divide the program into A and B sides. Selecting
Cancel will be back to Tact Simulator window.

* When dividing PCB into A/B sides, save the divided programs in new names. Otherwise, the
original data will be replaced.

5. After dividing the program, use Side A program on one inspection machine, and use Side B program
on the other inspection machine.

(Screen 5)

(Screen 6) (Screen 7)

(Screen 8)
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24. Scanning bharcode and Tracing
PCB

You can scan the barcode on the PCB using the camera on the machine. The barcode scanned is at-
tached to the inspection result. You can also use external barcode scanner to read barcode.
The inspection result can be output on roll paper printer, or sent to the optional Production Management

software (Rc22x/CS-Center) via LAN. How to set and work is described in this chapter.

24-1 Scan barcode with AOI’'s camera

Paste special stamp onto the barcode on PCB. Barcode will be captured automatically during inspection.

V¥ 24-1-1 Compatible Barcodes

Barcode must be smaller than Work Area (If it is larger than Work Area, AOI’s camera can’t scan.) Resolu-
tion is 0.1mm for any barcode. Maximum 256 characters can be handled. Below is the table to show the

list of barcode enable to decode by AQI and by Production Management software Rc22X or CS-Center.

Decode-able barcode By AOI By Rc22X or CS-Center
QR Code (model 2) J J
Data Matrix (ECC200) J J
Code 39 J J
Code 128 J J
Interleaved 2 of 5 x J
Micro QR Code A (optional, charged) A (optional, charged)

WV 24-1-2 Setting Stamp for Barcode
1. Place the Special Stamp for scanning barcode such as DataMatrix.
2. Adjust the size to be slightly larger than the barcode, and press the Re-inspection button.
3. Once scanning is complete, the details will be displayed at the bottom of the screen. A “read
Error” will be displayed if reading fails.
4. Double click the stamp’s frame and open settings. Decide whether keeping inspection without

barcode “Ignore” or inputting manually “Manual” when failing to scan barcode.

V¥V 24-1-3 Adjustment

Adjust barcode stamp settings when a “read Error” is displayed. Double-click on the Inspection Frame to
display the setting window. While adjusting setting, you can see changes in real-time. Press Re-inspec-

tion button when you get a clear image.
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* Setting items differ depend on model.

- Color reduction will exclude checked color.

- Camera Special button (lamp icon) will enable to use Special lighting to read barcode.

- Negative will reverse black and white.

- Lighting Selection will enable to use other lighting than main light.

- Erode is used when reading barcode printed with not enough ink. This emphasizes black color.

- Dilate is used when reading barcode printed with too much ink. Or to sharpen lines when Erode
works too much.

- AutoBW judges the borderline of white and black, and converts to optimal image.

- Use search area when barcode sticker is not always pasted at the same place. Select frame by

pressing Control key. You can set Search Area.

V¥V 24-1-4 Use Barcode Stamp as parts number

You can use barcode as part number by activating "Use for parts number” function at setting window of
Barcode Stamp (Screen 1). Possible to send the data to production management software not only as

PCB serial code, but as part lot number.

[2017..4.19 13:47:53 ]

Total PCBs checked[4] block<0>

Total NG PCBs [0] block<O>

Current result (check O NG 0/0) Spent time 3 (check2 2){0/0/1]
BarNum (123456789)

p4-1-4

(Screen 1)

plist 1,35700,30000,0,0,0,0,0,0,1920,1920,266

SYM TTL NG NG_ID _X Y... _NOTE
0 0 - 14444 13065... (* *) ABCD123456789/BCD
{QRcode}
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Read contents will be outputted between “ABCD” and “A/BCD” in “_NOTE”.

V¥ 24-1-5 Block assignment

Possible to assign Block number to Barcode Stamp from setting window. If you make Block with the
Cell which contains Barcode Stamp, the inspection is executed by Block. Therefore inspection took time
when Barcode and inspection frame in same Block were located far apart (Screen 1). Barcode inspection
frame will be inspected before Blocked Cell with this function, so the tact time will improve compared to
the status when disactivate the function.

How to setup

1. Create inspection frame for Barcode.

2. In setting window, put check mark and activate "Apply for barcode in Block". Set the Block number

(Screen 2).

Operation
- If you activate the frame of Block number, minimum value is set automatically.
- Value is cleared when the check of “Apply for barcode in Block” is removed (deactivated the

function).

- Block number cannot be used together with another Barcode Stamp. If you set the duplicated

value, operation will be following.

24-1-5

(Screen 1)

(Screen 2)
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24-1-5

Example: Activate Block number of Barcode Stamp E, and set Example: Change Block number of Barcode Stamp E from "6"
value "1". (Screen 3) to "1". (Screen 4)

- If "Apply for barcode in Block" is not valid, put check, and set duplicated Block number. Duplicated
Barcode Stamp and Block number of Barcode Stamp which has greater and consecutive value will
increase by 1 (Screen 3).

- If "Apply for barcode in Block" is valid, adjust the duplicated Block number. Duplicated Barcode
Stamp and Block number is exchanged (Screen 4).

- Block assignment function becomes invalid when assigning Block to Barcode Stamp which already
assigned the Block.

- If you want to copy the Cell with Block assigned Barcode Stamp, open Copying window, and click
“OK” with pressing [option] key. Block number is assigned automatically to the copied Barcode
Stamp.

* If another Stamp is applied inside the same Cell with Barcode Stamp, copied Cell will become Block.

When you copy the Cell, please operate with the Cell which only Barcode Stamp is located.

V¥V 24-1-6 Barcode stamps in Pack

The same kind of barcode stamps can be in Pack. The packed barcode stamps behave “If one of the
barcode stamp can read, the Pack is judged OK”.

Start inspection. The barcode stamps in Pack is decoded in voluntary order; decode the 1st stamp, if it is
failed, decode the 2nd stamp and so on ... until any stamp is successfully decoded. When one stamp is

decoded,_the rest of stamps are not decoded.

If all stamps fail to be decoded, it is result in Read Error. If any barcode in Pack is decoded successfully,
the Pack is colored in blue and so is the decoded stamp, but the other stamps (failed to decode and not

decoded) are colored in red.

- Only barcode of same type can be in a Pack. For example, QRcode and Datamatrix stamps
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can't be in a Pack. As same, the other kinds of stamps such as pattern matching or histogram

can't be in a Pack together.

- The barcode stamps in Pack are in OR condition, therefore the Matrix tab in Pack setting is
not possible to change.

- Barcode Pack frame is not possible to rotate.

- When any barcode stamp in Pack is decoded, the inspection of rest of barcode stamps is

aborted. For this reason, the barcode stamps in Pack after inspection is colored in red except
the decoded one (colored in blue).

- Pack Master function not possible to use.

V 24-1-7 Read Error

When Manual Input is selected for error settings in this window, a Barcode Input dialog will be displayed

for key input when reading fails. No barcode number will be input if you press Cancel

At this timing, if you press “STOP” button on AQI, inspection will be paused and you can move camera
freely. This function is useful when barcode number is written out of the FoV. After confirming barcode
number, press START button. While inspecting, the Barcode Input dialog will be displayed again.

* Settings -> General -> NG Re-inspect must be active

* If barcode is inspected at the end of all inspection frames, this doesn’t function.

The same window will appear when you press the Space bar while waiting for barcode Data, and you can

input the barcode number from your keyboard (Screen 1).

2417

(Screen 1)
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24-2 Scan Barcode with Handy Scanner, Open File by Barcode

By connecting a barcode scanner to Mac, the barcode on the PCB can be scanned. The barcode which
is not possible to scan by AOI can be decoded by using external scanner. In addition, by using external

scanner, you can memorize barcode number to the inspection program and call it by scanning barcode.

WV 24-2-1 Connecting a Barcode Scanner

The barcode scanner should be connected by the USB or RS232C (Fig. 1). When it's connected to USB
through a Keyboard, all key entries are always accepted, so this may cause unexpected behavior. For ex-
ample, the barcode scanner responds to the keyboard input in dialog boxes, or Input Method changes to
non-English mode when reading barcodes.

On the other hand, input problems are not an issue with the RS232C interface, but Buffalo RS232C-USB
converter (the recommended model) is required, and serial spec should be set for each barcode scanner.
These settings can be made in Setting for supervisor > Other > Barcode reader > Setup button

(Screen 2).

The barcode scanner can be used for Open file and/or LAN output. This can be selected in the Other

Tab in Setting for supervisor.

*Open file... Assign the barcode to an inspection program, when scanning the barcode, the correspond-

ing file will autormatically open.

24-2-1 M22XFDL

o
USB CameraLink|

AC100-240V USER 110 Rs-232cPOTt

o
AC Cable I USB Cable I

| CameraLink Cable

o]
AC Outlet

barcodereader

Serialtype  USB type

Vo
||
/) \

P
Mouse Channel 0 |3,

KeyBoard | |

ThunderBolt Cable

PC  thunderBolt Port D g use Port

ii USB Port
N |

(Screen 2)
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[ AN...... When the barcode is scanned, the barcode number is added to the inspection results and sent

to the Rc22x.

V¥ 24-2-2 LAN (Identify PCB by barcode)

1. Select Setting for supervisor > Other > Barcode Reader > LAN.

2. Check Setting for supervisor > LAN > Send result after reading bar code. This will add the
barcode number scanned by the barcode scanner to the inspection results and send it to the
Rc22x after inspection (Screen 1). If Send bar code before inspection is checked, inspec-
tion start after reading barcode. This barcode number can be used as a reference number for
matching the PCB and the inspected data when using repair software(Rep22x)..

3. When the machine is in standby status, a standby message will flash. Standby will be aborted
after 1 hour. If you wish to abort standby, click the Stop button on the screen, the Stop button

on the machine, or press the Esc key. Key input can be enabled with the Space key.

WV 24-2-3 Open file (Open inspection program by barcodes)

1. The File menu contains an item Open recent file, and the files used recently will be listed here.
Usually, only the location of the file is linked to this file name.
Check Setting for supervisor > Other > Barcode Reader and select Open File, and the bar-
code number will be linked to this list.

2. If a file containing a barcode number is opened after you make this setting, the file will be dis-
played in italics in the Open recent file (Screen 1).

3. When the barcode scanner scans a number, that number and the barcode numbers stored in
the italicized files will be matched, and the corresponding file will open.

4. If the number corresponding to the number scanned by the barcode scanner is not found, a

24-2-2 24-2-3

(Screen 1) (Screen 1)
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dialog to select the file will appear. The barcode number will be linked to the file selected here
(Screen 2).
5. By using optional “Do not save files when opened by barcode scanning”, the file is opened by
read-only mode and you will not be asked to save or not save file.
* By pressing START button in 10 seconds after reading barcode for switching the inspection pro-

gram, the barcode is attached to the inspection result of the 1st PCB.

H Edit Recent Files

When you select Edit Recent Files from the Window menu, a window to edit the barcode numbers, lot
numbers and notes of recent files will be displayed (Screen 3). If necessary, click to edit each cell. Double-
click on the items in the NAME column to delete the file from the recent files. Click on the item name at

the top, to sort files by item.

e Barcodes can be edited in the NUMBER column. You can use the Wild character (* ) here, wild card
can replace more than one number, e.g. 123* will correspond to 123456 or 123789, but if you want to use

wild card between numbers such as 1237, you must use one wild card for one number.

o493 24-2-4
(Screen 2)
(Screen 1)
(Screen 3)
(Screen 4)
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¢ |n version 4.9.9 and later, more than one barcode can be set by separating them with “” (comma). Input
barcode number to “BARCODE” in the edit window.

Example) a00001,b002,c00*
*Maximum number of text to set for barcode is 127 to prevent inspection of incorrect PCB. Comma is

included in the number of text.

¢ To add LOT information, click on the cell in the LOT column. Up to 31 single-byte letters can be entered.
Once the cell has been edited, select LAN Window from the Window menu and press connect to up-
date the information.

* The recent files can store up to 512 files. Even if a file is not on the menu, it can be matched as long

as it is stored. If the storage capacity is exceeded, older files will be deleted.

- Possible to import/export the resent file list (Screen 4). Exported file is editable by text format.
Information of each file is in order from file pass, NUMBER, date, LOT, NOTE, and output by a line. Each
item is separated by Tab.
* Please use text editor or Excel for editing exported file.
Purpose
1. Only 1 file can be deleted in the menu Edit Recent Files. You can organize the list of recently used
files easily by deleting unnecessary line from exported file, and read the edited file.
2. Registration to each machine was required if the inspection data was created at network drive, and
shared with multiple machines. By using this function, it is possible to extend the list of Edit Recent

Files to multiple machines easily.

V¥ 24-2-4 Using Open File/LAN at the same time

In order to use the barcode scanner for both Open File and LAN, follow the procedure below:

1. Select Setting for supervisor > Other > Open File.

2. Then check Send result after reading bar code in the LAN tab.

3. Go to the Other tab again. Make sure that both Open File and LAN are selected (Screen 1).

4. If you would like to change the setting here, click on one of the radio buttons. Then the setting

will go back to the state in which only one of the two items is selected.

24-3 Prevent inspecting incorrect PCB by assigning barcode

In a factory, sometimes operator opens incorrect inspection program or inspects incorrect PCB. This
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(Screen 2)

(Screen 1)

(Screen 4)

(Screen 3)

option may prevent such human mistakes by using barcode on PCB.
* By activating this option, you can't use the function "Open File by barcode".

* Barcode in Block is not applicable.

V¥ 24-3-1 How to use

1. Open For Supervisors menu from Configuration in Settings menu. Move to Action tab,
check on " Prevent inspecting incorrect PCB by assigning barcode" (Screen 1)

2. A caution message will be displayed, click OK and activate this option.

3. Next step is assigning barcode to the inspection program. Open "Edit Recent Files" in Window
menu (Screen 2).

4. Input barcode number in BARCODE field. For example, if your PCB has barcode such as
abc001, abc002 ..., input abc™. (Screen 3)

V¥ 24-3-2 Running

After changing PCB model, when the first PCB arrives to AQOI, the barcode on PCB is scanned. If the

barcode is other than the assigned numer, an error message will be displayed (Screen 4).

* This also works in case using USB handy scanner.
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24-4 Connect to Production Management Software

This chapter describes how to connect to Production Management Software Rc22x or CS-Center via
LAN. Select Setting for supervisor from Configuration in the Settings menu and move to the LAN
tab. Set the Port and IP Address to that of Rc22x/CS-Center, check Enable LAN for Rc22X/CS-Center,

and check at least the following items. (Screen 1)

W Show remote G/NG screen
H Send inspection result text

M Enable remote Start/Stop

If a LAN connection is enabled and Rc22x/CS-Center is activated, it will be connected automatically and
the connection icon will be displayed next to Eyeglass button. When disconnected, the center of the icon
will turn red. Click this icon to connect again.

* If you start 22x with LAN connect on, and if Rc22x/CS-Center is not started, 22x re-tries for 10 sec-

onds, to terminate this connection, press Esc key.

H Send barcode number too
Attach numbers from barcode to inspection result.

H Read before inspection (by USB reader)
Inspection starts after reading barcode.

* This option is only valid when using external barcode scanner to read barcode

24-4

(Screen 1)
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l Send Good data too (dx, dy)
When this is checked on, 22X sends not only NG data but also OK data to the management software.
When checking up position shifting of components, check this on.

l Send Stamp name too
Output inspection result includes stamp names too.

l Send Cell images (CS-Center only)
This is an option for Catch System. If this is checked on, 22X sends Cell images, too.

*When machine is not connected to CS-Center via LAN, this menu is inactive.

24-5 Remarks

V¥V 24-5-1 Send OK Data

H Check Setting for Supervisor > LAN > Results include OK data to send OK data as well as NG
data to the Rc22x/CS-Center.

B When this setting is activated, the result data transferred to the Rc22x has shift information in the
NOTES column in X/Y coordinates (mm).

Ex: (-0.014 0.02)

The shift information is calculated from the Frame position to the inspection target. With wide tolerance
frames that match even if they are imperfect, accurate misalignment figures cannot be obtained, and this

should be used only as a guide. This data will be sent via LAN and be checked in the Rc22X.

* Since values cannot be obtained with Inspection Frames that do not use matching algorithms, the
value will be (* *).
* In a package, the center misalignment of the pack master will be displayed. If there are no pack

masters, the value will be (* *).

V¥ 24-5-2 Limitations when using Rc22X/CS-Center

- When sending data to Rc22X/CS-Center, you must select G/NG Confirmation mode or NG Cell
View. Otherwise NG pictures are not sent.

- When sending data from multiple AOI to Rc22X/CS-Center, do not use Auto Trace with
bar check in G/NG Confirmation mode. Because in this mode, all NG pictures are sent

simultaneously, Rc22X can not operate these enormous pictures.
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- When sending data from more than 3 AOI to Rc22X, if there are too many defective pictures and
inspection speed is fast, RC22X can not process data.

- When Esc/clear keys are pressed during verification in G/NG confirmation mode, log is output
to Log22x.log, you can confirm from Console.

- On AOI with angular cameras, images from angular cameras are not sent to Rc22X/CS-Center if

Auto Trace is active.

V¥ 24-5-3 Cut LAN connection during data transmission

When sending inspection data to optional software Rc22X or CS-Center, if you press STOP button
before data transmission is completed, “Wait for the transmitting completion. Do you cut LAN?” message

appears.

Data transmission is not cut even pressing OK button in the dialogue. This is because of preventing mis-
operation by operators. However, if you must stop transmission immediately, press OK button with option

key.
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Note: Hints when data output is too slower than inspection

First treatment is to send machine inspection result without confirming by operator. It is very use-
ful especially with in-line machine, because it can not be stopped. Later operator can confirm and

classify inspection result on Rep22x/CS-Repair.

To set this, open Map View Setting, and check Auto send for all NG in G/NG Confirmation
Mode. (For details, please refer chapter 13-8.) By the way, if you set Screen mode in Small and im-

age Quality in Standard, the time will be more reduced.

Second treatment is to send data in faster mode. Normally NG images are sent one by one, but
with this mode, images are sent continuously. This mode is very powerful when your network is gi-

gabyte.

To set this, open Map View Setting, and click Auto send for all NG twice in G/NG Confirmation
Mode. Then it will be checked with bar mark in stead of normal check mark. The NG images trans-

ferred in this mode is. if there is empty space, colored in green.
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25. PC SetUp and Installation

The PC (Macintosh) must be set up properly before using AOI. This process should be performed right
after you have purchased the PC, AOI using image capture board, insert the Camera Link Board in Mac’s

PCI slot before installation.

* Some items may have different names depending on the OS version, but their function is generally

the same.
25-1 Accounts

Accounts are set up when starting up the PC for the first time. Set up your user name, computer name

and password. Be sure to remember the password since it will be needed when you install the software.
25-2 System Preferences
Set up the following items in system preferences.

® Energy Saver

Set Never for Computer sleep and Display sleep. Uncheck Put the hard disks to sleep when pos-
sible (Screen 1).

¢ Desktop & Screen Savor

Click on the Screen Saver tab and select Never from pull down (Screen 2).

If Screensaver is active, the connection between PC and AOI may be cut.

¢ Software Update

Uncheck Automatically check for updates (Screen 3).

e Keyboard

Aluminum keyboard ( July 2007 on sale ) has a check option “Use all F1, F2, etc. keys...”

If you do not check on this box, shortcut keys for 22x are not available.

* General

On Mac 0S10.5, we recommend to change a font setting in Appearance of System Preference.
Change the value of "Turn off text smoothing for font sizes about 8. Without changing this,

there is no influence on software, but some small text is not smoothly displayed.
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(Screen 1)

(Screen 2)

(Screen 3)

Prohibited

Never activate Screen Sharing or install 3rd party's screen share software. Screen sharing is heavy task

as a result the synchronization of illumination and camera capturing will be incorrect.

25-3 Software Installation

1.

Double-click on Install 22XX and follow the instructions (you will need the password that you

setup in Accounts).

2. The PC will reboot and the installation will be complete.

3.

When the software starts up, the screen size will automatically be optimized regardless of the
System’s Screen Resolution (screen size) settings. If you would like to use a different screen
resolution, set the Resolution in System Preferences > Displays and then go to Settings >
Configuration > Let 22X stay in this display mode in the software. This will link the current
display mode to software startup, and the screen size will always change to this resolution at
software startup. After saving this setting, the menu will change to the Remain in desktop dis-

play mode menu to remove the startup link. (Screen 1)

. Select Settings > Configuration > Settings for Supervisor > Other. Confirm that Enable

cache is selected here. If Enable cache is selected, processes overlapping with the previous

inspection can be eliminated in the second round of inspection. If you have many areas to in-
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(Screen 1)

(Screen 2) (Screen 3) (Screen 4)

spect, we recommend that you select this option to save time (Screen 2).

5. Copy the Stamp Library to the hard disk. Copy the library on the CD, to User/ User name/ Doc-
uments for example (Screen 3).Feel free to copy this library to a location that is convenient for
you, we are sure you will find the various stamps useful.

6. To automatically start this software on system startup, add 22X to Accounts > Login ltems in

System Preferences (Screen 4).
25-4 Connect Mac to LAN

Inspection programs are very important, confidential information for your company. Therefore AOI's
operational PC should not be connect to open network like office LAN, which has connection with
outside. You should create private network exclusive for AOI, Stamp Database or Management software

(Rc22X/Rep22X/Watch22X or Catch System).

How to make private network with fixed IP address is discribed in this chapter. For settings of Rc22X or

Catch System, please refer to their instruction manual.

B Equipments

- LAN cables for each Mac
- Switch Hub (if you dare connect to office LAN, this is not necessary)

- Each Mac should have eithernet board inside.
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* LAN cable should be greater than category 5e for 1Gbps speed, straight cable. Less than category
5 is 100Mbps speed.

* Switch Hub can be called Eithernet Hub or just Hub. Select product for 1000Base-T or greater.

* Even LAN cable and Switch Hub is 1Gbps, Mac except Mac Pro (such as Power Mac G5, iMac) can

have eithernet card for 100Base, then access speed will be decreased.

W Setting 1 [ Physical Connection ]

1. Connect LAN cable to eithernet port on the rear panel of Mac. Mac Pro has 2 ports, connect to
Eithernet 1 (Screen 1).

2. Connect the other side of LAN cable to Hub. Any port of Hub is fine. Setting is completed.

H Setting 2 [ Setting on Mac ]

1. Open System Preferences (Screen 2), click Network (Screen 3).

2. Select Ethernet1 (Screen 4)
* If you log in by non administrator account, key on left bottom is locked. Input administrator password
and release lock.

3. Change configuration to Manually, input 192.168.1.1 for IP Address, and 255.255.255.0 for

Subnet Mask (Screen 4).
4. If your Mac has AirPort, turn it off.
5. Press Apply button, close System Preference window. Setting is done.

6. For another Mac, assign 2,3,4...for the last digit of IP Address (ex. 192.168.1.2). Subnetmask

25-4

(Screen 1)
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should be all the same, 255.255.255.0.
7. When connecting PC where stamp database or Rc22X/CS-Center is installed, assign IP

address as same rule. IP address must be unique.

* If you dare connect Mac to office LAN, ask IP Address, subnetmask, router setting will differ, please

ask administration. However, IP Address should be fixed address.

(Screen 2) (Screen 3)

(Screen 4)
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26. Initial Settings

Usually, these initial settings are already set by the suppliers, but if you are in need please refer each item.
26-1 Authorisation

Before setup, select File > Authorisation > Supervisor mode. This will give you access to all the func-
tions of the machine and software (Screen 1).

* See chapter 3 Startup, Shut Down and Authorisation for details on the Authorisation Mode.
26-2 Lighting Stabilization and Warm-up

After the software has started up, a message Waiting for illumination to stabilize may appear. lllumi-
nation stabilization is not necessary for AOI with LED. During stabilization, a warm-up for the drive unit (heat
run) can be executed. Warm-up operation will first set the Origin Position, then it moves around to the
Fiducial Points in the 4 corners of the PCB carrier. After the heat run, the machine will confirm the Origin

Position again and go to the Eject Position.

26-3 Camera Calibration
Calibration is an important task to set up a standard for the displayed image color. The calibration position

is not preset, so when using this device for the first time, you must set the calibration position.

26-1 26-3-1

(Screen 1)

(Screen 1)
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V¥ 26-3-1 Calibration Setting

1. Select Calibrate from the Settings menu. Click OK when the message "Move to calibration
position?" is displayed. A gray seal will be displayed on the screen, and the Calibrate window
will be displayed (Screen 1).

2. Press the Auto Cal button to adjust the level.

3. If the meters for Red, Green, Blue and Brightness are pointing straight up and the saturation
level is set to the far left (0), it does not matter what level the hue is set to.

4. On some types, calibration executed not only with standard lighting, also with Reduced Light.

5. Confirm that the manual adjustment Gain level is within the range of the arrow under the Gain
slider bar.

6. Press Renew DOAL timing if your AOI has Diffuse-On-Axis LED.

7. Once adjustment is complete, press the Auto Cal. button and end the calibration adjustment

process.

26-4 Mechanical Calibration

There is a plate attached for correcting position and compensate for distortion of the drive. By reading
these 4 Fiducials on the plate, the physical position can be converted into a logical position.

Please confirm Mechanical Calibration after un-packing AOI or after moving place.

V¥ 26-4-1 Confirming Mechanical Calibration

Select Settings > Machine Setup > Mechanical Calibration > Check.

Make sure that each Fiducial is close to the center of the screen. If they are not in the center, execute “Up-
date”. Even they are not in the center, you need to create new Mechanical Calibration by reading the fol-
lowing chapter. After new Mechanical Calibration is created, the coordinates of inspection programs made
in old Mechanical Calibration value will be shifted.

* In order to update (change) the Mechanical Calibration Value set here, hold down the Option key

while selecting Machine Setup > Mechanical Calibration > Update to change the offset value.

V¥ 26-4-2 Creating New Carrier Fiducial Marks

1. Select Setting > Machine Setup >Mechanical Calibration > New. A message window "Ex-
ecute new mechanical calibration.” will be displayed. Click OK.

2. Go to the top left Carrier Fiducial, and the Marker will be displayed in the Work area along with
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6.

the center line. At the same time, the Marker Setup Bar will be displayed underneath the win-

dow.

. Select the Inspection Frame Tool and select the Fiducial at a size roughly twice the size of the

marker (Screen 1).

. Binarise the Fiducial Mark to black and white. Use the Black and White Adjustment Lever in

the Marker Setting window (displayed when you double-click on the border line of the Inspec-
tion Frame) to clearly distinguish the black and white inside the marker (Screen 2). Do not press

the Center Correction Button.

. Once Binarisation is complete, click on the Start Inspection Button. To stop inspection, press

the Stop Button.

Follow the same procedure to adjust markers from top right --> bottom right to bottom left.

7. After all 4 corners have been adjusted, the Mechanical Calibration Value will be displayed. Click

OK.

This Mechanical Calibration Value will be stored in the file and can be used for Mechanical Calibrations in

the future.

26-4-2

(Screen 1) (Screen 2)
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27. Stamp Database

This software has stamp library in each program file. This method is simple and easy because user does
not need to have another stamp library file and manage it. However, if you are in need of following cases;
| want to use same stamps for all programs, or | want to use stamps between different AQI, it will be ef-

ficient to use Stamp Database.

This database can be used in 2 styles. One is alone style: Use stamps for 1 AQI, install database in Mac
which is controlling the AQI. The other is share style: Share stamps with multiple AQI, install database in

Mac which is prepared exclusive for database, and every AOI access to it via LAN.

Before starting up database, you should first install “Database Management Software DB22X”, while first
set-up of DB22X, database is automatically installed. For installation and set-up of DB22X, refer to its Help

Manual. This chapter only describes operations of StampDB which is a tool to access database on 22X.

27-1 Limitations

- This database is Lite edition.

- Mac OS should be greater than 0S10.4.4, 22x operation software should be greater than 4.2.0

- Mac hardware should be MacPro. (Power Mac G5, iMac, Mac mini can be also good, however
performance is not good enough.)

- Network should be 1000 Base eithernet connected via cables. Database response will be slower
under 100 Base environment. Wireless network is not guaranteed.

- Group stamps can not be saved in database.

27-2 First Start-up

Database must be already setup. If you still not, please read manual for database management software
DB22X, page 4 Chapter 4 Installation, and setup in advance.
If you use database in alone style, StampDB automatically search and connect to database.

In share style, make connection to shared database by yourself as following;
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. Open StampDB by clicking Folder Open icon in the right bottom of Stamp List (Screen 1). A

window "StampDB" opens, and message "No DB is set, please set DB first." is displayed

(Screen 2).

. Click OK, then click Please set DB (Screen 3), select DB settings... (Screen 4)

. DB setting window opens. Press Select...button to set DB preference file (Screen 5). Finder

opens, select shared directory of Mac for DB, select DB22XMaster.db22pref file in user's

public folder (Screen 6).

. After proper DB preference file is set, database will be listed on Database List. Click OK to finish

setup. From next time, this procedure is not necessary, database is ready connecting, and you
can start work immediately. However, on 0S10.4, when you try opening StampDB, Connect to
Server dialogue always pops up (See Screen4 on 27-2-), just press OK, then StampDB opens.

If StampDB does not be connected to DB automatically, check 27-6 Troubleshooting.

27-2

(Screen 1)

(Screen 5) (Screen 6)

(Screen 2)

(Screen 3) (Screen 4)
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Status Symbols

Copy stamp in DB to 22X program

Update stamp in 22X program by latest stamp
in DB

Add stamp in 22X program to DB

Update stamp in DB by latest stamp in 22X
program

Stamp not listing on current category, but
existing in DB (Add this stamp to current
category, and update stamps in DB.)

Stamps in DB current category when pressing
Home

27-3 StampDB Interface

Describes interface and functions of StampDB.

1. Current category. Enable to change category by pull-down list.
2. Home. All stamps in current category is displayed by pressing this button.
3. Change stamp list order: Ascending, Descending, Pack Prior, or Status order.
4. Search stamp in current category.
5. Stamp list. Displaying status, master picture and stamp name. Pack stamp is colored in purple.
6. Information navigator;
Selecting 1 stamp: show information of the stamp, if Pack Stamp, configured stamps listed
Selecting multiple stamps: show number of the selected stamps
Operation result: show message after updating stamps, etc
7. Button to compare stamps in 22x inspection program with stamps in database.
8. Copy selected stamp(s) from database to inspection program.
9. Copy selected stamp(s) from inspection program to database.
* If this button is grayed out, database is 'read only'. Release by pressing key icon.
10. Syncronize all stamps.
* If you see only left arrow on this button, database is 'read only'. In this mode,
stamps in database is not updated even after syncronizing.
11. Protect database from writing. Key can be released by pressing and input password which
you set on DB22X.

12. Select database.
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13. Check this on, when you just confirm the update of stamps in current inspection data.

27-4 Work Flow

A general procedure is shown as sample. The work flow does not always fit to your work style.

Open program, open StampDB
v
Select Category
v

Compare stamps

v
Update stamps in program (syncronize)
v
Start programming and finish

v

Update stamps in DB (syncronize)

v
\ Complete )

V¥V 27-4-1 Open StampDB

Start 22X software, open an inspection program. Open Stamp List (Screen 1) from Stamp menu, press

Folder Openicon on (See Screen 1 of 27-2).

V¥ 27-4-2 Select Category

Select stamp category that you want to use (Screen 2).

WV 27-4-3 Compare stamps

Press Check button to compare stamps between the inspection program and database (Screen 3). After
comparing, if there are updated (latest) stamps on database, stamp status will be indicated by green left
arrow (Screen 4). If there is no change between stamps in program and database, no stamp is displayed

on list. This means that you do not need to update stamps in this inspection program.

In case if you create new inspection program, check on "Check stamps 'not in use' too". Then press

Check button. Then you can load all stamps in cctegory.

337

27. Stamp Database




V 27-4-4 Update stamps in program (syncronize)

Update stamps. Select stamps and Press 22X button, or update all by Sync button (Screen 5).

V¥ 27-4-5 Start programming and finish

Create or debug the inspection program.

WV 27-4-6 Update stamps in DB (syncronize)

Press Check button and compare if any stamps in the program are changed. After comparing, the
stamps which are updated are shown with red right arrow (Screen 6). (If you are using DB in share
mode, some stamps can be shown with green left arrow because other operators can be updating

stamps while you are working.)

In order to update stamps in database, click key mark and release database protect by inputting

password (Screen 7). Then press DB button or Sync button (Screen 8).

27-4
(Screen 1) (Screen 2) (Screen 3) (Screen 4)
(Screen 5) (Screen 6) (Screen 7) (Screen 8)
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* When you want to confirm if stamp is surely updated, press home button and display stamps in

current category. Select any stamp which was updated, see information.

V 27-4-7 Complete

Save inspection program and exit 22X software.

27-5 About Stamps and Protection

Stamps once saved in DB has unique ID (UUID), for the detail of UUID please refer to the instruction

manual of DB22X Chapter 7-3.

On StampDB, user can handle Pack stamp without caring that it is Pack stamp. When updating or
copying Pack stamp, just select Pack stamp, you do not need to care for stamps inside Pack stamp,

because they automatically follows Pack stamp.

V¥ 27-5-1 Stamps with same name

Because stamp is given an unique ID, you can add a stamp with same name on DB. However the
category can not have stamps with same name. If you try to add, a dialogue to allow or not allow

overwriting current stamp is displayed (Screen 1). Select which stamp to use, and click OK. Then the

(Screen 1)

(Screen 2)

(Screen 3)
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stamp to overwrite the other one is displayed on StampDB. (Screen 2) Press Sync or 22X/DB button to
update (overwrite).

The sample screen is an example to overwrite the stamp in DB by the stamp in the inspection program.

On 22x software, if you load stamp with same name, a dialogue to select whether overwriting current
stamp or not is always displayed. The dialogue is also displayed even the stamp has same unique ID in

order for user to pay attention (Screen 3).

WV 27-5-2 Database protection

Database is usually protected from writing. It is because of avoiding careless stamp update by operator in

share mode. To unlock protection, click Key icon and input password.

If you are using database in alone mode and you are the only operator to access database, check
Verify password only when first access on DB22X. If this is checked, after inputting password once,

protection is always released.

27-6 Network Troubleshooting

1. Network icon does not exist on left menu in Finder, Mac OS 10.4.

Confirm Finder's Preference if Network is checked in Slidebar tab (Screen 1).

2. No PC is listed on SHARE menu, Mac OS 10.5.
Confirm Finder's Preference if Connected Servers and Bonjour Computers are checked (Screen 2).

Or network settings can be incorrect. Refer to DB22X manual, Appendix A, and confirm settings.

3. No PC is listed when clicking Network icon, Mac OS 10.4.
Depending on network environment, it takes time to show network computers. Please wait for max.
5 minutes. If still nothing is shown, network settings can be incorrect. Refer to DB22X manual

Appendix A, and confirm settings.

4. Logged in the Mac where DB is installed, however no volume is listed on Volume to mount.
- Confirm if you surely log in by right account (not wrong account nor guest account).
- Folder share setting can be incorrect. Refer to DB22X manual Appendix B and confirm share

setting.
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5. When [ try to update database, "Database is locked" message is shown.
- In case of other operator is writing, wait for a while and try again.
- 22x software (and StampDB) is running on the Mac on which database is installed. If you are using
database in share mode, and access to database from local StampDB, other network users can
not write in database.

- You logged in with Guest account. Guest user has no permission to write.

6. In share mode, when | open StampDB next time after first setup, StampDB can not automatically
connect to DB.
- Confirm if you can find Mac for DB in network, if you can not find, there is something wrong with
network or network settings.
- If you change PC name, DB can not be connected. In this case, set DB again by following 27-2-2.

- Confirm if Mac for DB is powered on.

7. My Mac is 0S10.5, but Connect to Server dialogue is always displayed when | open StampDB.
If no password is set for the user account, the dialogue is displayed because Mac can not remember

password in Keychain.

8. For me, it takes too long time to syncronize/update database
This database is free Lite edition, function and performance is limited.

Surely check-off "check stamps not in use too" otherwise you are confirming all stamp's update.

27-6

(Screen 1) (Screen 2)
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28. Angular Gameras

Angular Camera Unit is the optional 8 side camera unit for Model 22X U Series and F Series. The unit is
for inspecting and viewing defective components from 8 angles (each 45 degrees in 360 degrees) . This
chapter only describes the operation of Angular Camera. For setup, installation, or troubleshooting, please

refer the Chapter "Angular Camera Unit".
28-1 Limitations

- Verification mode only possible in G/NG confirmation mode.

- Power on AOI before PC. If PC is powered on at first, recognition of angular cameras may fail.
28-2 Settings Menu

There are settings for Angular Cameras in For Supervisors menu, Angular Camera tab (Screen 1).

H Enable angular cameras (require restarting)

Activate / Deactivate angular cameras.

B Use angular camera screen for verification

If you want to always verify with angular cameras, check this on. If this is not activated, operator verifies in
normal G/NG confirmation mode view, and when the operator wants to check with angular cameras, he

should switch the view manually by clicking mouse or pressing slash (/) key.

H Selected stamps only

Normally angular camera screen is used for verification, however if this option is active, only selected
stamp are displayed in angular camera view.This option is useful when you do not want to show every
defects with angular cameras, e.g. display component detects (missing, wrong or reversing) only by Top
camera, but defects of fillet should be displayed with angular cameras.

* By activating this option, automatically view45 stamps only option is activated also.

Stamps can be selected by following procedure. open Show/Hide Object Type window. Here you decide

which ID should use angular camera view (Screen 2).
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* Beforehand, you need to assign ID to stamps. Please refer the manual chapter 8-10 to know how to
assign ID to stamps.
* Angular camera view of view45 stamps are only sent to Rc22X/CS-Center. The other stamps verified

after switching to angular camera view are also sent.

l View45 stamps only

Normally angular camera screen is used for verification, however if this option is active, only View45Stamp
and View45Calc stamp is displayed in angular camera view. Of course while verifying the other stamps,
by pressing / or pressing screen switch button, the other stamps are also able to be confirmed by angular
camera view.

* Angular camera view of view45 stamps are only sent to Rc22X/CS-Center. The other stamps verified

after switching to angular camera view are also sent.

B Auto-move camera on NG position in Pack

Check this on, if you want angular cameras to show the defect stamp in the center in case of pack stamp.
For example, if there is a lifted lead detected in a QFP pack stamp, angular cameras show the lifted lead

in the center (Screen 3).

28-2

(Screen 1)
(Screen 2)

(Screen 3) ‘

(Screen 4)
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B Views for NG direction in Pack be noticeable
If this option is checked, the views except NG direction are hidden on Pack Stamp. This effect is made for
operators to find NG location as fast as possible (Screen 2 is the example, the 3 views on NG direction are

shown, but the rest of 5 views are hidden.).

Bl Show only NG direction in 4 views

Show NG area even bigger in 4 views. You can still switch to normal 9 views by pressing “view switching
button” at the bottom left (Screen 4).

* If there are defects in multiple views, you can't switch to 4 views.

B Send 'View45Stamp' result as OK to Server

Viewd5Stamp is an exclusive stamp for angular cameras. The stamp let the operator confirm the specified

location with eyes by angular camera view.

When running AQI in auto tracing mode, operator does not verify PCB right after inspection, in stead all
inspection results and NG pictures are sent to server, then after while, confirmed on Repair software with

buffered PCB. Normally, the location where View45Stamp is pasted are sent to Server as NG.

However, if you check on “Send ‘View45Stamp’ result as OK to Server”, the result is sent to Server as

OK. If you pay attention on the production status such as RTY rate, please check this option on.

Bl Show message to prohibit operation while startup

Show full screen startup message.

B Enable to assign reference number for trap frame

This option is assigning reference number to trap frame for tracing. The reference number is attached to
inspection result and sent to our optional production management software.

* When the reference number is assigned and multiple trap frames are detected NG, the NG
information is sent also multiple such as [IC60:1], [IC60:2] to the management software. This means,
normally only one result is sent for one reference designator. But by activating this option, there
are multiple results for one reference designator. This influences the statistics on the management

software.

H Capture delay(ms)

Set the display time for image for auto trace with G/NG confirmation by angular camra. Initial value is 100.

If the image of angular camera is blurred with G/NG confirmation, you can adjust by setting greater value.
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B Reduce Light

Activate the function which the image from angular camera will be displayed with reduced illuminance
status. Set the brightness by value (%) input.

* This function is unable to use in HDA/HMA type.

M Side Camera Debug

Image of NG result is displayed in the window of View45Calc Stamp when we want to debug false NG
point with View45Calc Stamp after inspection. You can switch the screen to current image by clicking
lower left button in the window, so you can check the latest image (Screen 5). Icon will be displayed at
Message Bar in Main Window when this function is activated (Screen 6).

* Inspection image is deleted when you clear the inspection result with pressing “STOP” button.

B Confirm all NG stamps inside the Pack

If there are several NG in Pack, you can check each NG point by angular camera in G/NG confirmation.
Right and left arrow is displayed under the GOOD/NG button in the right side of angular camera window.
You can move to other NG point by clicking arrows (Screen?7). Numbers shown below arrow buttons are

NG number and quantity inside the Pack. Display order of NG points in Pack will be order of Pack Stamp

28-2

® O

(Screen 5) (Screen 6)

(Screen 7) (Screen 8)

345
28. Angular Cameras (Optional)




which had been judged as NG first.

Regardless of displayed NG position, point moves to another NG point by clicking GOOD/NG or Next/

Prev button. It is not possible to judge GOOD/NG for individual NG points inside the Pack.

* Camera displays NG position of short and fillet for ICLead Stamp.

* Possible to display NG points inside the Pack with Auto trace mode, and send the result to Catch
System. Also remote control operation with CS-Center is possible.

* Function is available with following version for CS-Center and CS-Repair.

- CS-Center: Version 1.2.2.9 or greater

- CS-Repair: Version 1.2.2.6 or greater

* Function to confirm all NG stamps inside the Pack is not available if you use Rc22x for product

management software.

H Activate GOOD button only when confirming all NG stamps

If you activate this function, you cannot click GOOD button until you confirm all NG’s inside the Pack.
GOOD button is activated only when confirming all NG with right and left arrow displayed under the
GOOD/NG button in the right side of angular camera window (Screen 8).

* You need to activate “Confirm all NG stamps inside the Pack” to select this function.

Below menu is only shown with Angular Cameras for U22X Series.
H Information

Show information of Angular Cameras, and enable to save the information file on desktop for investigation

when trouble occurs.

B Angular Camera Settings

Menu to confirm and re-position angular cameras. Settings menu will not be used unless trouble

happens. Please refer Error and Troubleshooting in Angular Camera Unit for U22X Series manual.

B Enable Histogram Inspection

Show editing window for F series will be displayed in place of existent pattern matching window. Please

read next chapter 28-3 for usage.
28-3 Creating Inspection Programs [for 22X F Series]

There is a special stamp named "View45Calc" for inspecting by angular cameras. The inspection method
is simple pattern matching and histogram analysis. By simple pattern matchig, first check the matching

of whole image (tolerant), if passed, image is inspected in detail (less tolerant). Histogram analysis is the
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28-3

(Screen 1)

(Screen 2)

(Screen 3) (Screen 4)

same analysis process as original.

Here is the example workflow to create a program to detect QFP lifted lead.

V¥ Load view45Calc stamp

Load View45Calc stamp. Place the stamp where you want to inspect by angular cameras (Screen 1). The
stamp may possible to resize, however resizing stamp size does not change the view size to be captured

by angular cameras.

V Setting view45Calc stamp

1. By double-clicking the frame of View45Stamp, the angular camera screen opens (Screen 2).
Look at 8 views, and examine on which view you can see the lead the best. Here we use the

bottom center view where leads are seen from front.

2. At first, we recommend to place a frame for compansating the position shifting because angular
cameras are very high resolution, a slight position shifting may influence to inspection. Draw a
frame on a object which color is distinguishable to surrounding area. Here we draw a frame on
the lead leg. Select frame creation tool at bottom and draw a frame. Inspection menu window

will open (Screen 3).
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3. Select Cell Aid Frame from pull down menu (Screen 4). Frame color changes from green into

purple. This frame is now for position offset.

4. Next, draw a frame where you want to inspect. Here we like to detect the lifting lead, as a first
step draw a frame on one of the leg. Because lead joint is solder, select Histogram Analysis.

Press Go button or double click the frame. Histogram Analysis window opens (Screen 5).

5. Create trap frames and complete the histogram analysis settings (for the detail of Histogram

Analysis, please read the Chapter about Histogram Analysis Method.)

6. Copy the histogram frame to the other legs by pressing option key and dragging (Screen 6). The

copied frames have same settings as original, and have same number.

* If you resize the copy frame, the frame will be re-numbered and will no longer succeed the same
setting.

* Copy to the different view is not possible.

7. Close the window by pressing OK. Update the stamp by pressing golden stamp button in

Master Stamp Area.

(Screen 5) (Screen 6)

(Screen 7)

348
28. Angular Cameras (Optional)




8. Paste to all the legs of QFP.

9. Start inspection. When lifted lead is detected, show in angular camera view while verification

(Screen 7).

* In this example, we place frames only in one view, however you can place frames on any view.
* Maximum 100 frames can be placed in total views.
* There are other keys than option key possible to be used for operation. For detail, please open Help (?

icon in angular camera view.)

V¥ Tune-Up and Adjustment

View45Calc stamp for angular camera inspection does not show the inspection result by pressing Re-
inspect or Analyze button in Cell Map Area. To confirm the criterion, press Start button and inspect whole

PCB or press Re-inspect button in angular camera view.

V¥ Window

1. Release Anchor When there is Cell Aid frame, the frame position is with offset. By pressing this
anchor icon, the offset is released.

2. Help Explainign operation keys possible to use in these views

3. Selection Tool Select frame. Selected frame opens/shows settings window.

4. Frame Creation Tool Specify the area to be inspected by angular camera by creating trap frames.
After creation, settings window opens and can adjust settings.

5. Delete Delete frames. Also possible to delete frames by delete key.

6. Re-inspect Button Re-inspect all frames.
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V¥ Inspection Menu

1. Inspection Selection Selection from Simple Pattern Matching, Histogram Analysis or Cell Aid
Frame. Press Go button for Histogram Analysis to open Histogram
setting window.

2. Matching Blur Level Set matching level of selected trap frame. Default level is 60% matching.

3. Search Area Searching area for selected trap frame in pixels. Set to X or Y direction
by sliding levers. Area is shown by dotted line around trap frame.
Default size is 1/2 of short side of width or length.

4. Add/Delete Picture Add (+) or Delete (-) master picture.
Master picture can be added maximum 12.

5. Number Assign ID to trap frame. (when Enable to assign reference number is

active.)

V¥ Inspection Method

There are 3 inspection method available.

Histogram Analysis:

Major method for inspection. Setting and creterion is the same as normal histogram analysis by top

camera. However some functions are missing such as sampling debugging.

Simple Pattern Matching:

Simplified pattern matching method.

Cell Aid Frame:

This frame is not for inspection. This frame is for compensating position shifting. Placing a Cell Aid Frame
in one of the 8 views, offset is common in all 8 views. When more than one view has Cell Aid Frame in its

view, the offset is applied to individual view.

28-4 Creating Inspection Programs [for 22X U Series]

There is a special stamp named "View45Calc" for inspecting by angular cameras. The inspection method
is matching. First check the matching of whole image (tolerant), if passed, image is inspected in detail (less

tolerant).

V¥ How to use
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28-4

(Screen 1)

(Screen 2)

1. Load View45Calc stamp

2. Place the stamp where you want to inspect by angular cameras (Screen 1).
* The stamp's default size is same as the size to be seen by Angular Camera (8 angular camera's FoV
is smaller than 22X main camera). By resizing the stamp size, the FoV by angular camera does not
change.

* This stamp can't be include in Pack Stamp.

V¥V Data Creation

By double-clicking the frame of View45Stamp, the angular camera screen with drawing tools opens
Create frames by drawing tools. You can draw many frames. Dragging mouse by pressing option key, you
can copy the frame. Copied frame keeps the same setting, for example, if you add new master picture,

the copied frames also have the new picture (screen 2).

After setting is finished, close the window by pressing OK button. If you want to place this stamp in

multiple places, press golden button in Master Picture Area, update the stamp or save as new stamp.

V¥ Window (Screen 3)

1. Screen Brightness Change brightness and sharpness. This only changes the view of images, thus
this does not give influence to the inspection. For detail, please refer Chapter

28-4 Viewing Operation "Change screen brightness/sharpness".

2. Selection Tool Select trap frame. Selected trap frame opens/shows settings window.
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28-4

(Screen 3)

3. Frame Drawing Tool Specify the area to be inspected by angular camera by creating trap frames.

After creation, settings window opens and can adjust settings.

4. Trash Delete trap frames. Also possible to delete trap frames by delete key.

5. Re-inspect Button Re-inspect all trap frames.

V¥ Settings Window (Screen 3)

1. Master Picture List Show master pictures of selected trap frame.

2. Add/Delete Picture Add (+) or Delete (-) master picture. Master picture can be added maximum 12.

3. Search Area Searching area for selected trap frame in pixels. Set to X or Y direction by sliding
levers. Area is shown by dotted line around trap frame. Default size is 1/2 of short

side of width or length.

4. Matching Level Set matching level of selected trap frame. Default level is 60% matching.

5. Blur Level Add blur effect to decrease false calls..

V¥ Tune-Up and Adjustment

View45Calc stamp does not show the inspection result by pressing Re-inspect or Analyze button in Cell
Map Area. To confirm the criterion, press Start button and inspect whole PCB or press Re-inspect button
in angular camera view (Screen 4). After inspection, the passed frames are colored in blue and failed
frames are colored in red. Matching % and NG reason (in case of NG) will be shown by mouse over the

trap frames (Screen 5).
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(Screen 4)

(Screen 5)

If there are false calls, you can adjust by 1. Adding master picture 2. Decrease matching level or 3.
Increasing Search Area.

If NG reason is Matching (Detail) NG **%, adding master picture is the most recommended method.

28-5 Inspection with White Side Light

Function to brighten the angular camera image by lighting the components from sideway is available
with white side light mounted model. It is effective if main light from the top has difficulty to reach the
inspection point. Please refer to “28-3 Creating Inspection Programs [for 22X F Series] for data creation

procedure.

WV Applicable model

Model with white side lighting (S or GTAz series)

VW Setting of Stamp for auto inspection (view45Calc)

Display setting window by double clicking “view45Calc” Stamp. You can ON/OFF the side LED by clicking
the button in lower left of the window. If you want the inspection with side LED, set the trap frame after
light ON the LED.

* When you change the setting in one inspection frame, the setting will be reflected to other

inspection frame.
28-6 Viewing Operation
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28-5

Power OFF Power ON

V¥ Switch 22X main screen to angular camera screen

Switching from 22X main screen to angular camera screen;
Press slash "/" key on keyboard (including tenkey), or press switch button at the top-right corner of the
22X main window (Screen 1). Do the same operation for getting back to 22X main screen.

* Switching screen is not possible when the camera is at Eject/Home position.

28-6

(Screen 1)

(Screen 2)
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V¥ Change screen brightness/sharpness

While verification in angular camera views, the views sometimes are not comfortable to see by the
color of PCB. For comfortable verification, there is a button to make view “Bright/Dark” or "Sharp".

(Screen 2)

Single click on Brightness button changes views as;

Standard -> Bright -> Dark + Sharp -> Standard + Sharp -> Bright + Sharp -> Dark -> Standard

Once the brightness is changed, it is memorized and you can work in the brightness ever. This only
changes how the screen is seen, therefore this does not give influence to inspection, though the

screen is shown in changed condition while inspection and debugging.

V¥ Operation while verification

Various operation to recognize NG more clearly is possible from G/NG confirmation window of
angular camra.
- Verify the defective components by pressing Good/NG buttons by mouse or arrow keys
on keyboard.
- While verifying, if the image is difficult to see, click each picture to enlarge or press *

(asterisk) key (Screen 3).

28-6

(Screen 3)

(Screen 4) (Screen 8)
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While verifying, if it is difficult to find the target component, press "+" key and display red
cross-hair in the center (Screen 4).

If the area that you want to see is not seen by angular cameras well, double-click the
desired position in the center picture (by 22X top camera) with pressing control key, the
angular cameras move to the clicked position .

When you click the red colored camera icon in bottom right of G/NG Confirmation
window, red colored camera icon appears on NG Stamp in main screen. You can confirm
the position of NG stamp currently displayed (Screen 5). lcon in NG Stamp disappears
when you click the red colored icon again at bottom right of screen. The status of display
the icon is saved for each machine.

This function is available when “Confirm all NG stamp inside the Pack” is activated in

Angular Camera tab from Settings for Supervisors menu.

V¥ Operation while debugging

You can also use angular cameras for efficient debugging. While creating the inspection program, you can

use the angular cameras to confirm if the component/fillet is defect or not by pressing /" key or clicking

switch button.

28-6

(Screen 6)

(Screen 7)

(Screen 8) Move to the right, views from angular cameras are also refreshed together with top camera)
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- If you are selecting the pointer tool or the frame creation tool (Screen 6), you can zoom
the center picture by clicking (Screen 7).
- If you are selecting the move tool, you can freely move the camera position (Screen 8),

but can not zoom the center picture.

- If you click each picture, you can zoom the image (Screen 3). You can also zoom the

image by pressing “*” key.

You can display the cross-hair by pressing "+ " key (Screen 4).

28-7 Viewer Stamp

There is a speical stamp named "View45Stamp" for angular cameras. The area where View45Stamp
is placed, is not inspected by AOI, but when confirming AOI's inspection result, the area is shown by

Angulara Cameras. This stamp let operator to verify by his eyes.

V¥ How to use

1. Load View45Stamp.
2. Place the stamp where you want to confirm after inspection (Screen 1).

3. Start inspection. After inspection, the screen will be in G/NG confirmation mode. While

28-7

(Screen 1)

(Screen 2)

(Screen 3)
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verification, camera stops the area where View45Stamp is placed, and wait for human

verification (Screen 2).

V¥ Setting

By double-clicking the frame of View45Stamp, the setting window opens (Screen 3). In this window, you
can set the direction to high-light while verification. If the direction is set, operator can smoothly find the

best view to see out of 8 angle views.

V¥ Caution about this stamp

Viewd5Stamp is a special stamp. This stamp is not for inspection. Therefore you can not set Search Area,

having Master picture or the other setting which ordinary stamps can do.

28-8 Connect to Rc22X/CS-Center

The pictures taken by angular cameras can be sent to Rc22X/CS-Center as well as the inspection result,
and reconfirm by the PCB reparing software Rep22X/CS-Repair. The remote vefirication in angular camera

screen is also possible on Rc22X/CS-Center.
Below or greater version of software is required to receive pictures of angular cameras;
Rc22X: Version 1.4.4.0 Rep22X: Version 1.5.1.0

CS-Center: Version 1.1.3.0  CS-Repair: Version 1.1.3.0

To know the angular camera operation on each software, please read manual of each software.
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